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Introduction

Accounts Payable handles all your payables record keeping and reporting needs, regardless of the size 
and complexity of your business.

You can use Accounts Payable to set up and maintain your vendor accounts, enter or import transactions 
from various sources, and print checks. You can track vendor account and transaction details on screen 
and on printed reports. Accounts Payable produces the reports you need to avoid late payment charges, 
secure vendor discounts, and match cash requirements to cash resources.

You can use Accounts Payable by itself or as part of an integrated system with other Sage 300 programs.
 You can also transfer Accounts Payable account data to and from spreadsheet and database programs.

You can integrate Accounts Payable with the following Sage 300 programs:

 l General Ledger and Financial Reporter.

 l Purchase Orders.

 l Project and Job Costing.

Depending on your purchase agreement, some features described in this guide may not be available 
in your product.

The Accounts Payable User's Guide contains the following chapters: 

 l Chapter 1: Setting Up Accounts Payable

Set up records and specify options that determine how Accounts Payable processes transactions and 
interacts with other Sage 300 modules.

 l Chapter 2: Setting Up and Maintaining Vendor Records

After setting up processing records, such as the account sets, terms codes, payment codes, and 
distribution codes that you assign to vendor records, you can add vendor records to Accounts Payable.

You use icons in the A/P Vendors folder to add vendor group, vendor, remit-to location, and recurring 
payable records.

 l Chapter 3: Entering and Posting Accounts Payable Transactions

Use Accounts Payable transaction entry screens to record, edit, post, and inquire on the following types 
of transactions:
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 l Invoices, debit notes, credit notes

 l Payments

 l Adjustments

 l Chapter 4: Periodic Processing in Accounts Payable

Use Accounts Payable Periodic Processing screens to perform tasks that are part of your regular 
period-end procedures, such as clearing history, creating general ledger batches, and deleting inactive 
records. 

 l Chapter 5: Importing and Exporting Accounts Payable Data

You can import and export a variety of Accounts Payable records and transactions in a number of 
common formats.

 l Chapter 6: Printing Accounts Payable Reports

Use Accounts Payable report screens to print setup reports and analytical reports.

 l Appendix A: Accounts Payable Screen Guides

Learn how to find and use Sage 300 screens. 

Each screen guide includes navigation information, field help, and a list of tasks you can use the screen 
to perform.

 l Appendix B: Accounts PayableSecurity Authorizations

If security is turned on for your Sage 300     system,     the system administrator must assign users security 
authorization for Accounts Payable screens.

This appendix describes the authorizations you can assign to Accounts Payable users.

 l Appendix C: Data Entry Tools, Tips, and Shortcuts

Use these tools and shortcuts to speed up data entry in Sage 300.

 l Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.
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Chapter 1: Setting Up Accounts Payable

Use Accounts Payable Setup screens to set up records and options that determine how Accounts 
Payable:

 l Processes transactions.

 l Interacts with General Ledger and other Sage 300 modules.

Setting Up Accounts Payable
After you activate Accounts Payable, follow the steps in this topic to set up a new Accounts Payable 
ledger.

Before You Start

 1. Install Sage 300 programs in the following order:       

 a. System Manager (including Bank Services and Tax Services).

 b. General Ledger (if you intend to use it).

 c. Accounts Payable.

 2. Create a system database and a company database.

 3. Choose company-wide options in Common Services.

 4. Activate Bank and Tax Services, and add information about the bank accounts, taxes, and 
currencies used in your accounts receivable system.

 5. Add payables control accounts to your general ledger chart of accounts.

Step 1: Select options and add setup records

 1. Use the A/P Options screen and the A/P G/L Integration screen to specify how your Accounts 
Payable system will operate.

 2. Design coding schemes for your Accounts Payable records. For more information, see "About 
Designing Accounts Payable Coding Schemes" (page 13).

 3. Add records and print setup reports. For more information, see:
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 l "Adding 1099 / CPRS Codes" (page 17)

 l "Adding or Modifying an Account Set" (page 19)

 l "Adding or Modifying a Distribution Code" (page 22)

 l "Adding or Modifying Distribution Sets" (page 25)

 l "Adding or Modifying E-mail Messages" (page 29)

 l "Adding or Modifying an Optional Field" (page 31) (if you use them)

 l "Adding or Modifying a Payment Code" (page 35)

 l "Adding Payment Selection Codes" (page 37)

 l "Adding or Modifying a Terms Code" (page 42)

Step 2: Add vendor records

For more information, see:

 l "Adding, Modifying, or Deleting a Vendor Group" (page 49)

 l "Adding, Modifying, or Deleting a Vendor" (page 58)

 l "Adding, Modifying, or Deleting a Remit-to Location for a Vendor" (page 62) (optional)

 l "Setting Up a Recurring Payable for a Vendor" (page 66)

 l "Printing the Vendors List" (page 285) 

 l "Printing the Vendor Group List" (page 282) 

 l "Printing the Remit-To Locations Report" (page 280) (optional)

Step 3: Transfer your accounting data to Accounts Payable

For more information, see:

 1. "About Entering Current and Historical Transactions" (page 67)

 2. "About Batch Processing in Accounts Payable" (page 80)

 3. "Printing Batch Listings" (page 245) and "Printing Posting Journals" (page 266)

Step 4: Design formats for your preprinted forms

Design and test formats for printing checks, advices, letters, and labels, or adapt the sample formats to 
print on your own forms. For more information, see "Customizable Formats for Printed Accounts Payable 
Forms" (page 44)
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Using a Self-Assessed Tax
A self-assessed tax is one that you must pay, even though the vendor does not collect it. These taxes 
commonly arise when you order goods from another state or province, but you are still subject to local 
sales taxes.

Accounts Payable does not have a self-assessing tax type, but you can use the program to calculate self-
assessing taxes and distribute them to expense and tax payable accounts. The trick is to create two tax 
authorities.

To create a self-assessed tax for use in Accounts Payable:

 1. In Tax Services:

 l Use the Tax Authorities screen to create two new tax authorities:       

 l Authority 1 is the tax expense. This tax can be distributed with the invoice amount or 
expensed separately to a tax expense account.

 l Authority 2 is the tax payable. Specify that this tax is expensed separately to the tax 
payable account.

 l Use the Tax Classes screen to create Purchases tax classes for vendors and items for both 
tax authorities.

 l Use the Tax Rates screens to define tax rates for purchases for each of the authorities:       

 l For authority 1, specify the tax rate as you would for any other tax.

 l For authority 2, specify a negative tax rate of the same amount that you specified for 
authority 1.

Note: The two taxes will cancel each other, and not add to the value of the invoice.

 l Use the Tax Groups screen to add both taxes to the tax group you want to use for purchases 
that involve self-assessed taxes.

For more detailed information about setting up tax authorities, tax classes, and tax groups, see the help 
for Tax Services.

 2. In Accounts Payable, specify the self-assessing tax group when you add an invoice.     

Note: 
 l Make sure that you are using the same tax class for both taxes.

 l If you are not calculating tax, enter a positive tax amount for authority 1 and a 
corresponding negative amount for authority 2 on the Vendor Taxes tab.       

If you are calculating tax, set the two taxes to "No" in the Tax Included field.
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Accounts Payable Options
The options you select on the A/P Options screen determine how your Accounts Payable system 
operates and the types of data that it stores and displays. You can change most of these options after 
setup, as needed.

About Selecting Accounts Payable Options

Once you have activated Accounts Payable, your first task is to use Accounts Payable's Options screen 
to choose the options you want to use with your Accounts Payable system.

You also use the G/L Integration screen to specify how and when to produce transactions for General 
Ledger.

The options you choose determine how your Accounts Payable system will operate, and the types of data 
that will be stored and displayed. You can also use the screens after setup to review your entries and 
change most of them, if necessary.

About Displaying Open Documents in Payment Entry

You can control the order in which open documents (such as invoices that are not yet paid, or credit notes 
that have not been applied) appear in selection lists when you are applying payments in the Payment 
Entry screen. This option lets you display the documents in the order that is easiest for you to use.

Accounts Payable displays open documents by document number unless you choose another order. To 
change the order at any time, use the Default Order Of Open Documents option on the Transactions tab 
on the A/P Options screen.

You can choose to display open documents for each vendor account by:

 l Document number. This choice lists open documents, such as invoices, credit notes, and debit 
notes, by their document numbers, beginning with the lowest document number for each 
transaction type.     

If you use this option, you should consider prefixing vendor invoices, credit notes, and debit notes so 
Accounts Payable will list documents in the order you prefer.

The following prefixes would list invoices first, followed by interest invoices, credit notes, debit notes, 
and adjustments:

 l IN (invoice)

 l INT (interest invoice)

 l NCR (credit note)
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 l NDR (debit note)

 l XADJ (adjustment)

 l PO number. This choice groups open (unpaid or unapplied) documents (invoices, credit notes, 
and debit notes) by their purchase order numbers. Documents issued from the lowest purchase 
order number are displayed first.

 l Due date. This choice lists open invoices, credit notes, and debit notes by their due dates, 
beginning with the document with the oldest (earliest) due date.

 l Order number. This choice groups open documents by their sales order numbers. Documents 
entered with the lowest sales order number are listed first.

 l Document date. This choice lists open documents by the document dates entered with them, 
beginning with the oldest date.

 l Current Balance. This choice lists open documents by their outstanding balances, beginning with 
the smallest amount.

About Assigning Document Numbers to Prepayments

Accounts Payable assigns a unique number to each prepayment document you add to a payment batch.

The number is a combination of a prefix that identifies the transaction type, and a number that is assigned 
sequentially by Accounts Payable, starting with the number you specify.

You enter the prefix and next number to assign to prepayment documents on the Numbering tab of the 
A/P Options screen.

You may be able to continue using your current numbering scheme. At any time, you can also specify a 
different prefix and next number on the A/P Options screen for Accounts Payable to assign. (However, 
you cannot make a change that would create duplicate document numbers.)

Check number sequences and the next check number are set in Bank Services. Invoices use the 
numbers assigned by the vendor.

Prefix and Next Number

You can use up to six characters for the prefix, and up to nine digits for the document number.

If you do not enter a prefix and document number, Accounts Payable automatically assigns 1 as the first 
document number and uses "PP" as the prefix for all prepayment documents.

Sequence Number

When you add a prepayment in the Payment Entry screen, Accounts Payable automatically assigns a 
document number, using the prefix and next number you specified on the A/P Options screen. If you use 
the assigned number, the Next Number box is updated on the A/P Options screen.

Document numbers can go as high as 999999999, then they are automatically reset to 1.
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Changing the Next Document Number

If you want to change the next number to assign on the A/P Options screen to a lower number, you may 
want to also change the prefix, to prevent Accounts Payable from assigning the same document number 
twice. You cannot post two documents with identical document prefixes and numbers.

Selecting Options for Accounts Payable

You use the A/P Options screen to select processing, transaction, and numbers options and enter 
general information about your Accounts Payable ledger.

Note: You use the G/L Integration screen to select options that control how Accounts Payable interacts 
with General Ledger, including when and how to process General Ledger transactions.

Before You Start

 l Make sure that no other users are using Accounts Payable and that no other Accounts Payable 
screens are open on your computer.

 l Make sure that you understand the effect your selections have on Accounts Payable processing. 
For general information, see "About Selecting Accounts Payable Options" (page 6). For help on each 
option that appears on the screen, see "A/P Options Screen" (page 325).

To set processing options for Accounts Payable:

 1. Open Accounts Payable > A/P Setup > Options.

 2. Click the tab that contains the options you want to change.

 3. Make your changes.

 4. Click Save to keep your changes.

Note: You cannot save most changes to the A/P Options screen if any other Accounts Payable 
screens are open.

 5. Click Close when you are finished or to leave the screen without changing any information.

After selecting options for Accounts Payable

Print the A/P Options report. For more information, see "Printing the A/P Options Report" (page 231).

Setting Up Accounts Payable to Use Multicurrency Accounting

Accounts Payable lets you process invoices and payments in any currencies your vendors use. 

8Sage 300 2023 Accounts Payable User's Guide



Note: You require a license for Sage 300 Multicurrency to use multicurrency features.

Before You Start

 l If you have not already done so, set up multicurrency accounting for the company:      

 l Install Sage 300 Multicurrency.

 l In Common Services, on the Company Profile screen:

 l Select the Multicurrency option for the company.

 l Specify the Default Rate Type.

 l Specify the Gain/Loss Accounting Method.

 l In Common Services, use the Currency screens to add any currency codes you need for 
Accounts Payable, and enter rates for the currencies you use.

Note: When you install Sage 300, you also install a large set of currency codes that use 
standard international abbreviations. You need to define new codes only if you do not use the 
international codes.

To set up a multicurrency Accounts Payable ledger:

 1. On the Processing tab of the A/P Options screen, select the Multicurrency option for Accounts Payable.

Note: Once you turn on the Multicurrency option, you cannot turn it off again.

 2. Use the A/P Account Sets screen to add at least one account set for each currency you want to use in 
Accounts Payable. 

For each account set, enter the currency code and the numbers of your exchange gain and loss general 
ledger accounts.

 3. When you create vendor groups and vendor records, select the account set and the rate type for each 
record.

The vendor's account set determines the vendor's currency. The vendor group account set is only a 
default when adding vendor records. You can override it.

Note: Invoices are always issued in the vendor currency, although payment can be in any currency.

 4. If you post transactions to add year-to-date figures, enter them in the appropriate currencies.
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 5. If you enter statistics for previous years and periods, you must enter amounts in both the functional 
and vendor currencies. Accounts Payable cannot calculate equivalent amounts from statistics you 
enter yourself.

After setting up a multicurrency Accounts Payable ledger

When you post transactions during and after setup, Accounts Payable calculates statistical totals in both 
the functional currency and the vendor's currency, using the exchange rate posted with each transaction.

Integration with General Ledger
You select options on the A/P G/L Integration screen to:

 l Control how Accounts Payable interacts with General Ledger.

 l Specify the types of information to send with the transactions you send to General Ledger from 
Accounts Payable.

About Using Accounts Payable with Sage 300 General Ledger

If you use Sage 300 General Ledger, Accounts Payable creates batches of general ledger transactions in 
General Ledger and displays and validates General Ledger account numbers in Accounts Payable.

The G/L Transactions report and the summary at the end of each Accounts Payable posting journal list 
the general ledger accounts that will be debited and credited with payables transactions when you post 
the Accounts Payable batch of general ledger entries in General Ledger.

You use the G/L Integration screen to specify the type of reference and description to include with each 
General Ledger transaction.

Until you clear the transactions using the A/P Clear History screen, you can drill down from the General 
Ledger Transaction History screen to view originating transactions in Accounts Payable and Order Entry 
(if you use it).

General Ledger Accounts Used in Accounts Payable

Accounts Payable uses the following general ledger accounts: Payables Control, Bank, Purchase 
Discounts, Prepayment, and the accounts you assign to distribution codes or enter with transactions.

Multicurrency Ledgers

If you use multicurrency accounting, Accounts Payable also uses General Ledger's unrealized and 
realized exchange gain and loss accounts.
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If your Sage 300 General Ledger system is at another location, Accounts Payable creates its general 
ledger transactions in a batch that you can import into General Ledger.

Selecting General Ledger Integration Options for Accounts Payable

You use the A/P G/L Integration screen to select options that govern how Accounts Payable interacts with 
General Ledger, including when and how to create G/L batches and the type of information to send to 
General Ledger with posted transactions.

Before You Start

 l Make sure no one else is using Accounts Payable when you change options. 

Important! You can update some information while others are using Accounts Payable (such as the 
payables department phone number and contact person), but most options can be changed only if no 
one else is using the system.

 l Become familiar with the G/L integration options you want to change before you make any 
changes. For more information, see "A/P G/L Integration Screen" (page 320).

To change G/L integration options:

 1. Open Accounts Payable > A/P Setup > G/L Integration.

 2. Use the Integration tab to change options that determine how and when to process general ledger 
batches.

 3. Use the Transactions tab to change the information that is included with general ledger 
transactions. More...

To edit information for a G/L transaction field:

 a. Either double click the field for the particular transaction header or detail, or select the field, and 
then click Open.

The G/L Integration Detail screen appears, showing the transaction type and the G/L transaction 
field you selected on the Transactions tab. Use this screen to specify information from Accounts 
Payable transactions to use in G/L transactions.

 b. Specify information for the selected G/L transaction field, as follows:

 i. Select a character to separate segments of information. (The separator is used only if 
you assign more than one segment. The default separator is a hyphen.)
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 ii. To assign one or more segments to the selected transaction field, select the segment(s) 
from the Choose Segments From List, then click Include. More...

You can assign a maximum of five segments to a G/L Transaction field, providing the 
combination does not exceed 60 characters. If the assigned information exceeds this 
number of characters (including separators), it is truncated when the transaction is 
posted.

If you use Project and Job Costing, the names you chose for contract levels also appear 
(for example, Contract, Project, and Category).

 c. With the G/L Integration Detail screen open, you can edit information for other Accounts Payable 
transaction types, as follows:

 i. Select the transaction type or transaction detail type from the Transaction Type field.

 ii. Select the G/L transaction field to which you are assigning information.

 iii. In the Segment Separator field, select the symbol to use between information 
segments.

 iv. Assign segments to include from Accounts Payable transactions, as described in the 
preceding instructions.

 d. When you have finished editing reference and description fields, click Save, and then click 
Close to return to the Transactions tab.

 4. When you are satisfied with your choices for G/L integration, click Save, and then click Close.

After selecting G/L Integration options

 l Print the G/L Integration report by clicking File > Print on the G/L Integration screen or by using 
the G/L Integration icon in the A/P Setup Reports folder.

Setting Up and Maintaining Processing Records
Before you can add vendor records to Accounts Payable, you must set up the records that you will assign 
to vendors:

 l 1099/CPRS codes

 l Account sets

 l Distribution codes

 l Distribution sets (optional)

 l E-mail messages (optional)

 l Optional fields (if you use Sage 300 Transaction Analysis and Optional Field Creator)
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 l Payment codes

 l Payment selection codes

 l Recurring Payables

 l Terms

About Designing Accounts Payable Coding Schemes

Before you can use Accounts Payable, you must add codes to identify the account sets, distribution 
codes, vendors, and other records you will add to your system. You should take the time to design 
sensible coding schemes for each type of code you require, before you start assigning codes to records.

If you already have a system for these codes, you may be able to continue with the same system. To 
check whether each code type allows for the number and type of characters you use in your current 
system, review the following list:

Code Name Maximum Number of Characters

Account set code 6 digits and letters

1099/CPRS code 6 digits and letters

Distribution code 6 digits and letters

Distribution set 6 digits and letters

Payment selection code 6 digits and letters

Recurring Payable code 15 characters

Remit-to location code 6 characters

Terms code 6 digits and letters

Vendor group code 3 digits and letters

Vendor number 12 characters

Codes Used in Accounts Payable

If you are designing new codes, you should assign codes that make it easy to identify each record type 
and that list records in the order you want them to appear on reports and in Finder windows.

Each code is a unique set of letters, symbols, and digits. For example, each of the following could be a 
valid vendor number:
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 l 123

 l 123A

 l AB1234

 l A1

 l A01

To simplify codes, we recommend that you:

 l Use the same number of characters in all codes of the same record type.

 l Where permitted, define codes of at least three characters to allow for future expansion.

 l Use a numbering system that is significant for your business, such as a geographical region or 
division or vertical market.

 l If possible, use only numbers (not letters or symbols), for consistency of sorting.

Sorting Order of Codes

Accounts Payable sorts codes on screens and reports in a specific order, which you should take into 
consideration when designing codes.

The program reads codes from left to right, and uses the following sequence to put them in order:

[Blank] ! " # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C D E F G H I J K L M N O P Q R S T U V 
W X Y Z [ \ ] ^ _ ` a b c d e f g h i j k l m n o p q r s t u v w x y z { | } ~

The codes listed in the introduction to this discussion would be sorted by the program into the following 
order:

 l 123

 l 123A

 l A1

 l A01

 l AB1234

You should use the same number of characters in all your codes, to avoid number sequences such as:

 l 100

 l 10000

 l 19

 l 2

 l 2000
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About Importing Setup and Vendor Records

If you presently have a computerized accounts payable system, you may be able to transfer vendor 
records directly into Sage 300 Accounts Payable by importing them.

You can also export records from another Sage 300 Accounts Payable database, edit them in a 
spreadsheet or other program to change codes, amounts, and other information, then import them into 
the new Accounts Payable system you are setting up.

Accounts Payable records you can import and export include:

 l Account sets

 l 1099/CPRS codes (although these are set up by Accounts Payable)

 l Distribution codes

 l Distribution sets

 l E-mail messages

 l Payment codes

 l Remit-to locations

 l Terms codes

 l Vendor groups

 l Vendors

 l Payment selection codes

Example: You could export vendor records to a spreadsheet to analyze their statistics. You could also 
export all vendor records with the same account set to a spreadsheet, change their tax group, then 
import them back into Accounts Payable.

You can import and export data to different types of file, including:

 l Microsoft Excel

 l Microsoft Access

 l Comma Separated Values

 l Continuous ASCII

 l ODBC

 l XML

You can also create files to be imported by Accounts Payable in any of the above programs or formats.

For more information about importing and exporting records, see the System Manager Help.
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1099 / CPRS Codes

1099/CPRS expense class codes identify different categories of 1099/CPRS payments and establish 
how you print 1099/CPRS forms for different vendors. You must assign a 1099/CPRS code in the 
Vendors screen to each vendor you mark as subject to 1099/CPRS reporting.

About 1099 / CPRS Codes

You use the A/P 1099/CPRS Codes screen to add codes to assign to vendors that are subject to 
1099/CPRS reporting. You must enter a 1099/CPRS code in the Vendors screen for each vendor you 
mark as subject to 1099/CPRS reporting.

1099/CPRS expense class codes identify different categories of 1099/CPRS payments. You specify the 
default 1099/CPRS code for each vendor in the vendor records, but you can specify a different code for 
each invoice, if necessary.

The Minimum To Report amount that you enter for a 1099/CPRS code is used when you print 1099 forms 
or file 1099s electronically.

After activating a new database, you set up the 1099/CPRS codes that you need. Once this is done, you 
should have to add or edit codes only if the existing code structure changes.

1099/CPRS vendor amounts are accumulated by code and by period. Each time you enter an invoice, 
you can specify the 1099/CPRS code to which the invoice applies.

Accounts Payable prints each code amount in the appropriate box on the 1099/CPRS form. This is 
determined based on the form type and year that you specify when printing the form.

Note: Although 1099/CPRS codes and amounts are entered with vendor invoices, Accounts Payable 
accumulates the 1099/CPRS statistics each time you post payments for the vendor.

Editing 1099/CPRS Codes

You can change the description and Inactive status only. You cannot change the 1099/CPRS code.

However, assigning Inactive status does not affect the accumulation of 1099/CPRS information at 
posting.

Deleting 1099/CPRS Codes

Deleting codes does not remove any information from your ledger (except the code definition). However, 
you should not delete 1099/CPRS codes if you are required to print 1099/CPRS forms. If you accidentally 
delete a code, just add it again.

If you delete a 1099/CPRS code, you can no longer assign it to vendor records—nor can you update a 
vendor record which has that code assigned.

16Sage 300 2023 Accounts Payable User's Guide



Adding 1099 / CPRS Codes

1099 forms are used in the United States to report the amount of purchases from your US vendors.

The Contract Payment Reporting System (CPRS) is a Canadian tax reporting system designed for 
reporting payments made to Canadian construction subcontractors.

Before You Start

Select the Use 1099/CPRS Reporting option on the Transactions tab of the A/P Options screen.

To add a 1099/CPRS code:

 1. Open Accounts Payable > A/P Setup > 1099/CPRS Codes.

 2. Enter a code in the 1099/CPRS Code field, and then enter information in the remaining fields:

 l Description. Enter a description of the code.

 l Tax Reporting Type. Specify whether the code is for reporting 1099 or CPRS amounts.

 l Amount Type. If you select 1099 as the tax reporting type, you must also specify an amount 
type (such as Rents or Nonemployee Compensation).

Amounts of a certain type may need to be reported in different boxes, or even on different forms, 
from one year to another. When you print 1099/1096 forms, the amount type for each 1099 code 
is used together with the form type and year for which you are reporting to determine where to 
print amounts.

 l Minimum To Report. Enter the lowest amount you are required to report for each code. Only 
vendors with a total 1099 amount equal to or greater than this amount are included in the 
electronic 1099 file or on printed 1099 forms.

 3. Click Add.

After adding 1099/CPRS codes

 l Click File > Print, or choose the 1099/CPRS Codes icon from the A/P Setup Reports folder to print 
a list of the codes you have added.

 l Verify that the codes are correct and complete, and then file the report.

Account Sets

An account set is a group of general ledger account numbers, including the payables control account, to 
which vendors' transactions are distributed.

You must create at least one account set before you can add vendor records.
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About Account Sets

You must create at least one account set before you can add vendor records.

If you use multicurrency accounting, you must add at least one account set for each currency used by 
your vendors. The account set you assign to a vendor must use the vendor's currency.

In multicurrency ledgers:

 l Specify the currency used by vendors assigned to each account set.

 l For account sets that do not use the functional currency, enter account numbers for unrealized 
exchange gains and losses, and realized exchange gains and losses.

 l For account sets that do not use the functional currency, specify an account for exchange rounding 
differences.

Multicurrency Account Sets

If you use multicurrency accounting, you assign a currency code to each account set to identify the 
currency used by the vendors you will assign to the set. Once you save (add) an account set, you cannot 
change its currency.

Multicurrency account sets that do not use the functional currency also include the accounts to which you 
post gains and losses that result when you revalue Accounts Payable transactions at new exchange 
rates:

 l Unrealized Exchange Gain (available only if you use the Realized and Unrealized Gain/Loss 
accounting method)

 l Unrealized Exchange Loss (available only if you use the Realized and Unrealized Gain/Loss 
accounting method)

 l Exchange Gain

 l Exchange Loss

 l Exchange Rounding

These general ledger accounts must allow the account set's currency.

The general ledger accounts you assign to multicurrency account sets depend on the type of currency 
information you require in your general ledger. For example, you might use a separate Payables Control 
account for each currency, but use the same numbers for the rest of the accounts in all your account sets.

If you use the same account number for all the unrealized and realized exchange gains and losses 
accounts, the balance in that account in your general ledger will be the net exchange gain or loss on 
Payables transactions.
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Editing Account Sets

You can change everything in most records except the identifying code. To change the code, you first add 
a record with the code you want to use, then delete the record with the code you do not want.

If you use multicurrency accounting, you cannot change the currency code assigned to an account set.

Deleting Account Sets

You can delete account sets only when they are not assigned to vendors or vendor groups.

If you want to delete a code that is assigned to a vendor group or vendor record, you must first assign a 
different account set to the vendor record, then delete the unwanted code.

Adding or Modifying an Account Set

You use the A/P Account Sets screen to create groups of general ledger account numbers that you can 
use to categorize vendor transactions when they are posted in general ledger.

You must create at least one account set before you can add vendor records.

Before You Start

Before adding account sets:

 l Decide on the codes to use for the new account sets.

 l Determine the general ledger account numbers to assign to the account sets. More...

You need to know the numbers of these general ledger accounts:

 l Payables control

 l Payment discounts

 l Prepayments

 l Retainage (if you use retainage accounting)

 l If you use multicurrency accounting, you also need to know the currency code for each account 
set that does not use the functional currency, as well as the account numbers for the exchange 
gain and exchange loss accounts. (The names of the accounts vary, depending on the 
Gain/Loss Accounting Method selected for your company.)

Note: If your database does not include Sage 300 General Ledger, Accounts Payable does not verify 
any general ledger account numbers. You must check the numbers you specify against the general 
ledger that you use.

19Sage 300 2023 Accounts Payable User's Guide



Before editing or deleting account sets:

 l Verify the codes for the account sets you are changing or deleting.

 l Print the Vendor List and Vendor Group List, including Profile information, to see which vendors and 
vendor groups use the account sets you want to delete. 

Note: You can delete an account set only if it is not assigned to vendor records (including vendor 
groups).

 l Reassign any vendors and vendor groups to different account sets, if they use an account set you 
are planning to delete.

 l If changing account numbers, ensure that your general ledger contains the accounts you want to 
assign.

To add a new account set:

 1. Open Accounts Payable > A/P Setup >        Account Sets.

 2. On the screen that appears, enter information in the following fields:   

 l Account Set Code. Type a code, up to six characters, to identify the account set.

 l Description. Type a description of the account set.

 l Currency Code. If this is a multicurrency account set, type the currency code, or use the Finder to 
select it.

Note: You cannot change the currency code after you add the set.

 l General Ledger Accounts. Type or select the general ledger account numbers that make up the 
set. If you use Sage 300 General Ledger, you can select the account numbers from the Finder.

In a multicurrency account set that does not use the functional currency, you must also enter the 
currency code and account numbers for the exchange gain, exchange loss, and exchange 
rounding accounts.

 3. When finished, click the Add button.

To edit an account set:

 1. Open Accounts Payable > A/P Setup >        Account Sets.

 2. Select the account set you want to change.

 3. Make your changes.
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Note: If you use multicurrency accounting, you cannot change the currency code assigned to an 
account set.

 4. Click Save.

To delete a terms code:

 1. Open Accounts Payable > A/P Setup >        Account Sets.

 2. Select the account set you want to delete.

 3. Click Delete.

If a message appears asking you to confirm the deletion, click Yes.

After adding, editing, or deleting account sets

Print and file the Account Sets report.

Distribution Codes

A distribution code is a name for a single general ledger account. Distribution codes provide an easy way 
to specify account numbers when you distribute purchases, because you can make them shorter—and 
easier to remember—than the general ledger account numbers.

About Distribution Codes

Accounts Payable lets you distribute transactions by distribution set (a group of distribution codes), by 
distribution code, or by general ledger account number. You select a default distribution method for each 
vendor in the vendor records.

Once you define distribution codes, you can group them in distribution sets, to provide sets of default 
distributions for assignment to vendors.

Posting Transactions with Distribution Codes

When you post invoice and adjustment batches, Accounts Payable creates general ledger transactions 
for the accounts represented by distribution codes, and lists the information on the posting journals.

Effects of Changes

You can change the description and the general ledger account number assigned to a distribution code, 
but you cannot change the distribution code.
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If you change the general ledger account assigned to a distribution code, the new general ledger account 
is used only in transactions you add after making the change. Existing transactions will be posted to the 
original general ledger account, unless you edit the transactions to enter the new account number.

If you change the general ledger account assigned to a distribution code, the new account number is 
automatically entered in any distribution set records that use the distribution code.

Making a distribution code inactive has the following consequences:

 l You cannot select an inactive distribution code as the default code when adding a new vendor 
group or vendor record.

 l You cannot update a vendor group or vendor record that uses an inactive distribution code.

 l You cannot assign the inactive distribution code to items, or use it when you add an invoice. (But 
you can print and post the invoice if you made the distribution code inactive after you entered the 
invoice.)

 l You cannot add or save changes to a distribution set that includes an inactive distribution code.

Deleting Distribution Codes

Deleting codes does not remove any information from your ledger (except the code definition). If you 
accidentally delete a code, just add it again.

Note: Accounts Payable does not stop you from deleting a code which is part of a distribution set, or a 
code which is assigned to a vendor record. However, if you delete a distribution code, that code will be 
rejected when you try to distribute an invoice using the code (even if you are using the code in a 
distribution set).

Deleting a code after adding an invoice (but before posting it) has no effect on posting. However, you will 
have to change the code if you edit the invoice, because you cannot save changes to an invoice that uses 
a deleted distribution code.

Adding or Modifying a Distribution Code

You use the Distribution Codes screen to add distribution codes. For each record you enter a unique 
code, up to six characters, a description (name) for the code, and the general ledger account number that 
the code represents.

You can define as many distribution codes as you need to represent the various general ledger accounts 
to which you distribute purchases.
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Before You Start

 l Before adding distribution codes:

 l Decide on the distribution codes to use.

 l Determine the general ledger accounts to assign. (If necessary, add the general ledger accounts 
you want to assign.)

 l Before changing distribution codes, print the Distribution Codes report to check the information for the 
codes you want to change.

Note: You can modify existing distribution codes, as necessary, but you cannot change the 
identifying code itself.

 l Before deleting distribution codes:

 l Print the Vendor List and the Vendor Group List, including Profile information, to see which 
vendors and vendor groups use the distribution codes you want to change.

 l Assign a different distribution code to vendor groups and vendor records that use the code 
you want to delete. You cannot delete a distribution code that is assigned to a vendor.

 l Print the Distribution Sets report to check whether the distribution code is used in any 
distribution sets. (Accounts Payable does not warn you if you are deleting a code that is part 
of a distribution set, but you will not be able to use the code if you distribute an invoice using 
the distribution set to which it belonged.)

 l Post any outstanding batches containing transactions that use the code you want to delete. 
Although you can post these batches later, you must enter a new code.

To add a distribution code:

 1. Open Accounts Payable > A/P Setup >        Distribution Codes.

 2. On the screen that appears, enter information in the following fields:   

 l Distribution Code. Type a code, up to six characters, to identify the distribution code.

 l Description. Type a description of the distribution code.

 l G/L Account. Enter the general ledger account number to which amounts posted with the 
distribution code are distributed. If you use Sage 300 General Ledger, you can select the 
general ledger account number from the Finder.

 l Discountable. Select this option if you want invoice, credit note, debit note, and recurring 
payable details that use this distribution code to be discountable by default. (You can change 
the Discountable status when you enter a detail.)

 3. When finished, click Add.
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To edit a distribution code:

 1. Open Accounts Payable > A/P Setup >        Distribution Codes.

 2. Select the distribution code you want to change.

 3. Make your changes.

 4. Click Save.

To delete a distribution code:

 1. Open Accounts Payable > A/P Setup >        Distribution Codes.

 2. Select the distribution code you want to delete.

 3. Click Delete.

If a message appears asking you to confirm the deletion, click Yes.

After adding, editing, or deleting distribution codes

 l Print and file the Distribution Codes report. For more information, see "Printing the Distribution 
Codes Report" (page 227).

 l Print new copies of the Vendor Group List and Vendors List.

 l Update any distribution sets that contained a deleted distribution code. 

 l Print new copies of the Distribution Sets report.

 l Edit any transactions that used deleted distribution codes, assigning new distribution codes or 
general ledger account numbers to which to post the transactions.

Distribution Sets

Distribution sets are groups of distribution codes or accounts. 

For example, if you typically distribute invoices from vendors to three different accounts, you can define 
three distribution codes, then define one distribution set that includes the three codes. You then assign 
the distribution set to vendor accounts.

About Distribution Sets

You can define as many distribution sets as you need to represent the various combinations of general 
ledger accounts to which you post invoice data.

For each distribution set, you enter a unique code, up to six characters, a description (name) for the code, 
the method for distributing the amounts (Manual, Spread Evenly, Fixed Percentage, or Fixed Amount) 
and the list of distribution codes (or General Ledger accounts) in the set.
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Accounts Payable also lets you enter particular General Ledger accounts, as well as distribution codes, 
in distribution sets.

You do not have to add distribution sets, but it is more efficient to enter a single distribution set rather than 
several distribution codes or accounts when you add a transaction.

Editing a Distribution Set

You can change the description, the distribution method, the list of distribution codes, and the accounts in 
a distribution set, but you cannot change the code that identifies the distribution set.

If you want to reuse the description and discount status from an existing distribution code, add the 
distribution code to the distribution set. Then clear the Dist. Code field, and enter the G/L account you 
want to use. (You cannot change the account for a line to which a distribution code is assigned.)

Effects of Changes

If you make a distribution set inactive:

 l You cannot select the inactive distribution set as the default set when adding a new vendor group 
or vendor record.

 l You cannot save changes to a vendor group or vendor record that is assigned the inactive 
distribution set.

 l You cannot use the inactive distribution set when you add an invoice. (But you can print and post 
transactions that include the distribution set if you made it inactive after you entered the 
transaction.)

If you change the accounts for a distribution code, Accounts Payable immediately updates the 
distribution sets that use the those codes when you save the changes.

Deleting Distribution Sets

Deleting sets does not remove any information from your ledger (except the set definition). If you 
accidentally delete a set, just add it again.

You cannot delete a distribution set if it is assigned to a vendor record. You must assign a different 
distribution set to the vendor first.

Deleting a set after adding an invoice (but before posting it) has no effect on posting. However, you will 
have to change to a valid set if you edit the invoice.

Adding or Modifying Distribution Sets

You use the Distribution Sets screen to add distribution sets.
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Before You Start

 l Decide on the codes to use for identifying distribution sets.

 l Add the distribution codes and accounts that make up the set.

 l Before deleting a distribution set, assign a different distribution set to vendor groups and vendor 
records that use the set you want to delete.

To add a distribution set:

 1. Open Accounts Payable > A/P Setup >        Distribution Sets.

 2. For each distribution set, enter the following information:

Distribution Set.Enter a code to identify the distribution set, using up to six characters.

Description.Type a description of the distribution set.

Distribution Method. Select the method by which to apportion an invoice amount among the accounts 
in the distribution set:

 l Spread Evenly. This method divides the invoice amount evenly among all the distribution codes 
in the distribution set. You can then edit the result.

 l Fixed Percentage. This method lets you specify the percentage of the total invoice amount to allocate 
to each distribution code. You can specify a negative percentage or a percentage more than 100%. 
You can also edit the results of this distribution method. 

 l Manual. This method provides no amount allocation; it just enters the distribution codes and lets 
you enter the amounts of the distribution.

 l Fixed Amount. This method distributes a specific amount to each distribution code in the 
distribution set. You must specify a currency code to use this method, and you can select the 
distribution code only for vendors that use this currency. You can edit the result.

Note: The setting you select determines the default invoice distribution, which you can override at invoice 
entry.

Distribution Code.Type the distribution code you want to add to the distribution set or select the code 
from the Finder. Once you enter the code, Accounts Payable displays the code description and general 
ledger account number so you can verify them.

If you are adding to an existing list of codes, press the Insert key to start a new line.

Distribution Amount. If you selected Fixed Amount as the distribution method, enter the amount to 
allocate to the distribution code.
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Distribution Percent. If you selected Fixed Percentage as the distribution method, enter the 
percentage of the document total to distribute to each distribution code you add to a set.

You can use negative percentages and percentages greater than 100 percent, providing the total is 100 
percent.Accounts Payable warns you if the percentages you enter for a distribution set do not add up to 
100 percent, but lets you add or save the record. 

Use this type of distribution set when you need to enter additional general ledger account distributions 
with invoices, but do not want to include the extra accounts in the distribution set.

 3. When finished, click the Add button.

 4. Repeat steps 2 and 3 for each distribution set you want to add.

To edit a distribution set

 1. Open Accounts Payable > A/P Setup >        Distribution Sets.

 2. Enter the code for the distribution set, or select it from the Finder.

 3. Make the changes you need.

Tip: 
To reuse the description and Discountable status from an existing distribution code:

 a. Insert the code in the distribution set, as usual. 

 b. Clear the code by double-clicking the Dist. Code field, then pressing the Delete key.

 c. In the G/L Account field, enter the General Ledger account you want to use.

 4. Click Save to record the changes.

To delete a distribution set

 1. Open Accounts Payable > A/P Setup >        Distribution Sets.

 2. Enter the code for the distribution set, or select it from the Finder.

 3. Click Delete.

If a message appears asking you to confirm the deletion, click Yes.

After adding distribution sets

 l Print the Distribution Sets report by clicking File > Print on the Distribution Sets screen, or by 
using the Distribution Sets icon in the A/P Setup Reports folder.

 l Edit vendor groups and vendor records that are assigned the set.
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E-mail Messages

You use the A/P E-mail Messages screen to create standard messages to send with e-mailed 
statements, letters, and invoices.

About E-mail Messages

You use the E-mail Messages screen to create standard messages to send with e-mailed letters.

You can use variables (field names) from your company database to include vendor- or company-specific 
information on the messages.

You identify each e-mail message with a unique 16-character Message ID code. When you select Vendor 
as the Delivery Method on the Letters/Labels screen, you can select message codes for the message you 
want to send with e-mailed letters.

Variables for E-mail Messages

If you use variable names from your company database in the subject line or in the body of e-mail 
messages that you set up for use with letters, the program substitutes (or “merges”) vendor- or company-
specific information in the e-mailed messages.

For a list of the variables you can use with e-mail messages, see "E-mail Message Variables" (page 28).

E-mail Message Variables

A variable is a field name from your company database that can be replaced with specific terms or values 
from your company records.

You can use variables in the subject line and body of e-mail messages you create to send with letters to 
vendors. Accounts Payable substitutes vendor- or company-specific information when you specify an e-
mail delivery method and code when printing letters.

Example: In an e-mail message to a company where the specified vendor contact is Mr. Carl Jenner, 
the line "Dear $VENDOR_CONTACT" is replaced with "Dear Mr. Carl Jenner" when the message is 
sent.

You can use the following Accounts Payable variables in all e-mail messages.

Value to Insert E-mail Message Variable

Company contact $COMPANY_CONTACT

Company name $COMPANY_NAME

Common E-mail Message Variables
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Value to Insert E-mail Message Variable

Company fax number $COMPANY_FAX

Company telephone number $COMPANY_PHONE

Vendor ID $VENDOR_ID

Vendor contact $VENDOR_CONTACT

Vendor name $VENDOR_NAME

Adding or Modifying E-mail Messages

You use the E-mail Messages screen to create standard messages to send with letters that you e-mail to 
your vendors.

Before You Start

 l Decide on the codes to use to identify the message.

 l Determine the e-mail variables to use in the subject line and body of the message. For more 
information, see "E-mail Message Variables" (page 28).

To create a message that you can use with letters that you e-mail to vendors:

 1. Open Accounts Payable > A/P Setup >        E-mail Messages.

 2. In the Message ID field, type a code to identify the message, using up to 16 characters.

 3. In the Description field, type a description for the message, using up to 60 characters.

 4. In the E-mail Subjectfield, type the subject line to use for e-mailed messages that use this message ID.

 5. Enter the body of the message in the text box.

Note: You can use field names, preceded by a dollar sign to insert vendor- or company-specific 
information in the subject line and body of messages.

 6. Click Add  when you are satisfied with your message.
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To modify an e-mail message:

 1. Open Accounts Payable > A/P Setup >        E-mail Messages.

 2. In the Message ID field, type the message ID, or use the Finder  or the navigation buttons to 
select the code for the message you want to change.

 3. Make your changes.

 4. Click Save.

To delete an e-mail message:

 1. Open Accounts Payable > A/P Setup >        E-mail Messages.

 2. In the Message ID field, select the code for the message you want to delete.

 3. With the message displayed, click Delete.

After adding, editing, or deleting e-mail messages

Print and file the E-mail Messages report. For more information, see "Printing the E-mail Messages 
Report" (page 229).

Optional Fields

Optional fields are available if you purchased and activated Sage 300 Transaction Analysis and Optional 
Field Creator.

Accounts Payable optional fields let you customize your Accounts Payable system by letting you store an 
unlimited amount of additional information with vendor records and transaction details.

About Accounts Payable Optional Fields

Note: Optional fields are available if you use Sage Transaction Analysis and Optional Field Creator. 

You can customize your Accounts Payable system by using optional fields to store additional information 
that you want to keep with vendor records and transaction details.

Optional fields also provide an additional means of analyzing vendors and transactions in Accounts 
Payable. You can include optional field information when you print lists of vendors, vendor groups, remit-
to locations, and recurring payables. In addition, you can select aging reports and reports of vendor 
transactions by optional fields.

If you use exactly the same optional fields in Accounts Payable and General Ledger, General Ledger will 
retain the optional field information sent with transactions that you generate in Accounts Payable.
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You can use an unlimited number of optional fields in Accounts Payable. However, you must first define 
optional fields for your Sage 300 system using the Optional Fields screen in Common Services. For more 
information about setting up optional fields in Common Services, see the System Manager help.

Once you have set up optional fields for your Sage 300 system, you use the A/P Optional Fields screen in 
the A/P Setup folder to define optional fields for use with the following Accounts Payable records and 
transactions:

 l Vendors and vendor groups

 l Remit-to locations

 l Invoices (including interest and recurring payable invoices)

 l Invoice details

 l Adjustments

 l Payments

 l Revaluation

You can then assign the optional fields to particular setup records (vendor, vendor group, remit-to 
location, and recurring payable records) in Accounts Payable.

You can also assign optional fields that you set up for use in transaction entry screens to particular 
transactions (adjustments, invoices, payments) and invoice details.

Note: The Recurring Payables setup screen uses the same optional fields you assign to Invoice Entry.

Validating Optional Field Entries

Optional fields may use validation, which limits the values that can be entered in the fields:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed the 
length permitted for the field. You can also leave the field blank.

Adding or Modifying an Optional Field

Note: Optional fields are available if you use Sage Transaction Analysis and Optional Field Creator. 

Optional Fields let you store custom information with records and transactions. You can define an 
unlimited number of optional fields for each type of Accounts Payable record or transaction, providing the 
optional fields are set up in Common Services for use in your system.
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You can change the default value and Auto Insert status for an optional field at any time. If the field is 
validated, you must select a value that is defined for the optional field in Common Services. 

Any change you make to an optional field affects only records or transactions added after you make the 
change.

Before You Start

 l Make sure that the optional field you want to use in Accounts Payable is set up for system-wide 
use in Common Services.

 l If an optional field you want to delete is assigned to a record or a transaction, edit the record or 
transaction to remove the optional field, or post the batch that contains the transaction.

To set up an optional field for use in Accounts Payable:

 1. Open Accounts Payable > A/P Setup > Optional Fields.

 2. In the Optional Fields For field, select the type of record or transaction for which you are defining the 
optional field. More...

You can set up optional fields for use in the following types of records or transactions:

 l Vendors And Vendor Groups

 l Remit-to Locations

 l Invoices (associated with document headers—optional fields for document details are 
defined separately)

 l Invoice Details

 l Adjustments

 l Payments

 l Revaluation

 3. Use the Finder  to select the optional field code or codes you want to use for the selected type. The 

program displays the description for the optional field you select.

Note: If you want to retain Accounts Payable optional field information when you create batches for 
General Ledger, you must use the same optional fields for transactions in Accounts Payable as you 
use in General Ledger.

 4. If you want to specify a default value for the optional field:     
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 a. Double-click in the Value Set column to set the field to “Yes” for a selected optional field.

 b. In the Default Value field, enter or select the value that the program will display as the default for 
the optional field. More...

If the optional field you selected requires validation, select a value that is defined for the optional 
field in Common Services. If the optional field allows blanks, you can leave the default value field 
blank.

If the optional field does not use validation, you can do one of the following:

 l Select a value that is defined for the optional field in Common Services.

 l Leave the field blank.

 l Enter a combination of alphanumeric or special characters and spaces. The entry must be 
consistent with the type of field (text, number, date, amount, and so on), and must not 
exceed the number of characters specified for the optional field in Common Services. 

Examples: 
 l In a Yes/No field, you can enter only Yes or No.

 l In an Integer field you can enter any integer with an absolute value less than 
2,147,483,647.

When you specify a value from Common Services, the program displays the description for the 
value.

 5. To indicate that the optional field must be used in the records and transactions for which it is created, 
double click the Required field. 

During data entry, if an optional field is required and does not have a default value, you must fill in the 
field before you can proceed.

 6. To display the optional field and its default value when you set up new records or enter 
transactions on the screen for which you are defining the optional field, select Yes in the Auto 
Insert field.

 7. Click the Settings button, if it is available, to specify additional settings for the optional field.

A separate screen appears, listing all the groups of accounts that are affected when you post 
transactions of the type for which you are defining the optional field. Use the screen to specify:

 l The account groups for which values pass to General Ledger when you post transactions 
that include the optional field.

 l Whether Accounts Payable passes optional field information for job related transactions to 
Project and Job Costing, if you use Sage 300 Project and Job Costing.
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Note: If the optional fields in the posted transactions match the optional fields defined for billings in 
Project and Job Costing, the optional field information is sent to that program.

 8. Click Add (or Save).

To edit an optional field:

 1. Open Accounts Payable > A/P Setup > Optional Fields.

 2. In the Optional Fields For field, select the type of record or transaction for which you are defining 
the optional field.

 3. Make the changes you need on the table.

 4. Use the Settings button to select the type of General Ledger accounts to which optional field 
information can be passed, or to indicate whether optional field information can be passed to 
Project and Job Costing.

 5. Click Save to record the changes.

To delete an optional field:

 1. Open Accounts Payable > A/P Setup > Optional Fields.

 2. In the Optional Fields For field, select the type of record or transaction for which you want to 
delete an optional field.

 3. On the table, select (highlight) the optional field that you want to remove.

 4. Click the Delete button, or press the Delete key on your keyboard.

If a message appears asking you to confirm the deletion, click Yes.

After adding, editing, or deleting optional fields

Print the Optional Fields report to check the new record information and to update your printed records.

Payment Codes

You can enter all types of payments in Accounts Payable, including cash, checks, credit cards, and the 
other ways that you pay vendors, or that vendors refund payments to you. Accounts Payable uses the 
payment code you enter during payment entry to add information automatically about the type of 
payment.

Your Accounts Payable system must contain at least one payment code before you can add payment 
transactions.
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About Payment Codes

You can enter all types of payments in Accounts Payable, including cash, checks, credit cards, and the 
other ways you pay your vendors. 

You use the A/P Payment Codes screen to create codes that identify each type of payment you make. 
During payment entry, you simply enter the code, and Accounts Payable adds the information about the 
type of payment. 

Tip: Consider batching payments by payment code.

Adding or Modifying a Payment Code

Before You Start

 l Decide on the codes to use for all the types of payments you process.

 l Determine the payment type for each payment code—cash, check, credit card, or other.

 l You can change everything in a payment code record except the identifying code.

 l If you want to delete a code that is assigned to an unposted payment, you must first assign a 
different payment code to the transaction, or delete the transaction.

 l If you want to delete a code that is assigned to a vendor, you must assign a different payment 
code to the vendor, first.

 l If you make a payment code inactive, you need to assign another payment code to any unposted 
payments that use the inactive payment code.

To add a payment code:

 1. Open Accounts Payable > A/P Setup > Payment Codes.

 2. In the Payment Code field, type an identifying code, using up to six characters, and then press the 
Tab key.

 3. Type a description for the payment code, such as the name of the credit card.

 4. For the payment type, select Cash, Check, Credit Card, or Other.

 5. Click Add.

To edit a payment code:

 1. Open Accounts Payable > A/P Setup > Payment Codes.

 2. Select the payment code you want to change.
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 3. Make your changes.

 4. Click Save.

To delete a payment code:

 1. Open Accounts Payable > A/P Setup > Payment Codes.

 2. Select the payment code you want to delete.

 3. Click Delete.

If a message appears asking you to confirm the deletion, click Yes.

After adding, editing, or deleting payment codes

 l Click File > Print, or use the Payment Codes icon in the A/P Setup folder to print the Payment 
Codes report. 

 l When you select a different payment type (cash, check, credit card, or other) for a payment code, the 
change is not made in any existing, unposted transactions. 

You must edit and save unposted transactions to register changes in payment methods, so that the 
transactions are correctly recorded on deposit slips.

Payment Selection Codes

When you create an automatic payment batch with Accounts Payable, you specify a payment selection 
code for the batch, which contains criteria for selecting vendors and invoices to pay.

About Payment Selection Codes

Payment selection codes are identified by codes of up to six characters (letters and digits). The rest of the 
selection record defines the criteria for selecting—or excluding—vendor invoices for payment.

Payment selection codes define the following elements:

 l The bank on which the checks are drawn.

 l How you select invoices (by due date, discount date, or due date and discount date).

 l Whether you pay all documents or forced documents only.

 l The range of vendor groups.

 l The range of vendors.

 l The range of account sets.
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 l The range of check amounts (for example, so you could pay all the small outstanding amounts 
first).

 l Vendors you want to exclude from the payment selection.

 l The bank currency (multicurrency ledgers only.

 l The vendor currency (multicurrency ledgers only).

 l Exchange rates between the bank currency and functional currency and between the vendor 
currency and functional currency (if you have a multicurrency ledger).

You create payment selection codes using the Payment Selection Codes screen.

You cannot use the Create Payment Batch screen to generate checks unless you have defined at least 
one payment selection code.

You can change the payment selection criteria after you enter the payment selection code in the Create 
Payment Batch screen. So, if your payment selection needs are fairly simple (for example, if you use only 
one bank and have a small number of vendors), you may define only one code and modify it if you are 
generating a special check run.

Adding Payment Selection Codes

You must create at least one payment selection code if you want Accounts Payable to generate 
payments for invoices automatically. 

Note: You do not have to create payment selection codes if you intend to enter all your payments 
individually to a batch using the Payment Entry screen.

Before You Start

 l Decide on the codes to use to identify payment runs that you will generate.

 l Determine the criteria to use for selecting the vendors and invoices to pay for each payment 
selection code.

To add payment selection codes:

 1. Open Accounts Payable > A/P Setup > Payment Selection Codes.

 2. In the Selection Code field, enter or select a code to identify the payment selection criteria (such 
as “ALL” if you are defining only one). 

 3. In the next field, type a description for the code.

 4. Complete the Select tab as follows:
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 l Pay From Bank. Select the bank on which you are writing the checks.

 l Select Vendors With This Bank Code Only. This option restricts the payment selection to 
vendors that specify this bank in their vendor records.

 l If you have a multicurrency ledger, you also select the bank currency and the vendor 
currency.                         

All checks in a batch must be:

 l Drawn on the same bank.

 l In the same check currency.

 l For vendors with the same source currency.

 l Bank Currency. This is the check currency. You can only use one in a batch.

 l Rate Type (Bank). If the bank currency is different from your functional currency, you can 
enter or select the exchange rate type you want to use. (You can override this rate when you 
create a payment batch.)

 l Vendor Currency. All the vendors must use the same source currency. However, you do not 
have to specify the currency in the selection criteria record; you can select it when yo 
generate payments.

 l Rate Type (Vendor). If the vendor currency is different from your functional currency, you 
can enter or select the exchange rate type for converting vendor currency to functional 
currency.

 l Apply Method. Specify how to apply partial payments to invoices that use different contracts, 
projects, and categories. More...

You can choose:

 l Top Down to apply payments automatically to invoice details beginning with the first 
detail on an invoice until the payment is fully applied.

 l Prorate By Amount to apply payments proportionately to all invoice details.

Note: The apply method affects only job-related  invoices for which the applied amount is less 
than the current balance.

 5. Fill in the Criteria tab as follows:

 l Select Documents By. Specify how to select documents for payment. More...

You can choose:

 l Due Date. Use this option to select documents that are due on or before the end date 
you specify when you create the payment batch.
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The program does not select according to the discount date, but takes any discounts that 
are available.

 l Discount Date. Use this option to select documents that are eligible for a discount if 
paid on or before the end date you specify.

 l Due Date Or Discount Date. Use this option to select documents that are due on or 
before the date you specify, or that have a discount available if paid on or before the 
date you specify.

The due date you enter when you create a check batch is the latest date up to which you 
want transactions to be included. At batch creation, you must also enter a date indicating 
how far back you want to take discounts. The program ignores discounts that  ceased to be 
available before the date you enter.

 l Pay All Selected Documents / Only Forced Documents. Specify whether to pay all 
documents in the selection, or only transactions that have a Forced status. (You use the 
Control Payments screen to place invoices on hold or force their payment.)

 l Vendor Selection Range. Specify the range of vendor groups, vendor numbers, account 
sets, vendor (check) amounts, payment codes, and (if you use optional fields) a vendor 
optional field from which you want to choose documents for payment.

Specifying a range of vendor amounts lets you maintain different procedures for smaller checks.

Note: You can select a vendor optional field only if you use Sage Transaction Analysis and 
Optional Field Creator and you have defined optional fields for vendors. If you specify an 
optional field, additional fields appear, letting you specify a range of values for the field. If you 
do not want to use an optional field as a criterion, accept None, the default setting for this field.

 6. On the Exclusion tab, list any vendors that you want to exclude from the payment run.

 7. If you use Sage Transaction Analysis and Optional Field Creator and you want to assign optional fields 
to this payment selection code, click the Optional Fields tab.

Any optional fields set up for automatic insertion on payments appear on the table, along with their 
default values.

You can accept, change, or delete these entries. You can also add any other optional fields that are 
defined for payments.

Note: If you delete an automatically inserted optional field, the program reinserts the optional field 
with its default value when you create a batch using the payment selection code.

 8. When ready, click the Add button.

 9. Repeat the preceding steps for each payment selection code you want to add.
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After adding payment selection codes

 l Click File > Print or use the Payment Selection Codes icon in the A/P Setup Reports folder to print 
a list of the selection criteria you added. 

 l File the Payment Selection Codes report.

Terms

You use the A/P Terms screen to define all the terms Accounts Payable uses to determine invoice due 
dates, set the rates and eligibility periods of discounts for early payment, and calculate discount bases. 

You assign a terms code to each vendor record to set the default terms that appear when you enter 
invoices for the vendor.

You must define at least one set of terms before you can add vendor records.

About Terms Codes

You must add at least one terms code before you can enter Accounts Payable transactions.

For each terms code you:

 l Define the payment terms by which your vendors calculate invoice due dates.

 l Specify the method used to calculate discount periods and discount amounts on invoices from 
vendors who offer discounts for early payment.

Installment Payments

A set of terms can be as simple as a due date and discount date and rate, or they can include payment 
schedules to allow for installment (timed) payments.

When you enter invoices for a multiple payment schedule, Accounts Payable automatically calculates the 
schedule, but you can change schedule amounts or due dates for each invoice. For example, you can 
specify that the first payment is not due for a year from the invoice date.

Setting Up Installment Terms

You use the Multiple Payment Schedule option to set up a terms code that allows installment payments. 
You can define installment periods that vary in length, and use different methods to calculate due dates 
and discounts. You can also set up as many installment periods for a terms code as you need.

Calculating Discounts Before or After Tax

If you pay tax on purchases, you can specify whether to include tax in the document total that Accounts 
Payable uses to calculate discount amounts
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Using Standard Due Dates

Standard due dates are similar to "day of the month due," except they do not restrict you to a single due 
date. For example, you can use standard due dates to assign invoices to the 15th or 30th of each month.

If your vendor uses standard due dates, you can create a terms code table to calculate a due date for 
each of up to four ranges of days on which invoices were issued.

For example, your table could specify that invoices entered between the 1st and 15th of each month are 
due on the 30th of the month, and that invoices entered between the 15th and the end of the month are 
due on the 15th of the next month.

You define standard due dates with a table that lets you specify a due date for each of up to four ranges of 
days on which invoices were issued. You can also specify due dates that are one or more months later.

When you use due date tables, you can either define discount periods in the same way as for other terms 
options, or you can enter a table of standard discount periods.

Assigning Terms to Vendor Records

You assign a terms code to each vendor record to set the default terms that appear when you enter 
transactions for the vendor. You can choose different terms for the vendor during transaction entry 
without changing the standard terms assigned in the vendor record.

Using Terms with Transactions

When entering transactions, you enter a terms code with each invoice, and Accounts Payable 
automatically does all the required calculations.

Editing Terms Codes

You can change all the information in a terms code record except the terms code.

Effects of Changes

If you make a terms code inactive:

 l You cannot select an inactive terms code as the default code when adding a new vendor group or 
vendor record.

 l You cannot update a vendor group or vendor record that uses an inactive terms code.

 l You cannot use the inactive terms code when you add an invoice. (But you can print and post 
invoices you entered with the terms code before you made the code inactive.)

Other changes you make to terms codes have no effect on existing, unposted documents that use the 
codes. If you want to use changes such as new discount percentages on existing unposted invoices, you 
must edit the invoices to enter the new information for the terms code.
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Deleting Terms Codes

Deleting payment terms does not remove any information from your ledger (except the terms definition). 
If you accidentally delete a payment terms code, you can just add it again.

Deleting a payment term after adding an invoice (but before posting it) has no effect on posting. However, 
you must specify a different code if you edit the invoice (because you cannot save changes to the invoice 
if the terms code is invalid).

Accounts Payable prevents you from deleting a terms code that is assigned to a vendor record.

Adding or Modifying a Terms Code

You use the A/P Terms screen to set up codes for your vendors' payment terms.

You assign a terms code to each vendor record to set the default terms that appear when you enter 
transactions for the vendor. However, you can specify different terms during transaction entry.

Changes you make to terms codes have no effect on existing, unposted documents that use the codes. 
You must edit invoice batches to register changes such as new discount percentages and dates.

Note: You must add at least one terms code before you can enter Accounts Payable transactions.

Before You Start

 l Before adding a terms code, determine:    

 l The identifying code.

Note: You can change everything in a terms code record except the identifying code.

 l The method for calculating the due dates for invoices that will use the code.

 l Discount periods and percents (if used).

 l You may want to post batches that use terms codes you plan to delete, or edit the invoices to enter 
different terms codes. However, you can post batches that contain deleted terms codes.

To add a terms record:

 1. Open Accounts Payable > A/P Setup > Terms.

 2. In the Terms Code field, enter the identifying code.

 3. Press the Tab key, and then type a description for the terms code.

 4. For the Calculate Base For Discount With Tax option, specify whether to include tax amounts in 
the invoice totals on which discount amounts are calculated. More...
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Select:

 l Included if you can take a discount on taxes.

 l Excluded if your vendors do not allow a discount on taxes or do not charge taxes.

 5. If you want to allow payment by installments with this code, select the Multiple Payment Schedule 
option. Then select the due date type and enter information for each payment.

 6. In the Due Date Type field, select the method by which you calculate invoice due dates. More...

Select:

 l Days From Invoice Date if invoices are due in a specific number of days after the invoice 
date. Then type the number of days in the Number Of Days column that appears.

 l End Of Next Month if invoices are due on the last day of the next month.

 l Day Of Next Month if invoices are due on a specific day in the next month. Then type the 
number (representing the due date) in the Day Of Month column.

 l Days From Day Of Next Month if invoices are due a standard number of days after a 
specific day in the next month. Then type the number of days and the number that 
represents the day of the month.

 l Due Date Table if you use standard due dates for invoices entered within specified ranges 
of days. Then complete the table that appears.

 7. In the Discount Type field,  select the method you use to calculate the last day on which your 
vendors let you take a discount for prompt payment. If your vendors do not offer discounts, ignore 
the discount fields and columns. More...

You select from options as described for Due Date Type, and then type discount percentages.

 8. Click Add.

To edit a terms code:

 1. Open Accounts Payable > A/P Setup > Terms.

 2. Use the Finder or the navigation buttons for the Terms Code field to select the terms code you 
want to change, or type the code in the field.

 3. Make your changes.

 4. Click Save.

To delete a terms code:

 1. Open Accounts Payable > A/P Setup > Terms.

 2. Use the Finder or the navigation buttons for the Terms Code field to select the terms code you want to 
delete, or type the code in the field.
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 3. Click Delete.

If a message appears asking you to confirm the deletion, click Yes.

After adding, editing, or deleting terms codes

 l Click File > Print on the Terms screen to print the A/P Terms report, or use the Terms icon in the 
A/P Setup Reports folder.

 l Assign new terms codes to vendor records that require them.

 l If necessary, edit any unposted invoices in the A/P Invoice Entry screen. substituting other terms 
codes for those you deleted, or changing terms information for records you modified.

Customizable Formats for Printed Accounts Payable Forms
Accounts Payable includes sample checks and payment advices, letters, labels, and 1099/1096 and 
T5018 (CPRS) reports. You may be able to use these sample formats "as is," or adapt them to print on 
the forms you use.

Before entering or processing transactions, you should set up and test the formats you want to use for 
printing these forms.

You use Crystal Reports to design or edit formats for printing Accounts Payable reports and forms. 
(Crystal Reports is available separately.)

Accounts Payable includes Crystal (.RPT) versions of the following printed forms:

File Name Description

AP1099 Sample 1099 format for laser printers, for tax year 2019 and earlier.

Important! This format was valid at the time this program was released. If 
the form changes, you can update the format using Crystal Reports.

AP1099MISC-2020 Sample 1099-MISC format for laser printers, for tax year 2020 and later.

Important! This format was valid at the time this program was released. If 
the form changes, you can update the format using Crystal Reports.

AP1099NEC-2020 Sample 1099-NEC format for laser printers, for tax year 2020 and later.

Important! This format was valid at the time this program was released. If 
the form changes, you can update the format using Crystal Reports.

Forms Included with Accounts Payable
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File Name Description

AP1096 Sample 1096 format for laser printers, for tax year 2019 and earlier.

Important! This format was valid at the time this program was released. If 
the form changes, you can update the format using Crystal Reports.

AP1096-2020 Sample 1096 format for laser printers, for tax year 2020 and later.

Important! This format was valid at the time this program was released. If 
the form changes, you can update the format using Crystal Reports.

APCHECK Advice-only form for laser printers.

APCHK01 Advice-check-advice form for laser printers.

APCHK01A Similar to APCHK01. The check portion is ANSI-compliant. For more 
information, see "About Clearing Checks Electronically" (page 138).

APCHK02 Advice and check.

APCHK03 Check-advice-advice.

APCHK11 Check-advice-advice for 11-inch check forms.

APCHK11A Similar to APCHK11. The check portion is ANSI-compliant. For more 
information, see "About Clearing Checks Electronically" (page 138).

APCHK14 Check-advice-check-advice for 14-inch forms.

APCPRS Sample T5018 (CPRS) format for laser printers.

Important! This format was valid at the time this program was released. If 
the form changes, you can update the format using Crystal Reports.

APLBL01 Sample labels, approximately 6.5 cm by 2.5 cm, which are designed to fit a 
tab of 30 labels arranged in 3 columns.

APLETT01 Sample letter.

Modifying Reports

For information about how to customize forms, see the online document Customizing Printed Forms with 
SAP Crystal.
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About Clearing Checks Electronically

The American National Standards Institute standard facilitates the conversion of checks to electronic 
images so that they can be cleared electronically. You can print ANSI-compliant refund checks for the US 
and Canada.

The ANSI format has a slightly different layout from other printed forms, as follows:

 l The date is printed in one of the formats DDMMYYYY, MMDDYYYY, YYYYMMDD, depending on 
your windows setup.

 l The currency code and currency symbol (for example, $) is printed before the check amount, 
depending on the currency setup in Common Services.

 l The text version of the amount prints "Dollars."
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Chapter 2: Setting Up and Maintaining 
Vendor Records

After setting up processing records, such as the account sets, terms codes, payment codes, and 
distribution codes that you assign to vendor records, you can add vendor records to Accounts Payable.

Use the screens in the A/P Vendors folder to add the following types of records for vendors:

 l Vendor groups

 l Vendors

 l Remit-to locations

 l Recurring payables

Vendor Groups
You use vendor groups to classify your vendor records into groups that share similar characteristics, such 
as geographical location.

You must define at least one vendor group before you can add vendor records.

About Vendor Groups

Vendor groups let you:

 l Set default entries to speed up the task of adding vendor records.

 l Select accounts for payment. (The vendor group is one of the selection criteria.)

 l Select vendors on reports. (Vendor transactions, aged payables, aged cash requirements, letters, 
and labels can all be printed for a range of vendor groups.)

About Setting Up Vendor Groups

You must define at least one vendor group, and you may define multiple vendor groups.

You use the Vendor Groups screen to define the vendor groups you need.

To define a vendor group, you must:
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 l Assign a unique code, up to six characters, to identify the group.

 l Select the account set, terms code, and bank code to use as the default selections for the vendor 
records you will add to the group.

 l Specify the method for distributing transactions to general ledger accounts. You can distribute 
invoices by distribution set, distribution code, or general ledger account.

 l Specify a default code for the distribution method. For example, if you select G/L Account, you 
must specify the default general ledger account to which you want to distribute amounts.

 l If you have a multicurrency ledger, specify the default rate type for vendors in the group.

 l Choose whether to check for duplicate invoices with the same vendor and amount or same vendor 
and date.

 l Choose whether to generate separate payments for each invoice, or pay several invoices with a 
single check.

 l Set default entries for vendor optional fields.

 l Select the default tax group for vendors in the vendor group. You must also enter a tax class for 
each tax authority in the group, and indicate whether tax is usually included in the invoice details.

 l Specify whether the vendors in this group are subject to 1099/CPRS reporting. (You can override 
this choice for individual vendors.)

About Editing Vendor Groups

You can change most of the information in a vendor group record, with the following restrictions:

 l You cannot change the vendor group code.

 l In a multicurrency ledger, you cannot change the account set to one that uses a different currency.

 l You can edit vendor group statistics only if the Allow Edit Of Statistics option is selected on the 
A/P Options screen. For more information, see "A/P Options Screen" (page 325).

Most changes you make to a vendor group affect only the vendor records you add to the group after 
making the changes. The only exception is if you set the status of the group to Inactive. If you assign 
Inactive status to the group, you cannot:

 l Add new vendors to the group.

 l Change any of the vendor records assigned to the group (except to change their vendor group).

Tip: If you need to make the same change to a number of vendor groups, use Sage 300's macro 
facility. For more information, see the System Manager Help.

Optional Fields

If you use Sage 300 Transaction Analysis and Optional Field Creator, you can use the Optional Fields 
screen to define vendor optional fields, marking for automatic insertion the ones you want to use as 

48Sage 300 2023 Accounts Payable User's Guide



defaults when you add new vendor group records. For more information, see "A/P Optional Fields Screen" 
(page 341).

Adding, Modifying, or Deleting a Vendor Group

You use the A/P Vendor Groups screen to add records for vendor groups to Accounts Payable. You must 
add at least one vendor group record before you can add vendor records.

You can change the information in a vendor group record at any time, with some restrictions. More...

When changing existing vendor group records, the following restrictions apply:

 l You cannot change the vendor group code.

To assign a different code to a vendor group, you must:

 1. Add a vendor group with the code you want to use.

 2. Transfer all vendors in the group to the new group.

 3. Enter the group statistics in the record for the new group.

 4. Delete the group with the code you no longer want.

 l If vendors are assigned to the vendor group, you can change only the Inactive status.

 l If a vendor group is Inactive, you cannot:

 l Add new vendors to the group.

 l Add invoices or other transactions for vendors in the group.

 l You can edit vendor group statistics only if the Allow Edit Of (vendor) Statistics option is selected 
on the A/P Options screen.

 l You cannot delete a vendor group that includes vendors. Before deleting a vendor group, you must 
first reassign the vendor records in the group to other groups, or delete them.

Note: Most of the changes you make to a vendor group record have an effect only on new vendor 
records you create and add to the group, later.

To add a vendor group record:

 1. Open Accounts Payable > A/P Vendors > Vendor Groups.

 2. In the Group Code field, do one of the following:

 l To create a completely new vendor group record, click the New  button.

 l To create a vendor group record based on an existing vendor group record, enter the code 
for an existing vendor group, and then press Tab.

 3. In the Group Code field, enter a code for the new vendor group.
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 4. Complete the fields on the vendor group record.

 5. Click Add.

To edit or view an existing vendor group record:

 1. Open Accounts Payable > A/P Vendors > Vendor Groups.

 2. In the Group Code field, specify the vendor group record you want to edit.

 3. Make the changes you need in the record.

 4. Click Save.

To delete a vendor group record:

 1. Open Accounts Payable > A/P Vendors > Vendor Groups.

 2. In the Group Code field, specify the vendor group record you want to delete.

 3. Click Delete.

 4. If a message appears asking you to confirm that you want to delete the record, click Yes.

After modifying a vendor group record

 l Print the Vendor Groups report that contains the type of information you changed for the group, to 
check the new record information. Save the report for your files.

 l Enter the changes, as needed, in the vendor records assigned to the group. For example, if you 
specified a new terms code for the vendor group and you want to use the terms with all vendors in 
the group, you must edit each existing vendor record to enter the change (or use macros to update 
them all).

Vendors
You must add vendor records before you can enter and process transactions in Accounts Payable.

About Setting Up Vendor Records

Adding vendor records to Accounts Payable involves transferring your existing vendor information to 
Sage 300 and selecting options that let you process payables more effectively.

You use the A/P Vendors screen to enter most of your vendor information, including:

 l The vendor number (the code you use to identify the account).

 l Whether the account is on hold.

 l An optional "short name," (an abbreviation or acronym that represents the vendor).
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 l The vendor's name, address, Web site, e-mail address (one for the vendor and one for your 
contact), and phone numbers.

 l The date on which you started to do business with the vendor.

 l Comments you want to store with the vendor record or want to print on correspondence with the 
vendor, display during transaction entry, or keep for other purposes.

 l Additional information your company wants to include in the optional fields created on the 
A/P Options screen for your vendor records, if you purchased the separate Optional Fields 
package from Sage 300.

Tip: If you have a large number of one-time vendors, you should add a "miscellaneous vendor" record, 
so you can process payments using Create Payment Batch and keep statistical data for this class of 
vendor. Make sure that you select the option Generate Separate Payments For Each Invoice for the 
miscellaneous vendor (on the Processing tab of the Vendors screen).

Vendor Numbers

For each vendor record, you assign a unique vendor number, using up to 12 characters, including letters, 
numbers, and symbols.

If your current system for assigning vendor numbers makes sense in Sage 300, you may want to transfer 
your present system. However, we recommend that you take the time now to evaluate your current 
system, because the best time to switch systems is when you already have to recreate all your vendor 
records.

If you do not have an established system for assigning vendor numbers, you should develop a system 
before you add any vendor records to Accounts Payable.

Your numbering system should let you organize the records as you require, such as alphabetically, by 
region, and for reporting purposes. The system should also allow for expansion as your business grows.

Processing Options

You identify the ways in which you process transactions for each vendor, specifying the following 
information:

 l The account set, which determines the general ledger accounts to which the vendor's transactions are 
distributed. Each set includes accounts for payables control, purchase discounts, and prepayments.

If you use multicurrency accounting, the account set also includes unrealized and realized exchange 
gain and loss accounts.

 l The default payment terms used to calculate the due date, discount period, and discount amount 
for vendor invoices.
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 l The bank code and credit limit associated with the vendor.

The vendor bank code is the bank account on which you usually write checks to pay the vendor.

 l The method for distributing invoice amounts to general ledger accounts.

You may distribute amounts by distribution code, distribution sets, or by general ledger account code.

 l How you check for duplicate vendor invoices.

 l Whether you pay each invoice separately or cover several invoices with a single payment.

 l Tax information for vendor invoices, and whether the vendor is subject to 1099 (for US vendors) or 
CPRS (for Canadian vendors) reporting.

The tax group for the vendor determines the taxing authorities and tax class for each authority to which 
you would pay tax on an invoice. This information tells Accounts Payable how to calculate tax amounts 
on the vendor's invoices.

 l If you use multicurrency accounting, the rate type for converting source currencies to their 
functional-currency equivalents.

In addition to the information you can enter for each vendor in the Vendors screen, Accounts Payable 
automatically adds the statistics it collects from all transactions posted to each vendor account

Note: If you select the Allow Edit Of Statistics option on the A/P Options screen, you can enter 
statistical figures when you are setting up a new Accounts Payable system, and revise them as 
needed.

You can define additional remit-to addresses on the A/P Remit-To Locations Screen. For more 
information, see "Adding, Modifying, or Deleting a Remit-to Location for a Vendor" (page 62).

If you regularly pay the vendor for the same order, such as monthly rent, you can create recurring payable 
records, using the Recurring Payables Setup screen. For more information, see "About Recurring 
Payables" (page 65).

Short Names

You can enter a code or "short name" of up to ten characters for each of your vendors. Short names are a 
means by which you can list vendors in alphabetical order (or any other order) on reports, and still include 
the full vendor name in the vendor record, because Accounts Payable can sort records by short name 
first.
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Example: 
You have four vendors. When listed alphabetically, their names appear in this order:

 l A. Craig & Son

 l Bashaw Bulldozing

 l Mr. Stephen Kershaw

 l The Garden Restaurant

You can assign short names to these vendors to change the order in which they are listed:

Vendor name Short name

Bashaw Bulldozing BASHAW

A. Craig & Son CRAIG

The Garden Restaurant GARDEN

Mr. Stephen Kershaw KERSHAW

You can print short names on vendor statements. You might then want to use them for a purpose that is 
unrelated to vendor names.

You may have designed your vendor numbers so that they list vendors in alphabetical order or in another 
order that meets your requirements. In that case, you might choose not to use short names at all.

Inactive and On Hold Account Statuses

You can change the status of a vendor account to either of the following:

 l Inactive. You can set a vendor record inactive prior to deleting it, to ensure that no further 
transactions are processed for the account.

Note: You cannot set a vendor record inactive if there are any unposted transactions for the vendor.

 l On Hold. If you place a vendor account on hold, you cannot enter payments or prepayments for 
the vendor, or otherwise decrease the balance in the vendor account, using the Create Payment 
Batch screen. However, you can still create invoices for the vendor. You can also pay the vendor 
using the Payment Entry screen.

Tax Information

Whether you are charged taxes on purchases or are tax exempt, you enter all the necessary tax 
information in the vendor record. Accounts Payable can then automatically calculate all the applicable 
taxes so you can verify the invoices you receive from vendors.
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To specify tax information in the Vendors screen, you first select the tax group that includes the taxing 
authorities and tables that apply in the vendor's geographical area. (You set up tax groups in the Tax 
Services screens in Common Services.)

You then select the taxing authorities that tax sales to the vendor and the tax class that indicates the type 
of sales on which the vendor is charged tax by each authority.

If the vendor has a tax-exemption number or a registration number, such as for the Canadian Goods and 
Services Tax (GST), you also enter it. You can also include the number in the information you print on 
invoices and statements.

Vendor Statistics

Accounts Payable keeps period and activity statistics for vendors, and displays them in the Vendors 
screen. For more information, see "About Vendor and Vendor Group Statistics" (page 70).

Reporting Tax Amounts in Statistics

The totals kept for invoices, credit notes, and debit notes can include or exclude tax amounts posted with 
the document. You can also see, but not change, the outstanding balance, open document count, current 
prepayment amount, and number of prepayments for the account.

Vendor Optional Fields

If you use Transaction Analysis and Optional Fields Creator, you can assign optional fields to store 
additional information you want to keep with vendor records.

You use the Optional Fields tab in the vendor record to assign optional fields to particular vendors.

Optional fields that are marked for automatic insertion in vendor records appear on the tab, along with 
their default values. You can accept the optional fields that are displayed as defaults, or you can delete 
them.

You can also assign any additional optional fields that are defined in Accounts Payable for vendors and 
vendor groups. The program assigns default values to the optional fields, as follows:

 l For optional fields that match those used by the vendor group, values from the vendor group 
record appear as defaults.

 l If no default entry is specified for an optional field in the vendor group record, the program uses the 
value specified in the optional fields record.

You can accept or change the default entries. However, if the optional field is validated, you must use a 
value that is defined for the optional field in Common Services.
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Retainage Options for Vendors

If you use retainage accounting in your Accounts Payable system, you should also specify default 
settings for each vendor, including the retainage percentage, retention period, and retainage terms. 

When you add a new vendor, Accounts Payable displays on the Invoicing tab of the new vendor record 
the default retainage percentage, retention period, and retainage terms you specified on the A/P Options 
screen, but you can change these settings for individual vendors.

When you enter an invoice, credit note, or debit note for a vendor, Accounts Payable uses the settings 
from the vendor record as defaults.

Processing Vendor Comments

You can enter any number of comments in vendor records, using up to 2,509 characters for each 
comment.

Tip: To view an entire comment on a separate screen (rather than having to scroll to see it), double-
click in the Comment column.

When you enter a comment, you can also enter a follow-up date when you want to check on the 
comment, as well as an expiration date when you want to delete the comment. Once the expiration date 
is reached, Accounts Payable automatically deletes the comment when you use the A/P Clear History 
screen to clear comments for the vendor number.

About Importing Vendor Records

You can import vendor records into Accounts Payable from non-Sage 300 programs, instead of entering 
them in the Vendors screen. For more information, see "About Importing Setup and Vendor Records" (page 
15)

About Vendor Comments

On the A/P Vendors screen, you can enter comments in vendor records. You can add any number of 
comments to a vendor record. Each comment can be up to 2,500 characters long. You can also specify 
follow-up and expiration dates for each comment.

You can enter a comment directly on the comment table on the Comment tab, or you can double-click in 
the Comment column to open a separate screen that lets you see the entire comment without having to 
scroll.

Clearing Comments

To make sure that comments are kept current, you assign a number of days for which you will retain each 
one, then, when you enter a comment, Accounts Payable adds this number of days to the comment date, 
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and calculates an expiration date.

When you use the Vendor Comments option on the A/P Clear History screen, comments that have been 
kept past the expiration date are deleted, saving you from having to delete each comment individually 
from the vendor records.

Note: To specify the default number of days to keep comments, use the Number of Days to Keep 
Comments option on the Processing tab of the A/P Options screen.

Printing Comments

You can print comments on the Vendors report. When you choose comments, the program lets you 
specify the range of follow-up dates for which you want the comments printed.

About Editing Vendor Records

Use the Vendors screen to edit vendor records in Accounts Payable. You can change most of the 
information in a vendor record at any time, with the following restrictions:

 l You cannot save changes to a vendor record if the vendor's group is inactive.

 l You cannot assign a vendor to a vendor group that has an Inactive status.

 l You can select Inactive status for a vendor record only if the account has a zero balance and no 
outstanding transactions.

 l You cannot post transactions to any vendor records that are inactive.

 l You cannot directly change a vendor number. However, if you accidentally add an incorrect vendor 
number, you can create a new record with the correct number, then delete the incorrect record.

You can also create a new record and delete the old one if the vendor record has a zero balance, and 
you have deleted paid transactions.

However, you must still edit the vendor statistics in the new record if you want to keep statistical data, 
and you must transfer the appropriate vendor group statistics if the new vendor number is assigned to a 
different group.

 l In multicurrency ledgers, you can change the vendor group, account set, and tax group assigned 
to a vendor, but only to another vendor group, account set, or tax group that uses the same 
currency.

Tip: If you need to keep more than one address for a vendor, use the Remit-To Locations screen to 
add any additional addresses you require.

Tip: If you need to make the same change to a number of vendor records, use Sage 300's macro 
facility. For more information, see the System Manager Help. For example, you can use a macro to 
change the default entries in optional fields.
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Changing the Vendor Group or Account Set

We do not recommend that you change the vendor group or account set assigned to a vendor record to 
which you have posted transactions.

If you do change the vendor group, be aware that the default choices for the new vendor group replace 
existing choices in the vendor record, although you can edit the vendor record to change the new 
selections.

You may also need to correct statistics for the affected vendor groups. You can edit statistics only if you 
have selected the Allow Edit Of Statistics option on the A/P Options screen.

If you are changing the vendor's account set, check the vendor's account balances.

If the vendor account has outstanding amounts, you will need to transfer the control account balances to 
the new control accounts in the General Ledger after updating the vendor record with the new account set 
code; otherwise, you will have old balances that are never reconciled.

If you move vendors from one payables control account to another, check the unpaid balance of the 
vendor account. You will have to transfer that balance from the original control account to the new 
account.

Optional Fields

If you use Sage 300 Transaction Analysis and Optional Field Creator, you can use the Optional Fields 
screen to define vendor optional fields, marking for automatic insertion the ones you want to use as 
defaults when you add new vendor records. For more information, see "A/P Optional Fields Screen" (page 
341).

Setting Up Multiple Contacts for Vendors

If you use the Multiple Contacts (M/T) program, you can set up multiple contacts for a vendor, and specify 
which types of document to send to each contact.

Documents are sent to contacts by email.

Important! If you are setting up multiple contacts for the first time, check that your email settings are 
correct on the Company Profile screen in Common Services.

To assign contacts to a vendor:

 1. Open Accounts Payable > A/P Vendors > Vendors.

 2. In the Vendor Number field, specify the vendor to which you want to assign contacts.
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 3. On the Contact tab, in the Multiple Contacts section, assign contacts in the following ways:

 l Assign an existing contact:

 a. Click in the table and then press Insert.

 b. In the Contact Code field, enter the code for the contact.

 l Create and assign a new contact:

 a. Click Create New Contact.

The Contacts screen appears.

 b. Enter information for the new contact.

 c. Click Add, and then close the Contacts screen.

The new contact is saved and is assigned to the vendor.

 4. Specify the types of document to send to each contact by double-clicking the document type fields. 
For example, if you double-click the A/P Letters field, an X appears in the field indicating that A/P 
Letters will be sent to the contact.

Tip: Use the Show Documents For field to filter the types of document that are shown in the table.

 5. Click Save.

To edit or view details for a contact:

 1. Open Accounts Payable > A/P Vendors > Vendors.

 2. In the Vendor Number field, specify a vendor.

 3. On the Contact tab, in the Multiple Contacts section:

 a. Select a contact in the table, and then click View Contact Details.

The Contacts screen appears.

 b. If you change information for the contact, click Save.

Adding, Modifying, or Deleting a Vendor

You use the A/P Vendors screen to add records for your vendors to Accounts Payable. You must add 
vendor records before you can enter and process transactions in Accounts Payable.

You can change the information in a vendor record at any time, with some restrictions. More...

When changing existing vendor records, the following restrictions apply:

 l If you have unpaid posted transactions for the vendor, you can change the tax group assigned to a 
vendor only to another tax group that uses the same currency.
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 l You cannot delete a vendor record if the vendor is used in any documents.

 l You cannot change the vendor number.

To assign a different number to a vendor account, you must:

 1. Create a new vendor record.

 2. Post transactions to reduce the balance in the old vendor account to zero and transfer 
outstanding and historical invoice and payment information from the old account to the new 
account, vendor group, and national account, if any.

 3. Delete the old vendor record.

 l You must include a name in each vendor record.

 l You cannot change to a vendor group that has Inactive status.

 l You can edit vendor statistics only if the Allow Edit Of (vendor) Statistics option is selected on the 
A/P Options screen.

We recommend that you do not change the vendor group or account set assigned to a vendor record to 
which you have posted transactions. More...

If you do change the account set, you may need to post adjustments to your general ledger for 
transactions such as invoices that were posted to the original account set and payments to the invoices 
that were posted to the new account set.

If you change the vendor group, Accounts Payable preserves the existing entries in the vendor record. It 
does not overwrite any other fields. If you also change the account set, statistics for the affected vendor 
groups will no longer balance. You can edit the statistics to correct the information, but it can be a difficult 
task.

Before You Start

Before adding a vendor record:

 l Add Accounts Payable tax groups and other tax information to Tax Services.

 l Decide on the vendor number and a name and short name for the vendor.

Note: You must enter a number and name for each vendor before you can add the record. Short 
names are optional.

 l Decide on the vendor group, account set, terms code, payment code, distribution code, 
distribution set, bank code, optional fields, and tax group to assign to the vendor.       
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vendor groups provide default entries for new vendor records, and can be used as selection and sorting 
criteria on various reports. You must assign a vendor group to every vendor record before you can add 
the record.

If you use multicurrency accounting, you assign an account set that uses the vendor’s currency.

 l If you use multicurrency accounting, determine the rate type to use if the vendor does not use the 
functional currency.

 l If you want to enter statistics for vendors, select the Allow Edit Of Statistics option on the 
Processing tab of the A/P Options screen.

Before deleting a vendor record, make sure the vendor is not used in any documents.

Before editing a vendor record, select the Allow Edit Of (vendor) Statistics option on the A/P Options 
screen.

To add a vendor record:

 1. Open Accounts Payable > A/P Vendors > Vendors.

 2. In the Vendor Number field, do one of the following:

 l To create a completely new vendor record, click the New  button.

 l To create a vendor record based on an existing vendor record, enter the code for an existing 
vendor, and then press Tab.

 3. In the Vendor Number field, enter a code for the new vendor.

 4. Complete the fields on the vendor record.

 5. Click Add.

To edit or view an existing vendor record:

 1. Open Accounts Payable > A/P Vendors > Vendors.

 2. In the Vendor Number field, specify the vendor record you want to edit.

 3. Make the changes you need in the record.             

Note: 
If you change the vendor group:

 l Defaults for the new vendor group will be applied to the vendor record.

 l Statistical comparisons between fiscal periods or between vendor groups will be 
invalidated (unless you update the vendor group statistics).

 4. Click Save.
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To delete a vendor record:

 1. Open Accounts Payable > A/P Vendors > Vendors.

 2. In the Vendor Number field, specify the vendor record you want to delete.

 3. Click Delete.

Note: If a vendor is used in any documents, you must clear history before you can delete the vendor.

 4. If a message appears asking you to confirm that you want to delete the record, click Yes.

Remit-To Locations
You use the A/P Remit-To Locations screen to add records for the addresses to which you send 
payments and other correspondence to vendors. 

Then, you can use the remit-to location codes on Accounts Payable invoices, and, if you also use Sage 
300 Order Entry, on  orders, shipments, and invoices you process in that program.

About Remit-to Locations

Remit-to locations are the addresses to which vendors want you to send payments. The remit-to address 
may be different from the address in the vendor record, for example, if the vendor address is just for 
ordering.

You use the Remit-To Locations screen to add remit-to addresses for your vendors.

Primary Remit-To Locations

If you mark a remit-to location as the primary remit-to location (an option in the Remit-To Locations 
screen), Accounts Payable will use this location as the default address on invoices and on vendor 
checks.

Accounts Payable can keep an almost unlimited number of remit-to addresses for your vendors, and you 
can choose the remit-to location to use when you are entering payments.

For each remit-to location, you can:

 l Specify whether it is the primary location.

 l Set the location to active or inactive.

 l Specify the check language.

 l Enter a remit-to address.
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 l Provide default entries for the vendor optional fields.

Note: If you use the remit-to location, these entries override the optional field entries from the vendor 
record.

Specifying Remit-To Locations

When you add a remit-to location in the Remit-To Locations screen, you assign a code that identifies the 
location. You then use the code to select the location during invoice or payment entry.

Customizing Remit-To Address Information

If you use optional fields, you can use the Optional Fields screen to add extra fields to the Optional Fields 
tab of the Remit-To Locations screen. For more information, see "A/P Optional Fields Screen" (page 341).

If you set any remit-to location optional fields for automatic insertion, they appear on the tab, along with 
their default values.

You can accept or change the optional field values. If an optional field requires validation, you can select 
only a value that is assigned to the optional field in Common Services or, if the optional field allows it, you 
can leave the default value field blank.

Adding, Modifying, or Deleting a Remit-to Location for a Vendor

You use the A/P Remit-To Locations screens to add remit-to location records for your vendors to 
Accounts Payable.

You can change the information in a remit-to location record at any time, with some restrictions. More...

When changing existing remit-to location records, the following restrictions apply:

 l You cannot change the remit-to location code.

 l You cannot delete a remit-to location record, or set it inactive, if it is used on any unposted 
documents.

 l If you use multicurrency accounting, the tax group for a remit-to location must use the vendor’s 
currency.

 l If you use Sage 300 Optional Fields and Transaction Analysis, you can enter additional 
information for the remit-to location, but only if you have defined optional fields for use with remit-to 
locations.
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Before You Start

 l Print the Remit-To Locations report.

 l Print the Vendor List, including the information you want to change for the remit-to location.

 l Make sure you want to add or change the remit-to information—not the vendor information.

 l Identify the vendor number for which you are adding a remit-to location.

 l Decide on a code to identify the new remit-to location.

To add a remit-to location:

 1. Open Accounts Payable > A/P Vendors > Remit-To Locations.

 2. In the Vendor No. field, enter the vendor number.

Remit-to locations for the specified vendor are displayed in the table.

 3. Click New.

A screen appears allowing you to specify information for the new remit-to location.

 4. In the Remit-To Location field, enter a unique code to identify the remit-to location. Also, in the 
field to the right, enter a description of the remit-to location.

 5. Fill out the fields on each tab.

 6. Click Add.

To edit an existing remit-to location:

 1. Open Accounts Payable > A/P Vendors > Remit-To Locations.

 2. In the Vendor No. field, enter the vendor number.

Remit-to locations for the specified vendor are displayed in the table.

 3. Select a remit-to location in the table, and then click Open.

A screen appears allowing you to edit information for the specified remit-to location.

Tip: You can also edit other remit-to locations on this screen. To do so, enter the code for another 
remit-to location in the Remit-To Location field.

 4. Make your changes.
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Notes: 
 l If you make a remit-to location inactive:

 l You can no longer use it when adding an invoice.

 l Ensure that the Primary Remit-To option is not selected.

 l You cannot make a remit-to location inactive if it is used on any unposted documents.

 5. Click Save.

To delete a remit-to location:

 1. Open Accounts Payable > A/P Vendors > Remit-To Locations.

 2. In the Vendor No. field, enter the vendor number.

Remit-to locations for the specified vendor are displayed in the table.

 3. Select a remit-to location in the table, and then click Delete.

Note: You cannot delete a remit-to location if it is used on any unposted documents.

 4. If a message appears asking you to confirm the deletion, click Yes.

After adding or modifying a remit-to location

Print and file the updated Remit-To Locations report. For more information, see "Printing the Remit-To 
Locations Report" (page 280).

Looking Up Remit-to Locations for a Vendor

You can use the A/P Remit-To Locations screen to view the remit-to locations that are defined for a 
vendor.

To view remit-to locations for a vendor:

 1. Open Accounts Payable > A/P Vendors > Remit-To Locations.

 2. In the Vendor No. field, enter the vendor number.

Remit-to locations for the specified vendor are displayed in the table.

Recurring Payables
Use the A/P Recurring Payables setup screen to create templates for standard invoices you receive from 
your vendors at regular intervals, such as charges for monthly rent.
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Then, you can process the recurring payables periodically, using the A/P Create Recurring Payable 
Batch screen, or, if you attached schedules that use reminders you can process the payables directly 
from the Reminder List.

About Recurring Payables

If you have vendors who issue standard invoices at regular intervals, such as rent, standing orders, or 
services that vary little from period to period, you can set up records for the payables using the Recurring 
Payables screen.

You can also attach schedules with reminders to alert specific or all Sage 300 users to process the 
recurring transactions when they are due.

You use the Create Recurring Payables Batch screen to create an invoice batch automatically when the 
payables are due. If a recurring payable record uses a schedule with a reminder attached, you can also 
process the payable right from the Reminder List. For more information about creating schedules and 
using the Reminder List, see the System Manager help.

Specifying When to Invoice Recurring Payables

You can set up a recurring payable to be processed indefinitely, or you can specify a limit for the payable. 
You can also assign a schedule to each recurring payable, then generate an invoice for it at the 
frequency determined by the schedule.

Specifying Limits for a Recurring Payable

To limit the number of times you can process an invoice for a recurring payable, you enter a start date 
and, by choosing Specific Date as the Expiration Type, you can enter an expiration date for the payable. 
No invoice is created for the payable prior to its start date or after its expiration date.

You can also specify a maximum amount that can be invoiced for a payable. No invoices are created that 
would cause the total amount invoiced to exceed this maximum for a recurring payable.

Assigning Payment Terms to Recurring Payables

You enter a terms code for each recurring payable. The code determines the due date for recurring 
payable invoices, as well as the discount percentage and period.

Note: Once you generate an invoice, you can change the due date, discount percentage, and period 
on the Invoice Entry screen. For more information, see "A/P Invoice Entry Screen" (page 401).
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Adding General Ledger and Tax Information

You can distribute each detail of a recurring payable to a different distribution code or general ledger 
payable account, and you can specify whether or not taxes are calculated automatically.

Setting Up a Recurring Payable for a Vendor

You can set up recurring payable records for recurring payments you make to a vendor.

Before You Start

 l Add the vendor record for which you are adding a recurring payable.

 l Determine the following:

 l Code to identify the recurring payable.

 l Start date and, if you are using one, the expiration date for the recurring payable.

 l Maximum amount that you will pay, if there is one.

 l Number of invoices that you will pay, if there is a limit.

 l Amount of each detail for the recurring payable.

To create a recurring payable:

 1. Open Accounts Payable > A/P Vendors > Recurring Payables.

 2. Click the New  button beside the Recurring Payable Code field, and then enter the recurring 
payable code you want to use with the new payable.

Note: You can use the same recurring payable code for different vendors.

 3. Enter a description for the recurring payable.

 4. In the Vendor Number field, enter the number of the vendor you will pay periodically using this 
recurring payable.

 5. On the Invoice tab, enter:     

 a. A start date for the payable.

 b. An expiration type and related information for the expiration type you specify.

 c. Header information for the document.

 6. On the Detail tab, enter details for the recurring payable, as you would for an invoice. More...

 a. If this is a job-related  document, enter the contract and project, and (as applicable) the 
category and resource.
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 b. Enter the item number, unit of measure, quantity, price, and distribution code. You may 
enter a negative quantity, but the invoice total cannot be negative.

If the detail is job-related , Accounts Payable displays as defaults the A/P item number and the 
unit of measure for the specified resource (for standard contracts) or category (for basic 
contracts).

 c. Enter an optional comment.

 d. If you use optional fields, click the Optional Fields Zoom  button to check, change, or add 
optional fields for the detail.

Tip: To check or change the general ledger accounts and tax information for a detail, click 
Account/Tax.

 7. Check or change tax information for the document on the Tax/Totals tab.

 8. Click Add (or Save, if you are updating an existing recurring payable record).

After creating a recurring payable

Print a list of recurring payables. For more information, see "Printing the Recurring Payables Report" (page 
279).

About Entering Current and Historical Transactions
Accounts Payable can display statistical information for vendor accounts, and vendor groups for the 
current year and for all the previous years for which you retain the data. You add the historical information 
you need during setup. Accounts Payable then automatically updates the statistical information every 
time you post transactions.

To properly set up your Accounts Payable system, you must enter and post the current-year opening 
balances in your vendor accounts. If you set up partway through a fiscal year, you must also enter and 
post figures for the current year, up to the present date, and all outstanding transactions. If you want to 
display and print reports of previous-year data, you must enter those figures during setup as well.

Note: You should delete all general ledger batches created from posting historical transactions. If you 
post these to your general ledger, you will be duplicating posted transactions.

Entering Outstanding Invoice Balances in Vendor Accounts

You create the opening balances in your vendor accounts by entering them as invoices using the Invoice 
Entry screen, then posting them.
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The opening balance invoice should use the first date of the current fiscal year as the transaction 
(document) date. You can also import the figures from a spreadsheet or other non-Sage 300 program.

Entering Current-Year Transactions

When you set up an Accounts Payable system part way through a fiscal year, you must enter the 
transaction data for the current year-to-date.

You can use any of the following method to add current-year transactions:

 l Enter data directly in Accounts Payable.

 l Import data, then post it using one of the following methods:

 l Post all the current-year transactions, one at a time, period by period.

This provides full detail for current-year transactions.

 l Post all the transactions for the current period, and the net changes in each vendor's invoice 
and payment totals for each of the earlier periods in the current year.

This provides full detail for current-period transactions, and creates accurate balances for 
previous periods in the current year.

 l Post the net changes in each vendor's invoice and payment totals for each of the periods in 
the current year.

This produces accurate balances for each account in each period of the current year, but does 
not provide transaction detail for the audit trail reports.

 l Post the net change between the opening and current balances for each vendor account.

This is the quickest method of entering the data, but it does not provide transaction detail for 
audit trail reports.

Entering Statistics for Previous Years

If you need to add purchase history for previous years to a new Accounts Payable system, you can add it 
quickly, or import it, using the Vendors and Vendor Groups screens.

You enter statistics by the periods and years specified for the options to keep the data.

For each vendor and vendor group, you can enter the amount and number of:

 l Invoices

 l Payments

 l Discounts taken

 l Discounts lost
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 l Credit notes

 l Debit notes

 l Adjustments

 l Paid invoices

You can also enter the:

 l Amount and date of the high and low balance for the current year and previous year

 l Largest invoice for the current year and previous year

 l Amount and date of the last:

 l Invoice

 l Payment

 l Credit note

 l Debit note

 l Adjustment

 l Discount

 l Total invoice amount paid, number of checks, average payment, days to pay, and average days to 
pay.

You can review the figures in the Vendors and Vendor Groups screens, and you can print them using the 
Statistics option in the Setup reports for each type of data.

If you do not need historical data right away, you do not have to add it when you set up an Accounts 
Payable system. The figures are updated automatically each time you post transactions.

Inquiring on Vendors
Use the A/P Vendor Activity screen to view the following information for a selected vendor:

 l Activity statistics

 l Aging information

 l Document history, including payments and exchange gains and losses for a selected document

 l Payment history

Use the A/P 1099/CPRS Inquiry screen to look up the history of 1099/CPRS payments made to vendors 
that are subject to 1099/CPRS reporting.

Tip: You can also use the 1099/CPRS Inquiry screen to add, modify, or delete 1099 or CPRS amounts 
(if your Accounts Payable system allows editing of these amounts).
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About Vendor and Vendor Group Statistics

Statistics are automatically accumulated for vendors and vendor groups, and automatically updated 
when you post invoice batches.

Period Statistics

For each vendor and vendor group, Accounts Payable stores the total amount and number of:

 l Invoices.

 l Payments.

 l Discounts taken.

 l Discounts lost.

 l Credit notes.

 l Debit notes.

 l Adjustments.

 l Total paid invoices.

Period statistics are reported by the period specified on the A/P Options screen, for as long as you keep 
transaction details.

Statistics are accumulated into the year and period derived from the document date. Even if you change 
the year and period to which you post the transaction, the statistics will still go to the period specified by 
the full document date.

Use the Vendors and Vendor Groups screens to enter, edit, and review statistics. For more information, 
see "A/P Vendors Screen" (page 518) and "A/P Vendor Groups Screen" (page 508).

Activity Statistics

Activity statistics kept for each vendor include the current outstanding balance, year-to-date amounts, 
amount and date of the vendor's highest balance and largest invoice in the current and previous years, as 
well as the amount and date of the last invoice, payment, credit note, debit note, adjustment, and 
discount posted to the account.

Each vendor record also shows the total amount of the invoices paid in the current year, the number of 
checks, the average payment, and the total and average number of days it took to pay the invoices. 
Activity statistics for the previous year are cleared at year end.

No activity statistics are kept for vendor groups.

Options for Keeping Statistics

On the A/P Options screen, you can set the following options for vendor and vendor group statistics:

70Sage 300 2023 Accounts Payable User's Guide



 l Allow Edit Of Statistics. Specify whether or not statistics can be manually edited.

 l Include Tax In Statistics. Specify whether or not to include tax amounts in statistical totals.

 l Accumulate By. Specify whether to accumulate statistics by calendar year or fiscal year.

 l Period Type. Specify the length of period by which to accumulate and report statistics.

For more information about these options, see "A/P Options Screen" (page 325).

Changing the Method of Reporting Statistics

If you change the type of year and period (by which Accounts Payable reports all three types of statistics), 
such changes will distort the figures in past periods.

For example, if you update statistics quarterly for nine months, then change to monthly updating, the 
totals for the first three quarters become the totals for the first three months. The result is overstated 
totals in each of the first three months, and zeros in the following six months.

If you need to change the type of year or period by which Accounts Payable reports statistics, you should 
either do so after running Year End, or edit the statistics for the earlier periods in the year to correct 
distortions.

Looking Up Vendor Activity

On the A/P Vendor Activity screen, you can look up information about account activity for vendors, 
including:

 l Summary account information.

 l Specific payments or transaction documents.

To look up information about vendor activity:

 1. Open Accounts Payable > A/P Vendors >        Vendor Activity.

 2. In the Vendor No. field, specify a vendor number.     

On the Activity tab, summary account information is displayed for the specified vendor, including the 
effects of the most recently posted transactions.

Note: If you use multicurrency accounting, you can specify in the Amounts In field whether to display 
amounts in the vendor currency or the functional currency.

 3. Look up payments or transactions:
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 a. On the Payments tab or the Transactions tab, specify search criteria.

 b. Click the Go  button or press F7.

Payments or transaction documents matching the specified criteria are displayed for the 
specified vendor.

Looking Up Vendor Payment Information

You use the A/P Payment Inquiry screen to look up payments.

To look up payments:

 1. Open Accounts Payable > A/P Transactions > Payment Inquiry.     

The A/P Payment Inquiry screen displays all payments as the default list.

 2. Select criteria to limit the list of payments:

 l A range of bank codes to list payments that were processed using one of the bank codes that 
fall within the given range.

 l A range of vendor numbers to view payments only for the vendors in the specified range.

Note: To include miscellaneous payments you must use blanks in the vendor number range.

 l A Payment status to include only payments that are outstanding, cleared, or returned, or you 
can display all payments that meet the other specified criteria.

 l A transaction type to include only Prepayment or Payment transaction types, or you can 
display all payments that meet the other specified criteria.

 l A range of payment dates to include only payments that were posted within the specified 
date range.

 l A range of years and periods to include only payments that were posted within the specified 
year and period range.

 l A range of payment numbers to limit the list to the specified range of payment numbers.

 3. Click the Go  button.     

Payments that meet the specified criteria are displayed.
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Notes: 
 l To view a payment in the Payment Entry screen, select the payment on the list, and then 

click Document.

 l To view details of the payment (including, in a multicurrency system, any gains or losses 
on settlement of a document) in a separate Payment Information screen, select the 
payment, and then click Open.

 l To print the Payment Inquiry report, click Print.

Looking Up 1099 or CPRS Vendor Amounts

You use the A/P 1099/CPRS Inquiry screen to look up 1099 or CPRS amounts.

To look up 1099 or CPRS amounts stored in your Accounts Payable system:

 1. Open Accounts Payable > A/P Vendors > 1099/CPRS Inquiry.

 2. Specify search criteria.

 3. Click the Go  button.

Amounts matching the specified criteria are displayed for each month of the year, including the last 
payment date in each month, the number of payments, and the total amount paid.

After looking up 1099/CPRS amounts

Click Print to print a report of the information displayed on the screen.

Adding, Modifying, or Deleting a 1099 or CPRS Vendor Amount

You use the A/P 1099/CPRS Inquiry screen to look up 1099 or CPRS amounts. You can also use this 
screen to:

 l Add new amounts.

 l Change or delete amounts you look up.

Before You Start

Ensure that the Allow Edit of 1099/CPRS Amounts option is selected on the Transactions tab of the 
A/P Options screen.
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To add, edit, or delete a 1099 or CPRS amount for a vendor:

 1. Open Accounts Payable > A/P Vendors > 1099/CPRS Inquiry.

 2. Specify search criteria.

 3. Click the Go  button.

Amounts matching the specified criteria are displayed for each month of the year, including the last 
payment date in each month, the number of payments, and the total amount paid.

 4. Do one of the following:

 l To add an amount, click the first blank line on the table or press Insert, and then enter 
information in the field in the line.

 l To change an amount, double-click the Amount field, and then enter the correct 1099 or 
CPRS amount.

 l To delete an amount, select the line for the amount, and then press Delete.
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Chapter 3: Entering and Posting 
Accounts Payable Transactions

Use Accounts Payable transaction entry screens to record, edit, post, and inquire on the following types 
of transactions:

 l Invoices, debit notes, credit notes

 l Payments

 l Adjustments

Journal Entries Generated by Accounts Payable
When you post transactions, journal entries are created in general ledger. The journal entries that are 
created vary depending on transaction type.

The following sections include information about the journal entries associated with Accounts Payable 
transactions.

Invoices

On the G/L Transactions report, invoices are assigned source code AP-IN; interest invoices are assigned 
the source code AP-IT.

Posted invoice transactions debit the general ledger inventory account or expense account you specify 
with each invoice detail (either directly or using a distribution code) and credit the vendor's Payables 
Control account.

G/L Account Debit Credit

Inventory (or Expense) X  

Retainage Control  X

     Payables Control  X

Journal Entries for Invoices

The entry for a retainage invoice is:
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G/L Account Debit Credit

Retainage Control X  

     Payables Control  X

Journal Entries for Retainage Invoices

Credit Notes

Credit notes are assigned source code AP-CR on the G/L Transactions report.

Credit note transactions credit the general ledger account (the inventory account in this example) and 
debit (decrease) the vendor's Payables Control account.

G/L Account Debit Credit

Payables Control X  

Retainage Control X  

     Inventory (or Expense)  X

Journal Entries for Credit Notes

Debit Notes

Debit notes are assigned source code AP-DB on the G/L Transactions report.

Debit note transactions debit the general ledger account represented by the distribution code (inventory 
in this example) and credit (increase) the vendor's Payables Control account.

G/L Account Debit Credit

Inventory X  

Retainage Control  X

     Payables Control  X

Journal Entries for Debit Notes

Payments

Payments are assigned source code AP-PY on the G/L Transactions report.

Payments debit the vendor's Payables Control account, credit the Bank account specified for the 
payment batch, and credit the Payment Discounts account (if a discount is taken). Discounts are 
assigned the source code AP-ED (for earned discount).
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G/L Account Debit Credit

Payables Control X  

Bank  X

     Payment Discounts  X

Journal Entries for Payments

Prepayments

Prepayments are assigned source code AP-PI on the G/L Transactions report.

Prepayments debit the Prepayment account and credit the Bank account for the payment batch. When 
you apply the prepayment later, Accounts Payable will credit the prepayment account and debit the 
expense or asset account that you specify.

G/L Account Debit Credit

Prepayments X  

     Bank  X

Journal Entries for Prepayments

Miscellaneous Payments

Miscellaneous Payments are assigned source code AP-PY on the G/L Transactions report.

Miscellaneous cash payments debit the general ledger account you specify on the Payment Detail tab of 
the Payment Entry screen and credit the Bank account for the payment batch.

G/L Account Debit Credit

Misc. Expense X  

     Bank  X

Journal Entries for Miscellaneous Payments

Adjustments

Adjustments are assigned source code AP-AD on the G/L Transactions report.

An adjustment entered as a positive number credits the vendor account (increases the payables balance) 
and debits the general ledger account you specify when you enter the adjustment.

For example, the following adjustment was entered as a positive adjustment to the inventory account:
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G/L Account Debit Credit

Inventory X  

     Payables Control  X

Journal Entries for Credit Notes

An adjustment entered as a negative amount debits the vendor account and credits the general ledger 
account you specify when you enter the adjustment.

Exchange Gains and Losses

On the G/L Transactions report, exchange gains or losses are assigned source code AP-GL (for 
"gain/loss").

In a multicurrency system, exchange gains or losses result when you revalue or settle an invoice using an 
exchange rate that is different from the rate currently used by the invoice.

During Revaluation

Accounts Payable creates entries for General Ledger when you revalue an invoice in a source (non-
functional) currency at an exchange rate that is different from the rate currently used by the invoice.

The following transaction registers a loss, because changes in the exchange rate have increased the 
value of the vendor invoice:

G/L Account Debit Credit

Exchange (or Realized) loss X  

     Payables Control  X

Journal Entries for Exchange Losses During Revaluation

If you use the Realized and Unrealized Gain/Loss accounting method for your company, exchange gains 
and losses are considered unrealized until the document is paid. Revaluation sends unrealized gain and 
loss transactions to General Ledger as reversing transactions (meaning they are automatically reversed 
at the beginning of the next fiscal period).

The following entry shows how the unrealized loss is reversed:

G/L Account Debit Credit

Payables Control X  

     Exchange (or Realized) loss  X

Journal Entries to Reverse Unrealized Loss
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When you print the Vendor Transactions report for the period in which you post the reversing revaluation 
transaction, both transactions appear for the vendor. Their net effect on the account balance is zero.

If you use the Recognized Gain/Loss accounting method, revaluation exchange gains and losses are not 
reversed.

Arising on Settlement

This type of exchange gain or loss arises when you settle an invoice using an exchange rate that is 
different from the rate currently used by the invoice.

If posting changes the value of an invoice (for example, through partial payment, full payment, or credit 
note), Accounts Payable calculates the gain or loss for the portion of the invoice that was changed by the 
posting, and creates gain or loss transactions for the general ledger accounts.

The following transaction registers a gain, because the exchange rate on settling reduced the value of the 
vendor invoice:

G/L Account Debit Credit

Payables Control X  

     Exchange (or Realized) gain  X

Journal Entries Exchange Losses Arising on Settlement

Note: Credit notes and debit notes do not affect gains or losses if they are issued at the exchange rate 
of the original invoice. However, they do generate gains or losses if they are issued at a different rate.

About Locked Fiscal Periods
In Sage 300, fiscal periods are locked separately for each transaction-oriented Sage 300 program.

The system checks the status of a fiscal period for Accounts Payable when you enter certain dates in 
Accounts Payable transactions. It also checks the status of the fiscal period for Bank Services when you 
print a check.

If the period is locked for Accounts Payable, you receive a warning, an error message, or no message, 
depending on the setting for the Locked Fiscal Period option on the Company Profile’s Options tab, as 
follows:

 l If the period is locked for Bank Services and the Locked Fiscal Period option is set to Error, you 
receive an error message when you add a receipt or print a refund check. (Otherwise, no warning 
or error appears.)     
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Important! Generally, you should lock a period for Accounts Receivable, Bank Services, and 
Accounts Payable at the same time, to avoid this situation.

 l If a fiscal period is locked for General Ledger but not for Accounts Payable, you can create batches 
for General Ledger during posting or using the A/P Create G/L Batch screen (depending on 
Accounts Payable's G/L Integration settings). When you try to post transactions to a locked period 
in General Ledger, however, the transactions will be placed in an error batch.     

Important! You should create and post General Ledger batches for outstanding Accounts Payable 
transactions before locking a period for General Ledger.

About Batch Processing in Accounts Payable
Batches are groups of transactions that share the same batch number and batch date. Each transaction 
has its own entry number, vendor number, date, and details.

Accounts Payable operates on a batch system. This means that you:

 1. Enter the three main types of transactions—invoices, payments, and adjustments—into batches.

 2. List the batches to check for errors.

 3. Post the batches to record the transactions in vendor accounts and distribute the amounts to 
general ledger accounts.

 4. Print the posting journals and G/L Transactions report as part of your audit trail records of batches.

The batch system for processing transactions provides great flexibility at the batch-entry stage, and tight 
auditing control during and after posting.

For details, see the following topics:

 l "About Creating Accounts Payable Batches" (page 82)

 l "Journal Entries Generated by Accounts Payable" (page 75)

 l "About Listing Batches" (page 87)

 l "About Posting Batches" (page 84)

 l "About Printing Posting Journals and the G/L Transactions Report" (page 88)

 l "About Tracking Batches" (page 86)

About Batch Types

There are three types of transaction batches in Accounts Payable:

Invoice batches. Invoice batches contain invoices, debit notes, credit notes, and interest invoices. In 
multicurrency ledgers, each invoice batch can contain documents in different currencies.
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Payment batches. Payment batches contain payments, prepayments, miscellaneous payments, and 
transactions that apply previously posted payments and credit notes to documents in vendor accounts. 
You can also enter adjustments to specific documents in payment batches if you use the Allow 
Adjustments In Payment Batch option.

In multicurrency ledgers, all payments in a single payment batch must be in the same currency, and the 
currency must be accepted by the bank code assigned to the batch.

Adjustment batches. Adjustment batches contain corrections to posted transactions. In multicurrency 
ledgers, a single adjustment batch can contain transactions in different currencies.

Assigning and Using Batch Numbers and Entry Numbers

To keep a clear and accurate audit trail, Accounts Payable automatically assigns a number to each batch 
and to each entry (transaction) you add to a batch, starting with 1. You must use the assigned batch and 
entry numbers.

A separate numbering sequence is used for each type of batch (invoice, payment, and adjustment).

The batch and entry numbers are a permanent part of each transaction record, and they appear with the 
transactions on Accounts Payable reports, such as posting journals and the Vendor Transactions report.

You can use batch and entry numbers to trace the progress of transactions through the Accounts 
Payable system and, if you use the numbers as the descriptions or references for G/L transactions, into 
your general ledger (unless you consolidate the transactions during posting in Accounts Payable).

Number of Open Batches Permitted at One Time

You can have an almost unlimited number of batches open at once, depending on available disk space. 
The ability to use several open batches means you can group transactions by data entry person, 
currency, date, location, or any other criteria you find useful.

System-Generated Payment Batches

You can have only one open payment batch that has been created using the A/P Create Payment Batch 
screen, although you can have other payment batches that you imported or created with the Payment 
Entry screen.

Force Listing of Batches

If you use the Force Listing Of Batches option, you must print batch listings for each batch you want to 
post. You must also print a new listing for each batch you edit.
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About Creating Accounts Payable Batches

You use the A/P Invoice Entry screen, the A/P Payment Entry screen, and the A/P Adjustment Entry 
screen to create batches and enter transactions directly into them.

In addition, Accounts Payable automatically creates batches when you:

 l Use the Create Payment Batch screen to create a batch of payment transactions for currently due 
invoices.

Note: You must create at least one payment selection code before you can use the Create Payment 
Batch screen to create a payment batch.

 l Post transactions that contain errors. Accounts Payable posts error-free transactions only, and 
creates a new batch that contains all the transactions it could not post.

 l Use the Create G/L Batch screen or post Accounts Payable batches. Depending on whether you 
defer general ledger batch creation or not, Accounts Payable creates batches of general ledger 
transactions arising from the invoices, payments, and adjustments you post to vendor accounts.

 l Import Accounts Payable batches from Sage 300 programs at another location or from non-Sage 
300 products.

Multicurrency Ledgers

If you have a multicurrency ledger, you must create a new payment batch for each currency you want to 
process. All transactions in the same payment batch must be in the same currency. You can enter a mix 
of currencies in invoice and adjustment batches.

About Accounts Payable Batches Created by Intercompany Transactions

If you use Intercompany Transactions (ICT), the Accounts Payable component in ICT lets you enter 
invoices, debit notes, credit notes, and interest charges for related companies.

Posting an ICT A/P batch creates an Accounts Payable batch in the originating company's Accounts 
Payable ledger (for posting invoices, debit notes, credit notes, and interest to vendor accounts), and it 
creates an ICT G/L batch in the ICT company. 

Note: For online help specifically about ICT features, you must open an ICT screen, and then press F1 
on your keyboard. You can do this only if you have installed ICT and activated it for an ICT company.

About Editing and Deleting Batches and Transactions

You can edit transactions or delete open batches according to your selection for the following options:

 l Allow Edit Of System Generated Batches.

 l Allow Edit Of Imported Batches.
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 l Allow Edit of External Batches.

Note: System generated batches are payment batches created using the A/P Create Payment Batch 
screen.

Editing Batches

You can always change most batch header information, regardless of the restrictions you may place on 
batch editing. For example, you can always change dates and descriptions of all open batches, whether 
you created them in Accounts Payable or imported them from another ledger.

You can add a new vendor or a new remit-to location during invoice entry or when editing an invoice.

You cannot change the bank code in payment batches once you add the first transaction.

Editing Imported Batches

If you need to correct an imported batch, you should delete the batch from Accounts Payable and make 
the corrections to it in the program where you created the batch. This procedure ensures that the batch 
you post in Accounts Payable contains exactly the same information as the batch in the source program.

To prevent editing of imported batches in Accounts Payable, make sure that you do not select the Allow 
Edit Of Imported Batches option on the A/P Options screen.

Editing Transactions

The status of a batch must be Open or Printed to edit the transactions. (Printed status means that the 
batch listing has been printed). 

If the batch has a Ready To Post status, you must turn off the Ready To Post selection before you can 
edit transactions.

If you allow editing of batches, you can always delete unposted transactions. You can also change any 
transactions in an open batch except payment transactions for which you have printed checks.

If you have printed the check for a transaction, you cannot edit it. You can delete the transaction to void 
the check.

Deleting Entries and Batches

When you delete a batch or an entry in a batch, you cannot reuse its number. Deleted batches and 
entries are reported on the batch listing and posting journal for the batch. Deleted batches are also 
reported on the Batch Status report.

If you delete a payment transaction for which you printed a check, you will void the check.
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About Posting Batches

Posting accomplishes the following tasks:

 l Updates vendor accounts with the transaction information entered in batches, and updates vendor 
and vendor group statistics.

 l Updates 1099/CPRS information for vendors who are subject to 1099/CPRS reporting (with tax 
information from invoices and payment totals from payments).

 l Creates general ledger transaction information for the G/L accounts affected by the transactions.

Posting creates G/L batches for the transactions if the Create G/L Transactions During Posting option is 
selected on the A/P Options screen. If you do not use the option, the G/L transaction information is 
stored for later addition to a G/L batch.

 l Creates transactions to realize gains or losses due to changes in exchange rates for payments 
that settled invoice transactions. These transactions affect the General Ledger only.

 l Updates bank services with payment amounts and check numbers, if you printed and posted 
checks.

 l Creates a posting journal for each group of batches posted at the same time.

 l Updates the posting sequence numbers for each type of batch listed on the Numbering tab of the 
A/P Options screen.

 l If you create General Ledger transactions during posting, updates the sequence numbers for the 
General Ledger batches on the Integration tab of the Integration screen.

 l Updates the status of each batch that was posted.

Preparing to Post Batches

You take the following steps to post batches:

 1. Print listings of the batches you want to post.

If you use the Force Listing Of Batches option, you must print batch listings for each batch you want to 
post. You must also print a new listing for each batch you edit.

 2. Select the Ready To Post option for each batch you want to post.

Posting Invoices and Adjustments

You can post invoices and adjustments in the following ways:

 l Post individual batches from the Invoice Batch List screen or Adjustment Batch List screen.

 l Post one or more batches in a range using the Post Batches screen. For more information, see 
"Post Batches Screen" (page 455).
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Posting Payment Batches and Printing Checks

You post payment batches using the Print/Post button on the Payment Batch List screen.

Print/Post is a two-stage process:

 1. Accounts Payable prints any checks in the batch that have not been printed using the Payment 
Entry screen, and,if the print run was successful, posts the check information to Bank Services.

 2. Once the check data has been posted to Bank Services (when you leave the Print Checks screen), the 
program proceeds to the payment-posting stage.

If all checks in the batch have been printed or if the payment batch did not contain any checks for 
printing, Print/Post skips the printing step, and proceeds directly to post the payment information to 
vendor accounts.

Payment posting applies all payment information to vendor accounts, and creates a Payment Posting 
Journal and a Check Register, which are the audit trail reports of the checks that were produced to pay 
vendors.

Posting Errors

If errors are found in a batch during posting, the incorrect transactions are not posted. Instead, they are 
placed in a new batch that uses the next available batch number.

The details of the incorrect transactions are printed in an error report which you print separately from the 
posting journal. If checks were printed for any of the incorrect entries, the word "Printed" appears with the 
transaction on the error report.

Posting Sequence Numbers

Accounts Payable assigns a posting sequence number to each transaction during posting. The same 
sequence number is assigned to all transactions that are posted together. Posting sequence numbers 
provide another way to trace posted transactions back to source documents.

Each time you post batches, Accounts Payable increases the posting sequence number by 1, and 
updates the posting sequence numbers that are displayed on the A/P Options screen. You can look up 
the current posting sequence numbers on the A/P Options screen to be sure you have up-to-date copies 
of posting journals and G/L Transactions reports.

Accounts Payable uses a separate numbering sequence for each type of batch (invoice, payment, and 
adjustment).

Posted Batches Are Automatically Deleted

When you post a batch, its contents are transferred to the vendor accounts and you can no longer edit the 
transactions. 

85Sage 300 2023 Accounts Payable User's Guide



You must enter adjustments or apply debit or credit notes to change any transactions you have already 
posted.

Delete Imported Batch Source Files After Posting

When you import and post a batch, the original file you imported still exists in the program where you 
created it. Imported batches are deleted automatically only from Accounts Payable.

You should also delete the batch file from the program where you created it, to avoid accidentally 
importing the batch twice.

If You Do Not Use Sage 300 General Ledger

If you do not use Sage 300 General Ledger—or if your Sage 300 General Ledger system is at another 
location—Accounts Payable creates its general ledger transactions in a file called APGLTRAN.CSV, 
which can be imported by a remote site Sage 300 General Ledger, or transferred to another general 
ledger that you use. The file is in a Comma Separated Values (CSV) format.

All general ledger transactions are placed in the same CSV file. Each time Accounts Payable creates 
transactions it will ask you whether you want to add to the file, or replace it.

You should always add to the CSV file using the Append option when you create G/L transactions. If you 
overwrite the file, you will destroy all transactions that are already in the file.

When you are ready to transfer the batch to your general ledger, copy the file to the computer or directory 
where your general ledger is located, and delete the original CSV file. Then make a backup copy of the 
CSV file.

About Tracking Batches

To check on current batches, print their batch listings or print the A/P Batch Status report for the type of 
batches you want to review. 

To display batch information on your screen, print the reports using Preview as the print destination, or 
look up the batches using the A/P Invoice Batch List, A/P Payment Batch List, and A/P Adjustment Batch 
List screens.

Batch Statuses

Batches are categorized by:

 l Status. Statuses include Open, Deleted, Ready To Post, Printed, Post In Progress, Posted, Check 
Creation In Progress (payment batches).

 l Type. These are the methods by which the batches were entered in Accounts Payable, including 
Entered, Imported, Generated (error batches), or System (system generated payment batches).
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Clearing Batch Status Information

You can remove information about posted and deleted batches from the A/P Batch Status report if you 
select the option to clear deleted and posted batches on the A/P Clear History screen.

About Listing Batches

Once you have entered all transactions in a batch, you should print the batch listing and compare it to 
your source documents to be sure all transactions were entered correctly. 

If you find mistakes, edit the batch to correct the errors, then reprint and check the batch listing before 
posting the batch.

Using the Force Listing Of Batches Option

To make sure listings are printed for each batch before you post it, select the Force Listing Of Batches 
option on the A/P Options screen. The option also prevents you from posting batches you edited but did 
not relist.

To print a listing for a batch you are working on, use the File > Print command on the batch entry screen.

To print listings for a range of batches, use the Batch Listings icon in the A/P Transaction Reports folder. 

File the reports as part of your audit trail.

Listing Payment Batches

You use the A/P Payment Batch List screen to work with payment batch listings.

To list batches:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. In the Batch Number field, enter the number of a payment batch.

Note: You cannot view a batch if you have cleared it using the Clear Deleted And Posted Batches 
option (on the A/P Clear History  screen).

Tip: To limit the display to batches that are open or ready to post, clear the Show Posted And 
Deleted Batches option.
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Note: 
You can also print the following reports from the A/P Payment Batch List screen:

 l Batch Status. To print this report, click Print Batch Status on the File menu.

 l Posting Errors. To print this report, double-click in the Number Of Errors column for the error 
batch.

 l Posting Journal. To print this report, click in the Posting Sequence Number column.

About Printing Posting Journals and the G/L Transactions Report

Each time you post batches, Accounts Payable creates a journal of the entries from the batches you 
posted together. These posting journals are an essential part of your audit trail, because they provide a 
record of all posted details and of the related general ledger distributions.

You should keep your audit trail of posted transactions up to date by printing and filing each posting 
journal as it is created.

You should also print the G/L Transactions report as part of your period-end procedures. You are 
required to print these reports only once, before you close the year. (You cannot use the A/P Year End 
screen until you have printed all outstanding posting journals and created the general ledger transaction 
batch.)

If you carefully maintain and identify source documents, and print and file all batch listings, posting 
journals, and other audit trail reports, you will be able to trace any transaction from source to general 
ledger entry.

About Importing and Exporting Batches

You can import invoice, receipt, refund, and adjustment batches created in non-Sage 300 programs and 
in remote Sage 300 subledgers. 

Accounts Payable treats imported batches as regular batches and, if the option to allow editing of 
imported batches is selected on the A/P Options screen, you can edit imported batches using the 
transaction-entry screens.  

You can also export transaction batches from Accounts Payable to other programs. For example, you 
could export data to a spreadsheet for analysis. You can also export batches of recurring transactions to 
import later.

For more information and instructions on importing and exporting batches, see the following sections in 
the chapter "Importing and Exporting Accounts Payable Data:"

 l "Importing Information into Accounts Payable" (page 217)

 l "Exporting Accounts Payable Information" (page 216)
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 l "Displaying a List of Fields You Can Import and Export" (page 218)

Invoices, Credit Notes, and Debit Notes
This section describes how to:

 l Create invoice batches.

 l Enter vendor invoices, credit notes, and debit notes using the A/P Invoice Entry screen.

 l Calculate tax.

 l Edit exchange rate information.

 l Assign multiple payment schedules to invoices.

 l Enter prepayments with invoices.

About Processing Invoices, Credit Notes, Debit Notes, and Interest

You can use the A/P Invoice Entry screen to create new batches for invoices, credit notes, debit notes, 
and interest charges. 

You use the A/P Invoice Entry screen to add these documents to invoice batches. You can add all four 
document types to a single batch, or use separate batches for each type.

You can also add retainage invoices, retainage debit notes, and retainage credit notes manually, if you 
do not want to use the A/P Create Retainage Batch screen to generate these documents automatically.

Information Entered with Documents on the Invoice Entry Screen

For each invoice, debit note, credit note, or interest invoice you enter on the A/P Invoice screen, you 
enter:

 l Header information for the document (transaction).

Header information includes the vendor number, document type and date, remit-to address, tax group, 
payment terms, and other data that are the same for the entire document.

 l Tax information.

 l Detail information to distribute the document and tax amounts to general ledger accounts.

With each document, you can also enter:

 l Payment amounts, dates, and discount information for payment schedules (installment payments).

 l Information in optional fields, if you use Sage 300 Transaction Analysis and Optional Field Creator 
and you have set up optional fields for use with invoices.
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Quick Mode

You can use Invoice Entry’s Quick Mode setting to save time during data entry. When you use this 
setting, Accounts Payable copies selected fields from the previous transaction or detail to the new 
transaction or detail, so you do not have to re‐enter them. For more information, see "Menu Commands" 
(page 558).

Multicurrency Ledgers

If you use multicurrency accounting, the vendor's currency code and the exchange rate appear on the 
Document tab when you enter the vendor number. You enter all amounts in the vendor's currency, which 
you cannot change.

Tip: Batches in multicurrency ledgers can contain documents in more than one currency. However, 
you may want to group documents into separate batches by the vendor’s source currency.

If the vendor does not use the functional currency, a Rates tab appears. You use the Rates tab to change 
the exchange rate, rate type, and rate date for an invoice, if necessary. 

When you enter a credit note or debit note for a specific invoice, the original exchange rate used for the 
invoice appears on the Rates tab.

Note: If you need to change the tax group for a multicurrency vendor, you must select another tax 
group that also uses the vendor's currency.

Editing Unposted Invoices, Credit Notes, and Debit Notes

You can change or correct open invoice batches, including error batches created during posting.

If you want to edit batches that were created by other Sage 300 programs or non-Sage 300 programs, 
you must select the Allow Edit Of Imported Batches option on the A/P Options screen.

Job-related  Invoices, Credit Notes, and Debit Notes

If you use Sage 300 Project and Job Costing, you can enter invoices, debit notes, and credit notes that 
update projects in that program when you post the documents in Accounts Payable.

When you enter a job-related  document, you must:

 l Select the Project and Job Costing option.

 l Identify the contract, project, and category for each detail you enter.

Note: Invoice details can either be job-related  or not job-related—you cannot enter an invoice with both 
types of details.

When you post job-related  invoices, Accounts Payable:
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 l Updates the project in Sage 300.

 l Creates journal entries to update the Work-In-Progress and Payables Control accounts in General 
Ledger.

About Applying Credit Notes and Debit Notes

When you enter credit notes and debit notes using the A/P Invoice Entry screen, you can also specify the 
number of the document to which the note applies.

If the note applies to several invoices or is issued on account (for example, as a purchase volume 
rebate), you do not enter an invoice number here. You apply the credit note or "pay" the debit note later, 
using the A/P Payment Entry screen.

Note: Discounts are not applied to credit notes or debit notes.

About Interest Invoices

You enter an interest charge on the Invoice Entry screen just as you would a debit note, except that the 
program does not let you enter or distribute taxes.

About Distributing Invoice, Credit Note, and Debit Note Amounts

For most invoices you need to distribute two amounts:

 l The amount of the invoice net of taxes.

 l The tax amount.

You distribute both of these amounts after you enter the document total on the Document tab and tax 
information on the Taxes tab of the Invoice Entry screen.

Including Tax in the Distribution Amount

If you select Tax Included for a tax authority and Calculate for the Tax Amount field on the Taxes tab, 
you distribute the invoice total—the details plus the tax that is included in the total on your vendor invoice.

If all the taxes are listed separately, you distribute the amount of the invoice net of tax, then calculate tax 
on the invoice.

If you select Distribute or Enter as the tax entry method, you always enter the tax amounts on the Taxes 
tab, then distribute the net-of-tax amount (the rest of the invoice) on the Document tab.

For instructions on distributing tax amounts, see the following topics:

 l "Manually Entering and Distributing Tax Amounts" (page 117)

 l "Calculating Included Taxes Automatically" (page 116)
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 l "Calculating Excluded Taxes Automatically" (page 116)

Multicurrency Ledgers

You distribute all invoice and tax amounts in the vendor's currency. Accounts Payable calculates the 
functional-currency equivalent to the invoice amount using exchange rates maintained in the Currency 
screens in Common Services.

You can change the exchange rate, rate type, and rate date for an invoice, using the Rate Information tab 
in the Invoice Entry screen, but you cannot change the vendor currency.

About Billing Types

Billing types are used for job-related  documents, where you manage the job using Sage 300 Project and 
Job Costing.

The billing type indicates to Project and Job Costing whether to bill the cost of a distribution line to the 
customer. You can change the billing type for a distribution if the project is billable and uses an Item 
invoice type, depending on the project style and accounting method.

Note: Only time and materials projects and fixed price projects that use an Item invoice type in Project 
and Job Costing can use item invoices. You cannot change the billing type for cost plus projects or 
fixed price projects that use a Summary invoice type in Project and Job Costing.

If a project is no charge or non-billable (regardless of the project type, project style, or accounting 
method), the program sets the billing type consistent with the project, and you cannot change it.

On a basic project:

 l For time and materials projects and for fixed price projects that use a billings and costs or accrual-basis 
accounting method and an item invoice type:

 l If both the specified project and category are billable, the detail is billable by default, but you 
can change the billing type.

 l If the project is billable, but the specified category is no charge or non-billable, the detail is 
also no charge or non-billable, consistent with the category, and you cannot change the 
billing type.

 l For fixed price projects that use a summary invoice type and an accounting method of:

 l Project percentage complete or completed project, if the project is billable, the detail is also 
billable.:

 l Billings and costs or accrual-basis:
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 l If both the specified project and category are billable, the detail is billable.

 l If the project is billable but the category is not, the detail is non-billable or no charge, 
consistent with the category, and you cannot change it.

On a standard project:

 l For time and materials projects and for fixed price projects that use a billings and costs or accrual-basis 
accounting method and an item invoice type:

 l If both the project and the specified resource are billable, the detail is billable by default. You 
can change the billing type for the detail.

 l If the project is billable, but the specified resource is no charge or non-billable, the program 
sets the detail No Charge or Non-billable, consistent with the resource.

 l For fixed price projects that use a summary invoice type and an accounting method of:

 l Project percentage complete or completed project, if the project is billable, the detail is also 
billable.

 l Billings and costs or accrual-basis:

 l If both the specified project and resource are billable, the detail is also billable. You 
cannot change the billing type.

 l If the project is billable but the specified resource is not, the detail is also non-billable 
or no charge (consistent with the resource), and you cannot change it.

For cost plus projects, the program sets the billing type, as follows:

 l For cost plus projects that use a completed project, total cost percentage complete, labor hours 
percentage complete accounting method, if the project is billable, the detail is automatically 
billable.

 l For cost plus projects that use a category percentage complete, billings and costs, or accrual-basis 
accounting method:

 l If both the project and category are billable, the detail is automatically billable.

 l If the project is billable, but the specified category is no charge or non-billable, the detail is 
automatically no charge or non-billable, consistent with the category.

Note: The Billing Type field is always blank for cost plus projects, and you cannot change it.

About Calculating Early Payment Discounts

If your vendors offer discounts for early invoice payment, you should define a terms code for each of the 
methods used to calculate discount amounts and discount periods.

Accounts Payable uses the terms code you specify with an invoice to calculate the discount period and 
amount for the document. 
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If the terms code includes multiple payments, Accounts Payable sets up a payment schedule that 
includes separate discount information for each payment.

You can also specify whether the invoice discount applies to a particular detail, or not. To indicate that a 
detail is not subject to the invoice discount, you simply clear the Discountable option for the detail on the 
Detail Items/Taxes screen, or select No for the option on the detail-entry table.

You can change the discount date, discount base, amount, and discount rate at any time until you post 
the invoice. 

Note: You must enter a discount date before you can enter an amount or a rate.

The discount date determines whether a discount is available when you enter a payment in the A/P 
Payment Entry screen. If a discount is available, Accounts Payable displays the available discount 
amount and the invoice total net of the discount when you apply payments to the invoice.

Note: Discounts do not apply to credit notes and debit notes.

About Assigning Multiple Payment Schedules to Invoices

To enter invoices that will be paid by a series of payments, you use a terms code that includes a multiple 
payment schedule. For example, the terms code might require six payments over a specified period to 
pay a single invoice. 

Based on the information entered for the terms code, Accounts Payable creates a payment schedule that 
divides the invoice total into the specified number of payments, each with its own due date, payment 
amount, and discount period.

Payment information appears on the Terms tab on the A/P Invoice Entry screen. You can change the 
payment schedule after you have distributed the invoice amounts.

You reference payments by payment number when you apply checks to multiple payment invoices. This 
feature makes it easy to track the payments for each invoice.

Note: You can include payment schedules on batch listings by selecting the Show Schedules option 
on the Batch Listing screen.

About Processing Advance Credits for the Return of Goods

Accounts Payable lets you record an advance credit for goods that you have returned to a vendor, but the 
vendor has not yet received and has not yet issued a credit.

When you pay the invoice, you reduce your payment by the agreed amount , at the same time recording 
the advance credit for the returned goods.
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The advance credit offsets the full amount of the invoice. However, because the vendor has not received 
either a payment or the goods, it preserves the outstanding balance for the unpaid portion of the invoice.

When the vendor issues the real credit note, you enter it in Invoice Entry, offsetting the advance credit in 
the vendor account.

About Calculating Tax

Account Payable gets all its tax rates and tax account information from Tax Services, which is part of 
Sage 300's Common Services.

Accounts Payable provides three methods for entering tax amounts and tax bases on invoices, credit 
notes, and debit notes:

 l You can let the program calculate all taxes for you.

 l You can enter all taxes manually for the document and its distribution lines.

 l You can enter total tax amounts for the document, and then prorate and allocate the total amounts 
to distribution lines.

Whether you let the program calculate taxes or you enter them manually, Accounts Payable sends all the 
appropriate tax information to Tax Services for tax reporting purposes.

Specifying a Tax Entry Method for a Document on the Invoice Entry Screen

You specify how taxes are calculated for a document on the Taxes tab of the Invoice Entry screen. In the 
Tax Amount and the Tax Base fields, you can select:

 l Enter. If you select this method, you enter total tax amounts and/or tax bases on the Taxes tab 
manually, and enter tax amounts for each detail on the Detail Accounts/Taxes screen using the 
information from the invoice.

If you want, you can distribute amounts automatically to the invoice details using the Distribute Taxes 
button. You can edit the detail taxes, later, on the Detail Accounts/Taxes screen.

Note: Clicking the Calculate Taxes button overrides all manually entered taxes—the total amounts on 
the Taxes tab as well as the detail taxes.

 l Distribute. If you select this method, you enter the total tax amounts and/or tax bases on the Taxes 
tab manually, using the information from the invoice.

You use the Distribute Taxes button to allocate to invoice the total tax amounts you enter manually.

Note: You cannot edit taxes on the Detail Accounts/Taxes screen if you choose this method.

 l Calculate. If you select this method, you  let the program calculate and distribute taxes when you 
add the invoice or distribute the invoice amount.
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The only way to change the amounts calculated for a document is by changing one of the following:

 l The tax group

 l The tax classes

If you choose Calculate for the tax amount and Distribute or Enter for the tax base, the program uses the 
tax base to calculate tax amounts automatically.

The main reasons for having the program calculate tax are:

 l To check the tax amount that appears on the invoice.

 l To track a tax which is hidden in the invoice total.

Note: Accounts Payable automatically uses the default tax entry method specified on the Transactions 
tab on the A/P Options screen. You can change the method for individual invoices.

Tips: 
If you want Accounts Payable to calculate all tax amounts for an invoice, select Calculate for the Tax 
Amount, Tax Base, and Tax Reporting options on the Taxes tab. You can change the tax calculations 
as follows:

 l To change the vendor’s tax class for the invoice, use the Taxes tab on the Invoice Entry screen.

 l To change the tax group for the invoice, use the Taxes tab.

 l To change the tax class for a detail, select the detail, and then click the Account/Tax button or 
press the F9 key. Edit the detail tax class on the Detail Accounts/Taxes screen.

 l Change the tax rates in Tax Services.

If you want to enter tax amounts manually:

 l Select Enter for the Tax Amount and the Tax Base options on the Taxes tab on the Invoice Entry 
screen, and then enter tax amounts for each authority. You can then prorate and distribute the 
tax amounts to invoice details.

 l Select Enter for the Tax Reporting option if you want to enter tax reporting information manually 
for the invoice and its details.

Accounts Payable does not calculate any tax for the invoice unless you click the Calculate Taxes 
button on the Taxes tab.

Tax Groups and Tax Authorities

The tax group you select for an invoice determines which tax authorities appear on the Taxes tab and the 
tax class for each tax authority. The only way to change the list of tax authorities is by changing the tax 
group.

For an overview of tax groups, see "About Tax Groups" (page 98).
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Tax Classes

The tax class usually determines whether goods are taxable. 

You can change the tax classes for each tax authority on the Taxes tab.

If you select Calculate as the tax entry method, you can also change the tax classes for individual 
distribution lines using the Detail Accounts/Taxes screen.

Tip: Whatever method you choose, you can always override manually entered amounts by clicking the 
Calculate Taxes button.

Tax Included Amounts

The Tax Included field on the Taxes tab determines whether distribution amounts are net of taxes or 
include taxes.

Note: You can change the Tax Included setting only if the tax authority permits it.

Tax on Retainage

You can report taxes on retainage amounts when you post an original invoice or when specified by a tax 
authority. Accounts Payable respects the option specified for each tax authority.

This feature meets the reporting requirements for GST and VAT, for which tax is reported separately on 
the amount payable on the original invoice, and then on the amount of the retainage when the retainage 
is due.

Tax Reporting in Multicurrency Ledgers

In a multicurrency system, if you assign to the invoice a tax group that uses a different currency than the 
vendor, Tax Reporting fields appear. Tax reporting amounts are required in some jurisdictions, such as 
Singapore.

You can let Accounts Payable automatically calculate all taxes in source currency, functional currency, 
and the tax reporting currency.

You can also change the rate type, rate date, and exchange rate for the tax reporting currency, and let 
Accounts Payable calculate the Tax Reporting amounts for each authority.

Distributing Document Taxes

When Accounts Payable distributes tax amounts to invoice details, it:
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 l Checks the Taxes tab to see which taxes apply to the vendor and the tax entry method.

 l If Calculate is not selected, Accounts Payable uses the tax amounts entered on the Taxes 
tab.

 l If Calculate is selected, Accounts Payable checks the Tax Included settings, then 
calculates the total tax amount for the distributions listed on the Document tab.

 l Allocates entered or calculated taxes in the same proportion as you distributed the rest of the invoice 
amount.

 l Removes any proportion of the tax that is recoverable from the tax distribution amount, and assigns it to 
the tax recoverable account.

You define tax authorities and specify whether taxes are recoverable using the screens in the Tax 
Services folder. 

 l Removes any tax that is separately expensed from the tax distribution amount and assigns it to the tax 
expense account.

You specify whether taxes are expensed separately in Tax Services.

Tax Services performs the tax calculations when you click the Distribute Taxes button on the Taxes tab.

About Tax Groups

Tax groups specify the authorities that tax the goods you purchase from vendors, and determine the 
specific classification for a tax, such as which rate is applied or whether you are tax-exempt.

You assign a tax group to each vendor record with other tax information, such as tax numbers and 
whether tax is usually included in invoice amounts. This information appears by default when you enter 
an invoice from the vendor.

If you need to change tax rates or amounts for a document, you can assign a different tax group or you 
can change the tax class or tax included settings, as follows:

 l On the A/P Invoice Entry screen, you change the settings on the Taxes tab.

 l On the A/P Recurring Payables screen, you change the settings on the Tax/Totals tab.

If you are calculating tax automatically for a document, you can change the tax settings for individual 
distribution lines on the Detail Accounts/Taxes screen. 

To open the Detail Accounts/Taxes screen, on the Invoice Entry Document tab, select (highlight) the 
distribution line on the table, and then click the Account/Tax button or press the F9 key.

Note: To change tax rates for a tax authority, you use the Tax Services screens in Common Services.
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About Distributing Self-Assessed Taxes

A self-assessed tax is one that you must pay, even though it is not collected by the vendor. These taxes 
commonly arise when you order goods from another state or province, but are still subject to local sales 
taxes.

Accounts Payable does not have a self-assessing tax type, but you can use the program to calculate self-
assessing taxes and distribute them to expense and tax payable accounts. The trick is to create two tax 
authorities, one for the tax expense, and one for the tax payable.

About Changing the Tax Class for a Single Invoice Distribution

You can change the tax class (tax status) for single invoice distributions by highlighting the invoice 
distribution line, pressing F9 or clicking the Accounts/Taxes button, and then selecting a different tax 
class.

Important! You must specify the tax class before you distribute taxes.

If you know the tax amounts for each distribution, you can also enter the taxes manually for each line.

Editing Taxes on an Invoice, Debit Note, or Credit Note

Accounts Payable can calculate all tax amounts on invoices, debit notes, or credit notes, or you can enter 
the taxes manually.

Before You Start

 l Decide whether you want to enter taxes manually, or let Accounts Payable calculate all taxes for 
you.

To change tax amounts for a document:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Display the batch and the invoice you want to edit, as usual.

 3. Click the Taxes tab.

 a. If you need to change the tax group for the document, select a different tax group in the Tax 
Group field.

Note: In a multicurrency ledger, if the new tax group does not use the vendor's currency, Tax 
Reporting fields appear.

 b. In the Tax Amount field and/or the Tax Base field, specify the tax entry method. More...
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Select one of the following tax entry methods:

 l Calculate. Select this option if you want Accounts Payable to calculate all tax 
amounts (or tax bases) for you.         

 l Do not enter tax amounts on this tab because the program calculates them for 
you.

 l A Tax Included column appears beside the Vendor Tax Class column. Use the 
column to specify whether taxes are included or excluded in the amounts you 
will distribute in the detail distribution table.

 l Check the vendor tax classes. If they are not correct, use the Finder to select the 
correct classes.

 l Distribute. Select this option if you want to enter the total tax for each tax authority 
manually and allocate tax amounts to distribution lines automatically.

 l Enter. Select this option if you want to enter all tax amounts (including taxes for 
distribution lines). Accounts Payable does not calculate any tax for the invoice, unless you 
click the Calculate Taxes button.

Note: 
 l If you select Calculate or Distribute as the tax entry method, you cannot directly edit 

tax amounts for distribution lines, although you can change tax classes.

 l You can use the Calculate Tax button to calculate the tax for the document.

 l You can use the Distribute Taxes button to prorate the total tax amounts for 
individual document details.

 l If you enter tax reporting amounts manually, you can use the Derive Rates button to 
calculate the implicit exchange rate for the tax reporting currency.

 c. If you selected Distribute for the tax entry method, enter the total tax for each tax authority 
manually, and then click Distribute Taxes to allocate tax amounts to the distribution lines.

 d. If you selected Enter for the tax entry method:

 i. Enter the total tax for each tax authority on the Taxes tab.

 ii. Enter the tax amounts for each distribution line that appears on the Document tab. More...

 i. On the Document tab, select the distribution line, then click the Account/Tax 
button. Make the changes in the Detail Accounts/Taxes screen that appears.

 ii. Click the Taxes tab to check tax amounts for the document and compare the 
totals on the screen with the totals on the source document.

Changing the Tax Class or Tax Included Setting for a Distribution Line

If you do not select Enter as the tax entry method for an invoice, debit note, or credit note, you can 
change the tax allocation for a distribution line only by changing the tax class or the Tax Included status 
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for the distribution line before you calculate and distribute taxes for the document.

Before You Start

Enter the invoice, debit note,or credit note, as usual.

To change the detail tax class or tax-included setting for a distribution line:

 1. If you have not already displayed the invoice, debit note, or credit note in the A/P Invoice Entry 
screen:

 a. Open Accounts Payable > A/P Transactions > Invoice Entry.

 b. Select the invoice, debit note, or credit note.

 2. On the detail table, highlight the distribution line for which you need to change the tax settings.

 3. Click the Account/Tax button, and then press the F9 key or press Alt+U to display the 
Accounts/Taxes screen.

 4. Change the Detail Tax Class or the Tax Included setting.

Important! You can change the Tax Included setting only if the tax authority permits.

 5. Click Save.

Note: If you changed the detail tax class to a non-taxable class, when you calculate tax, the total tax 
amount is reduced and is prorated over all other distribution lines based on their percentages of the 
total amount.

 6. Click Close to return to the A/P Invoice Entry screen.

After changing the tax settings for a distribution line

On the Taxes tab of the Invoice Entry screen, click Calculate Taxes or Distribute Taxes.

About Entering Multicurrency Invoices, Credit Notes, and Debit Notes

You enter multicurrency transactions in the same way as functional-currency transactions. The only extra 
consideration arises if you need to change exchange rates or assign a different tax group to the 
transaction.

The currency for an invoice, credit note, or debit note is displayed along with the current exchange rate 
when you enter a vendor number.

To change exchange-rate information for a document, use the Rates tab that appears for multicurrency 
transactions. You can change the rate type, rate date, and exchange rate for the document.
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You can change the tax group for a document only to another tax group that also uses the vendor's 
currency.

When you post multicurrency transactions, Accounts Payable converts the amounts to the functional 
currency, using the exchange rate information entered with the transaction.

About Entering Optional Fields on Invoices

If you use Sage 300 Transaction Analysis and Optional Field Creator and you have set up system-wide 
optional fields, you can define optional fields for the A/P Invoice Entry screen.

You define optional fields for invoices and invoice details using the A/P Optional Fields Screen in the A/P 
Setup folder. For more information, see "A/P Optional Fields Screen" (page 341).

When you enter a new invoice, debit note, or credit note, Accounts Payable displays any invoice optional 
fields that are marked for automatic insertion, along with their default values.

The Optional Fields check box on the Invoice Entry screen shows whether a selected document uses 
optional fields. 

Note: The program sets this indicator. You cannot select or clear it. If you delete all the optional fields 
associated with the document, the program resets the Optional Fields indicator.

Assigning Optional Fields to Documents

You can view or change the optional fields assigned to an invoice, debit note, or credit note, as follows:

 l To view or assign optional fields to a document, you use the Optional Fields tab on the Invoice 
Entry screen. More...

The program displays invoice optional fields that are set up for automatic insertion, and displays their 
default values, as follows:

 l If you assigned to the vendor the same optional fields as you defined for invoices, the 
program displays the optional field values from the vendor record as defaults for the invoice.

 l If you assigned to the remit-to location used on an invoice the same optional fields as you 
defined for invoices, the program displays the values from the remit-to location record as 
defaults for the invoice.

 l If you assigned the same optional fields to the vendor record and the remit-to location 
record, the program displays the values from the remit-to location record.

 l If an optional field that is defined for invoices is not assigned either to the vendor or the 
remit-to location, the program displays the value specified for the optional invoice field.
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Note: You can add or delete optional fields for invoices. However, you can add only optional fields 
that you have defined for invoices using the Optional Fields screen using the A/P Setup folder.

 l To view or assign optional fields for a document detail, you use a separate Optional Fields screen. 
Select the detail on the table, and then click the Optional Fields column heading, or press 
Shift+F9. (You can also display the detail on the Detail Accounts/Taxes screen, and then click the 

Optional Fields Zoom  button.) More...

When you first enter a document detail, the program selects the check box if at least one invoice detail 
optional field is set for automatic insertion in invoice details. 

Note: Accounts Payable sets this indicator—you cannot select or clear the check box. If you delete all 
the optional fields associated with the detail, the program resets the Optional Fields indicator.

You can add or delete optional fields for invoice details. However, you can add only optional fields that 
you have defined for invoice details using the Optional Fields screen in the A/P Setup folder.

You can change the value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that you have defined for the optional field 
in Common Services. You can leave the value blank only if the optional field allows blanks.

 l If the optional field is not validated, you can either select an value that you defined for the optional 
field in Common Services, or you can enter any value that is consistent with the type of optional 
field and that does not exceed the length specified for the field.

Optional Fields for job-related  Details

On a job-related  invoice, if the detail optional fields are identical to the optional fields used for the contract 
project in Project and Job Costing, Accounts Payable uses the optional field values from the project as 
default values for the details.

If an optional field you assign to an invoice detail is not used in the contract project, the default value from 
the optional field record appears.

If the optional fields match the optional fields defined for Project and Job Costing billings, the optional 
field information is passed to Project and Job Costing when you post the invoice.

Optional Fields for Retainage Document Details

On retainage documents, the optional fields and values specified on the original documents are used as 
defaults for the related retainage invoices, retainage credit notes, and retainage debit notes, whether you 
enter the retainage documents manually or create them using Create Retainage Batch.
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Updating General Ledger

Accounts Payable transfers optional field information to General Ledger when you create transactions for 
General Ledger if:

 l You specified in the optional field setup record that optional field information will be passed to the 
General Ledger account.

 l You defined the same optional fields for invoices and invoice details as you defined for transaction 
details in the General Ledger account record.

The General Ledger accounts can include:

 l Payables Control

 l Recoverable Tax

 l Expense Tax

 l Purchase Discount

 l Prepayment

 l Retainage

 l Realized Exchange Gain

 l Realized Exchange Loss

 l Rounding

About Using Optional Fields on job-related  Invoices, Debit Notes, and Credit Notes

On job-related  invoices, debit notes, and credit notes, if the optional fields for the document details match 
the optional fields used in Project and Job Costing, the values from the contract appear as defaults, as 
follows:

 l For time and materials projects:

 l For basic contracts, values from matching optional fields used by the project category appear.

 l For standard contracts, values from matching optional fields used by the project resource 
appear.

 l For fixed price projects that use a Completed Project or Project Percentage Complete accounting 
method, values from matching optional fields used by the project appear.

 l For fixed price projects that use a Billings and Costs or Accrual-Basis accounting method, values from 
matching optional fields used by the project category appear.
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 l For cost plus project that use a Completed Project, Total Cost Percentage Complete, or Labor Hours 
Percentage Complete accounting method, values from matching optional fields used by the project 
appear.

 l For cost plus project that use a Billings and Costs, Accrual-Basis, or Category Percentage Complete 
accounting method, values from matching optional fields used by the project category appear.

If the invoice detail optional fields do not match those used in Project and Job Costing, the values from 
the optional field setup records appear.

You can change the values, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in Common 
Services. If the optional field allows a blank, you can leave the value blank.

 l If the optional field is not validated, you can select a defined value, or you can enter any value that is 
consistent with the type of field, providing your entry does not exceed the length specified for the 
optional field.

The optional field information will be passed to Project and Job Costing when you post job-related  
invoices if:

 l You selected the Project and Job Costing Billings setting for the optional field in the optional field setup 
record.

 l The invoice details optional fields match the optional fields defined for Project and Job Costing billings.

Working with Invoice Batches

The A/P Payment Batch List screen lets you work with payment batches in a number of ways:

 l It provides an overview of all payment batches (entered, imported, generated, external, ready to 
post, and, if you choose to show them, deleted and posted). 

 l It shows the status of each batch, as well as batch totals and numbers of entries.

 l It provides batch maintenance functions that you use to set batches Ready To Post, and to post and 
delete selected batches. 

Note: You must set batches Ready To Post before you can post them using the Post Batches screen.

 l It provides links to several transaction report screens.

 l It provides a point of entry to the A/P Payment Entry screen. You can select and open existing 
batches, and create new batches, with the click of a button.

 l It lets you print all the checks in a batch before you post the payments.
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Note: You can view only posted batch that you have not have cleared using the A/P Clear History 
screen.

To view a list of existing payment batches:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. To start the display with a specific batch number, type the number or select it from the Finder.

Tip: To limit the list to batches that are open or ready to post, clear the Show Posted And Deleted 
Batches option.

 3. To edit or view an existing invoice batch in the Payment Entry screen, double-click it on the table, or 
select it, and then click Open.

Note: You cannot work with posted or deleted batches.

To create a new payment batch:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. Click the New button.

Accounts Payable displays the new batch in the A/P Payment Entry screen.

For more detailed information, see "Creating a New Invoice Batch" (page 107).

To set a batch Ready To Post:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. Select (highlight it) the open batch on the list, then double-click in the Ready To Post field. 

Note: You cannot edit a batch for which you have selected the Ready To Post option.

After setting a batch Ready To Post, you can print the checks in the batch and then post the batch using 
the Print/Post button.

To delete an invoice batch:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. Select (highlight it) the batch on the list, and then click Delete.

 3. When prompted, click Yes to confirm the deletion.
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To print reports from the Payment Batch List screen:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 l To print the Batch Status report, click File > Print Batch Status Report.

 l To print the Batch Listing report, click File > Print Batch Status Report.

 l To print the posting errors report, double-click in the Number Of Errors column for the error 
batch.

 l To print the invoice posting journal, double-click in the Posting Sequence column for the 
batch.

Creating a New Invoice Batch

Because Accounts Payable operates on a batch system, you must create batch files to contain invoices, 
debit notes, credit notes, and interest invoices before you enter these transactions. 

You then post batches of transactions to update vendor accounts and general ledger accounts, rather 
than posting transactions one at a time.

Before You Start

 l Set up the following Accounts Payable records:

 l Account sets.

 l Distribution codes.

 l Distribution sets (if you plan to use them).

 l Terms codes.

 l Vendor groups.

 l Vendors.

 l Remit-to locations (if your vendors have different payment addresses).

 l Use the Invoicing tab on the A/P Options screen to:

 l Select 1099/CPRS reporting.

 l Allow you to edit imported batches using the Invoice Entry screen.

 l Define any optional fields you want to add to the Invoice Entry screen.

 l Define the following information in Tax Services and Bank Services:

 l Tax authorities, tax groups, tax classes, and tax rates.

 l Bank codes.
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To create an invoice batch:

 1. Open Accounts Payable > A/P Transactions > Invoice Batch List.

 2. On the Invoice Batch List screen, click the New button to open the A/P Invoice Entry screen.

 3. Enter a batch date and a description.

Tip: You can also create batches directly in the Invoice Entry screen by clicking the New  button 

beside the Batch Number field.

After creating an invoice batch

Add invoices, debit notes, credit notes, and interest charges to the batch.

Deleting an Invoice Batch

When you delete an invoice batch, all transactions in the batch are deleted and the batch is listed as 
Deleted on the Batch Status report.

You cannot reuse the batch number.

To remove the data for the deleted batch from Accounts Payable, select the Clear Deleted And Posted 
Batches option when you clear history using the A/P Clear History screen.

To delete an invoice batch:

 1. Open Accounts Payable > A/P Transactions > Invoice Batch List.

 2. Select (highlight it) the batch on the list, and then click Delete.

 3. When prompted, click Yes to confirm the deletion.

Entering an Invoice

You use the Invoice Entry screen to add invoices  and interest invoices to invoice batches.

For an overview of invoice entry, see "About Processing Invoices, Credit Notes, Debit Notes, and Interest" 
(page 89).

For an overview of tax calculation on invoices, see "About Calculating Tax" (page 95).

Important! If you use Sage 300 Project and Job Costing, note that a document can either be job‐
related or not. You cannot mix job‐related and non‐job‐related details on the same document.
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Before You Start

 l Make sure you have complete information for each document you want to enter, including the 
vendor number, document number, date, and purchase order number, if any.

 l Determine the distribution code or general ledger account number, item number, unit of measure, 
quantity, and price for each detail.

 l In multicurrency ledgers:

 l Find out the rate type, rate date, and exchange rate to use for each invoice, credit note, 
debit note, prepayment, and interest charge.

 l Update currency information and exchange rates in the Currency screens in Common 
Services, if necessary.

 l If retainage applies to the document, find out the retainage percentage or retainage amount, 
retention period, retainage due date, retainage terms, and whether to use the exchange rate from 
the original document or the current exchange rate when you process the outstanding retainage.

To add an invoice:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Select an existing batch using the Batch Number field, or create a new batch. More...

To create a new batch:

 a. Click the New  button beside the Batch Number field.

 b. In the field beside the Batch Number field, type a description for the batch.

 c. In the Batch Date field, enter a date for the new batch, or accept the session date.

 3. Click the New  button beside the Entry Number field to start a new document, and then enter a 
description for the entry.     

 4. Enter header information for the document on the Document tab. More...

You enter the following information for the header:

 l Originator. This field appears only for Intercompany Transactions (ICT) companies. Specify 
the code for the ICT company that is originating the transaction. 

 l Vendor Number. Type or use the Finder to select the vendor who issued the invoice, debit note, 
or credit note. 

 l Remit-to Location. Type the code for the location where you send payments for this vendor. 
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Click the Zoom  button beside the field if you want to check the address information for the 

location.

 l 1099/CPRS Code and 1099/CPRS Amount. You enter a 1099 or CPRS code and amount 
only if the vendor is subject to 1099/CPRS reporting. 

 l Document Type. Specify Invoice, Debit Note, Credit Note, Interest, Retainage 
Invoice,Retainage  Debit Note, or Retainage Credit Note.

 l Apply To Document. This field appears only for credit notes and debit notes, and is optional.

 l Document Number. Enter the number from the vendor's invoice, debit note, credit note, or 
interest charge.

 l Document Date. Enter the date of the vendor's document. This date is used for aging and 
statistical purposes.

 l Posting Date. Enter the date to which to post the document. 

This date determines the year and period to which the document is posted..

 l Document Total. Type the invoice total, including taxes.

If you know only the amount net of taxes, you must perform some additional steps. More...

 a. In the Document Total field, enter the amount net of taxes.

 b. Distribute the amount of the document excluding taxes in the detail-entry table on the 
Document tab.

 c. Note: On the Taxes tab:

 i. Select Calculate as the tax entry method.

 ii. In the Tax Included field, select No for each tax authority if it is not already 
selected.

 iii. Click Distribute Taxes.

Accounts Payable displays the total tax amount on the Taxes tab.

 d. On the Document tab:

 i. In the Document Total field, add the total tax amount to the amount shown.

 ii. Check the Undistributed Amount field at the bottom of the tab to ensure that the 
amount displayed is zero. 
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If it is not zero, the amount you entered in the Document Total field is not correct. 
Check your addition, then enter the correct total in the Document Total field.

 l PO Number and Order Number. Optionally, enter the purchase order number and sales 
order number.

 l Job Related. If this is a job-related  invoice, select this option so that you can enter job-related  
information for each detail.

See "Entering a job-related  Invoice" (page 121) for more information.

 5. Enter distribution details in the detail entry table. More...

 a. If this is an ICT company, select destinations and route numbers. (For more information 
about ICT entries, see the Intercompany Transactions online help.)

 b. If this is a job-related  document, enter the contract and project, and (as applicable) the 
category and resource.

 c. If this is not a job-related  document, and you want to distribute the document total by 
distribution set, enter the following distribution information:

Distribution Set. Accept or change a displayed code, as needed, or enter a code if none 
appears, and you want to use a distribution set.

Distribution Amount. Type the total amount to be distributed in the details created by the 
distribution set.

This total does not have to be the full amount you have to distribute. For example, after creating 
distribution details from a distribution set, you may need to add distribution lines for general 
ledger accounts that are not included in the distribution set.

 d. Click Create Distribution to create distribution details for the distribution set you selected. You 
can then edit the distributions.

Tip: If you need to redo the distribution, you can delete all the lines created by the distribution 
set.

If you are not using a distribution set, skip this step.

 e. Add or edit distribution lines as follows:

Dist. Code. Accept or change a displayed code, as needed. You can also enter a distribution 
code if none appears, or leave the field blank, then enter the general ledger account number.

A distribution code is displayed if the vendor record is set up to distribute by distribution code or if 
you use the Create Dist. button to create distributions from a distribution set.
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Description. Type a description for the distribution detail.

G/L Account. Accept or change a displayed account number, as needed.

 f. In the Amount column, enter or edit the amount of each distribution detail.

The portion of the document total that you distribute in this step depends on how you specify 
taxes.

You distribute the document total net of taxes (not including tax amounts) if:

 l You will enter tax amounts manually on the Taxes tab. (Enter or Distribute is the tax 
entry method.)

 l Accounts Payable will calculate tax automatically and tax is not included in distribution 
amounts. (Calculate is the tax entry method, and No is the Tax Included option on the 
Taxes tab).

You distribute the document total, including taxes, if:

 l Accounts Payable will calculate tax automatically and taxes are included in the 
document total you want to distribute. (Calculate is the tax entry method and Yes 
appears in the Tax Included column on the Taxes tab.)

 l More than one tax applies to the document, and one tax is included while another is 
not included. You distribute the document total net only of the tax amount that is not 
included.

 g. Enter retainage separately for each detail.

If retainage applies to the document you are adding, enter the retainage percentage or amount, 
the retention period, and the retention due date for the detail.

 h. Enter an optional comment.

 i. If you use optional fields, press Shift+F9 or click the Optional Fields Zoom  button to 
check, change, or add optional fields for the detail. More...

The Optional Fields screen displays any invoice details optional fields that are marked for 
automatic insertion.

Use this screen to add or delete optional fields for the detail. You can add any optional fields that 
are defined for invoice details. You can also change the default values that appear, as follows:

 l If the optional field is validated, you must specify a value that is defined for the 
optional field in Common Services. If the optional field allows blanks, you can leave 
the value field blank.
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 l If the optional field is not validated, you can select a predefined value, or you can 
enter any value that is consistent with the type of field (amount, text, yes or no, and so 
on), providing your entry does not exceed the length permitted for the field.

To check or change the general ledger accounts and tax information for a detail, click the Account/Tax 
button. (Click Close to return to the Invoice Entry screen.)

For more information, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 99).

 6. Check to be sure you have distributed all document amounts before you calculate tax for the document. 

After distributing taxes, you should have distributed all document amounts, and the Undistributed 
Amount field should show zeros. More...

If the Undistributed Amount field does not show zeros, you have distributed either more or less than the 
total amount to distribute. 

Examples: 
 l If the Undistributed Amount contains a positive number, you have not distributed the total 

invoice.

If you used Calculate or Distribute as the tax entry method and tax is included, you must also 
distribute the tax amount.

 l If the Undistributed Amount is a negative amount (with a minus sign or in parentheses), 
check to see whether you accidentally distributed the taxes.

Tip: Click the Totals tab to see the document summary information, so you can find out where the 
mistake occurred.

 7. To check or change taxes for the document , click the Taxes tab.

 l Click the Distribute Taxes button to allocate tax to each of the distributions in the list. The 
amounts are displayed in the Allocated Tax column.

 l You can edit the tax amount that was allocated to each distribution detail if you select Enter 
as the tax entry method on the Taxes tab.

For more information, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 99).

 8. On an invoice from which retainage will be deducted, use the Retainage tab to specify terms for the 
retainage document. 

Note: In a multicurrency ledger, you also specify which rate to use when you process the retainage.

 9. Use the Terms tab to enter Payment terms for the invoice.
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 10. If you use invoice optional fields, use the Optional Fields tab to view or edit the optional fields 
assigned to this invoice.

 11. If the document does not use the functional currency and you need to edit the exchange rate, rate date, 
or rate type, use the Rates tab to adjust them.

For more information, see "Editing Exchange Rate Information on an Invoice" (page 118)

 12. Click Add to add this document to the batch.

 13. If you need to enter a prepayment for the invoice,click Prepay to add it now.

For more information, see "Entering a Prepayment with an Invoice" (page 119).

After adding an invoice, debit note, or credit note

 l Print the invoice.

 l Print the Batch Listing report. Make corrections, if needed, and then reprint the listing for each 
corrected batch.

Note: You must print batch listings before posting batches, if the Force Listing Of All Batches option 
is selected on the A/P Options screen. File the printed reports for your audit trail.

About Document Headers

Certain information, such as the vendor number, document number, and document type, is the same for 
all details on a single invoice, credit note, or debit note. This is the header information for the document 
and you enter it on the Document tab on the A/P Invoice Entry screen.

Header information for invoices, credit notes, and debit notes includes:

 l Entry Number. This is a sequence number that Accounts Payable assigns. It indicates the order in 
which a document was added to a batch. Entry numbers let you select documents for editing and 
identify documents on Accounts Payable reports.

 l Vendor Number. This number identifies the vendor, sets the default tax group and payment terms 
(for invoices), and specifies the currency of the document in multicurrency systems.

 l Remit To Address. You can use this field to specify the address to which the payment should be 
sent.

 l 1099/CPRS Code and Amount.

 l Document Type. You can select Invoice, Credit Note, Debit Note, or Interest Charge.

 l Apply To. If you are entering a credit note, debit note, or interest charge, identify the invoice to 
which the document applies.
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 l Document Number. The vendor assigns this number. You can use each document number only 
once.

 l Document Date. This is the date from which the document is aged on reports. You can choose 
whether to age credit notes and debit notes by document date or treat them as current 
transactions. Invoices are always aged by due date.

 l Fiscal Year and Period. The fiscal calendar defined for the company in Common Services 
identifies the period to which the document will be posted.

 l Document Description. You enter a description that will appear on the Invoice Batch Listing and 
the Invoice Posting Journal.

 l Tax Group. The tax group determines the tax authorities and tax classes that apply to goods you 
buy from the vendor. It is also used to calculate tax amounts for the document.

 l Purchase Order Number. Optional field. You can sort documents by purchase order number in 
Finders and for payment application, and you can use the number as the reference or description 
in G/L transaction batches.

 l Sales Order Number. You can sort documents by sales order number in Finders and for payment 
application, and you can use the number as the reference or description in G/L transaction 
batches.

 l Terms Code. This field appears for invoices only. If the terms code is for a multiple payment 
schedule, Accounts Payable adds an additional Schedule tab to the screen. Otherwise, the code 
sets the information in the Due Date, Discount Date, Discount %, and Discount Amount fields.

Changing Document Header Information

After you save an invoice, you can change most of the header information, including the following:

 l Document date

 l Description

 l Payment terms and discount information

 l Purchase order number

 l Sales order number

 l Remit-to location

 l Tax group

You cannot change the following header information:

 l Vendor number

 l Document type
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Calculating Excluded Taxes Automatically

You can choose to have Accounts Payable automatically calculate and distribute taxes that should be 
listed separately on the invoice.

To calculate excluded taxes automatically:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Select an invoice, or enter a new one, as usual.

Before proceeding to the next step, make sure that on the Document tab, you have:

 l Entered the total amount of the document in the Document Total field.

 l Subtracted the excluded tax amount from the document total, and distributed the difference 
using a distribution set or entering distribution lines manually.

 3. On the Taxes tab:

 l Select Calculate as the tax entry method for both the Tax Amount field and the Tax Base 
field.

 l Check the tax classes. If they are not correct, use the Finder  to select the correct classes 
for each authority.

 l Double-click in the Tax Included column, or press the Spacebar, to select No for each tax 
that should be listed separately on the invoice. 

 l Click Distribute Taxes.

Note: Because detail taxes are calculated automatically, you cannot change the allocated tax 
directly for detail lines on the Document tab. However, you can change the tax class or Tax 
Included setting for an individual line, as described in step 2.

Calculating Included Taxes Automatically

You can choose to have Accounts Payable automatically calculate and distribute taxes that are 
included in the invoice totals.

To calculate included taxes automatically:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Select an existing invoice, or enter a new one, as usual.

Before proceeding to the next step, make sure that on the Document tab you have:
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 l Entered the total amount of the document in the Document Total field.

 l Distributed the total document amount, either using a distribution set or entering distribution lines 
manually. Accounts Payable calculates the portion of each distribution that is tax.

Important! If some taxes are not included in the invoice total, subtract these tax amounts from 
the document total, and then distribute the net amount.

If you need to change the tax settings for a single distribution, do it before you calculate tax, as 
follows:     

 l Select (highlight) the distribution line.

 l Press the F9 key to display the Detail Accounts/Taxes screen.

 l Change the Tax Class or the Tax Included setting, as required.

 l Click OK.

 3. On the Taxes tab:

 l Select Calculate as the tax entry method in the Tax Amount field.

 l Check the tax classes. If they are not correct, use the Finder  to select the correct classes 
for each tax authority.

 l Double-click in the Tax Included column, or press the Spacebar, to select Yes for each tax that 
should be included in the invoice total, and not listed separately on the invoice. 

Note: You can change the Tax Included setting only if the tax authority allows taxes to be 
included in invoice totals.

 l Click Distribute Taxes. 

The Vendor Tax Class and Tax Included settings on this tab are the default settings for all 
distribution lines on the Document tab.

Note: Because detail taxes are calculated automatically, you cannot change the allocated tax 
directly for detail lines on the Document tab. However, you can change the tax class or Tax 
Included setting for an individual line, as described in step 2.

Manually Entering and Distributing Tax Amounts

You can enter and distribute taxes manually on invoices, debit notes, and credit notes if you do not select 
Calculate as the tax entry method.
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To enter and distribute tax amounts manually:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Display an existing transaction, or create a new invoice, debit note, or credit note, as usual. More...

Enter the following information on the Document tab before editing tax information:

 a. Fill in all header information for the document, as required.

Note: Make sure you enter the total amount of the invoice in the Document Total field. 

 b. In the table, distribute the document amount net of taxes using a distribution set or by 
entering individual distribution codes or general ledger account numbers and amounts 
manually.

 3. On the Taxes tab, enter taxes for the document, as follows:

 a. In the Tax Amount and/or the Tax Base field, select Enter or Distribute as the tax entry method.

Important! You can enter or edit detail taxes only if you select Enter as the tax entry method on this 
tab.

 b. If you selected Enter or Distribute in the Tax Amount field, enter the amount of each tax from the 
vendor's invoice.

 c. If you selected Enter or Distribute in the Tax Base field, enter the amount of each tax base.

 d. Check the tax classes. If they are incorrect, use the Finder to select the correct classes.

 e. Click Distribute Taxes to allocate tax amounts proportionally to each distribution line on the 
document.

 4. If you selected Enter as the tax entry method, you can edit the amount of each tax allocation, as 
necessary.

 a. On the Document tab, select the distribution line, then click the Account/Tax button. Make 
the changes in the Detail Accounts/Taxes screen that appears.

 b. Click the Taxes tab to check tax amounts for the document and compare the totals on the 
screen with the totals on the source document.

 5. Click Add or Save.

Editing Exchange Rate Information on an Invoice

You can change the exchange rate for a document if the vendor uses a different currency than your 
functional currency. 
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To enter exchange rate information:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Display the invoice you want to edit, or add a new invoice as usual.

 3. Click the Rates tab.     

Note: The Rates tab appears only in multicurrency ledgers if the vendor does not use the functional 
currency.

 4. In the Rate Type field, enter the code for the rate type to use to convert the source currency to your 
functional currency.

 5. In the Rate Date field, enter the date to use for selecting the exchange rate.

 6. If the correct exchange rate does not appear in the Exchange Rate field, enter it, and then press 
the Tab key to record the rate.

Entering a Prepayment with an Invoice

You can add one prepayment with each invoice you enter in an invoice batch. 

Note: Although you enter the prepayment through the Invoice Entry screen, you actually add it to a 
payment batch.

Before You Start

 l Enter an invoice using the A/P Invoice Entry screen.

The Prepay button, used to enter prepayments, is available only after you add the invoice.

 l Decide which payment batch to use for the prepayment.

To add a prepayment with an invoice:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Select the open batch that contains the invoice you are prepaying, or to which you want to add the 
invoice.

 3. Select the existing invoice that you are prepaying. 

If the invoice does not yet exist, enter the invoice information, and then click Add or Save.

 4. Click Prepay. 

The Prepayments screen appears.    

119Sage 300 2023 Accounts Payable User's Guide



 5. In the Batch Number field, type the number of the payment batch to which to add the prepayment, 

or use the Finder  to select the batch.     

To create a new payment batch, click the New  button beside the Batch Number field, then enter a 

description and a date for the batch.

 6. Fill in the remaining fields in the screen, as you would for any prepament.

 7. Click the Add button to add the prepayment.     

Note: You can add only one prepayment per invoice.

Tip: To cancel a prepayment before you have processed it, click Close without first clicking Add, then 
click Yes at the message that appears.

 8. Click Close.

After adding a prepayment with an invoice

You can edit the prepayment in the Payment Entry screen after you post the invoice.

Editing Optional Fields for an Invoice Detail

Optional fields that are set up for automatic insertion with invoice details appear as defaults when you 
add invoice details. You can edit or delete the fields that appear automatically, and add any optional fields 
that are set up for use with invoice details.

Before You Start

Make sure that the invoice detail optional fields you want to assign are set up for your Accounts Payable 
system. For more information, see "A/P Optional Fields Screen" (page 341).

To change the optional fields for a document detail:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Display the invoice that you want to edit, or enter a new invoice, as usual.

 3. On the detail table, select the detail you want to change, and then click the Optional Fields column 
heading.     

Tip: You can also select the detail, then press Shift+F9.

An Optional Fields screen appears, displaying any optional fields assigned to the invoice detail.
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 4. On the Optional Fields screen:

 l Add or delete optional fields for the detail, as required. You can add any optional fields that 
are defined for invoice details.

 l If necessary, edit the default values that appear.

Note: 
 l If the optional field is validated, you must specify a value that is defined for the 

optional field in Common Services. If the optional field allows blanks, you can leave 
the value field blank.

 l If the optional field is not validated, you can select a predefined value, or you can 
enter any value that is consistent with the type of field (amount, text, yes or no, and 
so on), providing your entry does not exceed the length permitted for the field.

Entering a job-related  Invoice

You can enter invoices in Accounts Payable that will update jobs that you manage using Project and Job 
Costing.

Important! Invoices can be either job-related  or not job-related . You cannot enter a mixed invoice.

Tip: To prevent the program from inserting a default distribution line, select None as the Distribute By 
option in the vendor record. If you do not select this option, you must delete the default distribution line 
from each invoice before you can enter a job-related  invoice.

Before You Start

 l Make sure you have complete information for each document you want to enter, including the 
vendor number, document number, date, and purchase order number, if any.

 l Determine the contract, project, category, and resource for each detail.

 l Find out the billing type and billing rate for each detail.

 l Find out the rate type, rate date, and exchange rate to use for each job-related  document, and, if 
necessary, update the currency information and exchange rates in Common Services.

 l If retainage applies to the document, find out the retainage percentage or retainage amount, 
retention period, retainage due date, retainage terms, and whether to use the exchange rate from 
the original document or the current exchange rate when you process the outstanding retainage.

 l Make sure you are familiar with the standard invoice entry process. These instructions focus on the 
differences from the usual process.

For help with standard invoice entry, see "Entering an Invoice" (page 108).
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To enter a job-related  invoice:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Enter the vendor number and other header information, as usual.

 3. Select the Job Related option.

Note: If the option is dimmed, delete the default distribution line from the detail table.

Additional fields appear that have the Level 1, Level 2, and Level 3 names specified on the PJC Options 
screen. Accounts Payable uses the default names, Contract, Project, and Category (and their plurals), 
respectively, unless Project and Job Costing specifies different names.

 4. In the detail table, for each detail:

 a. Specify the contract, project, category, and resource in the associated field.

Depending on the project type, Accounts Payable may display the default billing type, billing rate, 
A/R item number, unit of measure, General Ledger account, and unit cost from the contract.

 b. Update the billing type, billing rate, A/R item number, unit of measure, General Ledger account, 
and unit cost, if required.

 c. In the Quantity field, enter the quantity of the resource  for which your vendor is billing. 

You enter quantities in the unit of measure specified for the detail.

 d. If you use optional fields, enter the codes for the optional fields to use for the detail. 

The optional fields used for the project, category,or resource in Project and Job Costing appear 
as defaults, but you can change them. 

 5. Complete the rest of the tabs and fields as you would for any other invoice, credit note, or debit note.

Note: On the Optional Fields tab, Accounts Payable displays optional fields used for the contract in 
Project and Job Costing, but you can change them.

 6. Click Add when you are finished.

Invoicing a Recurring Payable Manually

Use this procedure if you accidentally delete a recurring payable invoice, or if you need to create an 
additional invoice for some other reason.
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To create an invoice for a recurring payable:

 1. Open Accounts Payable > A/P Vendors >        Recurring Payables.

 2. In the Recurring Payable Code field, select the code for the type of payable.

 3. In the Vendor Number field, select the vendor whose invoice you want to create.

 4. Click Create Invoice.

 5. Fill in the fields on the Create Invoice screen that appears.

 l Specify the date for the invoice, as follows:     

 l Select Next Scheduled to create an invoice using the next scheduled date.

 l Select Other if you want to use a different date (for example, to reproduce an invoice that 
you accidentally deleted). 

If you select Other, specify the invoice date in the date field that becomes available.

 l Specify whether to create a new batch for the invoice or add the invoice to an existing invoice 
batch. 

If you select Add To An Existing Batch, enter the batch number in the next field (or use the 
Finder to select the number).

 6. Click Process to create the invoice.

 7. Click Close.

Entering a Debit Note or a Credit Note

You use the Invoice Entry screen to add debit notes and credit notes to invoice batches.

For an overview of invoice entry, see "About Processing Invoices, Credit Notes, Debit Notes, and Interest" 
(page 89).

Before You Start

 l Find out the invoice number to which the debit note or credit note applies, if any.

Note: If the debit note or credit note applies to several invoices or is issued on account (for example, 
as a purchase volume rebate), you apply the credit note or "pay" the debit note later, using the 
A/P Payment Entry screen.
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 l For job-related credit notes and debit notes, if you specify an Apply To Document:

 l The credit note or debit note can use only jobs that were used on the apply-to document.

 l The credit note cannot reduce the current outstanding amount or quantity for a detail to less 
than zero.

 l For credit notes generated from P/O for invoices that have reverse charges:

 l On the Processing tab of the A/P Options screen, ensure that the Allow Edit of External 
Batches option is selected.

 l On the A/P Batch Listing screen, for the batch that was generated from PO, enter No in the 
Ready To Post field.

To add a debit note or a credit note:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Select an existing batch using the Batch Number field, or create a new batch. More...

To create a new batch:

 a. Click the New  button beside the Batch Number field.

 b. In the field beside the Batch Number field, type a description for the batch.

 c. In the Batch Date field, enter a date for the new batch, or accept the session date.

 3. Click the New  button beside the Entry Number field to start a new document, and then enter a 
description for the entry.

 4. Enter header information for the document on the Document tab. More...

Header information includes:

 l A description for the document.

 l Vendor number.

 l Whether the document is job-related. When you select the Job Related option, additional 
fields appear on the detail entry table and on the Detail Accounts/Taxes screen, where you 
enter job-related information.

 l Whether the document is subject to retainage (a holdback). More...

This option appears in Invoice Entry only if you selected the Retainage Accounting option for your 
Accounts Payable system. When you select the Retainage option, a Retainage tab appears that 
lets you specify the retainage terms for the document.

If you have a multicurrency ledger, you also use the Retainage tab to specify whether to use the 
original exchange rate or the current exchange rate when you produce the retainage document.
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Retainage fields also appear in the detail-entry table where you specify the retainage percentage 
or retainage amount, retention period, and retainage due date for each detail.

 l Remit-to location. Select credit note or debit note, retainage credit note, or retainage debit 
note.

 l Document Type.

 l Original Document. If you are processing a retainage credit note or debit note, specify the 
original document for which you are now processing retainage.

 l Document number.

 l The apply-to document that this credit note or debit note is offsetting.

 l Document date (for aging and statistical purposes).

 l Fiscal year and period to which you want to post the document.

 l Purchase order number and sales order number (if known).

 l Any special instructions regarding the credit note or debit note.

 5. Enter distribution details in the detail entry table. More...

 a. If this is a job-related  document, enter the contract and project, and (as applicable) the 
category and resource.

 b. Enter the item number, unit of measure, quantity, price, and distribution code. You may 
enter a negative quantity, but the invoice total cannot be negative.

If the detail is job-related, Accounts Payable displays as defaults the A/R item number and the 
unit of measure for the specified resource (for standard contracts) or category (for basic 
contracts).

 c. Enter retainage separately for each detail. If retainage applies to the document you are 
adding, enter the retainage percentage or amount, the retention period, and the retention 
due date for this detail.

 d. Enter an optional comment, and indicate whether to print the comment when you print the 
debit note or credit note.

 e. Indicate whether the document discount applies to this detail.

 f. If you use optional fields, click the Optional Fields Zoom  button to check, change, or add 
optional fields for the detail.

To check or change the general ledger accounts and tax information for a detail, click the Account/Tax 
button. (Click Close to return to the Invoice Entry screen.)

For more information, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 99).
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 6. To check or change tax information for the document, click the Taxes tab.

For more information, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 99).

For credit notes generated from P/O for invoices that have reverse charges, you must manually adjust 
the Tax Amount and Reverse Charges Amount. More...

 a. In the Reverse Charges Amount field, enter the amount that is shown in the Tax Amount 
field.

 b. In the Tax Amount field, enter 0.

 c. Click Distribute Taxes, and then verify the tax amounts and reverse charge amounts in 
details.

 7. On a document from which retainage will be deducted, use the Retainage tab to specify terms for 
the retainage document. In a multicurrency ledger, you also specify the type of rate to use when 
you process the retainage.

 8. If you use invoice optional fields, click the Optional Fields tab to view or edit the optional fields 
assigned to this invoice.

 9. If the document does not use the functional currency and you need to check or adjust exchange 
rate information, use the Rates tab.

For more information, see "Editing Exchange Rate Information on an Invoice" (page 118).

 10. Click Add to add this document to the batch.

 11. Click Save.

After adding a debit note or credit note

 l Print the invoice.

 l Print the Batch Listing report. Make corrections, if needed, and then reprint the listing for each 
corrected batch. File the printed reports for your audit trail.

Note: If the Force Listing Of All Batches option is selected on the A/P Options screen, you must print 
batch listings before posting batches.

Deleting an Invoice, Debit Note, or Credit Note

You can delete invoices, credit notes, and debit notes from batches that you have not yet posted.

Deleted documents are reported on the batch listing and posting journal for the batch.

When you delete a document in a batch, you cannot reuse its entry number.
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To delete an invoice, credit note, or debit note:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Display the batch and the invoice you want to delete.

 3. Click Delete. 

 4. If a message appears asking you to confirm the deletion, click Yes.

Posting an Invoice Batch

You can post invoice batches individually from the Invoice Batch List screen or the Invoice Entry screen.

For information about posting multiple batches, see "Posting a Range of Batches" (page 127).

Before You Start

 l If the Force Listing Of All Batches option is selected on the A/P Options screen, you must print a 
listing of the batch you want to post.

 l On the Invoice Batch List, select the Ready To Post option for the batch you want to post.

To post an invoice batch from the Invoice Batch List screen:

 1. Open Accounts Payable > A/P Transactions > Invoice Batch List.

 2. Select (highlight) the batch you want to post on the list.

 3. Click Post.

Note: If the Ready To Post option is not selected for the batch, a message appears asking whether 
you want to select the option and post the batch. Click Yes.

To post an invoice batch from the Invoice Entry screen:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Create or modify an invoice batch. For more information, see "Entering an Invoice" (page 108).

 3. Click Post.

Note: If the Ready To Post option is not selected for the batch, a message appears asking whether 
you want to select the option and post the batch. Click Yes.

Posting a Range of Batches

You use the A/P Post Batches screen to post a range of batches to vendor accounts.

127Sage 300 2023 Accounts Payable User's Guide



You can post all batches that are set Ready To Post, or you can specify a range of batches that are set 
Ready To Post.

Tip: 
You can also use batch list screens to post all batches that are set Ready To Post, as follows:

 l Invoice Batch List. Click Post All to post all unposted invoice batches.

 l Adjustment Batch List. Click Post All to post all unposted adjustment batches.

 l Payment Batch List. Click Post All to post all unposted payment batches.

Before You Start

 l Decide on the batches you want to post. Write down the batch numbers, if necessary. 

 l Use the A/P Batch List screen to mark the batches you want to post Ready To Post. (You double-
click in the Ready To Post column for each batch to select the option.)

 l Print listings of the batches you want to post. 

Note: If you use the option to force listings of batches, you cannot post batches until you print the 
batch listings for them.

To post a range of batches:

 1. Open Accounts Payable > A/P Transactions > Post Batches.

 2. Select the type of batch to post: Invoice, Payment, or Adjustment. 

Note: You can post only one type of batch at a time.

 3. Select the All Batches option to post all the batches of the chosen type, or select Range and then 
specify the range numbers for the batches you want to post. 

You can post a single batch, a range of batches, or all ready-to-post batches of the chosen type.

 4. Click Post.

After posting batches

 l Print posting journals.

 l Print the G/L Transactions report.
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Note: You should keep your audit trail of posted transactions up to date by printing and filing each 
posting journal as it is created, and by regularly printing and filing the G/L Transactions report and 
creating general ledger transactions.

Payments
You can enter payments in the following ways:

 l Use the Payment Entry screen to create new payment batches manually, enter payments one at a time, 
and print single checks for those payments.

You can also issue checks or other payments manually, and then use the Payment Entry screen to 
record the checks.

 l Use the Create Payment Batch screen to create batches of checks automatically.

Once you generate payment entries, you can list them, edit them using the Payment Entry screen, print 
the checks, and post the transactions to vendor accounts.

Note: You can change the information that appears on, and the layout of, printed checks and advices. 
For more information, see the documentation that comes with Crystal Reports.

About Payment Entry

You use the A/P Payment Entry screen to:

 l Create new batches of payments.

 l Enter payment information for checks you have already issued or for checks you want to print 
using Accounts Payable.

 l Apply existing documents, such as prepayments, to invoices.

 l Apply payments and partial payments to job-related  invoices.

 l Edit system-generated payment batches.

 l Print checks.

 l Enter adjustments to invoices you are paying in the Payment Entry screen, instead of using the 
Adjustment Entry screen.

Types of Payment Transactions

In most cases, a payment transaction is the information that Accounts Payable needs to print one check 
for a vendor and update the vendor account with the check information.

You can enter four types of transactions using the Payment Entry screen:
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 l Payment. Records a check, cash, or other type of payment of outstanding transactions. 

 l Prepayment. Records a check or other type of payment to prepay an invoice. 

 l Apply Document. Lets you apply one posted document against another, such as a prepayment 
against an invoice.

 l Miscellaneous Payment. Lets you enter an invoice at the same time as you enter the payment for 
an Accounts Payable vendors or for a one-time vendor.

For each type of transaction (except Apply Document transactions), you can print checks immediately 
after entry, or you can print them when you post the payment batch.

For more information about payment types, see "About Payment Types" (page 132).

Restrictions on Batch Entries

The main restrictions on the entries in a single payment batch are these:

 l All checks in the batch must use the same bank account. (You specify the bank when you create 
the payment batch.)

 l All checks in the batch must be in the same currency and use the same rate of exchange between 
the bank currency and the functional (home) currency (if they are different).

As with the bank, you specify the batch currency and rate when you create the batch. (You can change 
the bank rate later, but not the check currency.)

The currency you specify for a payment batch is the check currency, not the currency of the vendors 
paid in the batch. 

Accounts Payable lets you pay vendors in any currency you choose. For example, you can have a 
functional currency of Canadian dollars, but create a payment batch using US dollars to pay vendors in 
Mexico (whose source currency is the peso).

Information Entered with Payments

For each payment batch, you enter:

 l Batch Number (supplied by the program).

 l Batch Date.

 l Batch Description (optional).

 l Bank Code.

 l Currency (of the payment batch in multicurrency ledgers).

 l Rate Date (date for establishing the rate of exchange between the payment currency and the 
functional currency if you have a multicurrency ledger).
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 l Rate Type (such as spot rate, average rate, or weekly rate).

 l Bank Rate (set by the rate date and type, or overridden by the user).

You enter the following general information for payments on the Payment Entry screen:

 l Entry number (select only if editing; otherwise, Accounts Payable supplies the number).

 l Transaction Type (Payment, Prepayment, Apply Document, or Miscellaneous Payment).

 l Description.

 l Vendor (do not enter for one-time vendors).

 l Remit To (a primary remit-to location code will appear by default if the vendor has one; enter the 
payee name for miscellaneous payments).

 l Check Date (or Apply Date if applying a document).

 l Fiscal Year and Period (to which transaction posted).

 l Print Check (select if you want program to print it).

 l Check Number (if a payment or prepayment, you must enter a number if not printing the check 
from Accounts Payable).

 l Check Language (unless you are applying a document).

 l Apply Method (for job-related  payments).

 l Optional Fields (if you use Transaction Analysis and Optional Field Creator).

You also enter the following payment details:

 l Document(s) to which you are applying the transaction. How you do this depends on the type of 
transaction:

 l For Payment-type transactions, you select documents using one of two selection modes 
(Select mode or Direct mode).

 l For Prepayment-type transactions, you specify a document number, purchase order 
number, or sales order number.

 l If you are applying a payment or credit note you entered before, select the payment or credit note 
and the document to which it applies.

 l For miscellaneous payments, you enter the distribution accounts.

 l Check amount. How you do this depends on the type of transaction:

 l For Payment-type transactions, you enter the total applied to documents.

 l For Prepayment-type transactions, you enter a single amount.

 l For Miscellaneous Payment-type transactions, you enter the total of all distributions.
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 l Activation date for prepayments—usually the date you expect the invoice.

Note: A prepayment is not considered a credit to the vendor's account until the activation date. So, if 
you generate payments using Create Payment Batch before the activation date, the prepayment 
does not offset vendor invoices or debit notes.

Exchange Rates

If either the bank currency or the vendor currency differs from the functional currency, you enter 
exchange rate information for multicurrency payments on a separate Rate Override screen. 

Click the Rates button to display the Rate Override screen.

There are two sets of rate information:

 l Bank Rate. This is the rate of exchange between the check currency and the functional currency.

 l Vendor Rate. This is the rate of exchange between the vendor's source currency and the 
functional currency.

You can also override the check amount if the bank currency differs from the vendor's. This will, in turn, 
change the exchange rate.

About Payment Types

In most cases, a payment transaction is the information that Accounts Payable needs to print one check 
for a vendor and update the vendor account with the check information.

However, the Payment Entry screen lets you enter four types of transactions:

 l Payment. Records a check, cash, or other type of payment of outstanding transactions. You can print 
the check from Payment Entry or enter the number of a previously written check.

The program displays the vendor's outstanding transactions (invoices, debit notes, and interest 
charges), and you select the transactions you want to partially or fully pay.

 l Prepayment. Records a check or other type of payment to prepay an invoice. You can print the check 
from Payment Entry or enter the number of a previously written check.

Prepayments pay for a purchase before you have been invoiced for it. When you receive the invoice, 
you enter it using the Invoice Entry screen, and post it. The prepayment will then be applied against the 
invoice.

 l Apply Document. Lets you apply a posted prepayment or credit note to an invoice, debit note, or 
interest charge.

 l Miscellaneous Payment. Lets you enter an invoice at the same time as you enter the payment for an 
Accounts Payable vendors or for a one-time vendor for which you have not set up a vendor record. 
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You enter the details of the purchase in the detail entry table in the same way as you enter an invoice. 
The distributions debit the general ledger accounts you specify and credit the bank account.

Tip: If you have a large number of one-time vendors, you should add a "miscellaneous vendor" 
record, so you can process payments using Create Payment Batch and keep statistical data for this 
class of vendor. Make sure that you select the option Generate Separate Payments For Each Invoice 
for the miscellaneous vendor (on the Processing tab of the Vendors screen).

If you are entering a payment for a one-time vendor, for whom you do not create a vendor record, 
Accounts Payable does not create an invoice when you post the payment.

About Payment Limits

The A/P Control Payments screen lets you set a maximum that you can pay for an invoice when using the 
Create Payment Batch screen to generate a payment batch.

Accounts Payable applies the payment limit in Payment Entry and when creating payment batches, as 
follows:

 l For Payment and Apply Document transactions you enter in Payment Entry, if you apply an invoice 
for which a payment limit exists, Accounts Payable displays a reduced applied amount that 
observes the payment limit. It also warns you that a payment limit exists for the invoice. You can 
enter a larger amount, if you want to override the payment limit.

 l For Prepayment transactions in Payment Entry, when a payment limit is applied depends on whether 
you are matching the prepayment to a PO number, order number, or document number:

 l If you select Document Number in the Apply By field, Accounts Payable reduces the amount 
consistent with the payment limit, warns you about the payment limit, and lets you edit the 
applied amount, as for Payment and Apply Document transactions.

 l If you select PO Number or Order Number in the Apply By field, you do not receive a 
warning when you apply an amount.

The specified PO number or order number can be billed using more than one invoice, and each 
invoice can have its own payment limit. Therefore, when you post the prepayment, Accounts 
Payable applies the payment limits of all invoices that use the PO or order number, and reduces 
each payment, as necessary.

 l When generating a batch of payments using the Create Payment Batch screen, Accounts Payable pays 
the invoice only up to the amount permitted by the payment limit.

If a payment limit causes an invoice to be only partially paid, Accounts Payable uses zero as the 
discount taken, even if a discount is available, deferring the discount until the invoice is fully paid.
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If you want to override the payment amount or the discount amount calculated by Accounts Payable, 
you can edit the payment batch in Payment Entry, provided you selected the option to allow edit of 
system batches (on the A/P Options screen).

About Multicurrency Payments

If you use multicurrency accounting, all payments in a payment batch are in the currency you specify for 
the payment batch.

Exchange Rates are Maintained in Common Services

The default bank rate for each transaction is set in the batch header. Click the Zoom  button beside 

the Currency field to view exchange rate information for the batch. 

When you create the batch, the default rate for the batch comes from Common Services, and is based on 
the rate type and the session date.

The vendor exchange rate for payments, prepayments, or miscellaneous payments also comes from 
Common Services, and is based on the rate type and session date.

"Apply Document" Exchange Rates

If you are applying a document, you cannot change any rates, because the document you are applying 
has already been entered and posted with a rate.

If the Batch is in the Functional Currency

The Check Amount you enter in the Payment Detail screen is in the functional currency.

The Applied Amount or Prepayment Amount shown on the Payment Detail table is in the vendor 
currency.

The exchange rates are for converting the bank currency or the vendor currency to your functional 
currency. If either of these currencies is the functional currency, the rate for that currency will be 
1.0000000.

Note: If you use the Rate Override screen to change the exchange rate, you will change the amount in 
the Check Amount field, which shows the amount in the vendor currency in this screen.

About Posting a Payment to a Future Year

If you are near the end of your fiscal year and want to create a post-dated check, you must post to a future 
year.
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To do so, make sure the Create GL Transactions By option is set to Creating a New Batch on the A/P 
G/L Integration screen. 

If Create GL Transactions By option is set to Creating and Posting a New Batch, the system tries to post 
to the current fiscal year, not a future one, and an error message appears.

About Reversing Posted Checks

You do not reverse posted checks in Accounts Payable. You must use the Reverse Transactions screen 
in Bank Services to reverse a posted check.

When you post the reversal in Bank Services, you can choose whether to reinstate the associated invoice 
in Accounts Payable, if the invoice information still exists. However, you cannot reinstate an invoice if the 
vendor has no record in Accounts Payable (for example, if you reverse a miscellaneous payment to a 
one-time vendor).

Note: If your Sage 300 system uses security, you must have authorization to use the Reverse 
Transactions screen in Bank Services.

For more information about reversing a posted check, see the Bank Services help.

If you have not yet posted the payment, see "Voiding a Printed Check" (page 173).

About Entering Optional Fields on Payments

If you use Sage 300 Transaction Analysis and Optional Field Creator and you have set up system-wide 
optional fields, you can define optional fields for the Payment Entry screen. You can then assign these 
optional fields to all types of payment transactions: payments, prepayments, and unapplied cash, apply 
document, and miscellaneous payment transactions.

You define payment optional fields using the A/P Optional Fields Screen in the A/P Setup folder. For 
more information, see "A/P Optional Fields Screen" (page 341).

When you enter a new payment, Accounts Payable displays any payment optional fields that are marked 
for automatic insertion, along with their default values. 

The Optional Fields check box on the Payment Entry screen shows whether a selected payment uses 
optional fields. 

Note: The program sets this indicator. You cannot select or clear the check box. If you delete all the 
optional fields associated with the payment, the program resets the Optional Fields indicator.
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Assigning Optional Fields to Particular Payments

To view the optional fields that are assigned to a selected payment, click the Zoom  button beside the 

Optional Fields check box. The Optional Fields screen appears, where you can change the values for 
optional fields that appear as defaults, or delete them. You can also add any other optional fields that you 
have defined for payments.

If exactly the same optional fields are defined for vendors and for payments, the optional field values from 
the vendor record are used as defaults when you enter a new payment.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services. If the optional field allows a blank, you can leave the value blank.

 l If the optional field is not validated, you can select a defined value, or you can enter any value that 
is consistent with the type of field, providing your entry does not exceed the length specified for the 
optional field.

Updating General Ledger

When you post a payment that contains optional field information, the optional field information specified 
for the payment is passed to General Ledger and is included in the journal entry if:

 l You specified in the optional field setup record that optional field information will be passed to the 
General Ledger account.

 l You defined the same optional fields for payments as you defined for transaction details in the 
General Ledger account record.

About Printing Checks

You can print vendor checks in one of the following ways:

 l From the Payment Entry screen, when you enter a payment for a vendor. More...

Open the Payment Entry screen, add a payment or open an existing one, and click the Print Check 
button to print a check for the payment.

 l From the Payment Batch List screen, for all the checks in a selected payment batch. You also post the 
payment batch to vendor accounts after printing the checks. More...

Select the payment batch, and then click the Print/Post button to print checks for all the payments in the 
batch.

When you click the Print Post button, Accounts Payable performs the following tasks:
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 l Makes sure that the batch has been listed, if the Force Listing Of Batches option is selected on 
the A/P Options screen.

If you use the option and the batch has not been listed, you must list it before you can print and 
post the checks.

 l Makes sure that the batch you selected is set Ready To Post. If it is not, prompts you to set it 
to Ready To Post and continues with posting.

 l Posts the batch immediately if all checks in the batch have been printed, or if the payment batch 
does not contain checks. 

If the batch includes unprinted checks, Accounts Payable displays the Print Checks screen 
where you can print the checks. More...

You can review the settings in the Print Checks screen before you proceed, and review the list of 
checks the program is ready to print.

You can change the following items if they are incorrect:

 l Check stock.

 l Next check number.

 l Number of leading checks. Although is printed on leading checks, Bank Services 
needs the information to assign check numbers for the blank forms, to keep the audit 
trail correct.

 l Report file used to print the check and/or advice forms. You cannot proceed with 
printing and posting checks without a valid check report file.

Once the check data has been posted, you cannot reprint the checks or advices.

For step-by-step instructions for printing checks, see

 l "Printing a Single Check When You Pay a Vendor" (page 252)

 l "Printing Checks for a Batch of Payments" (page 255). (This is the most common way of printing 
checks.)

Print Formats for Checks

Sage 300 Accounts Payable comes with several sample formats for checks with attached advice slips. 
You can use the sample formats or change them to suit your company's requirements (for example, to 
adapt the formats if you use separate pre-printed check and advice forms) using Crystal Reports.

For a list of the sample check-printing formats that come with Accounts Payable, see "Customizable 
Formats for Printed Accounts Payable Forms" (page 44).

For instructions on printing checks, see "Printing Checks for a Batch of Payments" (page 255) or "Printing a 
Single Check When You Pay a Vendor" (page 252).
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Canceling the Printing and Posting Process

Accounts Payable does not post to vendor accounts until you confirm that:

 l Checks (and advices, if printed separately) were correctly printed.

 l Accounts Payable can post the batch.

If the checks were not printed properly (and you cannot reprint them at this time), you can cancel the print 
run as follows:

 1. Answering No when the program asks whether the checks were printed properly.

 2. Setting the check status to Not Printed.

 3. Clicking the Close button on the Print Checks screen.

You then have the option to void all checks that were printed.

 l If you void checks, the check numbers will be marked as void in Bank Services, and a subsequent 
printing will issue all new check numbers.

 l If you do not void checks, you will be able to specify which checks you want reprinted the next time 
you choose Print/Post for this batch.

 l The status for the batch will be set to Check Creation In Progress, and you will have to complete 
check printing in future before posting can proceed.

Void and Reversed Checks

You cannot reprint a check once the check information has been posted to Bank Services. However, if 
you delete the payment from the payment batch after you print the check, Accounts Payable changes the 
status of the check to Void in Bank Services.

You can delete payments (void checks) until you post the batch. Deleted checks do not appear on the 
Accounts Payable Check Register.

If you need to put a stop-payment on a check for which you have posted the payment to vendor accounts, 
you can reverse the check using the Reconcile Statements screen in Bank Services. Accounts Payable 
will reverse the payment application associated with the check when you do the reversal.

About Clearing Checks Electronically

The American National Standards Institute standard facilitates the conversion of checks to electronic 
images so that they can be cleared electronically. Accounts Payable lets you print ANSI-compliant 
checks for the US and Canada.

The ANSI format has a slightly different layout from the other forms, as follows:
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 l The date is printed in one of the formats DDMMYYYY, MMDDYYYY, YYYYMMDD, depending on 
your windows setup.

 l The currency code and currency symbol (for example, $) is printed before the check amount, 
depending on the currency setup in Common Services.

 l The text version of the amount prints "Dollars".

The following Accounts Payable check formats are ANSI-compliant:

 l APCHK01A

 l APCHK11A

About Reprinting Checks

The simple rule is that you cannot reprint checks if you accept them as correctly printed and then close 
the Print Checks screen.

If your checks are not printed correctly and you need to reprint them, you must click No when Accounts 
Payable asks you whether the checks were printed correctly, and then change the check status to Not 
Printed on the Print Checks screen.

After you reject printed checks, you can reprint them immediately, or you can reprint them later. If you 
decide to reprint the checks later, you can choose whether to void all printed checks when you close the 
Print Checks screen.

If you were printing checks using the Print/Post button on the Payment Batch List screen, Accounts 
Payable does not proceed with posting.

Reprinting Checks Immediately

If you want to reprint checks that do not print correctly:

 1. When asked if the checks printed correctly, click No to reject the checks.

 2. On the Print Checks screen:

 a. Double-click in the Check Status column for each check to set its status to Not Printed.

 b. Click the Reprint button on the Print Checks screen to reprint the checks.

Voiding Printed Checks

If you cannot reprint checks immediately and you want to edit the batch later (for example, if you are 
entering and printing single checks from the Payment Entry screen), you should void the check when you 
close the Print Checks screen.

If you do not void the checks, Accounts Payable sets the batch status to Check Creation In Progress, 
preventing you from opening or editing this batch unless you reset the batch status.
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For instructions on voiding checks during a check run, see "Voiding Printed Checks During a Check Run" 
(page 258).

Previously Printed Checks Are Assigned “Void” Status

Accounts Payable assigns check numbers to checks just before printing them. 

If you did not cancel the previous check run, the program must void the old check numbers and issue new 
ones when you reprint checks. Accounts Payable:   

 l Reprints the checks using a new series of check numbers beginning with the Next Check Number 
specified in the Print Checks screen.

 l Voids the check numbers it used earlier.

 l Asks whether the new checks printed correctly.

Working with Payment Batches

You use the following screens to work with payment batches:

 l Payment Batch List. You use this screen to create new payment batches to which you add 
individual payment transactions, later, using the Payment Entry screen. You also use this screen 
to view the status of all payment batches, to set payment batches Ready To Post, to print checks, 
to post batches, and to print batch listings, batch status reports, posting journals, and posting error 
reports.

 l Payment Entry You use this screen to create a new payment batch, and to enter and edit 
payments, print individual payment checks, and adjust specific open documents.

 l Create Payment Batch. You use this screen to create a batch of vendor payments automatically.

 l Control Payments. You use this screen to review and change the status of transactions. You can 
put holds on invoices and force payments.

You can also create a payment batch when you add a prepayment with an invoice you are entering using 
the Invoice Entry screen. 

About Creating Payment Batches Automatically

You use the A/P Create Payment Batch screen to create batches of payment entries automatically to pay 
all or a selection of your due accounts.

Important! You must create a separate payment batch for each bank account on which you want to 
write checks.

Once you create a batch of payments, you can edit them using the A/P Payment Entry screen—if the 
Allow Edit Of System Generated Batches option is selected on the A/P Options screen.
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Preparing to Create a Payment Batch

Before you create a payment batch, you should:

 l Post all outstanding batches.

 l Post invoice batches to update vendor accounts with any new charges, credit notes, and debit 
notes.

 l Post adjustment batches to ensure that vendor records are correct.

 l Post payment batches. Accounts Payable will scan all open batches for pending payments, but 
problems can arise when you work on several payment batches simultaneously.

For example, the payments listed on the Pre-Check Register will not match the generated payment 
batch if you continue to enter payments manually.

 l Choose Generate Separate Payments For Each Invoice in the vendor records of any vendors 
who require separate invoice payment.

 l Use the Control Payments screen to set maximum amounts or to hold payments on individual 
invoices.

 l Place vendor records on hold if you want to block payments.

 l Edit the payment selection criteria on the Create Payment Batch screen to exclude individual 
vendors from the check run.

 l Print the Pre-Check Register and review it before you generate the payment batch.

The Pre-Check Register

The Pre-Check Register lists the details and totals of checks that the program will produce, using the 
criteria you specify in the Create Payment Batch screen. 

After reviewing the Pre-Check Register, you may decide not to pay certain transactions, or you may want 
to force payment on certain transactions, or pay only a portion of a transaction.

If you use the Control Payments screen to add payment restrictions, reprint the Pre-Check Register to 
check their effects.

Payment Criteria and Payment Selection Codes

The Create Payment Batch screen selects vendors for payment according to criteria you specify, and 
creates a payment batch that you can later edit with the Payment Entry screen.

You define the criteria for selecting payments by first defining at least one payment selection code with 
the Payment Selection Codes screen. You then select the code you want to use when you create a 
payment batch, and modify the criteria, if necessary. More...
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When you specify a payment selection code on the Create Payment Batch screen, the criteria defined for 
the code appears, as follows:

 l The bank for the payment batch and the vendor. In multicurrency ledgers, you also specify the 
bank currency for the payment batch and the currency for the vendor.

 l The type of document date you want to use for selecting documents for payment. You must choose one 
of the following:

Due Date. Select this option if you want the program to select transactions only on the basis of due 
dates and not consider discount dates. (The program ignores discount dates when selecting 
transactions, but still takes the discounts that are available when paying the transactions.)

You must also enter the date on or before which the invoice must be due in order to be paid.

Discount Date. Select this option if you want the program to select transactions only on the basis of 
discount dates and not consider due dates. (The program ignores due dates when selecting 
transactions.)

You must also enter a range of dates during which the discount must be paid in order for the invoice to 
qualify.

Due Date and Discount Date. Select this option when you want to pay all transactions that are due on 
or before a certain date, or that may not be due, but which have a discount available on or before the 
same date. (The program looks at both due dates and discount dates when selecting transactions.)

You must enter an “on or before” due date and a range of discount dates.

 l Whether to pay all selected documents or forced documents only.

 l All Selected. Includes all selected transactions.

 l Only Forced. Includes only the selected transactions that have a Forced status.

 l Vendor ranges. You can select vendors by choosing ranges for each of the following:

 l Vendor groups.

 l Vendor numbers.

 l Account sets.

 l Check amounts (lets you place a ceiling on check amounts)

 l Vendors you want to exclude from the check run.

On Hold Transactions

Some transactions do not appear on the Pre-Check Register unless you assign them a Forced status on 
the Control Payments screen. These transactions include:
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 l Transactions that are being withheld, either because the associated vendors are on hold or 
because the transactions have been placed on hold in the Control Payments screen.

 l Prepayments with activation dates later than the check date.

Note: The Pre-Check Register lists transactions that have a Forced status only if the amounts of the 
checks that would include the forced payments are within the minimum and maximum check amounts 
specified for the check run.

The Pre-Check Register can also include all payables that were bypassed in the check run. Bypassed 
transactions include transactions placed on hold in the Control Payments screen, transactions being 
withheld from payment because the vendors have been placed on hold in the Vendors screen, and 
Forced transactions for amounts outside the specified range of check amounts.

Check Language

The language for printing the check amount in text is taken from the vendor record or primary remit-to 
record for each vendor. If you need to specify a different language for individual checks, you will have to 
edit the payment entries after you create the batch.

Note: The check language applies only to the textual amount printed on each check. All other text on 
the check or advice comes from the check report screen

Unposted Payment Batches

Create Payment Batch scans the payment entries in all unposted batches to make sure that outstanding 
invoices are not paid twice.

Payment Controls

Create Payment Batch also checks to see whether any payment controls have been placed on vendors 
or invoices using the Control Payments screen.

Multicurrency Ledgers

All payment entries in a batch are in the same currency and are drawn from the same bank.

All vendors being paid must have the same source currency; however, payments do not have to match 
the vendor's currency. For example, you can create a batch of checks in US dollars to pay vendors whose 
source currency is the drachma.

Discounts

If you take discounts, you must specify a range of discount dates on the Vendor and Date Selection 
Criteria tab of the Create Payment Batch screen. Accounts Payable will review all documents with a 
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discount date within the range you specify (that meet other criteria), and take discounts if they are 
available as of the batch date you specify on the Bank and Currency Selection Criteria tab of the screen.

Optional Fields

If you use optional fields, an Optional Fields tab is available. Initially, the tab displays any payment 
optional fields that you set up for automatic insertion, along with their default entries. You can accept or 
change the inserted optional field entries, or you can delete the optional fields. You can also assign 
different payment optional fields to the batch.

When you generate payment entries, Accounts Payable assigns optional fields to the payment entries, as 
follows, using the values specified on the Optional Fields tab:

 l All payment optional fields that are set up for automatic insertion. More...

If you removed any automatically inserted optional fields from the Optional Fields tab, Accounts 
Payable inserts them in the generated payment entries, reassigning values as follows:

 l If the optional fields specified for the vendor match the optional fields defined for payments, 
the program uses the values specified in the vendor record.

 l If the optional fields specified for the remit-to location match the optional fields defined for 
payments, the program uses the values for the remit-to location. (If the vendor and the 
remit-to location use the same optional field, the value from the remit-to location is used.)

 l If an automatically inserted payment optional field does not match any optional fields in the 
vendor record, the default value specified in the payment optional field record is used.

 l Any additional optional fields you specified for the payment batch on the Optional Fields tab.

Printing Checks for a Generated Batch

After creating a payment batch, you should:

 l Print the batch listing before you print checks. You can edit payments and delete transactions 
before you print checks. Once you print checks, you cannot edit the transactions, but you can 
delete them.

 l Print the checks and payment advices together or separately using the Print/Post button in the Payment 
Batch List screen. Once you indicate that the printed checks are acceptable, the checks are posted to 
the vendor accounts.

If the checks are not acceptable, you can reprint them as often as necessary. They will not be posted 
until you indicate that they are acceptable.

For information about printing checks for a batch, see "Printing Checks for a Batch of Payments" (page 

255).
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 l Print the Check Register. The Check Register provides a list of all valid checks issued by the check 
printing program.

Note: Normally, you print the Check Register immediately after you have printed and posted checks 
and advices.

You will likely do check runs on a regular basis—semi-monthly, for example, or as often as necessary to 
maintain a consistent cash flow.

Adding a Payment Batch

You add payments in batches.

Before You Start

 l You must assign a default bank code on the Transactions tab of the A/P Options screen before 
you can create payment batches.

To create a new payment batch:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Click the New  button beside the Batch Number field.

 3. Enter a description for the batch.

 4. In the Batch Date field, enter a date for the new batch.

Note: By default, the session date appears in this field.

 5. In the Bank field, enter or select a bank code.

Note: Each batch can use only one bank code because the batch is for a single check stock. If you 
have a multicurrency ledger, you must also select a bank code that accepts the currency you want to 
use in the batch.

 6. If you have a multicurrency ledger, select the currency for the batch.

Note: You can pay vendors in any currency, but all the payments in a batch are in the same currency. 
You must use a separate batch for each currency.

Tip: To check the currency information for the batch, click the Zoom  button beside the Batch 
Number field to display the Batch Information screen. On this screen, you can view and edit the default 
rate type, rate date, and exchange rate that will be used for the individual entries in the batch.
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Deleting a Payment Batch

On the Payment Batch List screen, you can delete batches.

To delete a batch:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. In the Batch Number field, enter the number of the batch to be deleted.

 3. Click Delete.

All transactions in the batch will be deleted and the batch will be listed as deleted on the Batch Status 
report. You cannot reuse the batch number.

Note: To clear the data for the deleted batch from Accounts Payable, select the Clear Deleted And 
Posted Batches option when you print the Batch Status report to a printer or file.

About Printing Payment Batch Listings

You print batch listings from the A/P Batch Listing Report. To print payment batch listings, you can open 
this report in the following ways:

 l Open Accounts Payable > A/P Transaction Reports >        Batch Listing.

 l From the Payment Batch List screen:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. In the Batch Number field, enter a batch number.

 3. Click Print.

 l From the Payment Entry screen:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. In the Batch Number field, enter a batch number.

 3. On the File menu, click Print Batch Listing Report.

Listing Payment Batches

You use the A/P Payment Batch List screen to work with payment batch listings.
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To list batches:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List.

 2. In the Batch Number field, enter the number of a payment batch.

Note: You cannot view a batch if you have cleared it using the Clear Deleted And Posted Batches 
option (on the A/P Clear History  screen).

Tip: To limit the display to batches that are open or ready to post, clear the Show Posted And 
Deleted Batches option.

Note: 
You can also print the following reports from the A/P Payment Batch List screen:

 l Batch Status. To print this report, click Print Batch Status on the File menu.

 l Posting Errors. To print this report, double-click in the Number Of Errors column for the error 
batch.

 l Posting Journal. To print this report, click in the Posting Sequence Number column.

Creating a Payment Batch Automatically

You use the A/P Create Payment Batch screen to create batches of payments to pay vendor invoices that 
are due or have a discount available for early payment.

Before You Start

 l Define the bank codes you want to use in payment batches using the Bank Services screens.

 l Define a payment selection code to set the criteria for batch creation.

 l Post all invoice, payment, and adjustment batches so your vendor records are up to date.

Create Payment Batch evaluates payments in unposted batches (to prevent double-paying an invoice), 
but your records will be clearer if you process your checks systematically.

 l Use the Control Payments screen to force or hold payments for vendors. 

 l Update currency information and exchange rates in Common Services.
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To create a payment batch:

 1. Open Accounts Payable > A/P Transactions > Create Payment Batch.

 2. In the Selection Code field, enter a payment selection code.

Tip: After you specify a selection code, the Selection Code field is no longer editable. To make the 
field editable again so you can change the selection code, click Clear. Alternatively, if the Selection 
Code field does not appear, you can edit all the fields in the Create Payment Batch screen to select 
the records you want.

 3. Fill in the fields on the Select tab.

For help on the fields on this and other tabs on the Create Payment Batch screen, see "A/P Create 

Payment Batch Screen" (page 388).

 4. Fill in the fields on the Criteria tab. 

Note: Transactions must meet all selection criteria on this tab and on the Select tab to be considered 
for payment.

 5. If you want to exclude specific vendors who match all other selection criteria from this payment 
run, add them to the list on the Exclusion tab.

 6. In multicurrency ledgers, if the bank or vendor currency is not the functional currency and you need 
to change the exchange rate information for the checks, use the Rates tab to adjust them. More...

For each type of rate (bank and vendor):

 l Type the rate type code or select it using the Finder.

 l Type the exchange rate or select it using the Finder.

You enter the rates for converting the bank currency or the vendor currency to your functional currency. 
If either of these currencies matches the functional currency, the rate for that currency is 1.0000000.

 7. Check all your criteria to make sure these are the vendors for which you want to generate checks.

 8. If you use optional fields, check the Optional Field tab to ensure that any payment optional fields 
assigned to the batch are correct. Edit the optional fields or add different ones, as necessary.

 9. Make sure your printer is turned on and ready, and then click Register to print the payment 
register.

 10. Review the register and make whatever changes are necessary for your check run.

Note: You can leave the Create Payment Batch screen at any time. The program retains all the 
criteria you specified to ensure that the generated checks match the Pre-Check Register.

 11. When you are ready to create the payment batch, click Generate.
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After creating a payment batch

 1. Print the batch listing. For more information, see "Printing Batch Listings" (page 245).

Note: If the Force Listing Of Batches option is selected on the A/P Options screen, you must print 
batch listings before posting.

 2. Correct payment entries using the Payment Entry screen, if necessary, then reprint the listing.

Note: The Allow Edit Of System Generated Batches option must be selected on the A/P Options 
screen before you can edit these batches.

 3. You can print a single check before processing all other checks, using the Print Check button in 
the Payment Entry screen.

 4. Select the Ready To Post option for each batch, or select each batch individually from the 
Payment Batch List screen, then click Yes when asked whether to choose the Ready To Post 
option.

 5. Print and post the payment batches. For more information, see "Printing Checks for a Batch of 
Payments" (page 255).

Excluding Vendors from Payment Selection

When creating a payment batch, you might need to exclude from the selection process certain vendors 
that otherwise meet the payment selection criteria. (For example, if you want to withhold payment from a 
vendor until you settle a dispute over the quality of goods you received.)

You can use the Exclusion tab on the Create Payment Batch screen to exclude a vendor from a single 
payment run, or you can exclude the vendor indefinitely using the Exclusion tab on the Payment 
Selection Codes screen. More...

These instructions are for excluding a vendor from one payment run. However, you can exclude a vendor 
indefinitely by modifying the payment selection code. The steps are similar, except that you do not 
generate payments when editing payment selection codes.

Note: You can also exclude vendors permanently by putting vendor records on hold, and you can 
place holds on specific transactions using the Control Payments screen

Before You Start

 l Define the bank codes you want to use in payment batches using the Bank Services screens.

 l Define a payment selection code to set the criteria for batch creation.
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 l Post all invoice, payment, and adjustment batches so your vendor records are up to date.

Create Payment Batch evaluates payments in unposted batches (to prevent double-paying an invoice), 
but your records will be clearer if you process your checks systematically.

 l Use the Control Payments screen to force or hold payments for vendors. 

 l Update currency information and exchange rates in Common Services.

To exclude a vendor from a payment run:

 1. Open Accounts Payable > A/P Transactions > Create Payment Batch.

 2. In the Selection Code field, enter a payment selection code.

Tip: After you specify a selection code, the Selection Code field is no longer editable. To make the 
field editable again so you can change the selection code, click Clear. Alternatively, if the Selection 
Code field does not appear, you can edit all the fields in the Create Payment Batch screen to select 
the records you want.

 3. Fill in the fields on the Select tab, as usual.

For help on the fields on this and other tabs on the Create Payment Batch screen, see "A/P Create 

Payment Batch Screen" (page 388).

 4. Fill in the fields on the Criteria tab, as usual.

 5. To exclude specific vendors who match all other selection criteria from this payment run, add them on 
the Exclusion tab:

 a. In the Vendor Exclusion List table, press Insert to add a new line.

 b. Enter the vendor number or select it using the Finder .

Note: You must add a separate line for each vendor you want to exclude.

 6. To remove a vendor from the exclusion list, select a line on the Vendor Exclusion List table, and 
then press Delete.

 7. If you use optional fields, check the Optional Field tab to ensure that any payment optional fields 
assigned to the batch are correct.

 8. Make sure your printer is turned on and ready, and then click Register to print the payment 
register.

 9. Review the register and make whatever changes are necessary for your check run.

Note: You can leave the Create Payment Batch screen at any time. Accounts Payable retains all the 
criteria you specified to ensure that the generated checks match the payment register.

 10. When you are ready to create the payment batch, click Generate.
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After creating a payment batch

 1. Print the batch listing. For more information, see "Printing Batch Listings" (page 245).

Note: If the Force Listing Of Batches option is selected on the A/P Options screen, you must print 
batch listings before posting.

 2. Correct payment entries using the Payment Entry screen, if necessary, then reprint the listing.

Note: The Allow Edit Of System Generated Batches option must be selected on the A/P Options 
screen before you can edit these batches.

 3. You can print a single check before processing all other checks, using the Print Check button on 
the Payment Entry screen.

 4. Select the Ready To Post option for each batch, or select each batch individually from the 
Payment Batch List screen, then click Yes when asked whether to choose the Ready To Post 
option.

 5. Print and post the payment batches. For more information, see "Printing Checks for a Batch of 
Payments" (page 255).

About Controlling Payments

When you use A/P Create Payment Batch to create a batch of checks, you can control which checks are 
generated in three ways:

 l By using payment selection codes to apply predefined criteria to select documents for payment.

Payment selection codes provide default settings for the Create Payment Batch screen. These settings 
cover such things as the payment bank and bank currency, the range of vendors, and a vendor 
exclusion list.

 l By imposing payment controls, either holding or forcing payment, for individual vendors and 
invoices.

 l By placing a vendor on hold. You cannot enter any payments for a vendor who is on hold.

Using Payment Selection Criteria

Payment selection codes specify how Accounts Payable should select vendor invoices for payment. You 
can create as many payment selection codes as you want using the A/P Payment Selection Codes 
screen. For example, you might have separate selection codes for processing US, Canadian, and 
Mexican payments.

When you create a payment batch, you specify a payment selection code that provides default criteria for 
creating the batch. You can override these criteria when you create the batch.
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Placing Invoices On Hold Using the Control Payments Screen

You use the A/P Control Payments screen to control payments for a specific vendor, document, and 
payment (for multiple payment schedules).

You can also change the status or clear any invoice payment limits of groups of transactions for a vendor 
or for a range of vendors.

Normally, you use the Control Payments screen after printing the Pre-Check Register and reviewing the 
current payables to select the transactions you want to pay.

Documents On Hold

Putting a transaction on hold means it will not be paid until you remove the hold.

Important! Placing invoices on hold using the Control Payments screen prevent you from generating 
payments using the Create Payment Batch screen. It does not prevent you from entering checks using 
the Payment Entry screen.

Forcing Payments

Forcing payment of a document means that a payment will definitely be generated the next time you 
create a payment batch, provided the vendor and the check amount are within the ranges of vendors and 
check amounts specified for the batch.

Note: We recommend that you set holds and force payments to control non-payment and payment of 
individual transactions, rather than trying to achieve the same effect by changing due dates or discount 
dates.

For information about applying payment controls to a single document, see "About Applying Payments 
Controls to a Single Document" (page 153).

For information about controlling payments for a range of documents, see "About Applying Payment 
Controls for a Range of Vendors" (page 154).

For instructions on using the Control Payments screen, see "Applying Payment Controls" (page 156).

Setting a Vendor On Hold

You can place an individual vendor on hold in the vendor record so that no transactions for that vendor 
are paid.

Important! This restriction applies only to the Create Payment Batch process. You cannot force a 
payment for an On Hold vendor using the Control Payments screen. However, you can make 
payments to an On Hold vendor manually, using the A/P Payment Entry screen.
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About Applying Payments Controls to a Single Document

You use the Single Document tab of the Control Payments screen to apply payment controls for a 
selected vendor and document. You can:

 l Set or change a payment limit for an invoice.

 l Change the due date, discount date, and discount percent or discount amount for a selected 
invoice.

 l Change the activation date for a selected prepayment.

 l Place a document on hold.

 l Force payment of the document.

 l Cancel a previous control status.

To control payments for a range of documents, see "About Applying Payment Controls for a Range of 
Vendors" (page 154).

For an overview of the Control Payments screen, see "A/P Control Payments Screen" (page 384).

For complete instructions on using the Control Payments screen, see "Applying Payment Controls" (page 
156).

Date and Discount Changes are Permanent

Changes to the due date, discount date, discount percent, and discount amount are permanent changes 
to the document. 

You would make these changes after renegotiating terms or if the original document was incorrect.

Normal Status

You use Normal status to clear documents of any Forced or On Hold status you applied previously.

Forced Documents

Invoices and debit notes that are assigned a Forced status are paid in the next check run, unless:

 l The payment amount of the check is outside the minimum and maximum amounts specified for the 
check run.

 l The vendor bank does not match the batch bank, and you selected the vendor record option to 
Select Vendors With This Bank Code Only.

 l The vendor currency does not match the vendor currency for the batch.

 l There is a pending payment in an open batch for the same document.
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Documents On Hold

Documents assigned an On Hold status are not paid in a system check run until the On Hold status is 
removed. 

On Hold documents are not applied during posting:

 l When you post invoice batches, Accounts Payable does not apply any matching prepayments if either 
the prepayment or the invoice has an On Hold status. 

In addition, it does not apply credit notes or debit notes if either the credit (or debit) note or the specified 
Apply-To document is on hold.

 l When you post payment batches, prepayments are not applied to matching invoices if the invoice 
has an On Hold status.

Note: You can also place the vendor on hold using the Vendors screen.

To apply a prepayment, debit note, or credit note to a document you have put on hold, you first remove 
the On Hold status using the Control Payments screen, and then use an Apply Document transaction in 
Payment Entry to apply the prepayment, debit note, or credit note.

Prepayment Activation

Bringing forward or delaying the activation date of a prepayment affects payments because the A/P 
Create Payment Batch screen does not take prepayments into account unless they are activated.

Payment Limit

You can use the Payment Limit field to set a maximum amount that can be paid for a selected document 
when you generate payments using the A/P Create Payment Batch screen.

You can enter a greater payment if you pay the document using the A/P Payment Entry screen.

About Applying Payment Controls for a Range of Vendors

You can use the Control Payments screen to change the status or to clear any invoice payment limits of 
groups of transactions for a vendor or for a range of vendors.

You use the Range Of Documents tab to change the status of a range of invoices, debit notes, credit 
notes, and prepayments for a range of vendors. For example, use Range Of Documents to hold all 
invoices for one vendor or for a vendor group. You can also clear all payment limits for invoices in a 
specified range.

For information about applying payment controls to a single document, see "About Applying Payments 
Controls to a Single Document" (page 153).

For an overview of the Control Payments screen, see "A/P Control Payments Screen" (page 384).
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For instructions on using the Control Payments screen, see "Applying Payment Controls" (page 156).

Date and Discount Changes are Permanent

Changes to the due date, discount date, discount percent, and discount amount are permanent changes 
to the document. 

You would make these changes after renegotiating terms or if the original document was incorrect.

Normal Status

You use Normal status to clear documents of any Forced or On Hold status you applied previously.

Forced Documents

Invoices and debit notes that are assigned a Forced status are paid in the next check run, unless:

 l The payment amount of the check is outside the minimum and maximum amounts specified for the 
check run.

 l The vendor bank does not match the batch bank, and you selected the vendor record option to 
Select Vendors With This Bank Code Only.

 l The vendor currency does not match the vendor currency for the batch.

 l There is a pending payment in an open batch for the same document.

Documents On Hold

Documents assigned an On Hold status are not paid in a system check run until the On Hold status is 
removed. 

On Hold documents are not applied during posting:

 l When you post invoice batches, Accounts Payable does not apply any matching prepayments if either 
the prepayment or the invoice has an On Hold status. 

In addition, it does not apply credit notes or debit notes if either the credit (or debit) note or the specified 
Apply-To document is on hold.

 l When you post payment batches, prepayments are not applied to matching invoices if the invoice 
has an On Hold status.

Note: You can also place the vendor on hold using the Vendors screen.

To apply a prepayment, debit note, or credit note to a document you have put on hold, you first remove 
the On Hold status using the Control Payments screen, and then use an Apply Document transaction in 
Payment Entry to apply the prepayment, debit note, or credit note.
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Payment Limits

You can use the Clear Payment Limit field to clear any payment limits set for documents in the range of 
documents you specified.

Applying Payment Controls

 You use the A/P Control Payments screen to specify payment controls for a single document or for 
ranges of transactions and vendors. More...

You use the tabs on the Control Payments screen as follows:

 l Single Document. Use this tab to select single documents for a specific vendor, and change 
the status of individual documents, as well as the due date, discount date, discount percent, 
and discount amount. You can also change the prepayment activation date for prepayments.

 l Range of Documents. Use this tab to select a range of invoices, debit notes, credit notes, 
and prepayments for a range of vendors. For example, you could use this tab to put all 
invoices on hold for a specific vendor or for a vendor group.

Important! Placing invoices on hold using the Control Payments screen prevents you from generating 
payments using the Create Payment Batch screen. It does not prevent you from entering checks using 
the Payment Entry screen.

Before You Start

 l Post all invoice, payment, and adjustment batches so your vendor records are up to date.

 l Print and review the Vendor Transactions report to see which payments you want to control.

Alternatively, you can open the Create Payment Batch screen, set your payment criteria, and then print 
a Pre-Check Register to review payments.

To control payments in system-generated batches:

 1. Open Accounts Payable > A/P Transactions > Control Payments.

 2. To apply controls to a single document:

 a. On the Single Document tab, fill in the following fields to select the document you want to 
change:

 l Vendor Number

 l Document Number (invoice, credit note, debit note, or prepayment)

 l Payment Number (will be "1" unless the document has a multiple payment schedule)
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 b. Click the Go  button or Press F7 to display information for the document so that you can 

change it. The fields you can change are:

 l Due Date

 l Discount Date

 l Discount Percent

 l Discount Amount

 l Document Status (Normal, Forced, or On Hold)

 l Activation Date for prepayments (the date after which the prepayment is considered 
when calculating the amount due for payment)

 3. To apply controls to a range of documents or a range of vendors:

 a. On the Range of Documents tab, fill in the following ranges:

 l Vendor Group

 l Vendor Number

 l Document Number (since different vendors use different numbering systems, this 
option may be useful only if you are selecting invoices from a single vendor)

 b. Select the document types for which you want to change the status.

 c. Select the Document Status that you want applied.

 4. Click Process.

After applying payment controls

Choose Create Payment Batch, set your payment criteria, and print a Pre-Check Register to review 
payments.

Entering and Applying a Payment

You use the A/P Payment Entry screen to enter and apply vendor payments.

You can also use the Payment Entry screen to print a single check for a vendors when you enter a 
payment, but if you want to enter and print checks for a large number of vendors, use the A/P Create 
Payment Batch screen.
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To add a vendor payment:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Select an existing payment batch using the Batch Number field, or create a new batch. More...

To create a new batch:

 a. Click the New  button beside the Batch Number field, and then type a description for the 
batch in the next field.

 b. In the Batch Date field, enter a date for the new batch, or accept the session date.

 c. Specify the bank and, for a multicurrency ledger, the default currency for the batch.

 3. Click the New  button beside the Entry Number field to start a new document, and then enter a 

description for the entry.     

If you are applying an existing payment, type the payment number in the field, or use the Finder or 
navigation buttons to select the payment.

 4. Enter a description for the payment, such as Payment of Inv 7764.

 5. if you are recording a check you issued to a vendor, or you are entering a vendor check you want 
to print, select Payment as the transaction type.

 6. In the Vendor Number field, type or select the code that identifies the vendor.

 7. Fill in general, or header, information for the payment. More...

Header information includes:

 l Remit-To

 l Account Set

 l Payment Date and Posting Date

 l Year and Period to which you want to post payment

 l Payment Code

 l Apply Method

 l Optional Fields (if you use them)

For more information, see "A/P Payment Entry Screen" (page 435).

 8. If you know the numbers of the documents to which you are applying the invoice, or there are a large 
number of documents for this vendor, clear the Select Mode option. Otherwise, select this option. Then:
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 l If you are using select mode:

 a. Select the type of documents you want to display (All, Invoice, or Debit Note).

 b. Select the order by which to list documents (Document Number, PO Number, Due 
Date, Order Number, Document Date, or Balance Due).

 c. Enter the starting number, date, or balance, depending on the choice you made for 
ordering documents.

Tip: Press F5 to use a Finder to select from available options.

 d. Click the Go  button, or press F7.

 e. For each document to which you want to apply the payment, select Yes in the Apply 
column.

 f. In the Applied Amount field, enter the amount to apply.

Notes: 
 l By default, the entire amount is applied, and the full discount is taken. 

However, you can post the transaction without fully applying the prepayment 
or credit note, leaving some to be applied at a later date.

 l You cannot apply more than the total amount of the payment.

 g. If an early-payment discount applies to the invoice, enter the amount in the Discount 
Taken column.

Note: You can enter a discount taken that exceeds the discount specified on the original 
invoice.

 l If you are not using select mode:

 a. In the Document Number field, enter the document number.

 b. In the Payment Number field, enter "1", or enter the number of the payment if the 
document has a multiple payment schedule.

 c. In the Applied Amount field, enter the amount to apply.

 d. If you are entering a partial payment for a job-related  document, choose an apply 
method for the payment, and edit the distribution for the payment, if necessary.

 e. If there is a discount amount, enter it in the Discount Amount field.

 9. If you need to adjust an invoice or other document, click the Adjust button to open the Miscellaneous 
Adjustment Entry screen, then:
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 a. Enter a reference and description for the adjustment.

 b. Select the line number you want to edit on the document you are adjusting. The program 
displays the distribution code and general ledger account used in the original transaction, 
but you can change them.

 c. Type the amount of each adjustment detail.

 d. Click Save, then click Close to return to the Payment Entry screen.

Note: The Adjust button is available only if the Allow Adjustments In Payment Batch option is 
selected on the A/P Options screen.

 10. If the document you are paying is job-related , and you are only paying part of the invoice, select 
an apply method, and apply the partial payment manually. More...

 a. Select an apply method to use as the default for the current payment entry. For more 
information, see "A/P Payment Entry Screen" (page 435).

 b. Select the job-related  invoice you want to pay in one of the following ways:

 l Select the Select Mode option, click the Go  button to display the unpaid invoices 
for the selected vendor, and then select Yes in the apply column for the invoice.

 l Clear the Select Mode option, and then enter the invoice number in the document 
field in the detail table.

 c. Enter the amount of your payment in the Applied Amount column for the selected invoice, 
then navigate out of the field.

 d. If the Applied Amount is less than the current balance and you want to select particular details to 
which to apply the partial payment or to use a different apply method for this invoice:

 i. Click Jobs to open the Project and Job Costing Apply Details screen.

 ii. Select the apply method to use to allocate the partial payment to invoice details.

 iii. Click the Go  button to display the invoice details.

 iv. Select any details that are not being paid at this time, then click Clear.

160Sage 300 2023 Accounts Payable User's Guide



 v. Make sure the amounts allocated to invoice details are correct.      

Notes: 
 l If you do not use an apply method to allocate amounts to the details, or you 

want to change the allocated amounts, you can manually enter or change the 
amounts that you are paying for invoice details.

 l To add or save the invoice, the Unapplied Amount must be zero, meaning 
that the sum of the amounts applied to the details is the same as the total 
applied to the invoice. For example, you might need to adjust the amounts for 
an invoice that uses a multiple payment schedule.

 vi. Click Close to return to the Payment Entry screen.

 vii. Click Save.

 11. In a multicurrency ledger, if the bank or vendor does not use the functional currency and you need to 
change the exchange rate information for the payment, click the Rates button, then for each type of rate 
(bank and vendor), enter:

 l The rate type code.

 l The exchange rate. If the bank currency or the vendor matches the functional currency, the 
rate for that currency is 1.0000000.

Note: The Rates button appears only if the vendor does not use your functional currency.

The check will be in the bank currency.

 12. When finished, click Add or Save.

After entering and applying payments

 l Print individual checks. For more information, see "Printing a Single Check When You Pay a Vendor" 
(page 252).

 l Print the batch listing, and then review the entries.

Correct entries, if necessary, and then reprint the listing for each corrected batch. When batches are 
correct, file the reports.

Note: You must print batch listings before posting if the Force Listing Of All Batches option is 
selected on the A/P Options screen.

 l Select the Ready To Post option for each batch.

 l Print and post payment batches. For more information, see "Printing Checks for a Batch of 
Payments" (page 255).
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Applying a Payment

You use the Payment Entry detail table to apply payments to specific outstanding documents. You can 
apply a payment at the same time that you enter it, or at a later time.

Once you have applied the payment, you can save the transactions and print the check, if you want.

Before You Start

 l Enter a payment. For more information, see "Entering and Applying a Payment" (page 157).

 l If you use multicurrency accounting, update currency information and exchange rates in Common 
Services.

 l Select a print destination.

 l If you use optional fields, define the optional fields you want to use in Payment Entry. For more 
information, see "A/P Optional Fields Screen" (page 341).

To apply a payment to an invoice:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. In the Batch Number field, enter a batch number.

 3. In the Entry Number field, enter the number of the payment you want to apply.

 4. If you know the numbers of the documents to which you are applying the invoice, or there are a large 
number of documents for this vendor, clear the Select Mode option. Otherwise, select this option. Then:

 l If you are using select mode:

 a. Select the type of documents you want to display (All, Invoice, or Debit Note).

 b. Select the order by which to list documents (Document Number, PO Number, Due 
Date, Order Number, Document Date, or Balance Due).

 c. Enter the starting number, date, or balance, depending on the choice you made for 
ordering documents.

Tip: Press F5 to use a Finder to select from available options.

 d. Click the Go  button, or press F7.

 e. For each document to which you want to apply the payment, select Yes in the Apply 
column.
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 f. In the Applied Amount field, enter the amount to apply.

Notes: 
 l By default, the entire amount is applied, and the full discount is taken. 

However, you can post the transaction without fully applying the prepayment 
or credit note, leaving some to be applied at a later date.

 l You cannot apply more than the total amount of the payment.

 g. If an early-payment discount applies to the invoice, enter the amount in the Discount 
Taken column.

Note: You can enter a discount taken that exceeds the discount specified on the original 
invoice.

 l If you are not using select mode:

 a. In the Document Number field, enter the document number.

 b. In the Payment Number field, enter "1", or enter the number of the payment if the 
document has a multiple payment schedule.

 c. In the Applied Amount field, enter the amount to apply.

 d. If you are entering a partial payment for a job-related  document, choose an apply 
method for the payment, and edit the distribution for the payment, if necessary.

 e. If there is a discount amount, enter it in the Discount Amount field.

 5. Click Add or Save to add and apply the payment.

After applying a vendor payment to an invoice

When you have finished adding payments to a batch, print the checks and post the payment batch.

Displaying an Existing Payment to Apply or Edit

You can display an existing payment to:

 l Apply the payment to the vendor account.

 l Edit amounts you previously applied for this payment.

 l Enter the distribution details for a miscellaneous payment.
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To display a payment:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. In the Batch Number field, enter the batch that contains the payment you want to apply or edit.

Note: To view header information for a payment batch, click the Zoom  button beside the Batch 

Number field. For more information, A/P Batch Information Screen (Payment Entry).

 3. In the Entry field, enter the payment entry number.

Applying Prepayments and Credit Notes Using the Payment Entry Screen

Use the Payment Entry detail table to:

 l Apply new payments to outstanding transactions.

 l Apply previously posted prepayments and credit notes.

 l Change unposted payment applications.

 l Enter adjustments to invoices, credit notes, or debit notes (if you use the Allow Adjustments In 
Payment Batch option).

 l View the history of applications to a document.

To apply a prepayment or credit note:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Enter the Document number of the prepayment or credit note you want to apply.

Accounts Payable will display the amount that you can apply in the Unapplied Amount field.

 3. If you use optional fields and you want to view or edit any payment optional fields automatically 

assigned to this transaction, click the Zoom  button beside the Optional Fields option.

The Optional Fields screen appears, letting you edit or delete the optional fields assigned to this 
transaction. You an also assign different payment optional fields.

 4. If you know the numbers of the documents to which you are applying the invoice, or there are a large 
number of documents for this vendor, clear the Select Mode option. Otherwise, select this option. Then:

 l If you are using select mode:

 a. Select the type of documents you want to display (All, Invoice, or Debit Note).

 b. Select the order by which to list documents (Document Number, PO Number, Due 
Date, Order Number, Document Date, or Balance Due).
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 c. Enter the starting number, date, or balance, depending on the choice you made for 
ordering documents.

Tip: Press F5 to use a Finder to select from available options.

 d. Click the Go  button, or press F7.

 e. For each document to which you want to apply the payment, select Yes in the Apply 
column.

 f. In the Applied Amount field, enter the amount to apply.

Notes: 
 l By default, the entire amount is applied, and the full discount is taken. 

However, you can post the transaction without fully applying the prepayment 
or credit note, leaving some to be applied at a later date.

 l You cannot apply more than the total amount of the payment.

 g. If an early-payment discount applies to the invoice, enter the amount in the Discount 
Taken column.

Note: You can enter a discount taken that exceeds the discount specified on the original 
invoice.

 l If you are not using select mode:

 a. In the Document Number field, enter the document number.

 b. In the Payment Number field, enter "1", or enter the number of the payment if the 
document has a multiple payment schedule.

 c. In the Applied Amount field, enter the amount to apply.

 d. If you are entering a partial payment for a job-related  document, choose an apply 
method for the payment, and edit the distribution for the payment, if necessary.

 e. If there is a discount amount, enter it in the Discount Amount field.

Applying a Posted Prepayment or a Credit Note

You can apply a poster prepayment.

Before You Start

You must select the Allow Adjustments In Payment Batch option on the A/P Options screen if you plan 
to adjust the invoice or debit note you are paying.
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To apply a prepayment or credit note to an invoice or a debit note:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. In the Batch Number field, enter the batch number for an existing batch, or click the New  
button to create a new batch.

 3. Click the New  button to the right of the Entry Number field, and then enter a description for the 
transaction, such as "Apply Prepayment to Inv 7764."

 4. In the Transaction Type field, select Apply Document.

 5. Fill in the remaining fields on the Payment Entry screen. For more information, see "A/P Payment 
Entry Screen" (page 435).

 6. If you know the numbers of the documents to which you are applying the invoice, or there are a large 
number of documents for this vendor, clear the Select Mode option. Otherwise, select this option. Then:

 l If you are using select mode:

 a. Select the type of documents you want to display (All, Invoice, or Debit Note).

 b. Select the order by which to list documents (Document Number, PO Number, Due 
Date, Order Number, Document Date, or Balance Due).

 c. Enter the starting number, date, or balance, depending on the choice you made for 
ordering documents.

Tip: Press F5 to use a Finder to select from available options.

 d. Click the Go  button, or press F7.

 e. For each document to which you want to apply the payment, select Yes in the Apply 
column.

 f. In the Applied Amount field, enter the amount to apply.

Notes: 
 l By default, the entire amount is applied, and the full discount is taken. 

However, you can post the transaction without fully applying the prepayment 
or credit note, leaving some to be applied at a later date.

 l You cannot apply more than the total amount of the payment.

 g. If an early-payment discount applies to the invoice, enter the amount in the Discount 
Taken column.

Note: You can enter a discount taken that exceeds the discount specified on the original 
invoice.
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 l If you are not using select mode:

 a. In the Document Number field, enter the document number.

 b. In the Payment Number field, enter "1", or enter the number of the payment if the 
document has a multiple payment schedule.

 c. In the Applied Amount field, enter the amount to apply.

 d. If you are entering a partial payment for a job-related  document, choose an apply 
method for the payment, and edit the distribution for the payment, if necessary.

 e. If there is a discount amount, enter it in the Discount Amount field.

 7. If you are issuing a payment that is not in your functional currency, click Rates to check or edit the 
exchange rate used for this payment.

 8. If you need to adjust a document you are paying:

 a. Click Adjust.

The Miscellaneous Adjustment Entry screen appears.

Note: This button is available only if the Allow Adjustments In Payment Batch option is 
selected on the A/P Options screen.

 b. Enter a reference and description for the adjustment.

 c. Enter the distribution code or general ledger account number for each adjustment detail.

 d. Enter the amount of each adjustment detail.

 e. Click Save.

 f. Click Close to return to the Payment Entry screen.

 9. Click Add or Save to apply the prepayment or credit note.

After applying a prepayment or credit note to an invoice or a debit note               

 l Print the Batch Listing. Correct entries, if necessary, then reprint the listing for each corrected 
batch. Once batches are correct, file the reports.

Note: You must print batch listings before posting if you select the Force Listing Of All Batches option 
on the Processing tab of the A/P Options screen.

 l On the Payment Batch List screen, select the Ready To Post option for each batch. Alternatively, 
select a batch, click the Post button, and then click Yes when asked whether to set the batch 
Ready To Post.
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 l Post the payment batch.

Note: If any transactions cannot be posted, Accounts Payable will create a new batch containing the 
transactions with errors.

Applying a Payment or Credit Note to a job-related  Invoice

You can distribute payment amounts to invoices.

Before You Start

 l Add the payment. For more information, see "Applying a Payment" (page 162).

To apply amounts to details for different contracts, projects, categories, and resources:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Display the payment, prepayment, or credit note.

 3. On the detail table, for the job-related  invoice you are paying, select Yes in the Apply column.

 4. Click Jobs.

The Project and Job Costing Apply Details screen appears.

 5. Enter the amount to apply to the selected invoice.

 6. In the Apply Method field, specify one of the following methods to apply the amount to contracts, 
projects, categories, and projects that appear on the invoice:

 l Top Down. Select this method to apply an amount automatically to invoice details beginning 
with the first detail (contract-project-category-resource) on an invoice until the amount is fully 
applied.       

If you are using this method to allocate a payment to an invoice that uses a multiple payment 
schedule, you may have to adjust the allocations manually.

Note that discounts, if any, are applied to the last line only. If you wish to allocate discounts 
proportionately, you should select the Prorate By Amount option.

 l Prorate By Amount. Select this method to apply a payment amount proportionately to all 
invoice details, depending on the relative amounts of the details.

 7. Select any details that are not being paid at this time, and then click Clear to remove the details 
from the distribution.

 8. Click Close to return to the Payment Entry screen.

 9. Click Add or Save.
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Tip: 
If you accidentally delete a line, or if you use the Clear button to remove all the lines, you can use the 
Apply Line Number Finder to select a particular detail for payment. More...

Select a detail for payment by doing the following:

 1. Select the first blank line on the table, or press Insert to create one.

 2. Click the heading for the Apply Line Number column, or double-click the Apply Line Number 

field, and then click the Finder  that appears.

 3. Highlight the detail you want to pay from the displayed list of details, and then click Select, or 
double-click the detail.

Partially Paying a job-related  Document

You use the A/P Payment Entry screen to apply partial payments to invoices.

To apply partial payments to job-related  invoices:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Enter payment header details as usual, including the vendor number, transaction date, year, and 
period.

 3. Select an apply method to use as the default for the current payment entry. For more information, 
see "A/P Payment Entry Screen" (page 435).

 4. Select the job-related  invoice you want to pay in one of the following ways:

 l Select the Select Mode option, click the Go  button to display the unpaid invoices for the 
selected vendor, and then select Yes in the apply column for the invoice.

 l Clear the Select Mode option, and then enter the invoice number in the document field in the 
detail table.

 5. Enter the amount of your payment in the Applied Amount column for the selected invoice, then 
navigate out of the field.

 6. If the Applied Amount is less than the current balance and you want to select particular details to which 
to apply the partial payment or to use a different apply method for this invoice:

 a. Click Jobs to open the Project and Job Costing Apply Details screen.

 b. Select the apply method to use to allocate the partial payment to invoice details.

 c. Click the Go  button to display the invoice details.

 d. Select any details that are not being paid at this time, then click Clear.
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 e. Make sure the amounts allocated to invoice details are correct.      

Notes: 
 l If you do not use an apply method to allocate amounts to the details, or you want to 

change the allocated amounts, you can manually enter or change the amounts that 
you are paying for invoice details.

 l To add or save the invoice, the Unapplied Amount must be zero, meaning that the 
sum of the amounts applied to the details is the same as the total applied to the 
invoice. For example, you might need to adjust the amounts for an invoice that uses 
a multiple payment schedule.

 f. Click Close to return to the Payment Entry screen.

 g. Click Save.

 7. Click Add.

Writing Off Small Differences During Payment Entry

You can adjust a document only if you have applied a payment to it by entering a Payment transaction.

Before You Start

Select the Allow Adjustments In Payment Batches option on the A/P Options screen.

To adjust a document during payment entry:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Create a new Payment or Apply Document transaction, or select one for editing.

 3. On the detail table, select Yes in the Apply column for the document you want to adjus, and then, 
in the Applied Amount column, enter the amount you are paying or applying to the document.

 4. With the apply-to document selected, click Adjust.

The Miscellaneous Adjustment Entry screen appears.

 5. Enter a reference and description for the adjustment, and then, for each adjustment detail:

 a. In the Adjust Line Number field, use the Finder  to select the document detail you want 
to adjust.

 b. Enter a distribution code or general ledger account number for the adjustment detail.

 c. Enter the adjustment amount for the detail.

 6. When finished, click Close to return to the Payment Entry screen.

 7. Click Add or Save.
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 8. Do one of the following:

 l If you have issued a manual check:

 a. Zero the check number, and then select the Print Check option.

 b. Adjust the invoice to which the payment is applied, and then save the payment.

 c. Edit the payment again after saving the changes, this time clearing the Print Check 
option and entering the check number.

 l If you have not issued a manual check:

 a. Select the Print Check option.

 b. Apply the transaction.

 c. Save the transaction.

 d. Highlight the invoice you want to adjust, click Adjust, enter the adjustment details, and 
save the adjustment.

 e. Edit the payment once again to clear the Print Check option and enter the number of 
the check you issued.

Viewing Document History when Applying a Payment or a Credit Note

You can view information about what has previously been applied to a document, including:

 l Transaction type

 l Check/document number

 l Transaction date

 l Applied amount

 l Transaction description

 l Vendor number and name

Note: These instructions assume you are working with the payment or credit note in the Payment Entry 
screen.

Before You Start

If you have not already done so:

 l Open Accounts Payable > A/P Transactions > Payment Entry.

 l Select or create the payment batch and the payment entry.
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To view the history of an invoice, credit note, or debit note while applying a payment or 
credit note:

 1. On the Payment Entry screen, select a document in the detail table.

 2. In the Apply field, select Yes (double-click in the Apply field to change the selection from No to 
Yes, or from Yes to No).

 3. Click History.

The Document History screen appears, providing information about each document that was previously 
applied to the selected invoice, credit note, or debit note.

Note: You cannot change any of the information on this screen.

 4. Click Close to return to the Payment Entry screen.

Changing Optional Fields

If you use exactly the same optional fields in vendor records and on payments, the program assigns the 
optional field values used in the vendor record to the payment.

You can accept or delete the optional fields that appear as defaults, and you can add other optional fields 
that you have set up for payment documents. You can also change the optional field values used in the 
entry.

To check or to change the optional fields and values for a payment:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Click the Zoom  button beside the Optional Fields option.

The Optional Fields screen appears, displaying any optional fields that are marked for automatic 
insertion on new payments.

 3. On the Optional Fields screen, add or delete optional fields for the payment document.

You can add any optional fields that are defined for invoice details. You can also change the default 
values that appear, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field 
in Common Services. If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can select a predefined value, or you can enter any 
value that is consistent with the type of field (for example, amount, text, yes or no), providing 
your entry does not exceed the length permitted for the field.
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Voiding a Printed Check

If you made a mistake when writing a check, then printed the check before realizing the error, you can 
void the check through Bank Services or from the A/P Payment Entry screen.

To void a printed check from the Payment Entry screen:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Display the batch and the entry.

 3. On the detail table, select a check to void.

 4. Click Void Check.

 5. When prompted, click Yes.

About Entering Prepayments Using the Payment Entry Screen

Use the Payment Entry screen to:

 l Specify the amount of the prepayment.

 l Specify the number of the document to which you want the prepayment applied. You can identify 
the unposted document by its invoice number, PO number, or sales order number.

You can post the invoice or the prepayment first. Accounts Payable matches up prepayments when you 
post payment batches and when you post invoice batches. If the prepayment correctly references the 
invoice number, PO number, or sales order number of an invoice, it is applied to the invoice no matter 
which document is posted first.

Prepaying a Vendor

When you enter a prepayment, you can specify the document number, purchase order number, or sales 
order number to which the prepayment applies. Accounts Payable will use this number to match the 
posted prepayment to the invoice when it is posted.

Note: It is not necessary to supply a matching document number when you enter a prepayment.

You can also add a prepayment at the same time as you enter an invoice. For more information, see "A/P 
Invoice Entry Screen" (page 401).

If Accounts Payable cannot match the invoice to the prepayment when the invoice is posted, you use an 
Apply Document transaction type to match them.

Prepayments have a payment activation date—which is the date on which Accounts Payable considers 
the payment to be credited to the vendor account. Prepayments are not used to calculate amounts due to 
vendors when you use the Create Payment Batch screen until their activation dates.
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For multicurrency prepayments:

 l All checks in a batch are issued in the bank currency.

 l You enter the amount of a prepayment in the vendor's currency—even if the vendor's currency is 
different from the bank currency.

 l If the bank or vendor does not use the functional currency, you can use the Rate Override screen 
to change the exchange rate information for the prepayment, and to see the conversion from the 
vendor currency to the bank currency. For more information, see A/P Rate Override Screen.

To add a prepayment that you will apply later:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. In the Batch Number field, enter the batch number for an existing batch, or click the New  
button to create a new batch.

 3. Click the New  button beside the Entry Number field, and in the field to the right, enter a 
description for the payment, such as "Prepayment of PO 5664."

 4. In the Transaction Type field, select Prepayment to record an advance to a vendor account.

 5. Fill in the remaining fields on the Payment Entry screen. For more information, see "A/P Payment 
Entry Screen" (page 435).

 6. If the prepayment is job-related :

 a. Select the Job Related option.

 b. Click Jobs.

The Project and Job Costing Apply Details screen appears.

 c. Distribute amounts to the contracts, projects, categories, and resources for which you are 
making payment. For more information, see A/P Project and Job Costing Apply Details 
Screen.

 7. Click Add or Save.

Note: When you click Add, Accounts Payable assigns a prepayment number to the prepayment. The 
number uses the prefix and next sequence number specified on the Numbering tab of the 
A/P Options screen.

After adding a prepayment

 l Print the Batch Listing. Correct entries, if necessary, then reprint the listing for each corrected 
batch. Once batches are correct, file the reports.
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Note: You must print batch listings before posting if you select the Force Listing Of All Batches option 
on the Processing tab of the A/P Options screen.

 l Print individual checks. For more information, see "Printing a Single Check When You Pay a Vendor" 
(page 252).

 l Select the Ready To Post option for each batch, or select each batch individually from the 
Payment Batch List screen, then choose Yes when asked whether to choose the Ready To Post 
option.

 l Post the batch. You must also post the prepayment before you can apply it to the vendor's 
account.

Note: If any payment transactions cannot be posted, Accounts Payable will create a new batch 
containing the transactions with errors. For more information, see "Printing Checks for a Batch of 
Payments" (page 255).

 l Apply the prepayment to the vendor's account.

About Entering Cash Invoices

The Payment Entry screen lets you enter invoices at the same time as you enter payments for existing 
vendors as well as for one-time vendors. In some programs, this is called a "cash invoice." 

To enter an invoice when you add a payment, you must select Misc. Payment as the transaction type. 
Accounts Payable then displays a detail-entry table where you can enter general ledger account 
distributions for the payment, as you would to add an invoice using the Invoice Entry screen. 

The distributions debit the general ledger accounts you specify and credit the bank account you chose for 
the batch.

When you post the miscellaneous payment, Accounts Payable creates an invoice transaction as well as a 
payment transaction. The entries are combined on the same posting journal.

Note: 
Invoices created for a miscellaneous payment do not include:

 l Retainage.

 l Optional fields.

 l Terms. (The invoice is paid immediately.)

One-Time Vendor or Accounts Payable Vendor

If you are entering a miscellaneous payment for an existing vendor, you must enter the invoice number 
and the vendor number. When you add the entry, Accounts Payable creates an invoice document that 
uses this number.
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Note: To enter a cash invoice for a one-time vendor, you must leave the Vendor Number field blank. 

You enter the payee name and address in the screen that opens when you click the Zoom  button 
beside the Remit-To field.

job-related  Miscellaneous Payments

Payment Entry also lets you enter job-related  details for miscellaneous payments. To display the 
necessary job-related  fields, select the Job Related option on the Payment Entry screen before you enter 
any details.

Calculating Tax for Miscellaneous Payments

Accounts Payable calculates tax and updates tax services for miscellaneous payments, as it does for 
invoices you enter using the Invoice Entry screen. 

The program displays tax information from the vendor record as defaults, which you can change for a 
miscellaneous payment, as follows:

 l To change the tax group or other tax information for the document, you use the A/P Document 
Taxes Screen. (You can use a tax group that is from the one specified in the vendor record.) For 
more information, see A/P Document Taxes Screen.

 l To change tax information for the invoice details, you use the separate A/P Detail Accounts/Taxes 
Screen (Miscellaneous Payments) to enter the details and detail tax information. For more 
information, see A/P Detail Accounts/Taxes Screen (Miscellaneous Payments).

Entering a Cash Invoice or Miscellaneous Payment

You enter a miscellaneous payment to issue a check to a person or company for which no vendor record 
exists in Accounts Payable. For example, you could enter a miscellaneous payment to record a purchase 
from a one-time vendor.

You can also enter a miscellaneous payment for an existing Accounts Payable vendor and create an 
invoice at the same time, so you do not have to enter the invoice separately in the Invoice Entry screen. 
This type of payment is known as a a "cash invoice."

Note: Accounts Payable does not create an invoice when you post a payment for a one-time vendor, 
for whom you do not create a vendor record.
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To add a cash invoice or cash payment:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Select an existing payment batch using the Batch Number field, or create a new batch. More...

To create a new batch:

 a. Click the New  button beside the Batch Number field, and then type a description for the 
batch in the next field.

 b. In the Batch Date field, enter a date for the new batch, or accept the session date.

 c. Specify the bank and, for a multicurrency ledger, the default currency for the batch.

 3. Click the New  button beside the Entry Number field to start a new document, and then enter a 

description for the payment (such as Payment for camera).     

 4. Select Misc. Payment as the transaction type.

 5. If the payment is for an existing vendor, enter the vendor number in the Vendor Number field, or 

use the Finder  to select the vendor.

 6. Fill in general, or header, information for the payment. More...

Header information includes:

 l A description for the entry.

 l Payment date and posting date.

 l Remit-to location.

 l Account set.

 l Payment code. 

 l If the code is for a check payment, you select Print Check, Check Number, and Check 
Language. 

 l If the code is for a cash payment, you specify a cash account.

 l Payment amount and, for a multicurrency system, the currency.

 l Invoice number.

 l Optional fields (if you use them).

 l Tax group.

For more information, see "A/P Payment Entry Screen" (page 435).

 7. Enter distribution details for the payment, as you would for an invoice. More...
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 l If the payment is job-related , select the Job Related option, and then use the fields that 
appear to distribute the payment to contracts, projects, categories, and resources, as 
required.

 l If the payment is not job-related , for each distribution detail, type the distribution code or the 
general ledger account number and the amount, then:

 a. Type the amount of the distribution. 

Note: You can enter a negative amount for a detail line, but the document total must not 
be a negative amount.

 b. Type a reference.

 c. Type a description for the distribution.

You can also type an optional reference and description.

 8. To check or change the taxes calculated for the document (including the tax reporting amount), or 
to change the tax group for the document, click the Taxes button.

 9. To check the taxes calculated for a distribution detail, or to enter them manually, select the detail, then 
click the Account/Tax button.

To find out about entering taxes manually, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" 

(page 99).

 10. In a multicurrency ledger, if the bank or vendor does not use the functional currency and you need to 
change the exchange rate information for the payment, click the Rates button, then for each type of rate 
(bank and vendor), enter:

 l The rate type code.

 l The exchange rate. If the bank currency or the vendor matches the functional currency, the 
rate for that currency is 1.0000000.

Note: The Rates button appears only if the vendor does not use your functional currency.

The check will be in the bank currency.

 11. When finished, click Add or Save.

After entering and distributing the payment

 l Print individual checks. For more information, see "Printing a Single Check When You Pay a Vendor" 
(page 252).

 l Print the batch listing, and then review the entries.
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Correct entries, if necessary, and then reprint the listing for each corrected batch. When batches are 
correct, file the reports.

Note: You must print batch listings before posting if the Force Listing Of All Batches option is 
selected on the A/P Options screen.

 l Select the Ready To Post option for each batch.

 l Print and post payment batches. For more information, see "Printing Checks for a Batch of 
Payments" (page 255).

Distributing Miscellaneous Payment Details

The Payment Entry screen lets you distribute a miscellaneous payment to general ledger accounts.

Once you have distributed the payment, you can save the transaction and print the check.

To distribute a miscellaneous payment:

 1. For each account to which you want to distribute this payment:

 l Enter the distribution code or the general ledger account number.

 l Enter the amount.

Note: You can enter a negative amount on a detail line. However, the document total cannot be 
a negative amount.

 l Optionally enter a reference and description.

 2. Specify distribution details. More...

 l To add a distribution line, press Insert.

 l To delete a distribution line, select the line you want to delete and press Delete.

 3. On the Rates tab, assign an exchange rate for the miscellaneous payment.

Note: This tab appears only in multicurrency systems.

 4. Click Add.

Entering an Advance Credit for Goods You Return

You can record an advance credit for goods you have returned.
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Before You Start

 l Determine the amount the vendor is prepared to credit for the returned goods.

 l Create or select a payment for the vendor.

To process an advance credit:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Display the payment entry.

 3. Click the Zoom  button beside the Advance Credit field.

The Advance Credit screen appears.

 4. For each claim for which you are recording a credit, press Insert to create a detail line, and then 
complete the following detail fields:

 l Document Number. Enter a number to identify the debit document that the system will 
produce for the advance credit.                     

The number should help you to match this document with the credit note, when it arrives. For 
example, if your vendor has given you an RMA number, you could use that for the document 
number (say RMA-00001).

 l Reference. Enter a meaningful reference number to identify the specific document that will 
be credited, typically, an invoice number.

 l Description. Enter a description for the debit note, such as a description of the goods you 
are returning and the reason.

 l Claim Amount. Enter the amount the vendor is crediting you for the return of the goods.                     

Note: The Advance Credit field displays the total amount of advance credits entered.

 5. Click Close to return to the Payment Entry screen, where you apply the Payment (including the 
advance credit), as usual.

 6. Click Save.

After adding an advance credit

Enter the "real" credit note when you receive it from the vendor.

Adjustments
In Accounts Payable, you can:
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 l Enter adjustments individually   using the A/P Adjustment Entry screen.

 l Adjust specific documents   in the A/P Payment Entry screen, if the Allow Adjustments In Payment  
Batches option is selected on the A/P Options screen.

About Processing Adjustments

Accounts Payable provides several convenient methods by which you adjust transactions and account 
balances. 

In Accounts Payable, you enter adjustments individually in one of the following ways:

 l By entering an adjustment transaction using the A/P Adjustment Entry screen, specifying the document 
number to adjust and the general ledger account to debit or credit.

When you add an adjustment, Accounts Payable automatically assigns a document number, beginning 
with 1.

 l By adjusting specific documents using the Payment Entry screens, provided the Allow 
Adjustments In Payment Batches option is selected on the A/P Options screen.

 l By entering a debit note or a credit note using the A/P Invoice Entry screen. You use this method to 
adjust documents that have been completed and cleared from Accounts Payable, or to enter a 
general adjustment to an account balance.

Vendor statistics include the total amount and number of adjustments entered for the period, and the 
amount and date of the last adjustment transaction entered.

Updating Bank Services

Important! If you make any adjustments that affect a bank account, you must make a second 
adjustment in Bank Services.

Accounts Payable does not send adjustment information to Bank Services.

Creating or Modifying an Adjustment Batch

You use the A/P Adjustment Entry screen to create and modify batches of adjustments.

To create an adjustment batch:

 1. Open Accounts Payable > A/P Transactions > Adjustment Entry.

Note: You can also open the Adjustment Entry screen by clicking New on the Adjustment Batch List 
screen.

 2. Click the New  button beside the Batch Number field.
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 3. Enter a description and a date for the batch.

 4. Enter adjustments. For more information, see "Adjusting a Posted Transaction" (page 184).

To edit an existing adjustment batch:

 1. Open Accounts Payable > A/P Transactions > Adjustment Entry.

Note: You can also open the Adjustment Entry screen by clicking New on the Adjustment Batch List 
screen.

 2. In the Batch Number field, enter a batch number.

 3. Make the changes you need to adjustments in the batch.             

Note: To view and edit header information for the batch, click the Zoom  button beside the Batch 

Number field.

 4. Click Save.

After creating or modifying an adjustment batch

Print a batch listing. For more information, see "Printing Batch Listings" (page 245).

Opening an Existing Adjustment Batch

You can view or open existing adjustment batches.

To open an existing adjustment batch:

 1. Open Accounts Payable > A/P Transactions > Adjustment Batch List.

 2. If there are a large number of adjustment batches, enter a batch number in the Batch Number 
field.

Tip: To show only batches that are open or ready to post, clear the Show Posted And Deleted 
Batches option.

 3. Click Open.

Deleting Adjustments

You can delete individual adjustments, or whole adjustment batches.
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To delete an individual adjustment entry:

 1. Open Accounts Payable > A/P Transactions > Adjustment Entry.

 2. In the Batch Number field, enter a batch number.

 3. Select an adjustment entry.

 4. Click Delete.

 5. If a message appears asking you to confirm the deletion, click Yes.

To delete an adjustment batch:

 1. Open Accounts Payable > A/P Transactions > Adjustment Batch List.

 2. In the Batch Number field, enter a batch number.

 3. Click Delete.

 4. If a message appears asking you to confirm the deletion, click Yes.

All transactions in the batch will be deleted and the batch will be listed as deleted on the Batch Status 
report. You cannot reuse the batch number.

Note: To clear the data for the deleted batch from Accounts Payable, select the option Clear Deleted 
And Posted Batches from the A/P Clear History screen.

Posting an Adjustment Batch

You can post adjustment batches individually from the Adjustment Batch List screen or the Adjustment 
Entry screen.

For information about posting multiple batches, see "Posting a Range of Batches" (page 127).

Before You Start

Print listings of the batches you want to post. For more information, see "Printing Batch Listings" (page 
245).

To post an adjustment batch from the Adjustment Batch List screen:

 1. Open Accounts Payable > A/P Transactions > Adjustment Batch List.

 2. Select the batch you want to post.

 3. In the Ready To Post field for the selected batch, specify Yes.

 4. Click Post.
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To post an adjustment batch from the Adjustment Entry screen:

 1. Open Accounts Payable > A/P Transactions > Adjustment Entry.

 2. Create or modify an adjustment batch. For more information, see "Creating or Modifying an 
Adjustment Batch" (page 181).

 3. Click Post.

Adjusting a Posted Transaction

If you need to change the amount for a posted transaction, you do so by entering an adjustment. You can 
also make changes to an existing adjustment, and then save your changes.

To add an adjustment:

 1. Open Accounts Payable > A/P Transactions > Adjustment Entry.

 2. Select or create the adjustment batch to use.

 3. To assign the entry number, click the New  button beside the Entry Number field.

 4. Enter an optional description for the entry, then enter the adjustment date, the posting date, the 
vendor number, an optional reference and reference description, the document number to adjust, 
and the payment number (if the adjusted document includes a payment schedule).

 5. Use the Finder for the Adjust Line Number field to select a detail for adjustment.

 6. Include for each detail:

 l The distribution code or the general ledger account number.

 l The amount. (Enter a positive amount to reduce the balance of an invoice or debit note, or a 
negative amount to increase the balance of these documents.)

 l If the adjustment is for a job-related  document, the contract, project, and category to adjust in 
Project and Job Costing.

 7. If you use retainage accounting, adjust retainage as necessary. For more information, see "About 
Processing Retainage in Accounts Payable" (page 195).

 8. Click Add.

Note: This button changes to Save. If you make changes to the adjustment after you have added it, 
click Save to record your changes.

About Entering Optional Fields on Adjustment Transactions

If you use Sage 300 Transaction Analysis and Optional Field Creator and you have set up system-wide 
optional fields, you can define optional fields for the Adjustment Entry screen.
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You define adjustment optional fields using the A/P Optional Fields Screen in the A/P Setup folder. For 
more information, see "A/P Optional Fields Screen" (page 341).

When you enter a new adjustment transaction, Accounts Payable displays any optional fields that are 
marked for automatic insertion in adjustments, along with their default values.

The Optional Fields check box on the Adjustment Entry screen shows whether a selected adjustment 
uses optional fields. 

Note: The program sets this indicator. You cannot select or clear the check box. If you delete all the 
optional fields associated with the adjustment, the program resets the Optional Fields indicator.

Assigning Optional Fields to Particular Adjustments

To view the optional fields that are used on a selected adjustment, click the Zoom  button  beside the 

Optional Fields check box. The Optional Fields screen appears, where you can change the values for 
optional fields that appear as defaults, or delete them. You can also add any other optional fields that you 
have defined for adjustments.

Accounts Payable assigns default values to adjustment optional fields as follows:

 l If the optional fields used on the original document are the same as the adjustment optional fields, 
the values from the original document appear.

 l If the vendor and adjustment optional fields are the same, the program displays the values from 
the vendor record. However, if the optional field is also used on the original document, the value 
from the original document is used.

 l If an adjustment optional field is not used either on the original document or in the vendor record, 
the program uses the default value specified in the optional field setup record.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services. If the optional field allows a blank, you can leave the value blank.

 l If the optional field is not validated, you can select a defined value, or you can enter any value that 
is consistent with the type of field, providing your entry does not exceed the length specified for the 
optional field.

Updating General Ledger

When you post an adjustment that includes optional fields, the optional field information specified for the 
adjustment is included in the journal entry passed to General Ledger if:

 l You specified in the optional field setup record that optional field information will be passed to the 
General Ledger account.
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 l You defined the same optional fields for adjustments as you defined for transaction details in the 
General Ledger account record.
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Chapter 4: Periodic Processing in 
Accounts Payable

Use Accounts Payable Periodic Processing screens to perform tasks that are part of your regular period-
end procedures, such as clearing history, creating general ledger batches, and deleting inactive records. 

Periodic Processing Procedures
There are several Accounts Payable screens you can use to complete the types of processing you do at 
specified intervals, such as at month end or period end, and to remove obsolete data and records.

This section outlines periodic procedures you might follow, and tells you how to use Accounts Payable to 
accomplish the tasks.

 1. Update Accounts Payable records, such as entering changes of address, making corrections, and 
selecting the Inactive option for records you plan to delete.

Use the icons in the A/P Vendors and A/P Setup folders to revise these records.

 2. Post transactions that apply to the period, and then print and file the posting journals.

Use the Invoice Entry, Payment Entry, and Adjustment Entry icons in the A/P Transactions folder.

 3. Print the Vendor Transactions and Aged Payables reports to identify amounts that should be paid, or 
that require other action.

Use the Vendor Transactions and Aged Payables icons in the A/P Transaction Reports folder to print 
the reports.

 4. Use the Create Recurring Payable Batch icon in the A/P Periodic Processing folder to generate 
invoices for the recurring payables you have set up.

 5. Create and post batches of adjustments, such as transactions to correct errors found when you 
reconcile bank statements.

Use the Adjustment Entry icon in the A/P Adjustments folder.

 6. If you have a multicurrency ledger, you may need to update exchange rates in Common Services and 
revalue multicurrency transactions and balances periodically, to reflect changes in exchange rates.
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Use the Revaluation icon in the A/P Periodic Processing folder.

 7. Print the G/L Transactions report, and then create any outstanding general ledger transactions. 

Use the G/L Transactions icon in the A/P Transaction Reports folder to print the report, and the Create 
G/L Batch icon in the A/P Periodic Processing folder to create transactions.

Process the batches in Sage 300 General Ledger, if you use it, or post them manually to your other 
general ledger.

 8. Clear the paid transactions, vendor comments, and statistics that you no longer need, and delete 
records that you classed as inactive and prepared for deletion.

Use the Clear History, Clear Statistics, and Delete Inactive Records icons, respectively, in the 
A/P Periodic Processing folder to clear this information.

 9. Use the 1099 Electronic Filing icons in the A/P Periodic Processing folder to file 1099s 
electronically, if you are required to file 1099 forms. (If you do not file electronically, you choose the 
1099/CPRS Amounts screen from the Vendor Reports folder to print out the forms.)

About Creating General Ledger Transactions
When you post invoice batches, Accounts Payable creates transactions for the inventory or expense 
accounts to which the invoices are distributed and creates balancing transactions for the general ledger 
payables control accounts.

If you want to automatically create general ledger transaction batches each time you post Accounts 
Payable transactions, select the option to Create G/L Transactions During Posting (on the A/P Options 
screen).

To create general ledger batches only when you want to, select Create G/L Transactions On Request 
Using Create G/L Batch Icon.

Note: If you use the Create G/L Batch screen, you must create the transactions before using the Year 
End screen to do year-end processing.

Reporting G/L Transactions

The G/L Transactions report and the summary at the end of each Accounts Payable posting journal lists 
the general ledger accounts that will be debited and credited with payables transactions when you post 
the batch of general ledger entries in General Ledger.

On the A/P Options screen, you choose the type of reference and description that is included with each 
General Ledger transaction.
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Note: You must print the G/L Transactions report before clearing posting journals (using the A/P Clear 
History screen), as this option deletes data for the G/L Transactions report.

G/L Accounts

Accounts Payable uses the following general ledger accounts: Payables Control, Purchase Discounts, 
Prepayments, and the accounts you assign to distribution codes or enter with transactions.

If you use multicurrency accounting, Accounts Payable also uses General Ledger's unrealized and 
realized exchange gain and loss accounts.

If you do not use Sage 300 General Ledger—or if your Sage 300 General Ledger system is at another 
location—Accounts Payable creates its general ledger transactions in a file called APGLTRAN.CSV, 
which can be imported by a remote site Sage 300 General Ledger, or transferred to another general 
ledger that you use. The file is in Comma Separated Values format, and is created in the same directory 
as your company database.

Note: All general ledger transactions are placed in the same CSV file, and each time Accounts Payable 
creates transactions, it appends them to the CSV file.

Multicurrency Ledgers

If you use multicurrency accounting, you use the Create G/L Batch screen to produce general ledger 
batches containing revaluation transactions that you created with the Revaluation screen.

Revaluation transactions revalue all outstanding multicurrency Accounts Payable documents at new 
exchange rates. Because revaluation transactions are for unrealized amounts, they are posted to the 
General Ledger system as reversing transactions, which means that General Ledger simultaneously 
posts reversing transactions to the first day of the next fiscal period.

Note: Revaluation transactions created by Accounts Payable are set as automatically reversing 
transactions. If they were posted to Sage 300 General Ledger, they would be reversed at the beginning 
of the next fiscal period.

If you are posting them to a different general ledger, you must also reverse these transactions in the next 
fiscal period.

Creating Batches of Transactions for General Ledger
If Accounts Payable does not create general ledger batches during posting, you use the Create G/L 
Batch screen to produce batches of general ledger transactions from the batches posted in Accounts 
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Payable. In a multicurrency system, you also use this screen to produce general ledger batches for 
transactions created during revaluation. More...

The selection for the Create G/L Transactions option on the G/L Integration screen determines whether 
Accounts Payable creates general ledger transactions during posting, or if you must use the Create G/L 
Batch screen to create them.

You create General Ledger batches for Sage 300 General Ledger, if you use it, or for your other general 
ledger system. For more information about the batches created for another general ledger, see "About 
Year End Processing in Accounts Payable" (page 213)

You must create all outstanding general ledger batches before you can clear posting journals or use the 
Year End screen.

Note: If you try to post a G/L batch to a period that is locked for General Ledger, the transactions will be 
placed in an error batch. Therefore, be sure to create and post General Ledger batches for outstanding 
Accounts Receivable transactions before locking a period for General Ledger.

Before You Start

 l Decide whether to create G/L batches during posting, or later using the Create G/L Batch icon, 
and then select G/L batch-creation options on the Integration tab of the G/L Integration screen.

 l Post all outstanding invoice, payment, and adjustment batches in Accounts Payable.

 l Print the G/L Transactions report. (You cannot print this report after you create the general ledger 
batches.)

To create G/L batches:

 1. Open Accounts Payable > A/P Periodic Processing > Create G/L Batch.

 2. Select the types of posted batches from which to create transactions (invoices, payments, 
adjustment, revaluation).

 3. Select the posting sequence number through which to create transactions for each batch type.

 4. Click Process.

If you use Sage 300 General Ledger, Accounts Payable either adds the new transactions to existing 
General Ledger batches or creates new batches, depending on your choice for the Create G/L Batches 
By option on the G/L Integration screen.

If you do not use Sage 300 General Ledger, you see a message asking whether to append transactions 
to an existing batch file or to overwrite the file.
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After creating a G/L batch

 l Post the batches in Sage 300 General Ledger, if you use.

 l If you use a different general ledger, import the CSV batch file into your general ledger, and then 
delete the file.

About Checking Data Integrity
You should check data integrity and back up your data whenever you add records that would be time-
consuming to enter a second time or perform other tasks that change your Accounts Payable data.

Important! 
You should always check data integrity:

 l Before posting batches

 l After importing data

Checking Integrity for Accounts Payable
Use the A/P Integrity Checker screen to limit the scope of Accounts Payable integrity checks to fit the 
time available. You can specify:

 l The type of data to check.

 l A range of vendor records for which to check data.

 l Whether to fix minor errors during the check.

 l Whether to check for or delete orphan records.

To check the integrity of Accounts Payable data:

 1. Open Administrative Services > Data Integrity.

 2. Include Accounts Payable in the Check Applications list, and then select (highlight) it.

 3. Click Application Options.

 4. Select options for checking Accounts Payable integrity.

About Processing Recurring Payables
If you regularly pay for such costs as rent, standing orders, or services that vary little from period to 
period, you can automatically create invoices for all or a selection of the payables and vendors at once.
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The ability to create separate recurring payable batches saves you from having to enter an invoice for 
each recurring payable and vendor manually. It also provides a specific audit trail for the recurring 
payables by assigning them a separate batch type (Recurring).

Preparing Recurring Payable Records

You use the Recurring Payables screen to add records for the recurring payables you use and to assign 
them to vendors.

Specifying When to Process Recurring Payables

You can create payables you intend to apply indefinitely, or you can set them up to stop once you have 
paid a maximum amount or reached a certain date, or once you have processed a specified number of 
invoices.

You schedule the recurring payable for processing at regular intervals, and you can also have System 
Manager remind specific or all Sage 300 users to create invoices for the recurring payables. For more 
information about creating schedules and using reminders, see the System Manager help.

Entering Details for Recurring Payable Invoices

You add distributions to recurring payable records, similar to invoice entry.

You can have Accounts Payable calculate taxes when you create a recurring payable batch, or you can 
enter the taxes manually.

Other Information You Can Enter with Recurring Payables

If you need to send your payment to a different address than the one in the vendor record, you can 
include a remit-to location with each payable. The remit-to location is used on the invoice when you 
create a recurring payable batch.

Creating Recurring Payable Batches

When the recurring payables are due, you use the Create Recurring Payable Batch screen to create a 
batch of invoices.

If the recurring payable record uses a schedule that includes a reminder, you can also process the 
recurring payable right from the Reminder List in Common Services.

You can create a recurring payable batch by vendor number, vendor group, or recurring payable code.

Accounts Payable creates invoices for the amounts specified in the selected recurring payable records.

When you process a recurring payable batch, Accounts Payable checks to ensure that the invoice total 
(including taxes) will not cause the amount invoiced to date to exceed the maximum amount specified in 
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the recurring payable record. If the maximum amount will be exceeded, Accounts Payable does not 
create the invoice, and does not update the Last Invoiced date field for the recurring payable.

If a recurring payable batch with the same batch date exists when you process a recurring payable batch, 
the new transactions are added to that batch.

You can edit the recurring payable batches, print listings for them, and post them in the same way you 
process other types of batches.

Manually Invoicing a Recurring Payable

If you accidentally delete a recurring payable invoice, or if you need to create an additional recurring 
payable invoice for another reason, Accounts Payable lets you create an invoice manually. For more 
information, see "Invoicing a Recurring Payable Manually" (page 122).

Assigning Document Numbers to Recurring Payable Invoices

When you create a recurring payable batch, Accounts Payable automatically assigns a document 
number to each invoice. The document numbers use the prefix and start with the next number assigned 
for recurring payables on the Numbering tab of the A/P Options screen.

Reusing Deleted Recurring Payable Invoice Numbers

If you delete a batch of recurring payable invoices before posting them, Accounts Payable does not 
automatically reset the next invoice number for recurring payables on the A/P Options screen. To prevent 
gaps in your audit trail of recurring payable invoice numbers, you should change back to the number 
assigned to the first invoice in the deleted batch.

Reporting Recurring Payable Invoices

Invoices for recurring payables are shown as transaction type IN on all listings and reports in Accounts 
Payable, and the batch type is Recurring. The G/L Transactions report assigns AP-IN as the source code 
for recurring payable invoices.

When you post a batch of recurring payables, the program adds the recurring payable amounts to vendor 
period-to-date and year-to-date invoice totals. It also updates the Last Invoiced date and Last Invoice 
Amount fields in the recurring payable record.

Posting Recurring Payable Batches

When you post a recurring payable batch, Accounts Payable creates a posting journal for the 
transactions and updates the following records:
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 l Vendors. Adds the amount and number of new recurring payables to the totals for the period in the 
vendor’s account. Also enters the amount and document date of the last recurring payable that 
was posted for the vendor.

 l Vendor Groups. Adds the total amount of the recurring payables invoiced to vendors in the group 
and the number of recurring-payable invoices created for the group to the group statistics. Use the 
Vendor Groups screen to view this information.

Creating General Ledger Transactions

When you post recurring payable batches, Accounts Payable creates transactions for the payable 
accounts specified for each detail line on a recurring payable invoice, and for the affected accounts in the 
vendor’s account set. Posting also creates balancing transactions for the corresponding payable control 
accounts. Print the posting journal for the recurring payable batch or the G/L Transactions report to view 
this information.

Processing Recurring Payables
You use the Create Recurring Payable Batch screen to create batches of recurring invoices.

Tip: If recurring payable records include reminders to to users, you can also create recurring payable 
batches from the Reminder List in Common Services.

Before You Start

 l Set up a recurring payable record for each vendor that invoices you on a recurring basis. For more 
information, see "Setting Up a Recurring Payable for a Vendor" (page 66).

 l As necessary, update recurring-payable records.

You can update charges for individual vendors using the Recurring Payables Setup screen (in the 
Vendors folder).

To process recurring payables:

 1. Open Accounts Payable > A/P Periodic Processing > Create Recurring Payable Batch.

 2. Type the run date.

 3. Specify whether to create invoices by recurring payable code, vendor number, or vendor group.

 4. Specify the ranges for the selected record type.

 5. Use the Method field to specify whether to create a new batch, add the invoices to an existing 
batch, or use the default method to determine whether to create a new batch or add the invoices to 
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an existing batch.

 6. Click Process.

After generating a batch of invoices

 l Use the Invoice Entry screen to make any changes to the recurring-charge invoices.

 l Print the invoice batch listing to verify the charges, then file the listing.

Choose Batch Listings from the Transaction Reports folder to print a listing of the batch. Select 
Recurring as the batch type. If you need to make corrections, reprint the listing after editing the batch.

 l Post the batch.

 l Process payments and print checks as you would for any other type of invoice. For more 
information, see "Creating a Payment Batch Automatically" (page 147).

About Processing Retainage in Accounts Payable
Accounts Payable lets you account for retainage (or a holdback) that occurs when your vendor withholds 
a percentage of an invoiced amount, usually by mutual agreement or according to a statute (such as a 
Builders Lien Act).

There are two steps in processing retainage:

 1. First, you post an invoice, debit note, or credit note that specifies a holdback (retainage) for the 
document.

 2. Later, you post a separate retainage invoice, debit note, or credit note to invoice the outstanding 
retainage amount.

Entering Original Documents with Retainage

An invoice, debit note, or credit note from which retainage is taken is called an original document in Sage 
300.

You enter the invoice, debit note, or credit note using the Invoice Entry screen, as usual. To indicate that 
retainage applies to the document, however, you select the Retainage option.

Note: The Retainage option appears only if you selected the Retainage Accounting option for your 
Accounts Payable system.

Accounts Payable then displays the retainage percentage, retention period, retainage rate, and the 
retainage terms from the vendor record. Unless the document is job-related, you can change these 
retainage factors for a particular document, as follows:
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 l Retainage Amount. To calculate the retainage amount, Accounts Payable multiples the document 
amount (or the document total, if you include taxes in retainage) by the retainage percentage. You 
can enter a new retainage amount, if necessary. When you enter an amount to replace a 
calculated amount, Accounts Payable recalculates the retainage percentage.     

The retainage amount is subtracted from the document amount (or the document total) to calculate the 
amount due.

 l Retainage Due Date. Accounts Payable calculates the retainage due date (the date the 
outstanding retainage is due for invoicing) by adding the number of days in the retention period to 
the original document date. You can enter a different due date, if you want.

 l Retainage Percentage. Accounts Payable uses the retainage percentage to calculate the 
retainage amount.     

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you enter a 
new percentage, Accounts Payable recalculates the retainage amount.

 l Retainage Rate. You use this field to specify the method Accounts Payable uses to determine the 
exchange rate for the retainage document when you eventually process it. You can choose one of the 
following:

 l Use Original Document Exchange Rate. Uses the same rate as the document you are 
processing.

 l Use Current Exchange Rate. Uses the rate in effect when you process the retainage 
document to clear the outstanding retainage.

 l Retainage Terms. You can use different terms for retainage documents (used to process invoices 
for outstanding retainage) than you used for the original document from which the retainage was 
taken.     

Accounts Payable displays the code specified for retainage terms in the vendor record, but you can 
change the retainage terms for a document.

 l Retention Period. Accounts Payable uses the retention period to calculate the due date for the 
retainage document. When you change the retention period, Accounts Payable recalculates the 
retainage due date, and vice versa.

Apply Document Transactions

When you apply original debit notes or credit notes that include retainage in Invoice Entry, or when you 
apply credit notes in Payment Entry, only the original document balances are affected.Outstanding 
retainage amounts remain with original documents until you post retainage documents or adjustments to 
clear the outstanding retainage.
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Job-related  Retainage

If the document is job-related, you enter the retainage exchange rate and the retainage terms at the 
document level. However, because outstanding retainage amounts are tracked separately for each 
job-related  detail, you enter a separate due date, retention period, and retainage amount or retainage 
percentage for each detail on a job-related  document.

Taxes on Retainage

Tax on retainage is processed according to the Report Tax option selected on the A/P Options screen. 
The option provides the following alternatives:

 l At Time Of Original Document. If you select this option, Accounts Payable calculates and reports 
(posts) tax on retainage when you post an original document that includes retainage.

 l As Per Tax Authority. If you select this option, Accounts Payable calculates tax when you post an 
original document, but reports (posts) the tax as required by each tax authority. The tax reporting 
requirements for each tax authority are specified by the Report Tax On Retainage Document 
option, in Tax Services. The tax authority can specify No Reporting, At Time Of Retainage 
Document, or At Time Of Original Document.

Some tax authorities require that you report tax when you post a retainage document; others let you 
report tax when you post an original document to which retainage applies.

If the tax authority reports tax At Time Of Original Document, the tax amount is calculated and the tax 
tracking reports are updated immediately when you post original documents.

If the tax authority reports tax At Time Of Retainage Document, the tax amount is calculated when you 
post the original document, but it is not reported until you post the retainage document.

To report tax, Accounts Payable posts tax amounts to a tax liability account and updates the tax tracking 
reports. The timing of the tax liability on retainage documents depends on the tax authority.

Posting Original Invoices, Debit Notes, and Credit Notes

When you post the original retainage document, Accounts Payable deducts the retainage from the 
document total, and posts the amount to the retainage control account.

For example, if you enter an invoice for $10,000 with 10% retainage, an invoice is posted for $9,000 with 
retainage outstanding of $1,000.

The retainage amount remains in the control account until you invoice it in accordance with:

 l The retention period or retainage due date specified for the invoice.

 l The number of days in advance specified on the A/P Options screen for generating retainage 
documents.
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Adjusting Original Documents

Adjustment Entry lets you adjust retainage related to posted invoices, debit notes, and credit notes, as 
follows:

 l To change the retainage amount for an original document, you use the detail-entry table to adjust 
each detail or to add a new detail that includes retainage. Enter the amount by which to adjust 
retainage in the retainage debit or retainage credit fields on the table.

You can also add retainage to a document that did not include retainage. You enter the retainage due 
date, as well as the retainage amount, for each detail on the detail-entry table. You also enter retainage 
terms and the retainage exchange rate for the document, if you are adding retainage to a document for 
the first time.

 l You specify retainage terms and the retainage exchange rate option for the whole document on 
the Retainage tab.

Note: If retainage was included on the original document, Accounts Payable uses the retainage 
exchange rate setting from the original document.

 l If you add a new detail to which retainage applies, the retainage document detail inherits the 
Discountable status from the distribution code used in the adjustment detail.

If you don't use a distribution code in the adjustment detail, the retainage detail is discountable by 
default.

 l You can change both the retainage amount and add or change document details. Accounts 
Payable then creates two entries: one for the detail adjustment, and the other for the retainage 
adjustment.It does not create a compound entry.

When you post the adjustment, Accounts Payable adjusts the outstanding retainage account.

Note that Accounts Payable does not calculate any retainage on adjustment transactions. You must enter 
the retainage manually, whether you are adding it for the first time, or adjusting existing retainage debits 
or credits.

Invoicing Outstanding Retainage

You invoice for outstanding retainage amounts, or holdbacks, either manually, using the Invoice Entry 
screen, or automatically, using the Create Retainage Batch screen. If you have posted debit notes and 
credit notes to which retainage applied, you also create retainage debit notes and credit notes using the 
Invoice Entry screen and the Create Retainage Batch screen.

Invoicing Retainage Manually

Normally, you would use the Create Retainage Batch screen to invoice periodically for retainage. 
However, Accounts Payable also lets you process outstanding retainage manually.
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To invoice manually for outstanding retainage, or to manually process a credit note or debit note to clear 
an outstanding retainage amount, you use the Invoice Entry screen.

You enter information for the retainage invoice, credit note, or debit note, as usual. To invoice for 
retainage, you must:

 l Select Summary as the detail type. (Retainage documents are summary documents.)

 l Select Retainage Invoice, Retainage Credit Note, or Retainage Debit note as the document type, 
consistent with the original retainage document for which you are now processing outstanding 
retainage. (These options are not available if you selected Item as the detail type.)

Because outstanding retainage remains associated with the original retainage document, you must use a 
retainage invoice if the original document was an invoice, a retainage debit note if the original document 
was a credit note, and a retainage debit note if the original document was a debit note.

Use the Original Document field to specify the original retainage document for which you are invoicing the 
outstanding retainage.

When you post the retainage documents (invoices, credit notes, or debit notes), Accounts Payable 
transfers outstanding retainage amounts from the retainage control account to the payables control 
account.

Viewing Retainage Information

You can view retainage information on the:

 l Vendor Activity screen. To review the relationships between retainage documents, you can use 
the Transactions tab on the Vendor Activity screen.

Select a retainage transaction, then click the:

 l Document button to open the document in the transaction entry screen.

 l Open button to display information for the retainage document in the separate Document 
Information screen.

The Document Information screen shows:

 l The original retainage amount and retainage due date.

 l The outstanding retainage amount (in the Retainage Amount field), if any.

 l The retainage documents used to clear the outstanding retainage amount for the 
original document, if you have processed any (on the Item Activity table).

 l Vendors screen. The Outstanding Retainage field on the Activity tab of the Vendors screen 
displays the amount of retainage outstanding for a selected vendor.

 l Aged Retainage report. For more information, see "Printing the Aged Retainage Report" (page 242).
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Revaluing Outstanding Retainage Amounts

If you use multicurrency, when you run Revaluation, Accounts Payable also revalues amounts 
outstanding in the retainage control account.

For revalued outstanding retainage, Accounts Payable creates general ledger entries to adjust the 
retainage control account rather than the payables control account.

If your Sage 300 system uses the Realized and Unrealized Gain/Loss the accounting method to revalue 
multicurrency documents, Accounts Payable also creates reversing entries for the next period. (You set 
the revaluation accounting method in the Company Profile, in Common Services.)

The Revaluation Posting Journal includes a separate section for retainage after the current revaluation 
for each vendor.

If you include job-related  details on the posting journal, a retainage section appears on the Summary 
page after the current job details.

Processing Outstanding Retainage
Use the A/P Create Retainage Batch screen periodically to process outstanding retainage automatically 
for the vendors, document numbers, or vendor groups you select.

Notes: 
 l You can also process individual invoices for outstanding retainage using the Invoice Entry 

screen. 

 l Accounts Payable can remind you and other users to process retainage transactions when they 
are due. If you assign a schedule that uses a reminder on the Retainage tab of the A/P Options 
screen, you can process retainage directly from the Reminder List in Common Services.

 l Taxes are calculated only on original documents. They do not appear for retainage documents.

Before You Start

 l Print and review the Aged Retainage report. For more information, see "Printing the Aged 
Retainage Report" (page 242).

 l On the A/P Options screen:

 l Set the option to use retainage accounting on the Processing tab.

 l Specify default retainage settings for vendors on the Retainage tab.

For more information, see "A/P Options Screen" (page 325).
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 l Specify a retainage control account for each account set in your Accounts Payable system. For 
more information, see "A/P Account Sets Screen" (page 312).

To create a batch of retainage documents:

 1. Open Accounts Payable > A/P Periodic Processing > Create Retainage Batch.

 2. Specify the Run Date for this retainage batch.

 3. Specify the types of original retainage documents for which you are now processing outstanding 
retainage.

 4. Choose the type of record by which to select outstanding retainage for processing, then enter the 
range of records from which to select outstanding retainage.

 5. In the Number Of Days In Advance field, specify the number of days in advance of the retainage 
due date that retainage documents can be created.

 6. Click Process to create the batch.

Accounts Payable generates the required retainage invoices, retainage debit notes, and retainage 
credit notes, and updates the Last Invoiced field on the Retainage tab of the A/P Options screen.

 7. When finished, click Close.

After generating a retainage batch

 1. Use the Invoice Entry screen to make any changes to the retainage invoices, debit notes, and 
credit notes.

 2. Print a batch listing (selecting Retainage as the batch type) listing of the batch. For more 
information, see "Printing Batch Listings" (page 245).

 3. Verify the information, then file the listing. 

Note: If you need to make corrections, reprint the listing after editing the batch.

 4. Select the Ready To Post option for the batch on the Invoice Batch List screen.

 5. Post retainage batches using the Invoice Batch List or the Post Batches screen.

Accounts Payable assigns the next available invoice, credit note, or debit note number when you post a 
retainage document. If you use separate numbering for retainage documents, the program assigns the 
next retainage invoice, retainage credit note, or retainage debit note number.

About Deleting Inactive Records
You use the Delete Inactive Records screen to remove obsolete vendor, vendor group, remit‐to location, 
and recurring payable records from Accounts Payable.
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You can remove records only if they currently have an inactive status and were set to inactive within the 
range of dates you specify.

If you do not want to use the same range of dates for deleting all types of records, you can delete each 
type of record separately.

Deleting Vendor Records

To identify inactive vendor records, print the Vendors report, selecting one or more of the Address, 
Profile, or Comment options. The report shows which vendor records are inactive (on the first line for 
each vendor), and when the status was changed.

When you delete vendor records, you also delete vendor statistics and comments.

Deleting Vendor Groups

You cannot delete a vendor group to which vendors are assigned. To determine whether any vendors are 
assigned to a group, print the Vendor Groups report, selecting the Group Members option.

Note: When you delete a vendor group, you also delete the vendor group statistics.

Deleting Remit-to Locations

Before you delete inactive remit-to locations, make sure there are no unposted transactions that use 
them. (You cannot edit and save a transaction with an inactive or deleted remit-to location; however, you 
can post such transactions without errors.)

Removing Inactive Records from Accounts Payable
You use the A/P Delete Inactive Records screen to remove obsolete vendor, vendor group, remit‐to 
location, and recurring payable records from Accounts Payable. This screen removes records only if they 
currently have an Inactive status and were set to Inactive within the range of dates you specify.

Before You Start

 l Assign Inactive status to all records you want to delete.

 l To identify inactive vendor records, print the Vendors report, selecting the Address, Profile, and 
Recurring Payables options.
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 l Before you can delete a vendor record:     

 l Pay or settle all invoices and debit notes.

 l Clear all fully paid documents for the vendor.

Note: You can use the Clear History and Clear Statistics screens to clear comments and 
statistics for the vendor. However, the Delete Inactive Records screen automatically deletes 
the comments and statistics for the vendor records it deletes.

 l Delete remit-to locations and recurring-payable records for the vendor.

 l To delete a vendor group, you must first either delete or reassign any vendors assigned to the 
group. To discover whether vendors are still assigned to the group, print the Vendor Group List, 
selecting the Group Members option.

To delete inactive records:

 1. Open Accounts Payable > A/P Periodic Processing > Delete Inactive Records.

 2. Select the types of records you want to delete.

 3. Specify the ranges for each type of record.

 4. Type the range of dates for which to delete records.

 5. Click Process.

After deleting inactive records

Print new lists of the types of records you deleted to update your files with current information.

Clearing Obsolete Data from Accounts Payable
You use the A/P Clear History screen to remove the following types of data from Accounts Payable:

 l Fully paid documents.

 l Vendor comments.

 l 1099/CPRS amounts.

 l Printed posting journals.

 l Posting errors.

 l Deleted and posted batches.

Important! After you clear posted batches, you can no longer drill down from General Ledger to the 
Accounts Payable transactions that they contained. Also, you can no longer reprint invoices.
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Before You Start

 l Post all outstanding batches that could affect records you want to clear.

 l Determine the dates through which to clear transactions and comments and the highest posting 
sequence number to clear.

 l Print reports of the data you want to clear. More...

 l Before clearing fully paid documents, print the Vendor Transactions report for the documents 
you plan to clear. 

Select the following options when printing the report:

 l For Transaction Types, select all types.

 l As the first Select By option, select Vendor Number, then specify the range of 
vendor records you plan to clear.

 l Select any other sorting options you want to use. 

 l Select Show Applied Details and Include Vendors With A Zero Balance.

 l Before clearing vendor comments:

 l Print the Vendors report, selecting the Comments option.

 l Check your vendor records to ensure that the expiration dates for comments you 
want to retain are later than the date through which you will be clearing comments.

 l Before clearing posting journals:

 l Print a copy of each posting journal you want to clear.

 l Create any outstanding general ledger transactions.

 l Before clearing posted batches:

 l Print the batch status report for the batches.

 l Review the batch dates, and then decide on the batch numbers to clear (for example, 
batches more than nine months old).

Note: If you delete batches, you lose the ability to drill down to the transactions from General 
Ledger.

To clear obsolete data:

 1. Open Accounts Payable > A/P Periodic Processing > Clear History.

 2. Select the types of records you wish to clear.

 3. Specify the ranges for each type of record.
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 4. Type the dates or fiscal year and period for which to clear.

 5. Click Process.

Clearing Statistics
You use the A/P Clear Statistics screen to remove obsolete vendor period statistics and vendor group 
period statistics data from your Accounts Payable system.

Note: To clear activity statistics, you use the A/P Year End screen. For more information, see "Starting 
a New Fiscal Year" (page 214).

Before You Start

 l Post all outstanding batches that could affect records you want to clear.

 l Determine the fiscal year and period through which to clear statistics.

 l Print reports of the data you want to clear.

For example, before clearing statistics for vendors or vendor groups, print the statistical report for the 
type of information you plan to clear, specifying a year/period range and a range of vendors.

 l Check the reports to be sure you are clearing the statistics you intended to clear, then file them as 
permanent records of the information.

To clear statistics:

 1. Open Accounts Payable > A/P Periodic Processing > Clear Statistics.

 2. Select the types of records you want to clear.

 3. Select the range of vendors for which you want to clear statistics.

 4. Type the fiscal year and period for which to clear.

 5. Click Process.

After clearing statistics

Check that data was cleared properly.

Filing 1099 Reports Electronically
You can create an electronic file to submit 1099 forms through the IRS FIRE (Filing Information Returns 
Electronically) System using a modem or by mailing them on magnetic tape or diskettes. 
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Before You Start

Refer to IRS documentation for information on electronic filing requirements before you submit 1099s 
electronically.

Example: The IRS does not accept compressed files. If the resulting IRSTAX file is larger than 1.4 
megabytes, you will have to submit a file that spans two or more diskettes.

To create an electronic file for your 1099 forms:

 1. Open Accounts Payable >  A/P Periodic Processing > 1099 Electronic Filing.

Note: To use this screen, you must have security authorization to maintain tax numbers.

 2. Complete the header, transmitter, and payer fields according to IRS requirements.

 3. Click Generate to produce the electronic file.

 4. Follow the instructions on FIRE system. 

Important! Be sure to record the name that the IRS assigns to your file. You will need the name if you 
are required to submit a replacement file.

 5. When you have finished, click Close.

After filing electronically

Accounts Payable automatically prints a summary report of the information you filed, which you can keep 
with your records.

Filing  a T5018 (CPRS) Information Return Electronically
If your company operates in Canada and your primary source of business income is construction, you 
must report amounts paid or credited for construction services to the Canada Revenue Agency (CRA) by 
filing a T5018 information return, which consists of a T5018 Summary and related T5018 slips.

You use the A/P T5018 (CPRS) Electronic Filing screen to create your T5018 information return in the 
required XML format. You can then submit the generated file to the CRA through their website or on 
electronic media acceptable to the CRA (DVD, CD, or diskette).

Important! If you file more than 50 T5018 slips for a calendar year, you must use CRA's Internet File 
Transfer application to file original or amended T5018 returns.

206Sage 300 2023 Accounts Payable User's Guide



Before You Start

 l Refer to the Canada Revenue Agency (CRA) documentation for filing requirements before you submit 
T5018 forms electronically.

Note: The CRA does not process files that span more than one diskette or CD. Be sure to choose a 
media type that can accommodate the entire information return.

 l Make sure you have a transmitter number (a six-digit number preceded by the characters MM) as 
well as an RZ account number (a combination of your business number, "RZ" as the program 
identifier, and a CRA reference number). These numbers are required for filing returns with the 
CRA electronically.

 l Ensure that vendor records for contractors that are subject to CPRS reporting include the vendor's 
tax number and the tax type. Tax types allowed for CPRS reporting are the GST Registration 
Number, the Social Insurance Number, or the Business Number (a 15-character "RZ" account 
number).

 l Make sure your Web Access Code is handy when filing the return over the Internet.

To create an electronic file for your T5018 information return:

 1. Open Accounts Payable > A/P Periodic Processing > T5018 (CPRS) Electronic Filing.

Note: To use this screen, you must have security authorization to maintain tax numbers.

 2. Complete the header, transmitter, and payer fields according to Canada Revenue Agency (CRA) 
requirements. 

Important! You must complete both the Transmitter Information and Payer Information sections, 
even if the transmitter and payer are the same company.

 3. Click Process to produce the electronic file.

 4. Make a note of the name and location of the generated output file.

 5. When you have finished, close the T5018 (CPRS) Electronic Filing screen.

After creating an electronic file

 l If you are filing more than 50 information slips, submit the file over the Internet, as follows:

 1. Using your Internet browser, navigate to the CRA website.
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 2. Search for and follow CRA's instructions on filing using Internet File Transfer (XML). When 
prompted, submit the electronic file from the output location you specified when you 
generated the file.

 3. When your return is accepted, record the submission number provided on the Confirmation 
of Receipt. You will need this number if you are required to submit an amended report.

 l If you are filing 1 to 50 information slips, you can submit the file over the Internet, as described in the 
previous steps, or you can submit it on electronic media that is acceptable to the CRA (DVD, CD, or 
diskette). Follow the instructions for filing on electronic media on the CRA website.

About Revaluing Multicurrency Transactions
When exchange rates fluctuate, you may need to revalue outstanding documents denominated in other 
currencies to reflect their present value in your own (functional) currency at a particular time, for example, 
at financial statement dates. When you revalue a transaction, Accounts Payable recalculates its 
functional equivalent value at a new exchange rate.

Some accounting standard-setting bodies require that you take gains or losses due to fluctuating 
exchange rates into income (recognized) in the period in which they occur.

In Sage 300, exchange gains and losses are treated as permanent or temporary, depending on the 
exchange Gain/Loss Accounting Method specified for your Sage 300 system (in the company profile):

 l Recognized Gain or Loss. If you use this accounting method, revaluation transactions are 
considered permanent. In this accounting treatment, they are recognized immediately when you 
post them, and they are not reversed in the next period.

 l Realized and Unrealized Gain/Loss. If you use this accounting method, revaluation transactions 
are considered temporary, or unrealized, gains and losses. Therefore, they are posted to General 
Ledger as reversing transactions, meaning that General Ledger simultaneously posts reversing 
transactions to the first day of the next fiscal period following the revalued period. In this way, 
revaluation has no permanent effect on the general ledger.

Under this method, realized exchange gains or losses are calculated only when you post payments to 
pay invoices and debit notes, or when you post credit notes to pay down invoices.

Note: Rounding differences may occur during revaluation. These exchange differences are 
automatically posted to the exchange rounding account when payments are posted.

You do not post revaluation batches in Accounts Payable. If you do not have Sage 300 General Ledger in 
your company database, Accounts Payable creates an export batch for your general ledger. If you import 
a revaluation batch into another general ledger, make sure that the revaluation transactions are reversed 
in the next fiscal period.
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Revaluing Periods that Contain Backdated Documents

Sage 300 lets you post a multicurrency document that predates the last revaluation for the document 
currency, and it lets you apply the backdated document. An exchange gain or loss can arise.

The accounting method you use to record exchange gains and losses in your Sage 300 system 
determines how the revaluation process handles backdated documents:

 l Realized and Unrealized Gain/Loss. If you use this accounting method, you can revalue the 
backdated document by running the Revaluation program again for the period to which you posted 
the document (process a backdated revaluation). For this accounting method, if you rerun 
revaluation for a period that contains a backdated document, you must also rerun all subsequent 
revaluations.

 l Recognized Gain or Loss. If you use this accounting method, you can let the program automatically 
correct any exchange gains or losses for backdated documents and the documents to which they are 
applied.

To automatically correct these exchange gains or losses, enter or accept a date in the Earliest 
Backdated Activity Date field on the Revaluation screen.

You can also choose to ignore the backdated document, for example, if it is not material or if you posted 
it to a period that does not coincide with the end of a reporting period. If you do not want the program to 
revalue backdated documents and activity when you perform a backdated revaluation, leave the 
Earliest Backdated Activity Date field blank on the Revaluation screen.

The program adjusts exchange gains and losses for backdated documents and documents affected by 
backdated activity as of the balance sheet dates:

 l If the current revaluation date is on or after the last revaluation date and there is a 
backdated document (or a document affected by backdated activity), the program revalues 
the document and creates adjustments as of the current revaluation date. (The Earliest 
Backdated Activity Date field does not appear.)

 l If the current revaluation date predates the last revaluation date and you are revaluing a 
backdated document or a document affected by backdated activity, Revaluation:

 l Creates entries to recognize exchange gains or losses for backdated documents as 
of each revaluation date from the earliest backdated activity date to the last 
revaluation date.

 l Ignores any backdated documents with posting dates before the Earliest Backdated 
Activity Date.

 l If the revaluation occurs between the document date and settlement date, and the revaluation 
rate is different from the current rate for the settlement document, Revaluation creates 
adjustments to:
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 l Update the document’s functional balance (including discount and retainage 
balances) for the revalued period.

 l Correct any exchange gains and losses recognized at the time of settlement for the 
period from the revaluation date to the settlement date.

Revaluing Documents with a Multiple Payment Schedule

If you use the Recognized Gain/Loss accounting method, when you revalue a document that uses a 
multiple payment schedule, Revaluation revalues each portion of the invoice that is due and applies the 
sum of the net gains (or losses) to the document.

Revaluing Outstanding Retainage

If you use multicurrency, when you run Revaluation, the program also revalues amounts outstanding in 
the retainage control account.

For revalued outstanding retainage, the program creates general ledger entries to adjust the retainage 
control account rather than the payables control account.

If your Sage 300 system uses the Realized and Unrealized Gain/Loss accounting method to revalue 
multicurrency documents, the program also creates reversing entries for the next period. (You set the 
revaluation accounting method in the Company Profile, in Common Services.)

The Revaluation Posting Journal includes a separate section for retainage, following the current 
revaluation of documents for each vendor.

If you include job-related  details on the posting journal, a retainage section appears on the Summary 
page after the current job details.

Unrealized Gains and Losses

If your Sage 300 system uses the Realized and Unrealized Gain/Loss method to revalue multicurrency 
amounts, Accounts Payable calculates unrealized exchange gains or losses as follows:

Source amount x Revaluation rate

Less:

Functional amount

Equals

Unrealized gain (loss)

The revaluation transaction is reported on the Vendor Transactions report for the vendor as type GL.
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When you post the revaluation batch in General Ledger, the program also posts a reversing entry to the 
first day of the next fiscal period:

When you print the Vendor Transactions report for the period in which you post the reversing revaluation 
transaction, both transactions appear for the vendor. Their net effect on the account balance is zero.

About Exchange Gains and Losses on Settlement

When you apply multicurrency payments, credit notes, debit notes, or adjustments to another document, 
if the exchange rate used for the applied document is different from the current rate of the apply to 
document, Accounts Payable recognizes an exchange gain or loss, as follows:

Source amount x current rate of applied document

Less:

Source amount x current rate of apply-to document

Equals

Exchange gain (loss) or realized exchange gain (loss)

Note: If you use the Realized and Unrealized Exchange Gain/Loss method to record exchange gains 
and losses, any gains or losses arising from differences in exchange rates at the time of settlement are 
called “realized” gains or losses.

Revaluing Transactions in Other Currencies
When exchange rates fluctuate, you may need to revalue outstanding documents denominated in other 
currencies to reflect their present value in your own (functional) currency at a particular time, for example, 
at financial statement dates.

You use the A/P Revaluation screen to revalue transactions.

Before You Start

 l Post all outstanding multicurrency transactions and update currency information in Common 
Services.

 l Determine the currencies to revalue and the rates to use.
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To revalue transactions:

 1. Open Accounts Payable > A/P Periodic Processing > Revaluation.

 2. Indicate whether to do a provisional revaluation or an actual revaluation. More...

If you want to preview the revaluation transactions that will be created, select the Provisional 
Revaluation option.

If you do not select this option, Accounts Payable creates the transactions for the general ledger batch 
when you click Process.

 3. For each currency you want to revalue, use one line on the table to enter the following information:

 l Currency. Type the currency code for which you want to specify revaluation options, or 
choose it from the Finder. The revaluation process selects only transactions that are in the 
specified currency.

Note: You cannot specify the same currency code more than once for a single revaluation. If 
you want to revalue different ranges of records for the same currency code, you must revalue 
each range separately.

 l Revaluation date. Type the date of the end of the period you want to revalue (normally, the 
end of a reporting period).

The revaluation process selects open transactions with posting dates that are on or before the 
date you specify.

 l Earliest backdated activity date. This field is available only if you use the Recognized 
Gain/Loss accounting method for your Sage 300 system. It identifies the earliest backdated 
document to revalue, if there is a backdated transaction in the period you are revaluing.

 l Rate type. Type the rate type for selecting the currency table, or select a rate type from the 
Finder.

 l The revaluation process selects transactions only from specified vendor accounts that use 
the selected currency.

 l Rate date. Type the date to use to select the exchange rate at which to revalue transactions 
for the specified currency code.

 l Exchange rate. Type the rate at which to revalue transactions for the specified currency 
code.

 4. To change the optional fields and values for a particular line or to delete optional fields, either 
double-click in the Optional Fields column for the line or select the line, then click the Optional 
Fields column heading. More...

An Optional Fields screen opens, showing any revaluation optional fields set up for automatic insertion 
and their default values. You can edit the values for existing optional fields, or add or delete optional 
fields for the detail. However, you can add only optional fields that you set up for use in Revaluation.
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 5. Optionally, do a test run before performing the final step:

 a. Select the Provisional Revaluation option, if you did not select it earlier.

 b. Click Process.

 c. Print the Provisional Revaluation posting journal to list the transactions that would be 
created for the exchange gain and loss general ledger accounts. 

 d. Make any necessary changes to your selections and to currency rates.

 6. When you are satisfied with the results of the provisional revaluation, clear the Provisional 
Revaluation option, and then click Process to create the revaluation transactions.

After creating a revaluation batch

Post the revaluation batch in General Ledger.

About Year End Processing in Accounts Payable
At the end of each fiscal year, use the Year End screen to transfer current-year activity statistics for 
vendor groups and vendors to the previous year, in preparation for a new year. You may also want to 
follow the same procedures you use at the end of each period.

The Year End function performs the following tasks:

 l If you select the Reset All Batch Numbers option, Year End resets the next batch number to 1 for 
all batch types, and deletes all information for posted and deleted batches, so they no longer 
appear on the Batch Status report.

Note: After resetting batch numbers, you can no longer view transactions from the General Ledger 
Transactions screen.

 l Inserts the Average Days To Pay total from the year you are closing into the Average Days To Pay 
field for the previous year and into the Total Days To Pay field for the new year in vendor records.

 l Clears activity statistics, if you select the Clear Activity Statistics option. This step moves year-to-
date vendor activity statistics to last-year activity statistics, and sets year-to-date totals for the new 
year to zero. It also sets the largest invoice this year and the largest balance this year to zero.

 l Resets to 0 (zero) the Total Days To Pay on the Statistics tab of the Vendors and Vendor Groups 
screens, and resets the Total Invoices Paid and Number Of Checks on the Statistics tab of the 
Vendors screen (if you select both the Clear Activity Statistics option and the Clear Invoices Paid 
And Days to Pay Counter option).

 l If you select the Clear Total Recurring Payable Amount option, clears the total amount 
accumulated for each recurring payable, so that you can resume processing the payables in the 
new year.
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Starting a New Fiscal Year
Starting a new fiscal year requires that you close the current year, transferring current-year activity 
statistics for vendor groups and vendors to the previous year.

Note: You can use the Year End screen at any time of year if you just need to reset batch numbers or 
clear recurring-payable amounts. However, you must first complete all the steps listed in the “Before 
You Start” section.

Before You Start

For the year you are closing:

 l Post or delete all outstanding batches.

 l Print all unprinted posting journals to a file or a printer, then (optionally) use the A/P Clear History 
screen to clear the data for older posting journals.

 l Create all outstanding general ledger batches (if you do not use the option to create the batches 
during posting), then print the G/L Transactions report.

 l Close all other Sage 300 Accounts Payable screens, and ask other users to leave Accounts 
Payable.

To start a new fiscal year:

 1. Open Accounts Payable > A/P Periodic Processing > Year End.

 2. Select the options you want to include in year-end processing. More...

You can select:

 l Reset All Batch Numbers. Select this option if you want to start batch numbers at 1 again.

The option resets the batch numbers for all types of batches.

You can have up to 999,999,999 of each type of batch in Accounts Payable. You do not need to 
reset batch numbers, except to meet a particular requirement in your company.

 l Clear Activity Statistics.Select this option to enter zeros in the current-year fields on the Activity 
tabs in the A/P Vendors screen, and to transfer current-year statistical information to the 
corresponding fields for the previous year.

When you select this option, the Clear Invoices Paid And Days To Pay Counter option appears.
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 l Clear Total Recurring Payable Amounts. Select this option to set the Year To Date Total Invoice 
and Number Of Invoices to zero in all recurring-payable records.

 l Clear Invoices Paid And Days To Pay Counter.You see this option only if you select the Clear 
Activity Statistics option first.

Select this option if you want to enter 0 (zero) in the Total Invoices Paid and Total Days To Pay 
fields on the Activity tab in the A/P Vendors screen.

Do not select the option if you want to include previous-year documents in the numbers you use 
to calculate the entry in the Average Days To Pay field for the account.

Note: We recommend that you clear activity statistics and the Total Invoices Paid and Total Days To 
Pay totals only at the end of your fiscal year.

 3. Click Process.

 4. When finished, click Close.
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Chapter 5: Importing and Exporting 
Accounts Payable Data

You can import and export a variety of Accounts Payable records and transactions in a number of 
common formats.

Exporting Accounts Payable Information

To export Accounts Payable information:

 1. Open the screen that displays the kind of data that you want to export. (You can export setup 
records, vendor records, and transactions.)

 2. If necessary, use the screen to create or select the records you want to export. 

For example, to export an invoice batch, create the batch in the A/P Invoice Entry screen, or select an 
existing batch.

 3. Click File > Export.

 4. If the File Import/Export Selection screen appears, select the type of data to export, and then click OK.

Example: When you export vendor records, you use the File Import/Export Selection screen to 
specify Vendor, Statistics, or Comments.

 5. On the Export screen that appears (depending on the type of records you are exporting):

 a. In the Type field, specify the format in which to save the exported data.

 b. In the File field, specify the name and location for the export file, and then press Tab.

 c. Select the type of information to export. You can also:

 l Click Load Script to choose a template that specifies the information you want to 
export.

 l Click Set Criteria to limit the range of records to export using criteria.

 l Click File > Display Export Fields to view a list of fields you can export.

 6. If you frequently export information with these specifications, click Save Template to create an 
export template that you can use the next time you export this data.
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 7. When ready, click OK to begin exporting.

If you specified a folder and file that do not yet exist, Accounts Payable asks whether to create them.

Importing Information into Accounts Payable

Before You Start

Create a file that contains the data you want to import.

Tip: To see exactly how to format records for importing, we suggest that you first export records from 
the sample data that comes with Accounts Payable, specifying the format in which you plan to import.

To import account information or transactions:

 1. Open the Accounts Payable screen that contains the data you want to import. 

For example, to import vendor accounts, open the Vendors screen. To import invoices, open the A/P 
Invoice Entry screen.

 2. Click File > Import.

 3. If the File Import/Export Selection screen appears, select the type of data to import, and then click OK.

Example: When you import vendor records, you use the File Import/Export Selection screen to 
specify Vendor, Statistics, or Comments.

 4. On the Import screen that appears:

 a. In the Type field, specify the format of the data you are importing.

 b. Specify whether to insert new records, update existing records, or insert and update 
records.

 c. In the File field, specify the name and location of the import file, and then press Tab.

 d. If you previously created an import template that matches the information you want to import, 
click Load Script, and then select the template file.

Otherwise, select the type of information to import. 

Tip: You can click File > Display Import Fields to view a list of fields you can import.

 e. Select any other options that appear. 
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 5. Optionally, click Save Script to save your choices as a template for the next time you import these 
records.

 6. Click OK to begin importing.

Displaying a List of Fields You Can Import and Export
You can display and print lists of the fields you can import or export for most Sage 300 records, including 
transaction batches. The report also indicates key fields.

To display a list of the fields you can import and export:

 1. Open the record or transaction entry screen for the type of record or transaction you want to import 
or export.

 2. For transaction fields, display an existing batch using the Batch Number field.

 3. Click File > Import or Export.

 4. If a File Import/Export Selection screen appears (for example, if you clicked Import or Export on the 
Vendors screen), select the type of record to import or export, and then click OK.

 5. On the screen that appears, click File > Display Import Fields or Display Export Fields to display 
the name, type, and length of each field in the record that you can import or export.
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Chapter 6: Printing 
Accounts Payable Reports

Use Accounts Payable reports screens to print reports of Accounts Payable vendors, setup records, and 
transactions. 

 l Setup reports list the information entered to define your Accounts Payable system.

 l Vendor reports list information about your vendors and vendor groups, including lists and 
statistical reports for vendors and vendor groups, as well as letters, and labels that you print for 
your vendors.

 l Transaction reports provide you with transaction listings and status information, and reports that you 
can use to interpret, analyze, and summarize your data.

If you have a multicurrency ledger, some of these reports can also include source and functional-
currency (home-currency) information.

Accounts Payable provides numerous sorting and selecting options on a full range of reports, journals, 
and lists.

About Accounts Payable Reports
You can use Accounts Payable to produce a wide variety of reports which provide you with up-to-date 
information and a source of backup information in case your Accounts Payable data is damaged.

This section briefly describes the reports you can produce in Accounts Payable.

Printing Reports

You can print reports in the following ways:

 l Directly to a printer, to obtain permanent copies of the information.

 l To your screen, for quick review.

 l To a file for printing later, importing into another program, or transferring to external storage.

 l To an RTF file, which you can send as an e-mail attachment.
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Note: If you are using Seagate Info server software, you can print a report at a specific time and date 
and define the publishing format and destination.

Using a laser printer, you can print all Accounts Payable reports on 8½" by 11" or A4-sized paper.

On dot matrix printers all Accounts Payable reports are 132 characters (columns) wide.

Setup Reports

From the A/P Setup Reports folder, you can produce reports showing the information entered to define 
each of the records you create when setting up or updating your Accounts Payable system.

Any time you add, delete, or change any of these records, you should print and file the corresponding 
reports, to keep your printed records up to date.

Vendor Reports

From the A/P Vendor Reports folder, you can produce reports showing the information entered for your 
vendor records, including the lists and statistical reports for vendors and vendor groups. Reports you can 
print for your vendors also include the 1099/CPRS Amounts and Remit-To reports.

Whenever you change any of these records, you should print and file the corresponding reports, to keep 
your printed records up to date.

Transaction Reports

From the A/P Transaction Reports folder, you can produce a complete range of reports of your Accounts 
Payable transactions.

Many of these reports are important for maintaining your Accounts Payable audit trail, including the batch 
listings, posting journals, error reports, batch status reports, and the G/L Transactions report. You should 
regularly print these reports, check them carefully, and file them in a secure place.

Note: You must print the G/L Transactions report before you clear posting journals.

Accounts Payable also provides three important reports that you can use to interpret, analyze, and 
summarize your data:

 l Aged Cash Requirements. This report highlights the cash amounts that will be required to meet 
obligations as they become due, including the amount needed to pay invoices that are overdue, 
current, and due in each of four future periods you define. Use the report for cash flow analysis and 
projections.     
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You can print the report in detailed form, listing all outstanding documents for each vendor, or summary 
form, printing one line for each vendor number, including the overdue and current balances and the 
balances in each aging period.

 l Aged Payables. This report groups outstanding transactions into a current period and four aging 
periods by document date or due date. Use the report to analyze your payables.     

You can print the report in detailed form, listing all outstanding documents for each vendor, or in 
summary form, printing one line for each vendor number, including the current balance and the balance 
in each aging period.

 l Vendor Transactions. This report serves as an audit trail of posted transactions in your vendor 
accounts, within the range of dates you specify. Use the report to obtain an overview of your 
vendor accounts in any period for which you have Accounts Payable data.     

You can report the details of any combination of invoices, debit notes, credit notes, and prepayments. 
You can also choose to include zero balances and applied details, and print a total for each transaction 
type.

If you use multicurrency accounting, you can also print the report in functional currency or in the 
vendors’ currencies.

About Print Destinations
There are several ways to print reports in Sage 300, depending on your needs. Before you print, you can 
select a print destination to:

 l Print to a physical printer, to create permanent copies of the information.

 l Print to a preview on your screen, for quick review.

 l Print to a file that you can save, print later, import into another program, or transfer to other 
electronic media.

 l Print to e-mail, to send a report as an e-mail attachment.

Note: To change the print destination for screens and reports, you must have Change Print Destination 
security authorization for Administrative Services.

You select print destinations from the Sage 300 desktop. For more information, see "Selecting a Print 
Destination" (page 222).

Important! When you print to any destination, the report’s status is updated to Printed.
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Tips: 
If you use Preview as your print destination, you can print or export the report from the preview screen 
in the following ways:

 l To print the report on your printer, click Print  on the SAP Crystal Reports® menu bar.

 l To export the report to a file, click Export  on the SAP Crystal Reports® menu bar. (You can 
select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

Selecting a Print Destination

You can print reports to a printer, to the screen, to a file, or as an attachment to an e-mail message.

Note: If you are not assigned to a security group that has authorization to change the print destination, 
the only destination available is a physical printer.

To select a print destination:

 1. On the Sage 300 Desktop, click Print Destination.

 2. Select a print destination:

 l Printer. Print to a physical printer. More...

Note: If you have multiple printers, you can specify the one to use when you print. For more 
information, see "Selecting a Printer for Reports" (page 223).

Tip: If you want to confirm the destination printer, page size, and orientation each time you print 
a report, on the Desktop, click View > Print Preferences, and then select Confirm on print.

 l Preview. Display reports in a preview screen. More...

Note: From the preview screen, you can do things such as saving the report to a file, or printing 
the report to a physical printer.

 l File. Print to a file. More...

When you print, you specify details about the file to create, including:

 l Format (for example, PDF, DOC, or XLS).

 l Destination.

 l Name.

 l Location.

222Sage 300 2023 Accounts Payable User's Guide



 l E-mail. Print reports as attachments to e-mail messages. More...

You specify the type of file to create:

 l Adobe Acrobat (PDF). You can open PDF files with Adobe Acrobat Reader (available 
as a free download from the Adobe Software website).

 l Rich Text Format (RTF). You can open RTF files with most Windows and Linux word 
processing programs.

When you print a report, Sage 300 creates a PDF or RTF version of the report and attaches the 
report file to a new e-mail message.

 3. Click OK.

Selecting a Printer for Reports

When your print destination is Printer, Sage 300 prints reports to the Windows default printer, unless you 
have assigned a specific printer to a report.

The ability to assign different printers to different reports at print time means that you are not limited to 
printing to the default printer. For example, you can use a different printer to print item labels than you use 
to print inventory worksheets.

To assign a specific report to a specific printer:

 1. Open the report screen that you want to assign to a printer.

 2. On the report screen, click File > Print Setup.

The program displays the Windows default printer, but you can change the printer for a specific report.

 3. Select the Specific Printer option, and then select from the list the printer to use for this report.

The printer list includes all printers that have been added to the Printers and Faxes list in Windows.

 4. Select a paper source if you want to use a particular paper tray or paper stock for this report.

 5. Click OK to close the Print Setup screen.

To clear the assigned printer for a specific report:

 1. On the Sage 300 Desktop, do one of the following:

 l Select (highlight) the icon for the report, and then click Object > Restore Defaults.

 l Right-click the icon for the report, and then click Restore Defaults on the list that appears.

 2. In the Restore Defaults screen, select the Print Settings option, and then click OK.

The print setup for that report is reverted to the desktop default.
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To have the program prompt you to specify a printer and print options each time you 
print:

On the Sage 300 Desktop, click View > Print Preferences, and then select Confirm on print.

Printing Tips
You can select a print destination for a report that is different from the default print destination, and you 
can save personalized settings for printing certain reports in Accounts Payable.

Report Printing Options

You can print Sage 300 data in a variety of reports to view key information. Printed reports also serve as a 
source of backup information in case your data is damaged on your computer.

Sage 300 provides four destinations for printing reports. You can:

 l Print to a physical printer, to create permanent copies of the information.

 l Print to a preview on your screen, for quick review.

 l Print to a file that you can save, print later, import into another program, or transfer to other 
electronic media.

 l Print to e-mail, to send a report as an e-mail attachment.

For instructions on specifying the print destination for Sage 300 reports, see "Selecting a Print Destination" 
(page 222).

If you print reports to a physical printer, you can also specify a particular printer to use for printing a 
report. For instructions, see "Selecting a Printer for Reports" (page 223).

Saving Default Report Settings

Sage 300 lets you save report settings as defaults for printing certain Accounts Payable reports, including 
Aged Payables, Aged Cash Requirements, Aged Retainage, Vendors, and Vendor Transactions reports, 
as well as Letters and Labels.

To save current settings as defaults:

 1. Open the Accounts Payable report screen for which you want to save printing settings.

 2. Select the default settings to use whenever you print this report.

 3. On the menu, click Settings > Save Settings As Defaults.
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To clear saved settings:

 1. Open the Accounts Payable report screen for which you want to reset printing settings.

 2. On the menu, click Settings > Clear Saved Settings.

Printing Setup Reports
Use the screens in the A/P Setup Reports folder to print reports of:

 l The options you selected, data you entered, and records you added to set up your Accounts 
Payable system.

 l Records you revised.

 l Vendor and vendor group statistics.

Printing the 1099/CPRS Codes Report

The 1099/CPRS Codes report lists the code and description for each 1099/CPRS code entered in your 
Accounts Payable system.

For information on the contents of this report, see "A/P 1099/CPRS Codes Report Screen" (page 368).

When to Print

Print 1099/CPRS reports at the end of each calendar year, after you have entered all transactions for the 
calendar year.

To print the report:

 1. Open Accounts Payable > A/P Setup Reports > 1099/CPRS Codes.

 2. Specify the range of 1099/CPRS codes to include in the report. The default range includes all 
1099/CPRS codes.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.
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 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Account Sets Report

This report lists the account sets defined for your Accounts Payable system. Print the report when you 
add, change, or delete account sets.

For information on the contents of this report, see "A/P Account Sets Report Screen" (page 360).

When to Print

Print the report when you add, change, or delete account sets.

To print the Account Sets report

 1. Open Accounts Payable > A/P Setup Reports >        Account Sets.

 2. Select the range of account sets to include in the report. The default range includes all account 
sets.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:
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 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Distribution Codes Report

The Distribution Codes report lists the descriptions and numbers of the general ledger accounts used in 
the distribution codes in your Accounts Payable system.

For information on the contents of this report, see "A/P Distribution Codes Report Screen" (page 361).

When to Print

Print the report when you add, change, or delete distribution codes.

To print the Distribution Codes report

 1. Open Accounts Payable > A/P Setup Reports >        Distribution Codes.

 2. Select a range of distribution codes. The default range includes all distribution codes.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.
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You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Distribution Sets Report

The Distribution Sets report lists the distribution methods and distribution codes specified for the 
distribution sets you use to allocate purchase amounts in your Accounts Payable system.

For information on the contents of this report, see "A/P Distribution Sets Report Screen" (page 362).

When to Print

Print the report when you add, change, or delete distribution sets.

To print the Distribution Sets report:

 1. Open Accounts Payable > A/P Setup Reports >        Distribution Sets.

 2. Select a range of distribution sets to include. The default range includes all distribution sets.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the E-mail Messages Report

The E-mail Messages report lists all the messages you created to send to vendors with e-mailed letters.

For more information on the contents of this report, see "A/P E-mail Messages Report Screen" (page 363).

When to Print

Print the report when you add, change, or delete e-mail messages.

When to Print

To print the E-mail messages report:

 1. Open Accounts Payable > A/P Setup Reports >        E-mail Messages.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the G/L Integration Report

The G/L Integration report lists the options and other information entered on the G/L Integration screen 
that determine how your Accounts Payable system interacts with General Ledger.

For more information on the contents of this report, see "A/P G/L Integration Report Screen" (page 364).
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When to Print

Print the report when you change the G/L Integration options for Accounts Payable.

Before You Start

 l If necessary, set up printing destinations, and turn on and connect the printer.

To print the G/L Integration report:

 1. Open Accounts Payable > A/P Setup Reports > G/L Integration.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Optional Fields Report

You print the Optional Fields report whenever you need a listing of all the optional fields set up for 
Accounts Payable.

For information on the contents of this report, see "A/P Optional Fields Report Screen" (page 364).

When to Print

Print the report when you add, change, or delete optional field records.
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To print the Optional Fields report:

 1. Open Accounts Payable > A/P Setup Reports > Optional Fields.

 2. Select Show Settings if you want to list the G/L accounts associated with transaction detail 
optional fields.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/P Options Report

The Options report lists the options selected and other information entered on the A/P Options screen to 
specify how your Accounts Payable system operates.

For information on the contents of this report, see "A/P Options Report Screen" (page 365).

When to Print

Print the report when you change option selections.

To print the report:

 1. Open Accounts Payable > A/P Setup Reports >        Options.

 2. Click Print.
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 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Payment Codes Report

The Payment Codes report lists the codes, descriptions, and methods of payment used in your Accounts 
Payable system.

For information on the contents of this report, see "A/P Payment Codes Report Screen" (page 366).

When to Print

Print the report when you add, change, or delete payment codes.

To print the report:

 1. Open Accounts Payable > A/P Setup Reports > Payment Codes.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     
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Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Payment Selection Codes Report

The Payment Selection Codes report lists the bank and currency codes, selection criteria, and exclusion 
criteria defined for the payment selection codes used to create payment batches in your Accounts 
Payable system.

For more information on the contents of this report, see "A/P Payment Selection Codes Report Screen" 
(page 367).

When to Print

Print the report when you add, change, or delete payment selection codes.

To print the Payment Selection Codes report:

 1. Open Accounts Payable > A/P Setup Reports > Payment Selection Codes.

 2. Specify the range of payment selection codes to include on the report. The default range includes 
all payment selection codes.

 3. Select the Optional Fields check box if you want to include optional fields associated with each 
payment selection code.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     
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Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Terms Report

The Terms report lists the information entered to define each terms code, including multiple payment 
schedules and due date and discount date tables, when used.

For information on the contents of this report, see "A/P Terms Report Screen" (page 367).

When to Print

Print the report when you add, change, or delete terms codes.

To print the Terms report:

 1. Open Accounts Payable > A/P Setup Reports > Terms.

 2. Select the range of terms codes that you want to print.

 3. Select Include Multiple Payment Schedules if you want to print schedules for terms codes that 
use them.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.
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 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Transactions Reports
Use the screens in the A/P Transaction Reports folder to print a variety of transaction reports to maintain 
your audit trail and to analyze Accounts Payable data.

Printing the Aged Cash Requirements Report

The Aged Cash Requirements report highlights the cash amounts that will be required to meet 
obligations as they become due, including the amount needed to pay invoices that are overdue, current, 
and due in each of four future periods you define. Use the report for cash flow analysis and projections.

For information on the contents of this report, see "A/P Aged Cash Requirements Report Screen" (page 
456).

When to Print

Print the Aged Cash Requirements report when you need a listing of the amounts owed and when they 
are due, to assist you with cash-flow management, short-term planning, and budgeting.

To print the Aged Cash Requirements report:

 1. Open Accounts Payable > A/P Transaction Reports >        Aged Cash Requirements.

 2. Select from the following report options:

 l Age By. You can age outstanding documents or balances by their due dates or document 
dates.

 l Age As Of. Specify the date on which to report the payables. Accounts Payable uses this date to 
assign transactions to aging periods.
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For example, if you print the report aged by due date, the program assigns each transaction to an 
aging period by calculating the number of days between its due date and the Age As Of date.

 l Cutoff By. The report includes only transactions that have a document date that is on or before 
the cutoff date you specify. More...

There are three methods for selecting a cutoff date:

 l Document Date. Select this option if you want to include documents based on their 
document date (regardless of the fiscal period to which you assigned them), and then 
enter a date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, 
regardless of date.

 l Posting Date. Select this option if you want to include documents based on their 
posting date, and then enter a date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, 
regardless of date.

 l Year/Period. Select this option if you want to include all transactions up to the end of a 
fiscal period, which you then specify in the Year/Period field.

 l Print Transactions In. Indicate whether to print a summary or detailed report, and whether to 
print the detailed version of the report with transactions ordered by document date (Detail by 
Date) or by document number (Detail by Document).

 l Sort Transactions by Transaction Type. Select this option if you want sort transactions by 
document type for each vendor on the report.

 l Use Aging Periods. The aging periods defined on the A/P Options screen appear as defaults, but 
you can assign different periods for this report. 

The aging periods are used to group transactions by the future dates at which they will become 
due, rather than by the amount of time they are overdue. All overdue amounts appear in the 
Overdue column on the report.

 l Select Vendors By. Specify up to four criteria to select the vendor accounts to list on the report. More...

For the first selection criterion, you can select Vendor Number, Vendor Group, or Short Name.

For the remaining three selection criteria, you can also choose from:

 l Account Set.

 l Vendor Balance.

 l Vendor Equivalent Balance. (multicurrency ledgers only)
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 l Vendor Name.

 l Currency Code. (multicurrency ledgers only)

 l Start Date.

 l Vendor optional fields, if any.

If you do not specify selection criteria, the report includes all vendor records.

 l Sort Vendors By. Specify up to four sort orders by which to organize records on the report. More...

If you specify Vendor Group, Account Set, or a vendor optional field as the sorting criteria in a 
single currency ledger, or Account Set in a multicurrency ledger, an additional subtotal line 
appears at the bottom of your report.

If you want to include subtotals (for a single currency company) or subtotals by currency (for a 
multicurrency company), select Vendor Group or Account Set as the primary sort order.

If you do not specify sorting criteria, the report orders the records by vendor number.

 l Title. If you want to include a title for each sorted group, select the Title check box for each 
group of records you are sorting by.   

 l Total. If you want to include subtotals for each sorted group, select the Total check box for 
the groups of records you are sorting by.

 l [Include] Contact/Phone/Credit. Select this option if you want to list the vendor's contact 
person and phone number and your credit limit for the vendor.

 l [Include] Space For Comments. Select this option if you want to leave blank space at the 
end of each vendor record for your notes.

 l [Include] Vendors/Transactions on Hold. Choose this option to include vendors that you 
have placed on hold in the Vendors screen, and transactions that you have placed on hold in 
the Control Payments folder.

 l [Include] All Available Discounts. Select this option if you want the program to calculate 
amounts owing by taking advantage of all available discounts.

 l Select Transaction Types. Select the types of transactions to include on the report. You can 
include any or all of the transaction types listed. 

Note: If you clear the Adjustments check box, adjustments can still appear as applied details 
on the documents that payment was applied to. If you select the Adjustments check box, 
adjustments can appear as both applied details and regular documents.

 l [Show] Applied Details. Select this option if you want to include all the documents such as 
payments and credit notes that were applied to each reported invoice. If you do not select 
this option, the report shows only the balance owing for each outstanding document.
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 l [Show] Fully Paid Transactions. Select this option if you want to list documents that are fully 
paid, but not yet cleared from Accounts Payable.

 l [Show] Aged Retainage. Select this option if you want to include retainage documents with taxes 
on the report. 

This option is not available if you are aging documents by document date.

 l Print Amounts In. Use this option to select the currency for the report. You can list 
transaction amounts in the vendor currency or the functional currency.

 l If you list transactions in the functional currency, and you have performed a revaluation, the 
report shows the new functional amounts.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Aged Payables Report

The Aged Payables report groups outstanding transactions into a current period and four aging periods 
by document date or due date. Use the report to analyze your payables.

For information on the contents of this report, see "A/P Aged Payables Report Screen" (page 458).
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When to Print

Print the Aged Payables report when you need a listing of the status of your payables on a given date, 
such as at the end of a fiscal year or period.

To print the Aged Payables report:

 1. Open Accounts Payable > A/P Transaction Reports >        Aged Payables.

 2. In the Report Type field, select Aged Payables By Due Date or Aged Payables By Document 
Date to age balances or documents.

 3. In the Age As Of field, specify the date on which to report the payables. 

Accounts Payable uses this date to assign transactions to aging periods. For example, if you print the 
report aged by due date, the program assigns each transaction to an aging period by calculating the 
number of days between its due date and the Age As Of date.

 4. In the Cutoff By field, specify the type of date by which to evaluate transactions for inclusion on the 
report, and then, in the Cutoff Date field, specify the latest date a transaction can have to be included 
on the report. (The report includes only transactions that have a date that is on or before this date.) More...

There are three methods for selecting a cutoff date:

 l Document Date. Select this option if you want to include documents based on their 
document date (regardless of the fiscal period to which you assigned them), and then enter a 
date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, regardless of 
date.

 l Posting Date. Select this option if you want to include documents based on their posting 
date, and then enter a date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, regardless of 
date.

 l Year/Period. Select this option if you want to include all transactions up to the end of a fiscal 
period, which you then specify in the Year/Period field.

 5. Select from the following options:

 l Print Transactions In. Indicate whether to print a summary or detailed report, and whether to 
print the detailed version of the report by document date (Detail by Date) or by document 
number (Detail by Document).

 l Sort Transactions by Transaction Type. Select this option if you want to sort transactions 
by document type for each vendor on the report.
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 l Use Aging Periods. The aging periods defined on the A/P Options screen appear, but you 
can assign different periods for this report.

 l Select Vendors By. Specify up to four criteria to select the vendor accounts to list on the report. More...

For the first selection criterion, you can choose from Vendor Number, Vendor Group, or Short 
Name.

For the remaining three selection criteria, you can also choose:

 l Account Set.

 l Vendor Balance.

 l Vendor Equivalent Balance. (multicurrency ledgers only)

 l Vendor Name.

 l Currency Code. (multicurrency ledgers only)

 l Start Date.

 l Vendor optional fields, if you use optional fields

If you do not specify selection criteria, the report includes all vendor records that meet the other 
criteria you select in this folder (for example, all vendors that have transactions on or before the 
cutoff date).

 l Sort Vendors By. Specify up to four orders by which to sort records for the report. More...

You can choose from:

 l Vendor Group.

 l Account Set.

 l Vendor Balance.

 l Vendor Equivalent Balance. (multicurrency ledgers only)

 l Vendor Name.

 l Short Name.

 l Currency Code. (multicurrency ledgers only)

 l Start Date.

 l A vendor optional field.

If you specify Vendor Group, Account Set, or a vendor optional field as the sorting criteria in a 
single currency ledger, or Account Set in a multicurrency ledger, an additional subtotal line 
appears at the bottom of your report.
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If you do not specify sorting criteria, the report orders the records by vendor number.

 l Show Group Title. If you want to include a title for each sorted group, select the Title check 
box for each group of records you are sorting by.

 l Show Group Subtotal. If you want to include subtotals for each sorted group, select the 
Show Group Subtotal option for groups of records you are sorting by.

 l [Include] Contact/Phone/Credit. Select this option if you want to list the vendor's contact 
person and phone number, and your credit limit for the vendor.

 l [Include] Space for Comments. Select this option to leave blank space at the end of each 
vendor record for your notes.

 l [Include] Vendors With A Zero Balance. Select this option to include vendors with zero 
balances.

 l [Include] Vendors/Transactions on Hold. Select this option to include vendors that are 
placed on hold in the Vendors screen, and transactions that you have placed on hold in the 
Control Payments screen.

 l Select Transaction Types. Select the types of transactions to include on the report. You can 
include any or all of the transaction types listed. 

Note: If you clear the Adjustments check box, adjustments can still appear as applied details 
on the documents that payment was applied to. If you select the Adjustments check box, 
adjustments can appear as both applied details and regular documents.

 l Applied Details. Select this option to include all the documents such as payments and credit 
notes that were applied to each reported invoice. If you do not select this option, the report 
shows only the balance owing for each outstanding document.

 l [Show] Fully Paid Transactions. Select this option to list documents that are fully paid, but 
not yet cleared from Accounts Payable.

 l [Show] Aged Retainage. Select this option to include retainage documents with taxes on the 
report. 

This option is not available if you are aging documents by document date.

 l Print Amounts In. Use this option to select the currency for the report. You can list transaction 
amounts in the vendor currency or the functional currency.

Note: If you list transactions in the functional currency, and you have performed a revaluation, 
the report shows the new functional amounts.

 6. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
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Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Aged Retainage Report

The Aged Retainage report groups outstanding retainage amounts by due date into a current period and 
four aging periods.

For information on the contents of this report, see "A/P Aged Retainage Report Screen" (page 459).

When to Print

Print the report when you need to review retainage that is due to vendors, such as at the end of a fiscal 
year or period.

To print the report:

 1. Open Accounts Payable > A/P Transaction Reports >        Aged Retainage.

 2. In the Report Type field, specify a type as follows:

 l Select Aged Retainage By Due Date to print a report that shows all outstanding retainage 
amounts that are due for each aging period, including Future and Current.

Outstanding retainage amounts are grouped according to the dates on which they become due.

Note: For job-related  documents, if one of the document details becomes due in a future 
period, the outstanding retainage amount for that detail appears in the Future period.
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 l Select Future Retainage By Due Date to print a report that shows outstanding retainage 
amounts that will become due in future aging periods, beginning with the Age As Of date.

Outstanding retainage amounts are grouped according to the future dates at which they will 
become due.

 l Select Overdue Retainage By Due Date to print a report that shows only outstanding retainage 
amounts that became overdue in each aging period.

Overdue outstanding retainage amounts are grouped according to the dates on which they 
became due.

 3. Select the remaining report options as follows:

 l Age As Of. Specify the date on which to report the retainage. The program uses this date to 
assign retainage to an aging period by calculating the number of days between its due date 
and the date entered in the Age As Of field.

 l Cutoff By. The report includes only those transactions or balances that have a due date before or 
on the cutoff date you specify. More...

There are three methods for selecting a cutoff date:

 l Document Date. Select this option if you want to include documents based on their 
document date (regardless of the fiscal period to which you assigned them), and then 
enter a date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, 
regardless of date.

 l Posting Date. Select this option if you want to include documents based on their 
posting date, and then enter a date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, 
regardless of date.

 l Year/Period. Select this option if you want to include all transactions up to the end of a 
fiscal period, which you then specify in the Year/Period field.

 l Print Transactions In. Indicate whether to print a summary or a detailed report, and whether 
to print the detailed version of the report by document date (Detail By Document Date), by 
due date (Detail By Retainage Due Date), or by document number (Detail By Document).

 l Use Aging Periods. Accounts Payable uses aging periods to group outstanding retainage 
amounts. 

The aging periods defined on the A/P Options screen appear as defaults, but you can assign 
different periods for this report.
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 l Select Vendors By. Specify up to four criteria to select the vendor accounts to list on the report. More...

For the first selection criterion, choose from Vendor Number, Vendor Group, or Short Name.

For the remaining three selection criteria choose from the above, and:

 l Account Set.

 l Vendor Balance.

 l Vendor Equivalent Balance. (multicurrency ledgers only)

 l Vendor Name.

 l Currency Code. (multicurrency ledgers only)

 l Start Date.

 l Vendor optional fields, if you use optional fields

If you do not specify selection criteria, the report includes amounts for all vendors that use the 
account type you select.

 l Sort Vendors By. You can choose up to four orders by which to list (sort) records for the 
report. If you do not specify sorting criteria, the report orders the records by vendor number.

 l Title. If you want to include a title for each sorted group, select this option for each group of 
records you are sorting by.   

 l Total. If you want to include subtotals for each sorted group, select the this option for each 
group of records you are sorting by.

 l Include Taxes. Select this option to include tax information on the report.

 l Print Amounts In. Use this option to select the currency for the report. You can list transaction 
amounts in the vendor currency or the functional currency.

If you list transactions in the functional currency, and you have performed a revaluation, the report 
shows the new functional amounts.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.
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 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Batch Listings

A batch listing is the printed record of the transactions in a batch.

You can print batch listings for invoice, payment, and adjustment batches that have been entered, 
imported, generated, or posted.

Note: 
 l You cannot print batch listings for deleted or posted batches.

 l The invoice batch listing includes debit notes and credit notes, as well as interest invoices.

 l Printing batch listings is optional, unless the Force Listing Of All Batches option is selected on 
the A/P Options screen.

For information on the contents of this report, see "A/P Batch Listing Screen" (page 460).

When to Print

You should print batch listings for your audit trail records after entering, importing, generating, or editing a 
batch, at any time before the batch is posted. 

Important! When you print to any print destination, including Preview, Accounts Payable changes the 
batch print status to Printed. Be sure to print the batch listing to a printer or a file before posting, even if 
the Force Listing Of Batches option is selected on the A/P Options screen.
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To print batch listings:

 1. Open Accounts Payable > A/P Transaction Reports >        Batch Listing.

Tip: 
You can also open the Batch Listing screen by:

 l Clicking the Print button on the Batch List screen.

 l Clicking File > Print Batch Listing Report on any transaction entry screen.

 2. Select the type of batch for which you are printing listings (invoice, Payment, or Adjustment).

Note: You do not print payment or adjustment batch listings for an Intercompany Transactions 
company.

 3. Use the From and ToBatch Number fields to specify the range of batch numbers to include in the 
batch listing.

 4. Use the From and ToBatch Date fields to specify the range of batch creation dates.

The default range includes all batches from the beginning of the current fiscal year to the session date.

 5. Select any optional information you want to include, as follows:

 l .Reprint Previously Printed Batches.

 l Show Comments.

 l Show Schedules. Select this option to include multiple payment schedules on invoice batch 
listings.

 l Show Tax Details. Select this option to include tax details on invoice batch listings.

 l Show Adjustment Details. Select this option to include details of adjustments posted with 
payments and an adjustment summary.

Note: This option appears only for payment batch listings, and it is not available for an 
Intercompany Transactions company.

 l Show Job Details. Select this option to include the contract, project, category, resource, applied 
amount, and discount taken for each job-related  detail, and to print a summary by contract. 

Note: This option appears only if you use Sage 300 and Job Costing, and it is not available for 
an Intercompany Transactions company.

 l Show Optional Fields. Select this option to include optional field information included with 
transactions.
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Note: This option appears only if you use Sage 300 Transaction Analysis and Optional Field 
Creator.

 6. Select the types of batches to print. You can choose:

 l Entered. These are batches created in Accounts Payable.

 l Imported. These are batches transferred to Accounts Payable using the File > Import (batch) 
command on transaction entry screens. More...

They can be batches created by Sage 300 Accounts Payable at another location, or by a non-
Sage 300 program. They could also be recurring batches that you created in your own Accounts 
Payable ledger, and then exported for later use.

 l Generated. These are batches created in Accounts Payable, such as transactions that were 
rejected during posting.

 l Recurring. If you are printing invoice batches, you can also print listings of the batches created 
using the Create Recurring Payable Batch screen. 

Note: This option is not available for an Intercompany Transactions company.

 l External. These are batches that you create in other Sage 300 programs, then send to 
Accounts Payable (for example, invoice batches that you generate in Purchase Orders).

 l System. These are payment batches created using the Create Payment Batch screen.

Note: This option is not available for an Intercompany Transactions company.

 l Retainage. These are batches that you create to clear outstanding retainage.

Note: This option appears only if you use retainage accounting, and it is not available for an 
Intercompany Transactions company.

 7. Select the statuses of batches to print. You can choose:

 l Open. These are unlisted batches, or edited batches that have not been relisted.

 l Ready To Post. These are completed batches that have been marked Ready To Post.

 l Posted. These are batches that have been posted.

 8. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

247Sage 300 2023 Accounts Payable User's Guide



 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

After printing batch listings

 l Verify the contents, correct any errors in the batches, and reprint the edited batches.

 l File the batch listings with your other audit trail records.

 l Post the batches.

Printing the Batch Status Report

The Batch Status report describes all unposted invoice, payment, or adjustment batches, and posted or 
deleted batches for which the information has not yet been cleared from Accounts Payable. It is a 
valuable management tool for tracking batches, particularly when several operators are entering batches 
on a multi-user system.

For information on the contents of this report, see "A/P Batch Status Report Screen" (page 463).

When to Print

Print the report when you need batch information, and before clearing batch status information (details of 
posted and deleted batches). 

Tip: You clear information about printed posting journals and deleted and posted batches using the 
A/P Clear History screen.
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To print the Batch Status report:

 1. Open Accounts Payable > A/P Transaction Reports >        Batch Status.

 2. Select the batch type for which you want to print the report (invoice, Payment, or Adjustment).

Note: You do not print payment or adjustment batch listings for an Intercompany Transactions 
company.

 3. Use the From and ToBatch Number fields to specify the range of batch numbers to include in the 
report.

 4. Use the From and ToBatch Date fields to specify the range of batch creation dates.

The default range includes all batches from the beginning of the current fiscal year to the session date.

 5. Select the types of batches to print. You can choose:

 l Entered. These are batches created in Accounts Payable.

 l Imported. These are batches transferred to Accounts Payable using the File > Import (batch) 
command on transaction entry screens. More...

They can be batches created by Sage 300 Accounts Payable at another location, or by a non-
Sage 300 program. They could also be recurring batches that you created in your own Accounts 
Payable ledger, and then exported for later use.

 l Generated. These are batches created in Accounts Payable, such as transactions that were 
rejected during posting.

 l Recurring. If you are printing invoice batches, you can also print listings of the batches created 
using the Create Recurring Payable Batch screen. 

Note: This option is not available for an Intercompany Transactions company.

 l External. These are batches that you create in other Sage 300 programs, then send to 
Accounts Payable (for example, invoice batches that you generate in Purchase Orders).

 l System. These are payment batches created using the Create Payment Batch screen.

Note: This option is not available for an Intercompany Transactions company.

 l Retainage. These are batches that you create to clear outstanding retainage.

Note: This option appears only if you use retainage accounting, and it is not available for an 
Intercompany Transactions company.

 6. Select the statuses of batches to print. You must select at least one of the following statuses:
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 l Open. These are unlisted batches, or edited batches that have not been relisted.

 l Deleted.You can select this option to include deleted batches that you have not yet cleared 
from Accounts Payable.

 l Ready To Post. These are completed batches that have been marked Ready To Post.

 l Posted. These are batches that have been posted.

 l Post In Progress. These are batches for which posting has begun. You cannot edit or print 
the batch.

 l Check Creation In Progress. When you print the report for payment batches, you can select 
this status.

 7. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing a Check Register

The Create Payment Batch screen provides a Pre-Check Register that lets you preview the payment 
transactions that will be created using the current selection criteria when you generate a payment batch.

Important! You should always print a Pre-Check Register, so you do not get unexpected results when 
you generate the batch.

The Check Register report lists details of checks that are produced and posted to vendor accounts during 
a check run. It can also list a summary of the general ledger distributions that result.

250Sage 300 2023 Accounts Payable User's Guide



Checks that are used for alignment or leading, as well as checks that are voided before posting, are not 
included on this report because they do not result in the creation of general ledger distributions or 
changes to vendor account balances. These checks are listed on the Check Status report in Bank 
Services.

For more information on the contents of this report, see "A/P Check Register Screen" (page 464).

When to Print

Print the report after posting a check run, as part of your audit trail of payments made during the check 
run.

To print a check register:

 1. Open Accounts Payable > A/P Transaction Reports >        Check Register.

 2. Select a range of posting sequences.

 3. Indicate whether to print a summary of the general ledger transactions created for the payments.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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After printing a check register

File the report with the rest of your audit trail reports.

Printing a Single Check When You Pay a Vendor

You can print a check for a single payment or prepayment when you enter the transaction using the 
A/P Payment Entry screen or the A/P Invoice Entry screen.

You can also print all the checks in a payment batch together using the A/P Payment Batch List screen or 
the A/P Invoice Entry screen. For more information, see "Printing Checks for a Batch of Payments" (page 
255).

You can print checks and advices on different types of check stock, including forms that include an advice 
slip listing the details of the payment. For information about the check and advice formats that come with 
Accounts Payable, see "About Printing Checks" (page 136).

You can print checks while other users are printing checks, provided the check runs are for different 
payment batches.

Notes: 
 l You cannot reprint a check after the check information has been posted to Bank Services.

 l If you delete a payment from the payment batch after you print the check, Accounts Payable 
changes the status of the check to Void in Bank Services.

 l You can delete payments (void checks) until you post the batch. 

 l Deleted checks do not appear on the Accounts Payable Check Register.

When to Print

Use the A/P Payment Entry screen or the  A/P Invoice Entry screen to print a check for a payment or a 
prepayment when you enter the payment or prepayment.

Before You Start

 l Adapt the layout of the check forms shipped with Accounts Payable to match your checks. (You 
use Crystal Reports to customize printed forms for Accounts Payable.)

 l Determine the report format to use to print the check and/or advice. 

 l In Bank Services, select the check form and enter the next check number for the payment bank. 
For more information, see the Tax and Bank Services Help.

 l Use the A/P Payment Entry screen to enter the payments for which you want to print checks.
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You can use the  A/P Invoice Entry screen to enter prepayments when you enter invoices.

Important! Specify a payment code that uses a Check payment type, and select the Print Check 
option for the payments.

 l On the Sage 300 desktop, set the print destination to Printer.

 l Load your printer with sufficient check/advice stock to print the check and any alignment and 
leading checks.

To print a check for a prepayment you enter using the Invoice Entry screen:

 1. Open Accounts Payable > A/P Transactions > Invoice Entry.

 2. Display the invoice that you are prepaying, or add the invoice, as usual.

Note: If you are entering a new invoice, you must click Add after entering all the invoice information

 3. Click Prepay.

 4. On the Prepayments screen, select the payment batch and the payment, or enter a new payment, as 
usual.

Note: If you are entering a new prepayment, you must click Add after entering all the payment 
information

 5. Make sure that the Print Check option is selected for the payment.

 6. Click Print Check to display the Print Checks screen.

 7. Continue at step 5 of the following instructions for printing a check from the Payment Entry screen.

To print a check for a payment or a prepayment when you enter it on the Payment 
Entry screen:

 1. Open Accounts Payable > A/P Transactions > Payment Entry.

 2. Display the payment for which you want to print a check, or enter a new payment, as usual.

 3. Make sure that the Print Check option is selected for the payment.

 4. Click Print Check to display the Print Checks screen.

 5. On the Print Checks screen, review the settings and the list of checks the program is ready to print. More...

You can change the following items if they are not correct:

 l Check stock. The check stock is set in Bank Services, but you can change it, if necessary.

 l Next check number.
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 l Number of leading checks. Although nothing is printed on the leading checks, Bank Services 
needs this information to assign check numbers to the blank forms, to keep the audit trail intact.

 l Report format for printing the check and/or advice forms.

You cannot proceed to print and post checks unless the report format is valid.

 6. To print a test copy of a check to verify that your check forms are aligned correctly in your printer, make 
sure your printer is ready, and then click Align. 

Note: Align always prints to your printer, no matter what print destination you selected for Sage 300. 

You can repeat this step as often as needed.

Tip: If you are not ready to print this check, click Close. When a message appears warning you "Not 
all checks have been printed," click Yes to leave the Print Checks screen, cancel the check run, and 
void the printed checks. (None were printed.)

 7. When you are ready to print the check, click Print.

Accounts Payable asks whether the check was printed correctly. 

 8. Review the printed check, and it was printed correctly, click Yes.

If the check was not printed correctly:

 a. Click No.

 b. Reset the print status in one of the following ways:

 l Double-click in the Print Status column for the payment.

 l Click the Select Reprint Range button, and then specify the number of the check you 
printed.

 c. Click Print again.

Important! If you cannot reprint the check at this time, click Close, and then click Yes  when 
asked to confirm that you want to cancel the print run and void the current check number. If 
you do not cancel the check run, Accounts Payable sets the batch status to Check Printing In 
Progress, and you cannot edit the batch until you reset the status to Open.

 9. If you are also printing a payment advice, Accounts Payable asks whether the advice forms are in the 
printer.

 a. Click Yes to print the advice form.

 b. If the advice printed correctly, click Yes again when asked.
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If the advice was not printed correctly click No, and then reset the print status, as before.

When you accept the check and the payment advice, if you printed one, Accounts Payable posts the 
check information to Bank Services, and closes the Print Checks screen.

After printing a check

 l When a check (and advice, if printed) is printed successfully, its status changes to "Printed." If the 
check is printed, but you have not yet printed the advice, the status is "Advice Not Printed."

 l Use the Payment Batch List to set the batch Ready To Post, and post the batch.

Check information is immediately posted to Bank Services, but the payment information is not posted to 
vendor accounts until you post the payment batch using the Payment Batch List screen. 

Printing Checks for a Batch of Payments

The most common way to print checks is using the Print/Post button on the Payment Batch List screen or 
the Post button on the Payment Entry screen to print checks for an entire batch, and then immediately 
post the batch. More...

You can print checks and advices on different types of check stock, as follows:

 l Print checks on forms that include an advice slip listing the details of the payment.

 l Print checks and advices, separately, on different forms.

 l Print only checks.

 l Print  only advices.

For more information about the check and advice formats that come with Accounts Payable, see "About 
Printing Checks" (page 136)

You can print checks while other users are printing checks, provided the check runs are for different 
payment batches.

When to Print

Print all the checks in a payment  batch before posting the batch.

Before You Start

 l Use the A/P Create Payment Batch screen to generate a payment batch using payment selection 
criteria.
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 l You can also use the A/P Payment Entry screen to enter the payments for which you want to print 
checks, and you can use the  A/P Invoice Entry screen to enter prepayments when you enter invoices.

Important! When entering payments, specify a payment code that uses a Check payment type, and 
select the Print Check option.

 l Print the payment batch listing. If the Force Listing Of Batches option is selected on the 
A/P Options screen, you must print listings before you can print and post checks.

 l On the Sage 300 desktop, set the print destination to Printer.

 l Determine the report format to use to print the checks and/or advices. 

 l Load your printer with sufficient check/advice stock to complete the check run, including alignment 
and leading checks.

To print checks and post the payment information to vendor accounts:

 1. Open Accounts Payable > A/P Transactions > Payment Batch List or Payment Entry.

 2. Select the batch for which you want to print checks.

 3. Click Print/Post on the Payment Batch List screen, or click Post on the Payment Entry screen.

 4. If you are posting the payments, click Yes. More...

Accounts Payable performs the following tasks after you click Yes:

 l Checks that the batch has been listed if the Force Listing Of Batches option is selected on 
the A/P Options screen.

 l Checks that the Ready To Post option is selected for the batch. If it is not, Accounts Payable 
asks whether to set the batch to Ready To Post and continue with posting.

 l Posts the batch immediately if all checks in the batch have been printed, or if the payment 
batch contains no checks.

 l If there are checks to be printed, Accounts Payable displays the Print Checks screen.

 5. On the Print Checks screen, review the settings and the list of checks the program is ready to print. More...

You can change the following items if they are incorrect:

 l Check Stock Code. select one of the check stock codes defined for your bank. The check stock is 
composed of the physical check forms, combined with report specifications and the check 
language. 

The description for the code and its type are displayed in the Print Checks form.

 l Next Check Number. Bank Services assigns numbers sequentially to the checks in the 
batch, beginning with this number.
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 l Number of Leading Checks. Although nothing is printed on leading checks, Bank Services 
needs this information to assign check numbers to the blank forms, to keep the audit trail 
intact.

 l Check/Advice Form. This is the report format for printing the check and/or advice forms. 
You cannot proceed to print and post checks unless the report format is valid.

 6. To print a test copy of a check to verify that your check forms are aligned correctly in your printer, click 
Align. 

Note: You can repeat this step as often as needed when the printing destination is Printer.

 7. When you are ready to print the checks, click Print.

If you are printing checks, then advices (instead of checks only or combined check and advices), 
Accounts Payable tells you to insert the check stock in the printer before proceeding.

When printing is finished, it asks whether the checks were printed correctly.

 8. Review the checks, and then click Yes or No. Then:

 l If you clicked No, click Select Reprint Range, specify a range of checks for reprinting, and 
then click Reprint.

 l If you clicked Yes and you are printing advices after the checks, the program starts to print 
advices immediately. It asks you to confirm that advices were printed correctly.

After you click Yes to accept the check run (or the advice run, if printing advices), Accounts Payable 
returns you to the A/P Payment Batch List screen and posts the payments to vendor accounts.

Important! After check data has been posted, you cannot reprint the checks or advices.

After printing a check

 l You cannot reprint a check after the check information has been posted to Bank Services.

 l You can delete payments (void checks) until you post the batch. 

If you delete the payment from the payment batch after you print the check, Accounts Payable changes 
the status of the check to Void in Bank Services.

Deleted checks do not appear on the Accounts Payable Check Register.

Reprinting Checks Using the Payment Batch List Screen

When printing checks using the Payment Batch List screen, if the checks do not print correctly, but you 
cannot reprint them immediately, you can reject the print run, and reprint the checks later.
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To reject a print run:

 1. Click No when asked if the checks printed correctly.

 2. If you want to void the checks, reset the status of the checks to Not Printed on the Print Checks 
screen.

 3. Click Close, and then confirm again that checks did not print correctly.

If you reset the check status to Not Printed, Accounts Payable asks whether you want to void the check 
numbers it issued.

 l If you do not want to keep any of the checks, click Yes. Accounts Payable then:

 l Assigns all check numbers a Void status.

Important! Make sure you destroy all printed checks.

 l Retains the Ready To Post status for the batch.

 l Does not post the payment batch.

 l If you do not void all the checks, Accounts Payable:     

 l Does not assign a Void status to check numbers at this time. It will void only the checks 
that you reprint later.

 l Sets the batch status to Check Printing In Progress, preventing you from opening or 
editing this batch unless you reset the batch status.

 l Creates a restart record, so that the next time you print checks, this batch will be 
processed first.

To reprint checks when you are ready:

 1. Open the Payment Batch List screen.

 2. Select the batch, and then click Print/Post.

 l If you voided the checks earlier, Accounts Payable opens the Print Checks screen so you 
can proceed.

 l If you did not void the checks previously, Accounts Payable displays a message stating that 
a restart record exists. Click OK. Accounts Payable opens the Print Checks screen and 
proceeds with the interrupted check run.

 3. When the Print Checks screen appears, click Print to reprint the checks.

Voiding Printed Checks During a Check Run

If you cannot reprint checks immediately and you want to edit the batch later (for example, if you are 
entering and printing single checks from the Payment Entry screen), you should void the check when you 
close the Print Checks screen.
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To void printed checks:

 1. When asked if the checks printed correctly, click No to reject the checks.

 2. On the Print Checks screen:

 a. Reset the status of the checks you printed to Not Printed, by double-clicking the Check 
Status column or by using the Select Reprint Range button.

 b. Click Close.

 c. When prompted to cancel the check run and void all checks, click Yes.

Printing the G/L Transactions Report

The G/L Transactions report is a list of the general ledger transactions created from all posted Accounts 
Payable batches, and from posted revaluations (in multicurrency ledgers). 

You can print detailed or summary versions of the report. The content of the detailed report depends on 
the consolidation options selected on the G/L Integration screen. For example, if general ledger 
transactions are consolidated by account and fiscal period, the report shows a total for each general 
ledger account and fiscal period. If they are not consolidated, the report shows full details for each 
transaction.

For more information on the contents of this report, see "A/P G/L Transactions Report Screen" (page 465).

When to Print

You should print this report:

 l After posting Accounts Payable batches, if you use the option to create G/L transactions during posting.

After creating general ledger batches, if you use the option to create G/L transactions using the Create 
G/L Batch icon.

If you do not use Sage 300 General Ledger, print the report before transferring the batch information to 
another general ledger system.

 l Before using the A/P Year End screen. 

You must create any outstanding general ledger batches (if you use the option to create the batches on 
request) and print the G/L Transaction report before clearing posting journals.

To print the G/L Transactions report:

 1. Open Accounts Payable > A/P Transaction Reports >        G/L Transactions.

 2. In the Select Batch Type field, select any or all of the Invoice, Payment, and Adjustment batch 
types. If you use multicurrency accounting, you can also select Revaluation.
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 3. Use the Posting SequenceFrom and To fields to specify a range of posting sequence numbers for 
each batch type you selected. 

The latest posting sequence numbers are displayed in the To field. You can accept them, or enter 
earlier numbers.

 4. Select additional options for the report using the following fields:

 l Report Format. Select Detail or Summary.

 l Sort By. If you are printing the detailed report, specify whether to list the transactions on the 
report by Account Number, Year/Period, or Batch/Entry Number. 

The summary report is sorted by general ledger account number.

 l Currency. If you use multicurrency accounting, specify whether to print amounts in each 
source currency or in the functional currency.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

After printing the G/L Transactions report

File the report with your other audit trail records.
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Source Codes Used on the G/L Transactions Report

Each type of Accounts Payable transaction is listed on the G/L Transactions report with the source code 
"AP," followed by the transaction type.

Source Code Transaction Type

AP-AD Adjustment

AP-CF Applied Credit (from)

AP-CR Applied Credit (to)

AP-DB Debit Note

AP-DF Applied Debit (from)

AP-DT Applied Debit (to)

AP-ED Earned Discount Taken

AP-GL Gain or Loss (multicurrency ledgers)

AP-IN Invoice

AP-IT Interest Charge

AP-PI Prepayment

AP-PY Payment

Source Codes

Printing the Overdue Payables Report

The Overdue Payables report groups outstanding transactions or balances into a current period and four 
aging periods by document date or due date. Use the report to analyze your overdue payables.

For information on the contents of this report, see "A/P Overdue Payables Report Screen" (page 467).

When to Print

Print the report when you need a listing of overdue payables on a given date, such as at the end of a fiscal 
year or period, or when you want to identify documents that must be paid immediately.
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To print the Overdue Payables report:

 1. Open Accounts Payable > A/P Transaction Reports >  Aged Payables.

 2. In the Report Type field, specify Overdue Payables By Due Date or Overdue Payables By 
Document Date to age balances or documents.

 3. In the Age As Of field, specify the date on which to report the payables. 

Accounts Payable uses this date to assign transactions to aging periods. For example, if you print the 
report aged by due date, the program assigns each transaction to an aging period by calculating the 
number of days between its due date and the Age As Of date.

 4. In the Cutoff By field, specify the type of date by which to evaluate transactions for inclusion on the 
report, and then, in the Cutoff Date field, specify the latest date a transaction can have to be included 
on the report. (The report includes only transactions that have a date that is on or before this date.) More...

There are three methods for selecting a cutoff date:

 l Document Date. Select this option if you want to include documents based on their 
document date (regardless of the fiscal period to which you assigned them), and then enter a 
date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, regardless of 
date.

 l Posting Date. Select this option if you want to include documents based on their posting 
date, and then enter a date in the Cutoff Date field.     

If you enter zeros for the month, day, and year, the report includes all transactions, regardless of 
date.

 l Year/Period. Select this option if you want to include all transactions up to the end of a fiscal 
period, which you then specify in the Year/Period field.

 5. Select from the following options:

 l Print Transactions In. Indicate whether to print a summary or detailed report, and whether to 
print the detailed version of the report by document date (Detail by Date) or by document 
number (Detail by Document).

 l Sort Transactions by Transaction Type. Select this option if you want to sort transactions 
by document type for each vendor on the report.

 l Use Aging Periods. The aging periods defined on the A/P Options screen appear, but you 
can assign different periods for this report.

 l Select Vendors By. Specify up to four criteria to select the vendor accounts to list on the report. More...
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For the first selection criterion, you can choose from Vendor Number, Vendor Group, or Short 
Name.

For the remaining three selection criteria, you can also choose:

 l Account Set.

 l Vendor Balance.

 l Vendor Equivalent Balance. (multicurrency ledgers only)

 l Vendor Name.

 l Currency Code. (multicurrency ledgers only)

 l Start Date.

 l Vendor optional fields, if you use optional fields

If you do not specify selection criteria, the report includes all vendor records that meet the other 
criteria you select in this folder (for example, all vendors that have transactions on or before the 
cutoff date).

 l Sort Vendors By. Specify up to four orders by which to sort records for the report. More...

You can choose from:

 l Vendor Group.

 l Account Set.

 l Vendor Balance.

 l Vendor Equivalent Balance. (multicurrency ledgers only)

 l Vendor Name.

 l Short Name.

 l Currency Code. (multicurrency ledgers only)

 l Start Date.

 l A vendor optional field.

If you specify Vendor Group, Account Set, or a vendor optional field as the sorting criteria in a 
single currency ledger, or Account Set in a multicurrency ledger, an additional subtotal line 
appears at the bottom of your report.

If you do not specify sorting criteria, the report orders the records by vendor number.

 l Show Group Title. If you want to include a title for each sorted group, select the Title check 
box for each group of records you are sorting by.
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 l Show Group Subtotal. If you want to include subtotals for each sorted group, select the 
Show Group Subtotal option for groups of records you are sorting by.

 l [Include] Contact/Phone/Credit. Select this option if you want to list the vendor's contact 
person and phone number, and your credit limit for the vendor.

 l [Include] Space for Comments. Select this option to leave blank space at the end of each 
vendor record for your notes.

 l [Include] Vendors With A Zero Balance. Select this option to include vendors with zero 
balances.

 l [Include] Vendors/Transactions on Hold. Select this option to include vendors that are 
placed on hold in the Vendors screen, and transactions that you have placed on hold in the 
Control Payments screen.

 l Select Transaction Types. Select the types of transactions to include on the report. You can 
include any or all of the transaction types listed. 

 l Applied Details. Select this option to include all the documents such as payments and credit 
notes that were applied to each reported invoice. If you do not select this option, the report 
shows only the balance owing for each outstanding document.

 l [Show] Fully Paid Transactions. Select this option to list documents that are fully paid, but 
not yet cleared from Accounts Payable.

 l [Show] Aged Retainage. Select this option to include retainage documents with taxes on the 
report. 

This option is not available if you are aging documents by document date.

 l Print Amounts In. Use this option to select the currency for the report. You can list transaction 
amounts in the vendor currency or the functional currency.

Note: If you list transactions in the functional currency, and you have performed a revaluation, 
the report shows the new functional amounts.

 6. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.
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 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Posting Errors Report

The Posting Errors report lists incorrect entries that were placed into error batches during posting and 
explains why the entries could not be posted.

For information on the contents of this report, see "A/P Posting Errors Report Screen" (page 468).

When to Print

Print the report after posting a batch, if the program warns you that an error batch has been created.

To print the Posting Errors  report:

 1. Open Accounts Payable > A/P Transaction Reports >        Posting Errors.

 2. Select the type of error report to print (Invoice, Payment, or Adjustment).

Note: If you are printing this report for an Intercompany Transactions company, the Payment Error 
and Adjustment Error reports are not available.  

 3. Use the From Posting Sequence and To Posting Sequence fields to specify the range of posting 
sequences for which to print the report.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.
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 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

After printing the G/L Transactions report

 l Use the report to identify entries that must be corrected, and then correct the errors.

 l When you have fixed the errors, print the batch listings, and post the error batches.

Printing Posting Journals

Posting journals list all the transactions in a group of batches that were posted together, as well as the 
general ledger transactions that were created from the batches.

The journals provide audit trail reports of all uncleared posted details.

For information about the contents of this report, see "A/P Posting Journals Screen" (page 469).

When to Print

You should print posting journals after each posting run, and then file them with your other audit trail 
records. 

You must print all outstanding posting journals before you can use the A/P Clear History screen to clear 
them, or use the Year End screen to do year-end processing.

If you use multicurrency accounting, you also print posting journals after revaluing transactions at new 
exchange rates.

To print posting journals:

 1. Open Accounts Payable > A/P Transaction Reports >        Posting Journals.

 2. Specify the following report options:
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 l Select Posting Journal. Select the type of journal to print (Invoice, Payment, or Adjustment).

The invoice posting journal includes credit note, debit note, and interest transactions, as well as 
invoices.

If you use multicurrency accounting, you can also select Revaluation or Provisional 
Revaluation.

Note: If you are printing a posting journal for an Intercompany Transactions company, you can 
select Invoice, only.

 l From Posting Sequence and To Posting Sequence. Type the lowest and highest numbers in the 
range of posting sequences for which you want to print journals.

A unique posting sequence number is assigned each time you post batches. These fields display 
the lowest and highest posting sequence numbers in your Accounts Payable system for the type 
of journal you select.

 l Reprint Previously Printed Journals. Select this option if you want to print additional copies of 
journals you printed before.

Note: Do not select the option if you want to print only the journals you have not already printed 
from the specified range of posting sequence numbers.

 l Include Job Details. Select this option to include job-related  information, such as the contract, 
project, and category, with each transaction printed. 

Note: This option is available only if you use Sage 300 Project and Job Costing. It is not 
available for an ICT company.

 l Include Optional Fields. Select this option to include optional field information for each 
printed transaction. (The option is available only if you use optional fields.)

 l Include G/L Ref./Desc. Select this option to print the G/L reference and description with 
each transaction.

 l Sort By. Specify the order in which to list transactions on the posting journal:

 l Batch/Entry. This option lists transactions in order by the batch and entry numbers 
they were assigned when you entered them.

 l Vendor Number. lists transactions in order by their vendor numbers.

 l Document Date. This option lists transactions in order by the dates that you entered when 
you created the transactions.The name of this choice varies with the type of journal you 
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want to print.

Note: You select Adjustment Date when you print adjustment posting journals.

 l Document Number. This option lists invoices, credit notes, debit notes, and interest 
charges by their document numbers.

 l Check Number. This option lists payment transactions by the check or payment 
number you entered with each transaction or by the numbers that are assigned by 
Accounts Payable to transactions entered without numbers.

 l Adjustment Number. This option lists adjustment transactions by the adjustment number 
that Accounts Payable assigns to the transactions when you create them. 

It also lists transactions in the same order as sorting by batch and entry number, unless you 
create transaction batches in a non-sequential order. For example, if one person opens an 
adjustment batch but does not enter the adjustments until after a second person has 
opened a second batch and entered transactions, the transactions in the second batch are 
listed first.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the Pre-Check Payment Register

The Payment Register report shows the payments that will be made if you generate checks using the 
selection and exclusion criteria you specify in the Create Payment Batch screen. The report can also 
provide a list of transactions or vendor accounts that have been placed on hold.

For information about the contents of this report, see A/P Pre-Check (Payment) Register Screen.

When to Print

Print the report before generating a check run, to verify the payment batch you are creating.

Before You Start

 l Post all outstanding batches.

 l Select Generate Separate Payments For Each Invoice in the vendor record for any vendor that 
requires a separate payment for each invoice.

 l Use the Control Payments screen to set maximum amounts or to hold payments on individual 
invoices.

 l Edit the payment selection criteria to exclude individual vendors from the check run.

 l Place vendor records on hold if you want to block payments.

To print a pre-check payment register

 1. Open Accounts Payable > A/P Transactions >        Create Payment Batch.

 2. Select options on the Bank and Currency Selection Criteria tab and the Vendor And Date 
Selection Criteria tab.

 3. On the Exclusion tab, enter the list of vendors to exclude from the batch.

 4. Click the Register button.

After printing the Pre-Check Payment Register

 l Review the report, and then make any changes you need in the selection criteria.       

 l If necessary, reprint the report.

 l When ready, create the payment batch.

Printing the Revaluation Posting Journal

A revaluation posting journal is the printed record of the transactions that are created for the general 
ledger exchange gain and loss accounts when you revalue multicurrency documents at new exchange 
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rates.

If you perform a provisional revaluation, you can print the provisional revaluation journal to check the 
transactions that will be created when you post the revaluation.

For information on the contents of the revaluation posting journal, see "A/P Posting Journals Screen" (page 
469).

When to Print

You should print the posting journals after revaluing transactions at new exchange rates, then file them 
with your other audit trail records.

Note: You must print all outstanding posting journals before you can use the A/P Clear History screen 
to clear them, or use the Year End screen to do year-end processing.

Before You Start

Use the Revaluation screen to revalue transactions at new exchange rates. You can also select a 
provisional revaluation.

To print the Revaluation Posting Journal:

 1. Open Accounts Payable > A/P Transaction Reports >        Posting Journals.

 2. Specify the following report options:

 l Select Posting Journal. Select Revaluation or Provisional Revaluation.

 l From Posting Sequence and To Posting Sequence. If you are printing a revaluation 
posting journal, type the lowest and highest numbers in the range of posting sequences for 
which you want to print journals.

You do not see this option if you are printing a provisional revaluation journal.

 l Reprint Previously Printed Journals. Select this option if you want to print additional copies 
of journals you printed before. You see this option only if you are printing a Revaluation 
Posting Journal.

Note: Do not select the option if you want to print only journals you have not already printed 
from the specified range of posting sequence numbers.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.
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 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Vendor Transactions Report

The Vendor Transactions report lists transactions that were posted to vendor accounts during the period 
you specify when you print the report. You can order the transactions by document date, by document 
number, or by fiscal year and period.

For information on the contents of this report, see "A/P Vendor Transactions Report Screen" (page 472).

When to Print

Print the report when you want to see the current status of your vendor accounts.

Before You Start

Update account information by entering, importing, and posting outstanding batches.

To print the Vendor Transactions report:

 1. Open Accounts Payable > A/P Transaction Reports >        Vendor Transactions.

 2. In the Report Type field, specify whether to print transactions by document date, by document 
number, or by fiscal year and period.

 3. If you are printing transactions by document date or by document number, use the From Document 
Date and To fields to specify the range of dates for which to include transactions. 
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If you are printing transactions by fiscal year and period, use the From Year/Period and To fields to 
specify the fiscal year and period range for which you want to print transactions.

 4. Use the Select Vendors By fields to specify up to four criteria to select the vendor accounts to list on the 
report. More...

For the first selection criterion, you can select Vendor Number, Vendor Group, or Short Name.

For the remaining three selection criteria, you can also select Vendor Number, Vendor Group, Short 
Name, Account Set, Vendor Balance,  Vendor Name,  Start Date, and vendor optional fields, if any. In 
multicurrency ledgers, you can also select Currency Code or Vendor Equivalent Balance.

Note: If you do not specify selection criteria, the report includes all vendor records that meet the other 
criteria you specify. (For example, the report does not include vendor records with a zero balance 
unless you select the Print Vendors With A Zero Balance option.)

 5. Use the Sort Vendors By fields to specify up to four orders by which to sort records for the report. More...

Choose from Vendor Group, Account Set, Current Vendor Balance,  Vendor Name, Short Name,  and 
vendor optional fields, if you use them. In multicurrency ledgers, you can also choose Current Vendor 
Equivalent Balance or Currency Code.

Note: If you do not specify sorting criteria, the report orders the records by vendor number.

 6. Specify whether to include group titles and/or group subtotals for each sorted group. More...

 l To include titles for groups of records you are sorting by, select Title for each sorted group.

 l To include subtotals for groups of records you are sorting by, select  Total for each sorted 
group.   

 7. Specify additional options for the report, as needed:

 l Select Transaction Types. Select one or more transaction types to include on the report. 
The choices are Invoice, Debit Note, Credit Note, Interest, Prepayment, and Payment.

 l Sort Transactions by Transaction Type. Select this option to sort transactions by document 
type for each vendor on the report.

 l [Include] Contact/Phone/Credit. Select this option to list the vendor's contact person and 
phone number, and your credit limit for the vendor.

 l [Include] Space For Comments. Select this option to leave blank space at the end of each 
vendor record for your notes.

 l [Include] Vendors With A Zero Balance. Select this option to include accounts with a zero 
balance, for example, to find out which vendor accounts are dormant. Note that an account 
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could have outstanding transactions even with a zero balance, for example, an offsetting 
invoice and credit note.

 l [Include] Totals By Transaction Type. Select this option to list a total for each transaction 
type  after the listing for each vendor.

 l [Show] Applied Details. Select this option to include all the documents such as payments and 
credit notes that were applied to each reported invoice. 

Note: If you do not select this option, the report shows only the balance owing for each 
document.

 l [Show] Fully Paid Transactions. Select this option to list documents that are fully paid, but 
not yet cleared from Accounts Payable.

 l Print Amounts In. If you use multicurrency accounting, select the currency for the report. You can 
list transaction amounts in the vendor currency or the functional currency. 

If you list transactions in the functional currency and you have performed a revaluation, the report 
shows the new functional amounts.

 8. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing Vendor Reports
Use the screens in the A/P Vendor Reports folder to print lists of vendors, vendor groups, remit-to 
locations, and recurring payables in your Accounts Payable system, as well as letters and labels for 
vendors.

Note: If the Use 1099/CPRS Reporting option is selected on the A/P Options screen, you can print 
1099/1096 and T5018 (CPRS) amounts in the required formats.

You can also print statistics reports for vendor groups and vendors.

Printing 1099/1096 Forms

You can print 1099/1096 amounts for vendors in your Accounts Payable system for the following forms:

 l 1099-MISC

 l 1099-NEC

 l 1096

For more information, see "A/P Print 1099/1096 Forms Screen" (page 540).

When to Print

Print 1099 or 1096 forms at the end of each calendar year, after you have entered all transactions for the 
calendar year.

To print 1099/1096 forms:

 1. Open Accounts Payable > A/P Vendor Reports > Print 1099/1096 Forms.

Note: To use this screen, you must have security authorization to maintain tax numbers.

 2. Enter information in the following fields and controls:

 l Form. Specify whether you are printing 1099 or 1096 forms.

 l Form Type. This field appears if you are printing 1099 forms. Use it to specify whether you 
are printing 1099-MISC or 1099-NEC forms.

 l Preaddressed Form. This option appears if you are printing 1096 forms. If you are using 
preprinted forms that already include the address, select this option so that the program 
does not print the address.

 l For Tax Year. Specify the year for which you want to report 1099 data.

 l Use Form. This field automatically shows the default RPT file for the form and year you've 

274Sage 300 2023 Accounts Payable User's Guide



specified. Generally, you should not change this file.

 l From/To Vendor Number. Specify a range of vendors for which to print 1099 data.

 3. Enter payer information, including the name, address, phone number, and tax number of your 
company.

If you are printing 1096 forms:

 l In the Type field, specify the type of tax number you are using (your Employer ID Number or 
Social Security Number).

 l Enter an optional contact name and email address.

If your company is not in the U.S., select the Foreign Entity option.

 4. To print a test copy of a 1099 or 1096 form to check the alignment of the forms in your printer, click 
Align.

You can repeat this step as often as needed when the printing destination is set to Printer.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

 6. If you want to use the same settings the next time you print these forms, click Settings > Save 
Settings As Defaults.
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Printing T5018 (CPRS) Forms

You can use Accounts Payable to track payments to vendors who are subject to CPRS reporting, and 
then print the data.

You can print the data on an official CPRS form, or you can print on plain paper. To print on plain paper, 
you need a file for printing the entire form (instead of only the data). For more information and to get the 
file, see Knowledgebase article 102399.

For information on the contents of the forms, see "A/P Print T5018 (CPRS) Forms Screen" (page 541).

When to Print

Print CPRS reports at the end of each calendar year, after you have entered all transactions for the 
calendar year.

To print the report:

 1. Open Accounts Payable > A/P Vendor Reports >        Print T5018 (CPRS) Forms.

Note: To use this screen, you must have security authorization to maintain tax numbers.

 2. Select report options as follows:

 l For Tax Year. Select the year for which you want to report CPRS data.

 l Use Form. Select the name of the CPRS form to use.

If you are not sure of the name of the form, click Browse (or press Alt+B ), and then select the 
form from the list that appears.

 l Business Number. Enter your business number.

 l Vendor Number. Select a range of vendor numbers.

 l CPRS Code. Select the range of CPRS codes to report on.

 3. To print a test copy of a CPRS form to check the alignment of the forms in your printer, click the 
Align button.

You can repeat this step as often as needed when the printing destination is set to Printer.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     
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Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Letters and Labels

You can print letters and mailing labels for the vendors in your Accounts Payable system. 

Sage 300 Accounts Payable comes with a sample covering letter and a sample mailing label form, 
formatted for laser printers, that you can use or change to suit your company's requirements.

Note: The sample labels are approximately 6.5 cm by 2.5 cm, and are designed to fit a tab of 30 labels 
arranged in 3 columns.

For information on the contents of letters and labels, see "A/P Letters and Labels Screen" (page 543).

When to Print

Print letters and labels whenever you need them for mailing to vendors. For example, you might want to 
send covering letters to your vendors with your payments.

If you are sending letters to accompany payment checks, you may find it simpler to print checks, then 
advices, specifying the letter you are sending with the checks as the advice form. This method ensures 
that you print a letter for each payment check.

To print letters or labels

 1. Open Accounts Payable > A/P Vendor Reports >        Letters / Labels.

 2. Fill in the fields on the screen, as follows:
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 l Letter/Label. Select the option for the type of form you are printing.

 l Use Letter/Label. Select the name of the letter or label form to use. 

If you are not sure of the name of the form, click Browse (or press Alt+B ), and then select the 
form from the list that appears.

 l Run Date. This is the date that appears on the forms.

 l Delivery Method. Specify how you want to send the letters to your vendors, as follows:

 l Print Destination Select this option to send the statements to the default print 
destination you selected on the company desktop.

 l VendorSelect this option  to send the letters via the method specified in your vendor 
records for each vendor.

 l Message ID. This field appears when you select Vendor for the Delivery Method. Select the 
code for the message you want to send with e-mailed letters.

 l Select By. Specify up to four selection criteria to select the vendor accounts for which to print 
letters or labels. More...

For the first selection, choose from Vendor Number, Vendor Group, and Short Name.

For the remaining three selection criteria choose from the above options, plus Account Set, 
Vendor Balance, Vendor Equivalent Balance (multicurrency ledgers only), Vendor Name, 
Currency Code (multicurrency ledgers only), Start Date, and vendor optional fields, if any.

Note: If you do not specify selection criteria, letters or labels are printed for all vendor records 
that meet the other criteria you select in this screen. (For example, the program does not print 
letters or labels for vendor accounts with zero balances unless you select the Include Vendors 
With A Zero Balance option.)

 l Sort By. Specify up to four orders by which to list (sort) records for the letters or labels. More...

You can choose from Vendor Group, Account Set, Currency Code (multicurrency ledgers only), 
Vendor Balance, Vendor Equivalent Balance (multicurrency ledgers only), Vendor Name, Short 
Name, Start Date, and Currency Code.

Note: If you do not specify sorting criteria, the report orders the letters or labels by vendor 
number.

 l Include Vendors with a Zero Balance. Select this option if you want to print letters or labels 
for vendor accounts with zero balances (as of the cutoff date).
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 3. To print a test letter or sheet of labels to check the alignment of the letterhead or labels in your printer, 
click the Align button. 

You can repeat this step as often as you need to when the printing destination is Printer.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Recurring Payables Report

The Recurring Payables report is a list of the recurring payables that you have set up. It can also show 
the processing schedule attached to each recurring payable record.

For information on the contents of this report, see "A/P Recurring Payables Report Screen" (page 544).

When to Print

Print this report prior to creating a recurring payable batch to ensure that the information is up to date.

To print the report:

 1. Open Accounts Payable > A/P Vendor Reports >        Recurring Payables.

 2. In the Recurring Payable Code From and To fields, enter the range of codes you want to list in the 
report.
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 3. In the Vendor Number From and To fields, enter the range of vendors you want to include in the 
report.

 4. Select the Show Schedules option if you want to include the schedules for the recurring payables 
codes that you are listing.

 5. Select Optional Fields to include optional field information for each recurring payable.

 6. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Remit-To Locations Report

The Remit-To Locations report lists the remit-to locations (addresses to which you send checks) used by 
your vendors.

For information on the contents of this report, see "A/P Remit-To Locations Report Screen" (page 545).

When to Print

Print the report when you add, change, or delete remit-to locations.
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To print the report:

 1. Open Accounts Payable > A/P Vendor Reports >        Remit-To Locations.

 2. Select:

 l Whether to include address information (address, contact name, and check language) or 
optional field information for the remit-to locations. You must select at least one of these 
options to print the report.

 l A range of vendor numbers.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Vendor Activity Statistics Reports

The Vendor Activity Statistics report lists information about the purchases and payment history for the 
current year to date and previous fiscal year for the vendor records in your Accounts Payable system. 
Most of the information on this report is also available on the Vendor Activity tab of the Vendors screen.

For information on the contents of this report, see "A/P Vendor Activity Statistics Report Screen" (page 545).

When to Print

Print the report when you need to check on vendor account activity such as the last time you made a 
purchase from the vendor, the date and amount of your last payment to the vendor, the average number 
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of days it takes you to pay the vendor, or the date a vendor's balance was last revalued (if you use a 
multicurrency Accounts Payable system).

To print the Vendor Activity Statistics report:

 1. Open Accounts Payable > A/P Vendor Reports >        Vendors.

 2. Select Vendor Activity Statistics as the report type.

 3. Specify whether to print amounts in the vendor currency or the functional currency (if you use a 
multicurrency Accounts Payable ledger).

 4. Select up to four selection and sorting criteria. If you do not specify selection criteria the report 
includes all vendor records. If you do not specify sorting criteria the report orders the vendor 
records by vendor number.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Vendor Group List

The Vendor Group List reports the information entered for each vendor group in your Accounts Payable 
system, and the vendors assigned to each group.

For information on the contents of this report, see "A/P Vendor Group List Screen" (page 549).
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When to Print

Print the report when you add, change, or delete vendor groups.

To print the report:

 1. Open Accounts Payable > A/P Vendor Reports >        Vendor Groups.

 2. Make your selections in the following fields:

 l Report Type. Select Vendor Group List.

 l Include. Specify whether to include profile information, group members, or optional fields. 
You must select at least one of these options to print the report.

 l From Group/To. Specify a range of vendor groups. If you are using only one group, enter the 
group code in both the From and To fields.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Vendor Period Statistics Report

This report lists the total amount of amount of invoices, payments, discounts taken, discounts lost, credit 
and debit notes, and adjustments you have recorded for a given vendor during the period covered by the 
report, as well as the total number of invoices paid during that period. 

Note: The reports list statistics for the type of year and period specified on the A/P Options screen.
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When to Print

Print the report when you need a summary of vendor statistics (for example, at the end of each period).

You can print the period statistics reports for vendors or for vendor groups.

To print the Vendor Period Statistics report:

 1. Open Accounts Payable > A/P Vendor Reports >        Vendors.

 2. Select Vendor Period Statistics as the report type.

 3. Select the currency (if you use multicurrency accounting).

 4. Specify whether to include the number of documents that make up the total amount for each type 
of transaction listed on the report.

 5. Specify the years and periods for which to include transactions, and up to four selection and 
sorting criteria

 6. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Vendor Group Period Statistics Report

This report lists the total amount of amount of invoices, payments, discounts taken, discounts lost, credit 
and debit notes, and adjustments you have recorded for a given vendor group during the period covered 
by the report, as well as the total number of invoices paid during that period. 

284Sage 300 2023 Accounts Payable User's Guide



Note: The reports list statistics for the type of year and period specified on the A/P Options screen.

When to Print

Print the report when you need a summary of vendor statistics (for example, at the end of each period).

You can print the period statistics reports for vendors or for vendor groups.

To print the Vendor Period Statistics report:

 1. Open Accounts Payable > A/P Vendor Reports > or Vendor Groups.

 2. Select Vendor Group Statistics as the report type.

 3. Specify whether to include the number of documents that make up the total amount for each type of 
transaction listed on the report.

 4. Select the ranges of groups, years, and periods to include on the report.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Vendors List

The Vendors report lists the information entered for the vendor records in your Accounts Payable system.

For information on the contents of this report, see "A/P Vendors Screen" (page 550).
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When to Print

Print the report when you add, change, or delete vendor records.

To print the report:

 1. Open Accounts Payable > A/P Vendor Reports >        Vendors.

 2. Make selections in the following fields:

 l Report Type. Select Vendors.

 l Include. Specify whether to include the vendors' addresses, profile information, comments, 
optional fields, or recurring payables.

Note: You must select at least one of these options to print the report.

 l Show Tax Numbers. If you are printing profile information from the vendor records, and you 
are authorized to maintain tax numbers, you can select this option to show full (unmasked) 
tax numbers in the report.

 l Follow-up Date From and To. If you are printing comments from the vendor records, enter a 
range of follow-up dates for which to include comments.

 l Select By. Specify up to four selection criteria for the report. Your choices for the first 
selection criterion are: Vendor Number, Vendor Group, or Short Name.

Your choices for the remaining three selection criteria include the above and Account Set, Vendor 
Balance, Vendor Equivalent Balance (multicurrency ledgers only), Vendor Name, Currency Code 
(multicurrency ledgers only), and Start Date.

Note: If you do not specify selection criteria, the report includes all vendor records.

 l Sort By. You can choose up to four orders by which to list (sort) records for the report. You 
can sort by Vendor Group, Account Set, Vendor Balance, Vendor Equivalent Balance 
(multicurrency ledgers only), Vendor Name, Short Name, and Currency Code (multicurrency 
ledgers only).

Note: If you do not specify sorting criteria, the report orders the records by vendor number.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     
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Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Appendix A: Accounts Payable 
Screen Guides

Learn how to find and use Sage 300 screens. 

Each screen guide includes navigation information, field help, and a list of tasks you can use the screen 
to perform.

Periodic Processing Screens
Use Accounts Payable Periodic Processing screens to perform tasks that are part of your regular period-
end procedures, such as clearing history, creating general ledger batches, and deleting inactive records. 

A/P Clear History Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Clear History.

Related Tasks

"Clearing Obsolete Data from Accounts Payable" (page 203)

Overview

Use the A/P Clear History screen to remove obsolete data from your Accounts Payable system, 
including:

 l Fully paid documents.

 l Vendor comments.

 l 1099/CPRS amounts.

 l Printed posting journals.
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 l Posting errors.

 l Deleted and posted batches.

Fields and Controls

1099/CPRS Amounts

Select this option to clear 1099/CPRS amounts. You then specify the:

 l Range of vendor numbers.

 l Year and period through which to clear amounts.

Notes: 
 l 1099/CPRS information is cleared for the period you specify, for all previous periods in the 

specified year, and for all periods in previous years.

 l This option is not available for an ICT company.

Deleted And Posted Batches

Select this option to clear deleted and posted batches. You then specify the:

 l Type of batches.

 l Number of the highest posting sequence through which to clear. The field displays the most 
recent batch number for the selected journal.

Notes: 
 l Once you clear posted batches, you can no longer drill down to view transaction details from 

General Ledger.

 l When you clear A/P history from within an ICT company, this option is labelled, "Clear Deleted 
and Posted Invoice Batches."

From/To

Enter the range of records from which to select:

 l To specify a range of records, enter the lowest number or code in the From field and the highest 
number or code in the To field.

 l To specify a single record, enter its number or code in both fields.

 l To select all records, leave the From field blank and the To field showing Zs
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Fully Paid Documents

Select this option to clear fully paid documents. You then specify the:

 l Range of vendor numbers.

 l Date up to which you want to clear transactions.

Accounts Payable clears invoices, credit notes, and debit notes that were fully paid on the specified 
Through date if:

 l The balance for each document is zero.

 l The check that paid a document has cleared the bank account and has been reconciled for 
at least 45 days.

Note: This option is not available for an ICT company.

Posting Errors

Select this option to clear posting errors. You then specify the:

 l Type of posting error.

Note: You can clear only one type of posting error at a time.

 l Number of the highest posting sequence you want to clear.

Notes: 
 l Clear History displays the most recent (highest) posting error numbers.

 l When you clear A/P history from within an ICT company, this option is labeled "Clear Invoice 
Posting Journal Errors."

Printed Posting Journals

Select this option to clear posting journals. You then specify the:

 l Type of posting journal.

Note: You can clear only one type of posting journal at a time.

 l Number of the posting sequence you want to clear. Clear History displays the most recent 
(highest) posting sequence numbers.
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Notes: 
 l You can clear only one posting sequence number at a time for each type of journal.

 l Clear History clears the data for the journal posted with that posting sequence number, 
provided that you have printed the journal and created any outstanding general ledger 
transactions.

Notes: 
 l After clearing journals, you can no longer print them, but the information in them is retained in 

the vendor accounts and may appear on other reports.

 l When you clear A/P history from within an ICT company, this option is labeled "Clear Printed 
Invoice Posting Journals."

Vendor Comments

Select this option to clear vendor comments. You then specify the:

 l Range of vendor numbers.

 l Date up to which to clear vendor comments.

Accounts Payable clears comments that reached their expiration dates (specified in the vendor 
records) on or before the Clear Vendor Comments Through date.

Note: This option is not available for an ICT company.

A/P Clear Statistics Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Clear Statistics.

Related Tasks

"Clearing Statistics" (page 205)

Overview

Use the A/P Clear Statistics screen to remove obsolete vendor period statistics and vendor group period 
statistics data from your Accounts Payable system.
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Note: This screen allows you to clear only period statistics. To clear activity statistics, use the A/P Year 
End screen. For more information, see "A/P Year End Screen" (page 303).

Fields and Controls

Clear Vendor Statistics

Select this option to clear vendor statistics. Then specify the:

 l Range of vendor numbers.

 l Year and period up to which to clear statistics.

Notes: 
 l Vendor statistics are cleared up to the specified year and period you specify, including 

uncleared statistics from any earlier years and periods.

 l If you do not want to clear all types of statistics for the same periods, use the Clear Statistics 
screen as many times as necessary to clear statistics separately for different ranges of 
vendors.

Vendor Group Statistics

Select this option to clear vendor group statistics. Then specify the:

 l Range of vendor groups.

 l Year and period up to which to clear statistics.

Notes: 
 l Vendor group statistics are cleared up to the specified year and period you specify, including 

uncleared statistics from any earlier years and periods.

 l If you do not want to clear all types of statistics for the same periods, use the Clear Statistics 
screen as many times as necessary to clear statistics separately for different ranges of vendor 
groups.

A/P Create G/L Batch Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Create G/L Batch.
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Related Tasks

"Creating Batches of Transactions for General Ledger" (page 189)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Create G/L Batch screen to create general ledger transactions:

 l From outstanding posted invoice, payment, and adjustment batches.

 l When you revalue accounts at new exchange rates in multicurrency ledgers.

Note: You use this screen to create general ledger batches only if you did not select the Create G/L 
Transactions During Posting option on the Integration tab of the A/P G/L Integration screen.

Fields and Controls

Create G/L Transactions From

Specify the types of batches for which to create general ledger transactions.

Note: You must select at least one batch type.

Through Posting Sequence

Specify the posting sequence number up to which to create general ledger transactions.

Notes: 
 l The last posting sequence number used for each type of batch is displayed. You can use this 

number or enter the number of an earlier sequence.

 l General ledger transactions are created for the batches in the posting sequence you specify 
and for any earlier posting sequence numbers for which you have not yet created general 
ledger transactions.
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A/P Create Recurring Payable Batch Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Create Recurring Payable Batch.

Related Tasks

 l "Processing Recurring Payables" (page 194)

 l "Posting an Invoice Batch" (page 127)

 l "Posting a Range of Batches" (page 127)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Create Recurring Payable Batch screen to create a batch of recurring-payable invoices for 
selected vendors and recurring payables.

The batch appears in the Batch List screen as a Recurring batch, using the next available invoice batch 
number.

Note: If you want to edit a recurring-payable batch, you use the A/P Invoice Entry screen.

You post the generated invoices, then process the payments and print checks as you would for any other 
type of invoice.

If the terms specified for a recurring payable include a multiple payment schedule, Accounts Payable 
calculates the schedule when it processes the payable.

Accounts Payable warns you when it creates the last invoice before a recurring payable expires. You can 
update the recurring payable if you want to continue using it.

Accounts Payable does not create an invoice for a recurring payable if:

 l It encounters an error while processing a recurring payables batch (for example, if the terms code 
used in a recurring payable record is invalid). The program displays an error message when it 
finishes processing the batch.

 l Posting the invoice would cause the amount invoiced to date to exceed the maximum amount for 
the recurring-payable.
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 l The invoice would exceed the maximum number of invoices permitted for the recurring-payable.

 l The invoice date is after the expiration date specified for the recurring-payable.

 l The vendor is inactive or on hold.

 l The recurring payable is inactive.

If the program does not create an invoice for a recurring payable, it does not update the Last Posted 
Invoice fields in the recurring payable record.

Note: When you delete a vendor record, Accounts Payable automatically deletes all recurring 
payables for the vendor.

Fields and Controls

From/To

Enter the range of records from which to select:

 l To specify a range of records, enter the lowest number or code in the From field and the highest 
number or code in the To field.

 l To specify a single record, enter its number or code in both fields.

 l To select all records, leave the From field blank and the To field showing Zs.

Method

Specify whether to create a new batch or add the invoices to an existing batch:

 l Default. Using this method, invoices are added to an open invoice batch that has the same run 
date. If no batch has the same run date, a new batch is created.

 l Create a New Batch. Using this method, a new batch of recurring payable transactions is 
created.

 l Add to an Existing Batch. If you select this method, an additional field appears with a Finder that 
lets you select the batch to contain the new transactions.

Run Date

Enter a run date. (The default date is the session date).

The program processes all the recurring payables that are due up to and including the specified run 
date.
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Accounts Payable uses the run date to update the Last Invoiced date in the recurring payable record 
when you create an invoice for a recurring payable.

Select By

Choose the type of record by which to select the accounts for which to create recurring-payable 
invoices:

 l Recurring Payable Code. Select this option to create invoices for vendors assigned to the range 
of recurring-payable codes you specify. Other charges assigned to the vendors are ignored if you 
do not include their recurring-payable codes in the range of codes.

 l Vendor Number. Select this option to create invoices for vendors to whom recurring payables 
are assigned in the range of vendor numbers you specify.

 l Vendor Group. Select this option to create invoices for all the vendors to whom recurring 
payables are assigned and who use the vendor groups or national accounts you specify.

Note: If you select Vendor Number or Vendor Group and more than one recurring payable is due for a 
vendor, Accounts Payable processes all recurring payables for the vendor.

A/P Create Retainage Batch Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Create Retainage Batch.

Related Tasks

"Processing Outstanding Retainage" (page 200)

Overview

Use the A/P Create Retainage Batch screen periodically to create a batch of retainage invoices, 
retainage debit notes, and retainage credit notes for the vendors, documents, or vendor groups you 
select.

If you assigned a schedule (on the Retainage tab of the A/P Options screen) that uses a reminder to 
users, Accounts Payable can remind users to process retainage transactions when they are due. Users 
can then process the retainage transactions directly from the Reminder List in Common Services, rather 
than from the A/P Create Retainage Batch screen. For more information about using schedules and 
reminders, see the System Manager Help.
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Accounts Payable assigns the next available invoice, credit note, or debit note batch number to the 
retainage batch. It assigns the next retainage invoice, retainage debit note, or retainage credit note 
number specified on the Retainage tab on the A/P Options screen.

Fields and Controls

Document Type

Specify the types of original documents for which you are now processing outstanding retainage 
amounts. You can select:

 l Invoices.

 l Debit Notes.

 l Credit Notes.

From / To

Enter the range of records from which to select.

Notes: 
 l To specify a single record, enter its number or code in both fields.

 l To select all records, leave the From field blank and the To field showing Zs.

Number of Days In Advance To Generate Retainage Documents

Specify the number of days in advance of the retainage due date that retainage documents can be 
created.

For example, if you specify 7 as the number of days in advance, Accounts Payable processes 
outstanding retainage that is due within seven days of the run date.

Run Date

Enter the run date for the retainage batch. Accounts Payable uses the session date as the default, but 
you can enter a different date if you want.

Accounts Payable processes all outstanding retainage amounts that are due up to and including the 
specified run date.
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Note: For job-related  documents, retainage amounts and due dates are specified at the detail level. 
The program invoices only for those details that are due.

Select By

Choose the type of record by which to select outstanding retainage for processing:

 l Vendor Number. Select this option to process outstanding retainage for all the vendors in the 
range of vendor numbers you specify.

 l Document Number. Select this option to process outstanding retainage for all the original 
retainage documents in the range of document numbers you specify.

 l Vendor Group. Select this option to process outstanding retainage for all vendors who belong to 
the vendor groups within the range you specify.

A/P Delete Inactive Records Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Delete Inactive Records.

Related Tasks

"Removing Inactive Records from Accounts Payable" (page 202)

Overview

Use the A/P Delete Inactive Records screen to remove obsolete vendor, vendor group, remit-to location, 
and recurring payable records.

Note: This screen removes records only if they currently have Inactive status, and were set inactive 
within the range of dates you specify.

Fields and Controls

Delete These Records

Specify the types of records to delete, including:
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 l Remit-to locations.

 l Inactive vendors.

 l Inactive vendor groups.

 l Inactive recurring payable records.

From/To Inactive Dates

Enter a range of dates to indicate when a record must have been made inactive to delete it. Accounts 
Payable selects records that have Inactive status and a corresponding "inactive" date within the range 
of dates you specify.

The current session date is the default To date.

Tip: If you do not want to delete all the records for the same range of inactive dates, process each set 
of records separately.

From/To Records

Enter the range of codes or numbers to delete for each record type you selected.

A/P Integrity Checker Screen

To Open this Screen

 1. Open Administrative Services > Data Integrity.

 2. Include Accounts Payable in the integrity check.

 3. In the Check Applications box, select Accounts Payable, and then click Application Options.

Overview

Use the A/P Integrity Checker screen to limit the scope of Accounts Payable integrity checks to fit the 
time available. You can specify:

 l The type of data to check.

 l A range of vendor records for which to check data.

 l Whether to fix minor errors during the check.

 l Whether to check for or delete orphan records.
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Fields and Controls

Check

Select this option for the records in the list for which you want to check data integrity.

Check For Orphan Records

Select this option to check the integrity of records in all database tables that have become dissociated 
from their "parent" record.

Notes: 
 l A "parent" record is a record that has other records nested under it, and a "child" record is a 

record that is nested under another record. For example, in the case of entry records nested 
under a batch record, the batch record is the parent of the entry records, and the entry records 
are the children of the batch record.

 l Child records that are no are longer associated with a parent are called "orphans."

Delete Orphan Records

Select this option to delete records that have become dissociated from their "parent" record.

Fix

Select this option to fix minor errors found in the selected records.

Open And Ready To Post Batches

Select this option to check for errors in all records that belong to unposted invoice, payment, and 
adjustment batches.

Posting Journals

Select this option to check for errors in posting journals.

Note: If you select this option, the program will find but not fix errors. To fix errors, you must select the 
Fix option.
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Setup Tables

Select this option to check for errors in all Accounts Payable setup records, such as Options, Account 
Sets, and Payment Codes.

Vendor Documents (From Vendor/To Vendor)

Select this option to check all records that store information for vendor payments for the range of 
vendors you specify.

A/P Revaluation Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Revaluation.

Secondary Screens

A/P Revaluation History Screen

Related Tasks

"Revaluing Transactions in Other Currencies" (page 211)

Overview

Use the A/P Revaluation screen to:

 l Revalue multicurrency transactions at new exchange rates, to determine the current value of 
payables on specific dates (in multicurrency ledgers only).

 l Process a provisional revaluation (select the Provisional Revaluation option) to determine the 
transactions that would be created for the general ledger exchange gain and loss accounts if you 
revalued the accounts at the specified rates.

 l Create revaluation transactions for the general ledger exchange gain and loss accounts.

 l Open a separate screen to view historical revaluations for a selected currency, and select 
revaluations that you need to redo.

When exchange rates fluctuate, you may need to revalue outstanding documents denominated in other 
currencies to reflect their present value in your own (functional) currency at a particular time, such as a 
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financial statement date. When you revalue a transaction, Accounts Payable recalculates its functional 
equivalent value at a new exchange rate.

Gains and losses due to fluctuating exchange rates are treated as permanent or temporary, depending 
on the exchange Gain/Loss Accounting Method specified for your Sage 300 system on the Company 
Profile screen in Common Services. For more information about this method, see the System Manager 
Help.

Fields and Controls

Currency Code

Enter the currency code for which you want to revalue transactions.

The revaluation process selects only transactions that are in the specified currency.

Note: You cannot specify the same currency code more than once for a single revaluation. If you want 
to revalue different ranges of records for the same currency code, revalue each range separately.

Earliest Backdated Activity Date

Specify the earliest backdated document to revalue.

Note: This field is available only if you use the Recognized Gain/Loss accounting method for your 
Sage 300 system, you are revaluing a period you revalued before, and there is a backdated 
transaction in the period.

If you leave this field blank, the program does not adjust the balances for the backdated transaction and 
associated documents. You might want to leave the field blank, for example, if the revaluation is not for 
the end of a reporting period, and the change will be captured in a subsequent revaluation.

Optional Fields

This field indicates whether any optional fields are assigned to the revaluation.

The program sets the value in this column for each line that you fill in on the table. If any optional fields 
are set up for automatic insertion on the Revaluation screen, when you first add a detail line, the 
program sets the field to Yes.

To view the assigned optional fields, or to change them, select the line on the table, and then click the 
Optional Fields column heading.
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Provisional Revaluation

Select this option to do a test run to preview the revaluation transactions before they are posted to the 
general ledger. You can then print the Pre-Revaluation Listing to check the effects of the revaluation 
before you do an actual revaluation and create general ledger transactions.

If you do not select this option, Accounts Payable creates the transactions for the general ledger batch 
when you click the Process button.

Rate

Type the rate at which to revalue transactions for the specified currency code, or use the Finder to select 
a rate (if one exists for the currency, rate type, and rate date in the rates table).

Rate Date

Enter the date to use to select the exchange rate at which to revalue transactions for the specified 
currency code.

Rate Type

Enter the rate type for selecting the currency table.

Revaluation Date

Enter the date of the end of the period you want to revalue.

The revaluation process selects open transactions with posting dates that are on or before the date you 
specify.

A/P Year End Screen

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > Year End.

Related Tasks

"Starting a New Fiscal Year" (page 214)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Year End screen to:

 l Reset batch numbers, so that the next batch you create of each type will use number 1.

 l Move vendor activity statistics for the current year into the previous year, and zero the totals for the 
new year.

 l Clear year-to-date statistics from recurring payable records.

 l Reset to 0 (zero) the Total Invoices Paid, Number Of Payments, and the Total Days To Pay fields 
on the Activity and Statistics tabs on the Vendors screen.

Note: Activity statistics are kept only for the current year to date and the previous year. When you clear 
activity statistics, the current-year statistics become the previous-year statistics.

Fields and Controls

Clear Activity Statistics

Select this option to enter zeros in the current-year fields on the Vendor Activity tab of the A/P Vendors 
screen, and to transfer current-year statistical information to the corresponding fields for the previous 
year.

Note: When you select this option, the Clear Invoices Paid And Days To Pay Counter option 
appears.

Clear Invoices Paid And Days To Pay Counter

Select this option to enter 0 (zero) in the Total Invoices Paid and Number Of Payments fields on the 
A/P Vendors screen, and in the Total Days To Pay field on the A/P Vendors and A/P Vendor Groups 
screens.

Do not select this option if you want to include previous-year documents when calculating the average 
days to pay for vendor accounts.

Note: This option is available only if the Clear Activity Statistics option is selected. You cannot clear 
these figures if you do not also clear the other activity statistics.
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Clear Recurring Payable Amount Invoiced To Date

Select this option to set the Amount Invoiced To Date field to zero in all recurring payable records.

Reset All Batch Numbers

Select this option to:

 l Reset all batch numbers to 1 (for all types of batches).

 l Delete posted and deleted batches so they no longer appear on the Batch Status report.

Notes: 
 l You can have up to 999,999,999 of each type of batch in Accounts Payable, so your company 

can decide whether it wants to reset the numbers.

 l Once you reset batch numbers, you can no longer drill down to view transaction details from 
General Ledger.

A/P 1099 Electronic Filing Screen

Note: To use this screen, you must have security authorization to maintain tax numbers.

To Open this Screen

Open Accounts Payable > A/P Periodic Processing > 1099 Electronic Filing.

Related Tasks

"Filing 1099 Reports Electronically" (page 205)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P 1099 Electronic Filing screen to create an electronic file to submit 1099 forms through the 
IRS FIRE (Filing Information Returns Electronically) System online or by mailing them on physical media.

When you finish filing, Accounts Payable automatically prints a summary report of the information you 
filed, which you can keep with your records.
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Note: You should refer to IRS documentation for information on electronic filing requirements before 
you submit 1099s electronically. For example, the IRS does not accept compressed files.

Fields and Controls

From/To Vendor No

Enter the range of vendors for which you want to produce 1099 data for submission.

Output File

Specify a file name and location for the output file.

Payment Year

Enter the calendar year for which you are submitting the 1099s.

Note: You can enter the current year or a previous year.

Payer Information

Final Filing

Select this option only if you will not be filing 1099s under this name and tax number again.

Foreign Entity

Select this option if your company is located outside the United States.

Name Control

Enter the four-character Payer Name Control that appears on the mail label on the Package 1099 that 
you received in December.

Name Line 1 and  Line 2

On Line 1, enter your company's usual business name.
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On Line 2, if you selected the Transfer Agent option, you must enter the name of the transfer agent. 
Otherwise, you may continue your company name on this line, if you need more room.

Office Branch

Enter additional identifying information that you want to appear with correspondence that the IRS sends 
you or your vendors.

Note: If you use a Branch code in your company profile, Accounts Payable displays it here.

Phone

Enter a phone number for your company or for the transfer agent, if you used one.

Street / City / State (Prov.) / Zip (Postal Code) / Country

Enter the address of the transfer agent, or enter your company's address.

Note: The Country field appears only if you selected the Foreign Entity option.

Tax Number

Enter your company's 9-digit federal tax number.

Transfer Agent

Select this option if another company paid or transferred funds to the U.S. resident for your company.

Note: If you select this option, you must enter the name of the transfer agent in the (Name) Line 2.

Transmitter Information

Company

Enter the name of the company to which correspondence regarding problems with the electronic 
submission should be sent.

Contact

Enter the name of a contact person to whom to send correspondence.
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Control Code (TCC)

Enter the five-character Transmitter Control Code issued by the IRS.

E-mail

Enter an e-mail address for the contact person.

Foreign Entity

Select this option if the transmitting company is located outside the United States.

Name Line 1 and Line 2

On Line 1, enter the normal business name of the company that is transmitting this information.

On Line 2, continue entering the business name, if you need more room.

Phone

Enter a phone number for the contact person.

Street/City/State/Prov./Zip/Postal Code/Country

Enter the address for the company you entered in the previous field.

Note: The Country field appears only if you selected the Foreign Entity option.

Tax Number

Enter the transmitter's 9-digit federal tax number.

Test File

Select this option if you are:

 l Applying for electronic filing.

 l Filing electronically for the first time.

 l Participating in the Combined Federal/State Filing Program.

A/P T5018 (CPRS) Electronic Filing Screen

Note: To use this screen, you must have security authorization to maintain tax numbers.
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To Open this Screen

Open Accounts Payable > A/P Periodic Processing > T5018 (CPRS) Electronic Filing.

Related Tasks

"Filing  a T5018 (CPRS) Information Return Electronically" (page 206)

Overview

Important! If you file more than 50 T5018 slips for a calendar year, you must use CRA's Internet File 
Transfer application to file original or amended T5018 returns.

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P T5018 (CPRS) Electronic Filing screen to create your T5018 information return in the 
required XML format. You can then submit the generated file to the CRA through their website or on 
electronic media acceptable to the CRA.

If your company operates in Canada and your primary source of business income is construction, you 
must report amounts paid or credited for construction services to the Canada Revenue Agency (CRA) by 
filing a T5018 information return, which consists of a T5018 Summary and related T5018 slips.

Fields and Controls

From/To CPRS Code

Enter the range of CPRS Codes for which you are producing this T5018 information return.

From/To Vendor No.

Enter the range of vendors to include on this T5018 information return.

Payment Year

Enter the calendar year for which you are submitting the T5018 forms.
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Note: You can enter the current year or a previous year.

Output File

Enter the location and name for the T5018 XML file generated during this process.

Report Type

Specify the report type as follows:

 l Original. Select this option if you are filing this year's T5018 information return for the first time.

 l Amended. Select this option if you are submitting a corrected return to replace one you filed 
earlier.

 l Cancelled. Select this option if you are cancelling a return you filed earlier.

Payer Information

Account Number

Enter the payer's account number.

To file T5018 information returns with the CRA, you require an RZ account number in the following 
format: 000000000RZ0000. You obtain this number from the CRA.

If you are amending or cancelling a T5018 information return that you filed earlier, use the same 
number you used to file the original information return.

City/State/Prov./Zip/Postal Code/Country Code

Enter the payer company's address.

Note: For the country code, use CAN for Canada, and USA for the United States of America. For 
other countries, use the alphabetic country codes described in the International Standard (ISO) 3166 
Codes for the Representation of Names of Countries, unless the CRA requires a more recent 
standard.

Contact/Phone

Enter the name and telephone number of a contact person that the CRA can contact about this T5018 
information return.
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Name Line 1 and Line 2

Enter the payer company's legal name and business (trade) name in these fields.

Transmitter Information

Address Line 1 and Line 2

Enter the street number and business address of the transmitter company.

City/State/Prov./Zip/Postal Code/Country Code

Enter the business address for the company transmitting the information return.

Contact

Enter the name of a contact person to whom to send correspondence. Do not use titles, such as Mr., 
Mrs., and so on.

E-mail

Enter an e-mail address for the contact person.

Language

Specify the language in which you do business with the CRA. (You can select English or French.)

Name Line 1 and Line 2

Enter the normal business name of the company that is transmitting this information on Line 1. Use Line 
2 to continue entering the business name, if you need more room.

Phone

Enter a phone number for the contact person.

Submission Reference ID

You must enter a unique number to identify this submission to the CRA.
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Transmitter Number

Enter the transmitter number assigned to you by the CRA. The transmitter number must be prefixed by 
the code MM.

Setup Screens
Use Accounts Payable Setup screens to set up records and options that determine how Accounts 
Payable:

 l Processes transactions.

 l Interacts with General Ledger and other Sage 300 modules.

A/P Account Sets Screen

To Open this Screen

Open Accounts Payable > A/P Setup >        Account Sets.

Related Tasks

 l "Adding or Modifying an Account Set" (page 19)

 l "Printing the Account Sets Report" (page 226)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Account Sets screen to create groups of general ledger account numbers that you can use 
to:

 l Categorize vendor transactions by accounts to which they are posted in general ledger. These general 
ledger accounts are:

 l Payables Control.

 l Purchase Discounts.
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 l Prepayment.

 l Use separate account sets to designate different types of payables, or vendors in different 
geographical areas.

Fields and Controls

Account Set Code

To begin adding a new account set, do one of the following:

 l Enter a code for the account set.

 l Click the New  button to the right of the field.

To edit an existing account set, enter its code.

Currency Code

If you use multicurrency accounting, you assign a currency code to each account set to identify the 
currency used by the vendors you will assign to the set.

You must assign a currency code that is included in the Currency screens in Common Services.

Note: Once you add an account set, you cannot change its currency.

Description

Enter a description of the account set, using up to 60 characters.

Exchange Gain

An income statement account to which you post differences arising from fluctuating exchange rates 
when you revalue a transaction at a new exchange rate or when you apply a payment to it.

A gain occurs when changes in the exchange rate cause an decrease in the functional-equivalent 
amount you owe to a vendor.

Exchange Loss

An income statement account to which you post differences arising from fluctuating exchange rates 
when you revalue a transaction at a new exchange rate or when you apply a payment to it.
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A loss occurs when changes in the exchange rate cause an increase in the functional-equivalent 
amount you owe to a vendor.

Exchange Rounding

Specify an income statement account that is updated with differences that arise when converting 
amounts from source currencies to the functional currency.

Inactive

Select this option if you do not want to assign the account set to any vendors. For example, if you decide 
to delete an account set, and want to ensure no further vendor accounts are assigned to it. You can 
change this option any time.

Note: If you make an account set inactive, you can no longer assign it to vendor records. You also 
cannot save changes to vendor records that use the inactive account set, unless you first assign the 
records to an active account set.

Last Maintained

This field displays the date of the last change made to the account set.

Payables Control

A liability account that contains the total amount payable to all vendors assigned to the control account 
set. The account is credited when invoices or debit notes are posted, and debited when payments or 
credit notes are posted.

Note: The word "control" in the account name means that the account contains only totals, whereas 
the information stored by the Accounts Payable program contains details at the transaction-
distribution level.

If all transactions are processed correctly, the total of all Payables balances in the Accounts Payable 
system balances with the totals in the Payables control accounts in your general ledger.

Prepayment

An asset account to which prepayments are debited. The account is credited when prepayments are 
applied to invoices or refunded.
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Purchase Discounts

An income statement account that is credited with discounts taken for early invoice payment.

Retainage

A liability account to which you post amounts you withhold (holdbacks) on vendor invoices.

Unrealized Exchange Gain and Unrealized Exchange Loss

These accounts are available only if you selected the Realized and Unrealized Gain/Loss accounting 
method in the Company Profile, in Common Services.

They are income statement accounts to which you post changes in the functional-equivalent values of 
multicurrency transactions when you revalue them at new exchange rates.

A gain occurs when a payable transaction decreases in value. A loss occurs when a payable transaction 
increases in value.

The gain or loss is "unrealized" because the transaction is not completed (that is, you have not paid it) 
and the exchange rate for the transaction can continue to change until it is fully paid.

A/P Distribution Sets Screen

To Open this Screen

Open Accounts Payable > A/P Setup > Distribution Sets.

Related Tasks

 l "Adding or Modifying Distribution Sets" (page 25)

 l "Printing the Distribution Sets Report" (page 228)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.
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Use the A/P Distribution Sets screen to create sets of distribution codes to represent the standard groups 
of distributions to general ledger accounts that you make when entering vendor transactions. You can 
also enter General Ledger accounts directly in distribution sets.

Note: You do not have to create distribution sets. If you prefer, you can assign the general ledger 
account numbers or distribution codes you need to invoice details as you enter them.

If you add distribution sets, you can assign them to vendor records. Accounts Payable automatically 
displays the corresponding distribution codes assigned to a distribution set when you enter transactions 
for the vendor, but you can make any changes you need.

You must define distribution codes before you can use them in distribution sets.

For each vendor account, you choose whether to distribute transactions for the vendor by general ledger 
account numbers, distribution codes, or distribution sets, and you enter the default set, code or account 
number. (You can override the default during data entry.)

Fields and Controls

Description (of the distribution set)

Type a description of the distribution set.

Distribution Method

Select the method by which to apportion an invoice amount among the accounts in the distribution set:

 l Spread Evenly. This method divides the invoice amount evenly among all the distribution codes 
in the distribution set. You can then edit the result.

 l Fixed Percentage. This method lets you specify the percentage of the total invoice amount to allocate 
to each distribution code. You can specify a negative percentage or a percentage more than 100%. 
You can also edit the results of this distribution method. 

 l Manual. This method provides no amount allocation; it just enters the distribution codes and lets 
you enter the amounts of the distribution.

 l Fixed Amount. This method distributes a specific amount to each distribution code in the 
distribution set. You must specify a currency code to use this method, and you can select the 
distribution code only for vendors that use this currency. You can edit the result.

Note: The setting you select determines the default invoice distribution, which you can override at 
invoice entry.
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Distribution Set

Enter a code to identify the distribution set, using up to six characters.

Inactive

Select this option if you do not want to assign the distribution set to any vendors.

If you make a distribution set inactive, you can no longer assign it to vendor records or invoice 
distributions. You also cannot save changes to vendor records or invoices that use the inactive 
distribution set, unless you first assign an active distribution set to the records or invoices.

You would primarily use the option when you decide to delete a distribution set, and want to ensure no 
further vendor accounts are assigned to it. You can change this status any time.

Last Maintained

This is an information field in which the program displays the date of the last change made to the 
distribution set. You do not make an entry in this field.

Table

Description (distribution code)

This column displays the descriptions of the distribution codes you add to the distribution set. You 
cannot change the descriptions in this column, except by typing a new description for the distribution 
code in the Distribution Codes screen.

Distribution Amount

If you selected Fixed Amount as the distribution method, enter the amount to allocate to the distribution 
code.

Distribution Code

Type the distribution code you want to add to the distribution set or select the code from the Finder. 
Once you enter the code, Accounts Payable displays the code description and general ledger account 
number so you can verify them.
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Distribution Percent

If you selected Fixed Percentage as the distribution method, enter the percentage of the document 
total to distribute to each distribution code you add to a set.

You can use negative percentages and percentages greater than 100 percent, providing the total is 100 
percent.

Accounts Payable warns you if the percentages you enter for a distribution set do not add up to 100 
percent, but lets you add or save the record. 

Use this type of distribution set when you need to enter additional general ledger account distributions 
with invoices, but do not want to include the extra accounts in the distribution set.

G/L Account

This column displays the number of the general ledger account that is assigned to the distribution code 
selected for the detail line. You cannot change the account number in this column, directly.

To change the general ledger account number assigned to a distribution detail, you must select another 
general ledger account number in the record for the distribution code, using the Distribution Codes 
screen. If you change the general ledger account assigned to a distribution code, the new account 
number is automatically entered in the distribution set records that use the distribution code.

You can also enter General ledger accounts directly in the distribution set if you do not use a distribution 
code. If you want to reuse the description and discount status from an existing distribution code, insert 
the distribution code in the distribution set, as usual. Then clear the code, and enter the General Ledger 
account you want to use.

A/P E-mail Messages Screen

To Open this Screen

Open Accounts Payable > A/P Setup > E-mail Messages.

Related Tasks

 l "Adding or Modifying E-mail Messages" (page 29)

 l "Printing the E-mail Messages Report" (page 229)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P E-mail Messages screen to:

 l Create messages to send with e-mailed letters.

 l Use variables (field names) from your company database so that e-mailed messages will include 
vendor- or company-specific information. For more information, see "E-mail Message Variables" 
(page 28).

When printing letters using the Letters/Labels screen, select Vendor as the delivery method. You can 
then select the message ID for the message you want to send with the letter.

Fields and Controls

Description

Enter a description for the message, using up to 60 characters.

E-mail Subject

Enter the subject line you want to use for the message. Note that you can use field names, preceded by 
a dollar sign to insert vendor- or company-specific information in the subject line of the messages.

Inactive

Select this field only if you do not want to you use it for e-mailed messages.

Last Maintained

This display-only field shows the last time you modified this e-mail message.

Message (unlabeled text box)

Use this field for your message.

Message ID

Enter a code to identify this message, using up to 16 characters.
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A/P G/L Integration Screen

To Open this Screen

Open Accounts Payable > A/P Setup > G/L Integration.

Secondary Screens

G/L Integration Detail Screen

Related Tasks

"Selecting General Ledger Integration Options for Accounts Payable" (page 11)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P G/L Integration screen to:

 l Specify how Accounts Payable produces and maintains information from posted transactions for 
General Ledger.

 l Define the source codes used to identify different types of Accounts Payable transactions created 
for General Ledger.

 l View the last posting sequence number for each type of batch posted to General Ledger.

 l Specify what data to include in the G/L Entry Description, G/L Detail Reference, G/L Detail 
Description, and G/L Detail Comment fields in general ledger transactions.

Sage 300 Accounts Payable produces general ledger transactions from all batches you post. Each 
general ledger transaction includes all the information you need to update Payables data accurately in 
your general ledger.

If you use Sage 300 General Ledger, Accounts Payable creates:

 l Batches of payables transactions right in General Ledger, where you can edit and post them.

 l Separate General Ledger batches from posted invoice, payment, and adjustment batches, as well 
as from revaluation (in multicurrency ledgers).
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If you use another general ledger system or your Sage 300 General Ledger system is at another location, 
Accounts Payable creates batches you can import into another application, or print, then enter manually 
into your general ledger.

Changing Settings

You can change any settings on the A/P G/L Integration screen at any time.

Note: Changes to settings are applied only to general ledger transactions created after the change, 
and do not affect pre-existing general ledger batches.

Tip: If you use the Create G/L Batch screen to produce general ledger batches and want to change to 
producing them during posting, we recommend that you first run Create G/L Batch to create any 
outstanding transactions.

Integration Tab

Use this tab to:

 l Specify whether to add general ledger transactions to the G/L batch each time you post, or to 
create the transactions at a later date.

 l Choose whether to add new transactions to the existing G/L batch, or create a separate G/L batch 
each time you post. You can also choose to post new batches automatically.

Note: This option applies only if you use Sage 300 General Ledger with Accounts Payable at the 
same location.

 l Choose whether to consolidate the G/L batch when you post, or always enter full transaction 
details in the batch.

 l Define the source codes used to identify different types of Accounts Payable transactions created 
for General Ledger.

 l Look up the posting sequence number to be assigned the next time you post invoices, payments, 
or adjustments, or the next time you revalue transactions, if you use multicurrency accounting.

Before changing the Create G/L Transaction option to create transactions during posting (if it was set to 
create transactions using the Create G/L Batch icon), print an up-to-date copy of the G/L Transactions 
report, then create any outstanding transactions.

Any change to your selections for the Consolidate G/L Batch option or the data to include in the 
transaction description, detail reference, detail description, and detail comment fields for general ledger 
transactions applies only to transactions posted after the change, and has no effect on transactions 
already in a general ledger batch.
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Transactions Tab

Use this tab to specify the type of information to use in the G/L Entry Description, G/L Detail Reference, 
G/L Detail Description, and G/L Detail Comment fields in general ledger transactions.

This information also appears on Accounts Payable posting journals and on General Ledger’s Journal 
Entry screen and reports.

You can assign one or more pieces of information (segments) to each field, provided that the combined 
length of the segments and separators does not exceed 60 characters. Fields exceeding this limit will be 
truncated when you post general ledger transactions.

The segments you can select depend on the type of transaction to which you are assigning information 
and whether the information is for the transaction header or the details. This ensures that the information 
passed to General Ledger is relevant for each type of transaction. For example, you can assign the remit-
to information from invoice details to any of the General Ledger fields.

When you create general ledger transactions, if no data exists in the source transaction field, the field will 
be blank in the general ledger transaction. For example, if you assigned the original transaction 
description to the G/L Entry Description field, but there is no description for a particular entry, the field will 
be blank in the G/L transaction.

Fields and Controls

Integration Tab

Consolidate G/L Batches

Use this option on the G/L Integration tab of the G/L Integration screen to specify whether to combine 
transaction details for the same general ledger account into single details, or to send every Accounts 
Payable transaction detail to General Ledger.

Note that if you consolidate transactions, you lose the ability to drill down to them from General Ledger.

You can choose:

 l Do Not Consolidate. All the details posted in Accounts Payable will be included in the General 
Ledger transaction batch. You maintain the ability to drill down to the transactions from General 
Ledger.

 l Consolidate by Posting Sequence, Account and Fiscal Period. All the details with the same 
posting sequence, account number and fiscal period are combined into one detail. You will not 
be able to drill down to the transactions from General Ledger.

 l Consolidate by Posting Sequence, Account, Fiscal Period, and Source. All the details with the 
same posting sequence, account number, fiscal period, and source code are combined into one 
detail. You will not be able to drill down to the transactions from General Ledger.
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Create G/L Transactions By

This option applies only if you use Sage 300 General Ledger with Accounts Payable.

You can create transactions by:

 l Adding to an Existing Batch. Choose this option if you want to add new general ledger 
transactions to existing batches.

 l Creating a New Batch. Choose this option if you want to produce a new general ledger batch 
each time you create general ledger transactions.

 l Creating and Posting a New Batch. Choose this option if you want to create and automatically 
post a new general batch when you create general ledger transactions.

Note: If you try to post a G/L batch to a period that is locked for General Ledger, the transactions will 
be placed in an error batch. Therefore, make it a practice to create and post General Ledger batches 
for outstanding Accounts Payable transactions before locking a period for General Ledger.

Accounts Payable automatically creates separate general ledger batches for the different types of 
transactions you can post (invoices, payments, adjustments) and for revaluation transactions (if you 
use multicurrency accounting).

If you do not use Sage 300 General Ledger, all general ledger transactions are added to the same 
general ledger batch, regardless of the type of transaction and your choice for this option. You are 
asked to whether to add the transactions to the existing batch or overwrite the batch. Always choose to 
add to an existing batch.

Create G/L Transactions (During Posting/On Request Using Create G/L Batch Icon)

Use this option to specify when to create general ledger transactions.

You can create transactions for the general ledger when you post Accounts Payable batches, or you 
can create a batch of general ledger transactions using the Create G/L Batch icon.

You can change your selection at any time. If you have been using the Create G/L Batch icon to create 
the transactions, before you change the option, be sure to print a copy of the latest G/L Transactions 
report, then create any outstanding transactions.

If you use the option to create the batch during posting in Accounts Payable, you cannot print the G/L 
Transactions report.
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G/L Source Codes

Use the Source Type fields in this section to define the source code for each type of Accounts Payable 
transaction, if you prefer not to use the default source codes.

The source code is a combination of the source ledger code (AP, which you cannot change) and the 
source type code, which you can specify for all the different types of transactions you can process in 
Accounts Payable, including revaluation.

The source codes are used to identify transactions in General Ledger.

Note: The default source code for payments is the same as for payment reversals.

G/L Transactions Generated Through

This box lists the posting sequence number of each type of transaction batch for which general ledger 
transactions have been created.

If all general ledger transactions are up to date, the posting sequence numbers in this box are the same 
as the posting sequence numbers shown for each batch type on the A/P Create G/L Batch screen.

Tip: If you create G/L batches using the Create G/L Batch icon, you can use this information to check 
whether you have created all outstanding general ledger transactions.

Transactions Tab

G/L Detail Comment

This field displays, for each detail transaction type, the comment information that will appear with 
unconsolidated details on the G/L Transactions report and in the general ledger batch.

To include different information as the comment for a selected transaction type, click the Open button, 
or double-click the Comment field you want to change, and then enter the information on the 
G/L Integration Detail screen that appears.

G/L Detail Description

This field displays, for each detail transaction type, the information that will appear with unconsolidated 
details in the Description column on the G/L Transactions report and in the Description field in the 
general ledger batch.
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Note: If you consolidate details during posting, the description is "CONSOL" for all the transactions in 
General Ledger.

To edit the information for a selected transaction type, click the Open button, or double-click the field 
you want to change, and then enter the information on the G/L Integration Detail screen that appears.

G/L Detail Reference

This field displays, for each detail transaction type, the information that will appear with unconsolidated 
details in the Reference column on the G/L Transactions report and in the Reference field in the general 
ledger batch.

Note that if you consolidate details during posting, the reference is blank for all the transactions in 
General Ledger.

To edit the information for a selected transaction type, click the Open button, or double-click the field 
you want to change, then enter the information on the G/L Integration Detail screen that appears.

G/L Entry Description

This field displays, for each entry transaction type, the information that will appear as the entry 
description on the G/L Transactions report and in the general ledger batch.

To edit the information for a selected transaction type, click the Open button, or double-click the field 
you want to change, then enter the information on the G/L Integration Detail screen that appears.

Transaction Type

This column shows the transaction types for which you can assign information for G/L transactions.

To edit the information for a selected transaction type, click the Open button, or double-click the field 
you want to change, then enter the information on the G/L Integration Detail screen that appears.

A/P Options Screen

To Open this Screen

Open Accounts Payable > A/P Setup > Options.
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Related Tasks

 l "Selecting Options for Accounts Payable" (page 8)

 l "Printing the A/P Options Report" (page 231)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Options screen to select processing options and enter general information about your 
Accounts Payable ledger.

Changing Settings

Important! Before changing any of the settings or other information on the A/P Options screen, make 
sure you understand the impact the options have on processing within Accounts Payable.

You can change the settings for most Accounts Payable options at any time, provided that no other 
Accounts Payable screens are open and no one else is currently using the Accounts Payable database.

Notes: 
 l The only option you cannot change is the Multicurrency option. Although you can select this 

option at any time, you cannot turn it off again once you have selected it and saved the change.

 l You cannot save most changes on the A/P Options screen if any other Accounts Payable 
screens are open.

Company Tab

Use this tab to change the contact name, telephone number, and fax number for Accounts Payable.

To change the company name and address, or to change the contact name, telephone number, and fax 
number at the company level, use the Company Profile screen in Common Services.

Numbering Tab

Use this tab to:

 l Choose the prefixes and next numbers to assign when you save recurring payables, payments, 
prepayments, and adjustment transactions, or you can allow Accounts Payable to assign them 
automatically.    
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These numbers include a prefix (up to 6 letters) followed by a sequence number. The prefix you assign 
must be unique and cannot be used for any other type of Accounts Payable document.

You can change these prefixes and next numbers at any time.

 l Restrict the length of the number to be assigned to recurring payables, payments, prepayments, 
and adjustment transactions. You can use a maximum length of 22 characters, including prefixes.

This tab also displays the numbers that will be assigned to the next invoice, payment, adjustment, and 
revaluation posting sequences, and the next invoice, payment, and adjustment batches.

Processing Tab

Use this tab to specify:

 l Whether your Accounts Payable system uses multicurrency accounting. For more information, see 
"Setting Up Accounts Payable to Use Multicurrency Accounting" (page 8).

Note: Once you turn on the Multicurrency option, you cannot turn it off again.

 l Whether to force listing of batches before posting.

 l Whether imported and external batches can be edited.

 l Whether Accounts Payable accumulates and reports vendor and vendor group statistics.

 l If statistics are accumulated, the type of year and period for which they are to be kept, whether tax 
is included in the statistics, and whether statistics can be edited.

 l Aging periods by which you group outstanding and overdue transactions on reports, and whether 
you age unapplied credit notes, debit notes, and prepayments in the current period or the period 
associated with their document dates.

 l The default number of days you keep comments in vendor records, and whether you require batch 
listings (before posting).

Retainage Tab

Note: This tab appears when you select the Retainage Accounting option on the Processing tab.

Use this tab to specify default settings for retainage when you add new vendor records.

Accounts Payable uses the retainage settings from vendor records as defaults when you enter invoices, 
credit notes, or debit notes, although you can change settings for particular vendors—and for individual 
documents.

Transactions Tab

This tab lets you:
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 l Specify the following options for invoice, credit note, and debit note transactions:

 l Whether you report 1099/CPRS payments, and whether you permit 1099/CPRS amounts to 
be edited.

 l The default method for calculating tax on invoices (automatic or manual tax calculation).

 l Whether to use document totals as default amounts subject to 1099/CPRS reporting on 
invoices, debit notes, and credit notes.

 l Set options for payment transactions, including:

 l The default bank code for your company.

 l The order in which to list documents when applying payments and credit notes in the 
Payment Entry screen. For more information, see "About Displaying Open Documents in 
Payment Entry" (page 6).

 l Whether you enter adjustment transactions in payment batches.

 l Whether you permit editing of system-generated batches (of payments).

 l Set the default sort order when printing checks, which include:

 l by Vendor Number.

 l by Payee Name.

 l by Payee Country.

 l by Payee Postal Code.

 l by Transaction Number.

You can change your choices for these options at any time, provided no other Accounts Payable screens 
are in use.

Fields and Controls

Company Tab

Use this tab to change company contact information for Accounts Payable.

Note: Changes you make on this tab apply only to Accounts Payable. To change contact 
information at the company level, use the Company Profile screen in Common Services.

Contact Name

Enter the name of the contact at the company.

328Sage 300 2023 Accounts Payable User's Guide



Telephone

Enter the phone number for the company.

Fax Number

Enter the fax number for the company.

Numbering Tab

Document Type

The Document Type column lists the types of documents to which you can assign the next document 
number.

Length

Accounts Payable lets you set separate document number lengths for recurring payables, payments, 
prepayments, and adjustment transactions to be assigned automatically by Accounts Payable.

Use this column to restrict the length of these document numbers to a maximum of 22 characters, 
including prefixes.

Next Number

The Next Number column displays the number that Accounts Payable will assign to the next recurring-
payable, prepayment, payment, and adjustment transaction.

If you want, you can enter the next number to assign to each document type.

If you assign document numbers automatically, Accounts Payable assigns a unique number to each 
document you add to a batch. The number is a combination of the prefix that identifies the transaction 
type and a number that is assigned sequentially, starting with the number you specify.

You can change the next number at any time. However, you must be sure not to assign a number and 
prefix you have used before. You cannot post duplicate document numbers in Accounts Payable.

Prefix

If you plan to use Accounts Payable to assign document numbers automatically and you want to 
continue with the document numbers in your previous payables system, use the Prefix fields on the 
Numbering tab to enter the prefixes you use to assign document numbers to recurring payables, 
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payments, prepayments, and adjustments.

You can use up to six characters in each prefix and you must use a different prefix for each type of 
document. Alternatively, you can accept the default prefixes that appear.

If you assign document numbers automatically, Accounts Payable assigns a unique number to each 
document you add to a batch. The number is a combination of the prefix you enter to identify the 
transaction type and a number that is assigned sequentially, starting with the number you specify in the 
Next Number field.

You can change the prefixes at any time. However, be sure not to assign a prefix that will create 
duplicates of document numbers that have already been assigned. You cannot post two transactions 
with the same document number in Accounts Payable.

Processing Tab

Accumulate By

Specify how to accumulate statistics:

 l Calendar Year. If you choose this option, the starting date for statistics will be January 1st.

 l Fiscal Year. If you choose this option, the starting date for statistics will be the first day of your 
fiscal year.

Tip: Use the Vendors and Vendor Groups screens to review statistics. You can also print reports of 
statistics.

Age Unapplied Credit Notes and Debit Notes

When you have credit notes and debit notes that do not apply to specific invoice numbers or other 
documents, you can report the amounts in the aging periods that contain their document dates, or you 
can group them all in the current (not due) period.

You use the Age Unapplied Credit Notes and Debit Notes option to make this choice, which you can 
change at any time.

Note: This option has no effect on credit notes and debit notes that are applied to specific document 
numbers. Applied amounts are always included in the same aging periods as the documents to which 
they apply.
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Age Unapplied Prepayments

When you have prepayments that do not apply to specific invoice numbers or other documents, you can 
report the amounts in the aging periods that contain their document dates, or you can group them all in 
the current (not due) period.

You use the Age Unapplied Prepayments option to make this choice, which you can change at any 
time.

Note: This option has no effect on prepayments that are applied to specific document numbers. 
Applied amounts are always included in the same aging periods as the documents to which they 
apply.

Aging Periods

Use the Aging fields to set the default time periods into which Accounts Payable groups outstanding or 
overdue transactions for the Overdue Payables and Aged Cash Requirements reports.

You can change the lengths of the periods for an individual report when you are about to print. You can 
also change the default periods at any time.

Allow Edit of External Batches

This option lets you revise information in batches generated for Accounts Payable in other Sage 300 
programs. Do not use the option if you want to ensure that the external batches are posted without 
changes in Accounts Payable.

You can change your choice for this option at any time, using it to increase your auditing and 
supervisory control of external batches and reducing the possibility of errors from accidental editing.

Allow Edit of Imported Batches

This option lets you revise information in batches you import from other programs. Do not use the option 
if you want to ensure that imported batches are posted without changes in Accounts Payable.

You can change your choice for this option at any time, using it to increase your auditing and 
supervisory control of imported batches and reducing the possibility of errors from accidental editing.

Allow Edit of Statistics

Accounts Payable automatically accumulates statistics from the transactions you post to vendor 
accounts, and displays them in the Vendors and Vendor Groups screens.
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Select the Allow Edit Of Statistics option if you want to enter or revise period statistics that are kept for 
vendors and vendor groups, as well as the current-year and previous-year activity statistics that are 
display on the Vendors screen.

Tip: Turn on the editing option while you are setting up your Accounts Payable system, particularly if 
you are creating the system partway through an accounting year. You can then enter more complete 
payables records by adding the statistics from your previous system.

Once your system is operating, you can turn off the option because the program automatically updates 
the statistics when you post invoice, adjustment, and payment transactions.

You may also decide to use the option to edit vendor group statistics if you change a vendor's group, or 
to edit a particular statistic because unusual circumstances have exaggerated the amount. For 
example, if a single invoice remained unpaid for a long period on an otherwise satisfactory account, you 
could adjust the total number of days to pay or the total number of paid invoices to correct the average 
so that it more accurately reflects your company's paying habits for the vendor.

Note: If you edit a vendor's statistics, you should make the same changes to the statistics for the 
vendor group to which the vendor belongs. Print the Vendor Group Period Statistics and Vendor 
Period Statistics reports for the records you change, to verify that the totals still balance.

Default Number of Days To Keep Vendor Comments

Use this option to specify the number of days for which to retain comments that you enter in vendor 
records.

The number you specify sets the default expiration date for comments on the Vendors screen, but you 
can change the date for each comment you add.

When you select the Vendor Comments option on the A/P Clear History screen, comments that have 
been kept for the specified number of days are deleted, saving you from having to delete each comment 
individually from the vendor records.

Force Listing of All Batches

Use this option to make sure that you print listings of all invoice, payment, and adjustment batches 
before you post them. You must also print new listings of batches you edit. 

This option helps to ensure that you keep your audit trail intact. You can print batch listings whether or 
not you use the option. You can also print posting journals that provide complete information about the 
contents of all posted Accounts Payable batches.

You can change your choice for this option at any time.
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Functional Currency

The functional currency for your company is set in Common Services (on the Company Profile screen) 
and, once it is assigned, it cannot be changed.

All Sage 300 modules activated for a company use the same functional currency.

Include Tax In Statistics

If your company pays taxes on its purchases and you want to include tax amounts in the statistical totals 
that are kept for vendors and vendor groups, select the Include Tax In Statistics option.

If you do not select the option, statistics are based on before-tax totals.

You can change your selection at any time, but you should make changes only at the end of a reporting 
period. If you change before the end of a period, statistics for the period may include taxes in some 
amounts, but not in others, so that you cannot make meaningful comparisons within a period or with 
other periods.

Keep Statistics

Select this option if you want to store vendor and group statistics for your company. 

You can turn this option on or off at any time, which is handy if your database is becoming too large. 
Also, with the option turned off, Accounts Payable can post transactions more quickly.

If you turn off this option, your system stops retaining information, but previously stored information 
remains intact.

Multicurrency

Note: This option appears only if the Multicurrency option is selected on the Company Profile screen 
in Common Services.

You can turn on the Multicurrency option for Accounts Payable at any time. However, once you turn on 
the option and save your changes, you cannot turn it off.

You can use multicurrency and single-currency modules together. For example, you can post 
transactions from a multicurrency Accounts Payable system to a single-currency Sage 300 General 
Ledger.

Note: If you want to track multicurrency transactions, you must first install Sage 300 Multicurrency 
(sold separately).
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Period Type

You use the Period Type option to specify the length of period by which to accumulate and report 
statistics.

The choices for period type are: Weekly (calendar weeks), Seven Days (weeks that begin on the days 
and dates in your fiscal calendar), Bi-Weekly (every two weeks), Four Weeks, Monthly, Bi-Monthly 
(every two months), Quarterly, Semi-Annually, and Fiscal Period.

Use the Vendors and Vendor Groups screens to review statistics. You can also print reports of statistics 
using the Vendors and Vendor Groups icons in the Setup Reports folder.

Retainage Accounting

You set the option to use retainage accounting on the Processing tab of the A/P Options screen.

When you select the Retainage Accounting option, a Retainage tab appears on the A/P Options screen, 
letting you specify retainage processing options.

You can turn off the Retainage Accounting option, later, only if there are no unposted retainage batches 
and no outstanding retainage amounts.

Retainage Tab

Base Retainage Amount on

Select whether retainage will be calculated on the document total before tax or after tax is included.

Default Retainage Exchange Rate

If you use multicurrency, specify whether to use the current exchange rate or the exchange rate used 
for the original document as the default for retainage documents.

Default Retainage Percentage

Enter the percentage of the document total to withhold on invoices, credit notes, and debit notes. This 
percentage will appear as the default when you add new vendors, but you can change the retainage (or 
holdback) percentage for particular vendors in the vendor record.
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Default Retention Period

Enter the number of days from the original document date that you can withhold the retained amount 
from vendors. The program determines the default retainage due date by adding the retention period to 
the original document date.

The default retention period is used for new vendor records, but you can specify different ones for 
individual vendors. You can also change the retention period on invoices.

Document Numbering

Accounts Payable uses a separate numbering system to identify retainage documents that you 
generate using the Create Retainage Batch screen.

The retainage document numbering table lets you specify the next number, length, and prefix to assign 
to retainage invoices, credit notes, and debit notes, or you can accept the default that appears on the 
table.

Last Invoiced

The Retainage tab displays the date that you ran Create Retainage Batch from the Reminder List.

Number of Days in Advance to Create Retainage Documents

Enter the number of days before the retainage due date that you can generate retainage documents 
using the Create Retainage Batch screen.

For example, if you enter 5, you can generate the retainage invoice five days before the retainage is 
due.

Report Tax

Generally, when you post invoices, Accounts Payable posts tax amounts to a tax account (either tax 
recoverable or tax expense) or to another general ledger account, and it updates the tax tracking 
reports.

For retainage, when the tax is reported can differ. Some tax authorities expect you to report tax when 
you post a retainage document; others let you report tax when you post an original document to which 
retainage applies.

Use the Report Tax field to specify when to report tax on retainage:
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 l At Time Of Original Document. If you select this option, the program calculates and reports tax 
on retainage when you post an original document that includes retainage.          

You can then use the Base Retainage Amount On field to specify whether to base retainage on 
amounts before tax or after tax.

 l As Per Tax Authority. If you select this option, the program calculates tax on retainage when you post 
an original document, but reports the tax as required by each tax authority:

 l No Reporting. The tax amount is calculated and the tax tracking reports are updated 
immediately when you post original documents.            

Note: You can select No Reporting for a tax authority only if you also use At Time Of Original 
Document for the Report Tax option in Accounts Payable.

 l At Time Of Original Document. The tax amount is calculated and the tax tracking reports 
are updated immediately when you post original documents.

 l At Time Of Retainage Document. The tax on retainage is calculated when you post the 
original document, but it is not reported until you post the retainage document.

Notes: 
 l Tax reporting requirements are specified for each tax authority by the Report Tax On 

Retainage Document option, in Tax Services.

 l When you specify As Per Tax Authority, retainage amounts are based on amounts 
before tax for all tax authorities and vendors.

Schedule to Use for Automatic Creation of Retainage Documents

Enter or use the Finder to select the code for the schedule you want to use to process retainage from 
the Reminder List.

If the schedule does not yet exist in Common Services, you can click the Zoom  button beside the 

field, then create the schedule using the Schedules screen that opens. You can also click the Zoom 
button after entering a schedule code to view information about the schedule.

Transactions Tab

Allow Adjustments in Payment Batches

This option lets you enter adjustments in Accounts Payable payment batches during payment entry, 
rather than having to enter them separately in the Adjustment Entry screen.
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You might use this option, for example, when the amount of a check you are entering to pay an invoice 
differs slightly from the invoice total. You can quickly write off the difference when you enter the 
payment.

You can choose the batch to which you want to add the adjustment or create a new adjustment batch 
from Payment Entry, and you can edit it later, if necessary, using the Adjustment Entry screen.

Allow Edit of 1099/CPRS Amounts

Use this option if you want to edit 1099 or CPRS amounts (in the 1099/ CPRS Inquiry screen), or enter 
zero amounts for a service provided by a 1099/CPRS-designated vendor that is not subject to 
1099/CPRS reporting.

Allow Edit of System Generated Batches

Select this option if you need to edit system-generated check entries (created by the Create Payment 
Batch screen). Unless the option is selected, you cannot edit or delete checks, or delete the check 
batch.

Note: You should use this editing feature on an exception basis. By not selecting the option, you 
ensure that the amount of each posted check matches the pre-check register you printed. 

The option applies only to batches created by the Create Payment Batch screen.

Allow Remit-To Information to be Changed

Select this option to allow changes to remit-to location information on the Payment Entry screen.

Check for Duplicate Checks

Use this option to display a warning or an error message, or no message when you attempt to process a 
check that uses the same number as an existing check for the same bank.

Default 1099/CPRS Amount

Select this option if you want to use document totals as default 1099/CPRS amounts on invoices, credit 
notes, and debit notes.

Default Bank Code

You must specify a default bank code before you can create payment batches. 
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Type or use the Finder to select the default bank code you want to use for new payment batches. You 
should choose the bank on which you most often write checks.

Each batch of checks is assigned to one bank code, which determines the bank accounts on which 
checks are drawn, the currency of the checks, and check forms on which check information is printed.

You can change your choice for this option at any time.

Note: Bank codes are defined on the Bank Services screen in Common Services. 

Default Detail Tax Class to 1

Select this option if you want to use 1 as the default tax class for new invoice details.

If you do not select this option, Accounts Payable uses the vendor tax class (from the Invoice Entry 
Taxes tab) as the default for new invoice details.

Default Order of Open Documents

This option controls the order in which open documents (such as invoices that are not yet paid, or credit 
notes that have not been applied) are listed on the Payment Entry screen when you use Select mode to 
apply prepayments and credit notes. 

You should display documents in the order that is easiest for you to use (by document number, 
purchase order number, due date, sales order number, document date, or balance due).

You can change your choice for this option at any time.

Default Payment Code

Specify the default payment code to use for vendors for which no default payment code is specified in 
the vendor record.

Default Posting Date (Invoices)

Specify whether to display the document date, batch date, or session date as the default posting date 
on the A/P Invoice Entry screen. 

The posting date is the date that a document is posted to General Ledger, and it may be different from 
the document date. This distinction is particularly useful if you post a document to a different year or 
period from the document date. For example, Accounts Payable uses posting dates, rather than 
document dates, to select open documents for revaluation, so that exchange adjustments are posted to 
the correct fiscal year and period.
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You can change the posting date for particular transactions when you enter or edit them.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Default Posting Date (Payments)

Specify whether to display the document date, batch date, or session date as the default posting date 
on the A/P Payment Entry screen.

The posting date is the date that a document is posted to General Ledger, and it may be different from 
the document date. This distinction is particularly useful when you post a document to a different year or 
period from the document date. For example, Accounts Payable uses posting dates, rather than 
document dates, to select open documents for revaluation, so that exchange adjustments are posted to 
the correct fiscal year and period.

You can change the posting date for particular transactions when you enter or edit them.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Default Tax Amount

Specify a default method for entering tax amounts on Accounts Payable invoices:

 l Calculate. Accounts Payable calculates tax amounts automatically, and you cannot change the tax 
amounts.     

Note: If you specify Calculate in the Tax Amount field and Distribute or Enter in the Tax Base 
field, the tax amount is calculated automatically based on the tax base.

 l Distribute. You enter total tax amounts manually but distribute tax automatically to individual 
distribution lines using the Distribute Taxes button. This prevents you from changing taxes for 
distribution lines.

 l Enter. You enter all tax amounts manually. Clicking the Calculate Taxes button or the Distribute 
Taxes button lets you override manually entered amounts, but you can always change the total 
tax amounts and the taxes for distribution lines.

Note: When entering an invoice, you can change the method that is used for that invoice.

Default Tax Base

Specify a default method for entering tax bases on Accounts Payable invoices:
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 l Calculate. Accounts Payable calculates tax amounts automatically, and you cannot change the tax 
amounts.     

Note: If you specify Calculate in the Tax Amount field and Distribute or Enter in the Tax Base 
field, the tax amount is calculated automatically based on the tax base.

 l Distribute. You enter total tax amounts manually but distribute tax automatically to individual 
distribution lines using the Distribute Taxes button. This prevents you from changing taxes for 
distribution lines.

 l Enter. You enter all tax amounts manually. Clicking the Calculate Taxes button or the Distribute 
Taxes button lets you override manually entered amounts, but you can always change the total 
tax amounts and the taxes for distribution lines.

Note: When entering an invoice, you can change the method that is used for that invoice.

Default Tax Reporting

Tax reporting amounts appear for invoices that use a currency that is different from the vendor's 
currency. (The currencies are determined by the tax groups assigned to the invoice and to the vendor.)

Tax reporting amounts are required in some tax jurisdictions, such as Singapore, where you must report 
tax amounts in the currency of that jurisdiction.

The Default Tax Reporting option identifies the tax entry method you use most often for reporting tax 
amounts. You can select:

 l Enter. Select this option if you want to convert and enter all tax reporting amounts manually for 
documents and their details.

 l Distribute. Select this option if you want to convert the total tax reporting amounts for each tax 
authority, then distribute the tax reporting amounts automatically to document details using the 
Distribute Taxes button. (You cannot detail edit taxes using this method.)

 l Calculate. Select this option if you want Accounts Payable to convert all taxes to the tax 
reporting currency for document and their details.

Accounts Payable automatically uses the specified default tax entry method when you enter new 
invoices, but you can change the method on individual documents.

Default Transaction Type

Select the transaction type you most often use in the Payment Entry screen.

You can select Payment, Prepayment, Apply Document, or Misc. Payment as the default transaction 
type for Payment Entry.
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Include Pending Transactions

Your selection for this option determines whether transactions from open (unposted) batches are 
included when Accounts Payable calculates pending amounts for Payment Entry.

You also specify the types of transactions to include. You can include unposted payments, unposted 
payments and adjustments, or all transactions, or you can choose to include none of them.

Sort Checks By

Set the order in which to print batches of checks by selecting one of the following options:

 l Transaction Entry Number

 l Customer Number

 l Payee Name

 l Payee Country

 l Payee Zip/Postal Code

Use 1099/CPRS Reporting

Use this option if your company reports payments to vendors that are subject to 1099/CPRS reporting. 
The option adds 1099/CPRS-reporting fields to the Vendors screen. If some of your vendors are subject 
to 1099/CPRS reporting and others are not, you can turn this option off for individual vendors (in the 
Vendors screen).

If you choose this option, the program maintains calendar year-to-date 1099/CPRS information in each 
vendor record.

You can turn the option on or off at any time. When the option is turned off, Accounts Payable does not 
accumulate vendor 1099/CPRS information, but you can still print any existing 1099/CPRS data and 
clear it.

A/P Optional Fields Screen

To Open this Screen

Open Accounts Payable > A/P Setup > Optional Fields.
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Secondary Screens

Settings Screen

Related Tasks

"Adding or Modifying an Optional Field" (page 31)

Overview

Notes: 
 l Depending on how your system is set up, this desktop screen may also be available as a web 

screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 
300 web screens.

 l Optional fields are available if you use Sage Transaction Analysis and Optional Field Creator. 

Use the A/P Optional Fields screen to set up optional fields to use with Accounts Payable vendor records 
and transactions.

Fields and Controls

Auto Insert

Select Yes in this field if you want the program to display the optional field and its default value on the 
screen for the type of optional field when you set up new records or enter transactions.

Select No if you do not want the optional field to appear automatically.

For example, if you define Transit Number as an optional field for Invoices and you select Yes in the 
Auto Insert field, the Transit Number field will appear automatically on the Invoice Entry screen.

Default Value and Description

Enter or select the value to display as the default for the optional field.

If the optional field you selected requires validation, you must select a value that is defined for the 
optional field in Common Services. However, if the optional field allows blanks, you can leave the 
default value field blank.

If the optional field does not use validation, you can do one of the following:
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 l Select a value that is defined for the optional field in Common Services.

 l Leave the field blank.

 l Enter a combination of alphanumeric or special characters and spaces. The entry must be 
consistent with the type of field (text, number, date, amount, and so on) and must not exceed the 
number of characters specified for the optional field. In a Yes/No field, you can enter only Yes or 
No.

When you specify a value that is defined in Common Services, the program displays the description for 
the value.

Optional Field and Description

Use the Finder to select the optional field codes you want to use for each type.

You can define an unlimited number of optional fields for each type, providing the optional fields are set 
up in Common Services for use in your system.

Note: If you want to retain optional field information from Accounts Payable transactions when you 
create batches for General Ledger, you must use the same optional fields for transactions in 
Accounts Payable as you use in General Ledger.

When you select an optional field code, the program displays the description for the optional field.

Optional Fields For

Specify the type of optional field you are defining:

 l Vendors and Vendor Groups.

 l Remit-to Locations.

 l Invoices (invoice header optional fields).

 l Invoice Details.

 l Payments.

 l Adjustments.

 l Revaluation.

Required

You select this option for an optional field if all the records or transactions to which you are adding the 
field must use the field.
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If you make an optional field a required field, it must also be inserted automatically in new records or 
transactions. (You must use the Auto Insert option for the field.)

Value Set

Double-click the Value Set column to indicate whether the optional field has a default value.

This column has two purposes:

 l You must set the Value Set field to "Yes" to specify a default value for the optional field.

 l The "Yes" flag provides information to the transaction-entry clerk, letting them know if the field 
contains default information.

A/P Payment Codes Screen

To Open this Screen

Open Accounts Payable > A/P Setup > Payment Codes.

Related Tasks

 l "Adding or Modifying a Payment Code" (page 35)

 l "Printing the Payment Codes Report" (page 232)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Payment Codes screen to:

 l Display on the A/P Payment Entry screen fields that are appropriate for the type of payment you 
are making.

 l Group vendor payments by the type of payment (cash, check, credit card, and other).

Tip: You can create custom reports that take advantage of this information. (For information about 
creating custom reports, see the documentation that comes with Crystal Reports, available 
separately.)
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Important! Payment codes are different from payment selection codes, which are used as criteria for 
generating payments from Accounts Payable.

Fields and Controls

Inactive

Select this option if you do not want to use the payment code.

The option is used primarily when you have decided to delete a payment code and do not want to assign 
it to any transactions in the Payment Entry screens.

You must also assign another payment code to any unposted payment transactions that use the 
inactive payment code. You can change your entry any time.

Last Maintained

This field displays the date of the last change made to the payment code.

Payment Code

Enter a code to identify the vendor payment type, using up to 12 characters. In the field to the right, enter 
a description for the payment code.

Payment codes are used to identify the types of payments you process.

If your company may use different codes for payments made by credit card—one to identify each of the 
three credit cards you use.

The Other payment type lets you define payment codes other than for cash, check, or credit card. For 
example, you might create an EFT code for electronic fund transfers.

Payment Type

Select the payment method for this payment code:

 l Cash.

 l Check.

 l Credit Card.

 l Other.
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A/P Payment Selection Codes Screen

To Open this Screen

Open Accounts Payable > A/P Setup > Payment Selection Codes.

Related Tasks

 l "Adding Payment Selection Codes" (page 37)

 l "Excluding Vendors from Payment Selection" (page 149)

 l "Printing the Payment Selection Codes Report" (page 233)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Payment Selection Codes screen to add payment selection codes.

Payment selection codes define the criteria for selecting outstanding invoices and generating 
transactions to pay them. You must create at least one payment selection code if you want Accounts 
Payable to generate payments for invoices automatically.

Note: You use the Create Payment Batch screen to generate the payment transactions.

Criteria Tab

Use this tab to:

 l Choose the method for selecting documents for payment (by due date, discount date, or both due 
date and discount date).

 l Select all documents meeting the criteria or forced documents only.

 l Set ranges of vendor groups, vendors, account sets, and vendor amounts.

Exclusion Tab

Use this tab to list all vendors that you want to exclude from payment batches you create using this code.
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Optional Fields Tab

Note: This tab appears only if you use Transaction Analysis and Optional Field Creator.

Use this tab to specify optional fields and values to be assigned as defaults when you create a payment 
batch.

When you enter a new payment selection code, the tab initially displays payment optional fields that are 
marked for automatic insertion, along with their default values.

You can add or delete optional fields, and change the default values. Note that you can add only optional 
fields that are defined for payments in the Optional Fields setup screen.

If you delete an automatically inserted optional field for a payment selection code, when you create 
batches using the code, the program will reinsert the optional field using the default value from the 
optional field setup record.

Select Tab

Use this tab to specify:

 l Whether the payment selection code is active.

 l The bank account from which to draw the checks.

 l The bank currency (check currency) and the vendor currency (multicurrency ledgers only) and 
exchange rate information.

This tab also shows the date when the payment selection code was last edited and saved.

Fields and Controls

Selection Code

Type a code to identify the payment selection criteria (such as "ALL" if you are defining only one). Press 
the Tab key, and then type a description for the code in the description field.

You enter this code in the Create Payment Batch screen to use the criteria that you are defining.

Criteria Tab

These criteria appear automatically when you use the payment selection code on the Create 
Payment Batch screen. You can change the selections for a particular check run.
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Account Set

Specify a range of account sets to include in the check run, or accept the blank in the From field and the 
ZZZZZZs in the To field to include all account sets.

Pay All Selected Documents

Select this option if you want to pay all documents that meet the selection criteria.

Pay Only Forced Documents

Select this option if you want to pay only documents that are marked Forced in the Control Payments 
screen and that:

 l Use the specified bank, if you selected Select Vendors With This Bank Code Only on the Select 
tab.

 l Use the vendor currency specified on the Select tab.

 l Do not have pending payments in an open batch.

 l Are within the range of vendor amounts.

Payment Code

Specify the range of payment codes for which to create checks, or accept the blank in the From field 
and the ZZZZZZs in the To field to include all payment codes.

Select Documents By

Choose whether to pay only transactions that are due on or before a specified date, pay only 
transactions that have available discounts for early payment, or pay transactions that are due and 
provide a discount.

Note: Because discounts do not apply to debit notes, credit notes, interest charges, and 
prepayments, they are not included in batches generated using the Discount Date selection.

Vendor Amounts

Specify the range of amounts you want to pay, or set a range from 0.01 to 999,999,999.99 to pay any 
amount, regardless of its size.

Restricting the vendor amounts allows you to pay smaller amounts routinely, and use different 
procedures for larger checks.

348Sage 300 2023 Accounts Payable User's Guide



Note: The total amount due for a vendor (one or more invoices) must be within the range you specify.

Vendor Group

Specify the range of vendor groups to include in the check run, or accept the blank in the From field and 
the ZZZZZZs in the To field to include all vendor groups.

If you have only one vendor group, enter the vendor group code in both fields.

Vendor Number

Specify the range of vendors to include in the check run, or accept the blank in the From and the 
ZZZZZZs in the To field to include all vendors.

Vendor Optional Fields

This field appears if you use Sage 300 Transaction Analysis and Optional Field Creator.

You can use this option to specify a vendor optional field as a criteria for selecting vendors for a 
payment batch. 

If you specify an optional field, additional fields appear, letting you specify a range of values for the field. 
You can also accept the blank From field and the ZZZZZZs in the To field to include all the values for 
the optional field.

If you do not want to use an optional field as criteria, accept None, the default setting for this field.

Note: Selected vendors must meet all the selection criteria on the screen.

Exclusion Tab

These exclusion criteria appear automatically when you use the payment selection code on the 
Create Payment Batch screen. You can exclude additional vendors, or remove vendors from the 
exclusion list for a particular check run.

Vendor Number and Name

On the table, type the number of each vendor you want to exclude from the payment batch, or use the 
Finder to select the number.
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Optional Fields Tab

Accounts Payable displays any payment optional fields that are set up for automatic insertion, 
along with their default values, when you start a new payment selection code record.

The optional fields and values you specify on this tab are used as defaults when you use the 
payment selection code on the Create Payment Batch screen.

Optional Field

You can add or delete any optional fields that are defined for payments on the Optional Fields setup 
screen.

If you delete an automatically inserted optional field, when you create a batch using the payment 
selection code, Accounts Payable reinserts the optional field with the default value from the optional 
field setup record.

Value and Description

Accounts Payable displays values from the optional field setup records as defaults, but you can change 
them. 

It also displays description for the value you specify.

Select Tab

Apply Method

Specify how to apply partial payments to job-related  invoices that use different contracts, projects, and 
categories:

 l Top Down. Select this option to apply payments automatically to invoice details, beginning with 
the first detail on an invoice until the payment is fully applied.

 l Prorate By Amount. Select this option to apply payments proportionately to all invoice details.

350Sage 300 2023 Accounts Payable User's Guide



Notes: 
 l This field appears only if you use Sage 300 Project and Job Costing.

 l The Create Payment Batch screen generates a partial payment if the invoice uses a multiple 
payment schedule, or if a payment control limits the size of a payment for a document.

 l The apply method affects only job-related  invoices for which the applied amount is less than 
the current balance. For example, it does not affect the last payment on a multiple payment 
schedule.

 l The apply method for the payment selection code appears as the default when you specify a 
code on the Create Payment Batch screen. However, you can specify a different apply method 
when you create a payment batch.

Bank Currency

This field appears only if you have a multicurrency ledger.

The bank currency is the payment currency. You can change the currency only to another currency that 
the bank uses.

If you need to add a currency for a bank, you must use the Banks screen in Bank Services to do so.

Inactive

You can set a code Inactive if you do not want it used accidentally, but want to keep the criteria for 
future use.

Last Maintained

This is the date when you last edited and saved the payment selection code.

Pay From Bank

This is the bank from which the checks will be drawn. 

If you have a multicurrency ledger, make sure the bank supports the currency that you want to use. 

Use the screens in Bank Services to change bank information.

Rate Type

Specify the code for the kind of rate you want to use when converting non-functional amounts to 
functional currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type, or select one from the Finder.
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Rate types are defined using the Currency Rate Types screen in Common Services.

Select Vendors with this Bank Code Only

Each vendor is assigned a bank code (on the Processing tab of the Vendors screen), which allows you 
to pay vendors from particular banks. 

If you select this option, Accounts Payable creates payments only for vendors that use the bank code 
you specify on the Create Payment Batch screen.

Vendor Currency

This field appears only if you have a multicurrency ledger.

Accounts Payable restricts payment batches to a single currency. For example, you can pay vendors 
whose source currency is US dollars, or you can pay vendors whose currency is Canadian dollars, but 
you cannot pay both sets of vendors in the same system-generated batch. 

If you are paying vendors manually using the Payment Entry screen, you can mix vendor currencies, 
although all the payments will be in a single currency.

A/P 1099/CPRS Codes Screen

To Open this Screen

Open Accounts Payable > A/P Setup > 1099/CPRS Codes.

Related Tasks

 l "Adding 1099 / CPRS Codes" (page 17)

 l "Printing the 1099/CPRS Codes Report" (page 225)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P 1099/CPRS Codes screen to add codes to assign to vendors that are subject to 1099/CPRS 
reporting.
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You must enter a 1099/CPRS code in the Vendors screen for each vendor you mark as subject to 
1099/CPRS reporting.

Fields and Controls

1099/CPRS Code

Enter an existing 1099/CPRS code, or specify a new code using up to six characters.

Amount Type

If you select 1099 in the Tax Reporting Type field, you must also specify an amount type (such as 
Rents or Nonemployee Compensation).

Amounts of a certain type may need to be reported in different boxes, or even on different forms, from 
one year to another. When you print 1099/1096 forms, the amount type for each 1099 code is used 
together with the form type and year for which you are reporting to determine where to print amounts.

Description

Enter a description of the 1099/CPRS code, using up to 60 characters.

Inactive

Select this option if you do not want to assign the 1099/CPRS code to any vendors.

Before selecting this option, make sure the code is not used in any existing vendor records because you 
cannot save changes to vendor records that use an inactive 1099/CPRS code. However, you can post 
existing transactions that use an inactive 1099/CPRS code, and the necessary 1099/CPRS information 
is correctly accumulated.

Last Maintained

This field displays the date of the last change made to the 1099/CPRS code.

Minimum To Report

The 1099 Electronic Filing screen and the Print 1099/1096 Forms report screen use the value in this 
field to determine which amounts to report.
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Enter the lowest amount you are required to report for each code. Only vendors with a total 1099 
amount equal to or greater than this amount will be included in the electronic 1099 file or on printed 
1099 forms.

Tax Reporting Type

Specify whether the code is for reporting 1099 or CPRS amounts.

A/P Terms Screen

To Open this Screen

Open Accounts Payable > A/P Setup > Terms.

Related Tasks

 l "Adding or Modifying a Terms Code" (page 42)

 l "Printing the Terms Report" (page 234)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Terms screen to:

 l Define the payment terms by which your vendors calculate invoice due dates.

 l Specify the method used to calculate discount periods and discount amounts on invoices from 
vendors who offer discounts for early payment.

Important! You must add at least one terms code before you can enter Accounts Payable transactions.

Fields and Controls

Calculate Base for Discount With Tax Included/Excluded

Specify whether to include tax amounts in the invoice totals on which discount amounts are calculated:
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 l Included. Select this option if you receive a discount on taxes.

 l Excluded. Select this option if you do not receive a discount on taxes or are not charged taxes by 
your vendors.

Note: You can change the discount amount on individual invoices that use terms codes with 
discounts.

Discount Type

Select the method your vendor uses to calculate the last day on which you may take a discount for 
prompt payment. You select from the options for Due Date Type, and type discount percentages.

If you do not receive discounts from your vendors, ignore the discount fields and columns.

You can select:

 l Days from invoice date. Select this option if discount dates are calculated as a particular number 
of days from the document date.

 l End of next month. Select this option if the discount date is the last day of the next month, 
regardless of the document date or the number of days in the month.

 l Day of next month. Enter the number of the day of the next month that is the discount date.

 l Days from day of next month. Enter the number of days from a specific day of the next month.

Example: If the due date is 10 days after the first of the month, enter 10 in the Number of Days field, 
and 1 in the Day of Month field.

 l Disc date table. Select this option if your vendors use standard discount dates for invoices 
entered within specified ranges of days.         

Standard due dates are similar to "day of the month due," except they do not restrict discount periods 
to a single date. For example, you can use standard discount dates to assign invoices to the 15th or 
30th of each month.

You define the standard discount dates used by your vendors with a table that lets you specify a 
discount date for each of up to four ranges of days on which invoices were issued. You can also assign 
discount dates that are one or more months later.

Due Date Type

Specify the method you use to calculate the due dates for transactions as:

 l Days from invoice date. Select this option if invoices are due by a particular number of days from 
the document date. Enter the number of days in the Number Of Days column that appears.
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 l End of next month. Select this option if invoices are due on the last day of the next month, 
regardless of the document date or the number of days in the month.

 l Day of next month. Enter the number of the day of the next month that is the due date, and then 
enter the number (representing the due date) in the Day of Month column.

Example: If invoices are due on the fifteenth of each month, enter 15.

 l Days from day of next month. Enter the number of days from a specific day of the next month.         

Example: If the due date is 30 days after the first of the month, enter 30 in the Number of Days field, 
and 1 in the Day of Month field.

 l Due date table. Select this option if your vendor uses standard due dates for invoices with 
specific ranges of days. Then complete the table that appears.         

Standard due dates are similar to "day of the month due," except they do not specify a single due date. 
For example, invoices may be due on the 15th or 30th of each month. Standard dates are geared to 
businesses that enter invoices throughout the month, but issue invoices only on specific days of the 
month.

You define standard due dates used by your vendors with a table that specifies due dates for each of 
up to four ranges of invoice dates. You can also specify due dates that are one or more months later 
than invoice dates.

Inactive

Select this option if you do not want to assign the terms code to any vendors.

Example: You might use this option if you decide to delete a terms code, and want to ensure no 
further vendor accounts are assigned to it.

You can change this option at any time.

Note: If you make a terms code inactive, you can no longer assign it to vendor records. You also 
cannot save changes to vendor records that use the inactive code, unless you first assign an active 
terms code to the records.

Last Maintained

This field displays the date of the last change made to the terms code.
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Multiple Payment Schedule

Select this option to define a terms code that allows installment payments. When you select this option, 
the terms table expands to add lines for additional payments (otherwise, only a single line is displayed).

Terms Code

When adding a new set of payment terms, enter a code to identify the terms, using up to six characters.

In the field to the right, enter a description (name) for the terms code.

Detail Table

Day of Month (discount)

Enter the number that represents the day of the next month on which the discount period expires (used 
with the Days From Day Of Next Month option).

Day of Month (due)

Enter the number of the day of the next month on which payment is due (used with the Days From Day 
Of Next Month option).

Discount Percent

Enter the amount of the discount, expressed as a percentage of the total due.

No. of Days (discount)

Enter the number of days in the discount period, counted from the invoice date (when using the Days 
From Invoice Date option) or from a specific day of the next month (when using the Days From Day Of 
Next Month option).

No. of Days (due)

Enter the number of days from the invoice date that is the due date for the invoice (when the due date is 
calculated using the Days From Invoice Date option) or the number of days from a specified day of the 
month (when the due date is calculated using the Days From Day Of Next Month option).
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Payment Number

If you selected the Multiple Payment Schedule option, enter as many payment lines as you need. Make 
sure the numbers entered in the Percent Due column are greater than zero, and total exactly 100%.

To add a payment, press the Insert key. 

To remove a payment, select a line, and then press Delete.

Note: Accounts Payable automatically numbers payments starting with 1. You can apply payments to 
individual payment numbers in a multiple payment schedule.

Percent Due

Enter the percentage of the balance that is due for each payment number.

Note: The total of amounts entered in this column must always equal 100.

Due Date Table and Discount Date Table

Add Months

Specify a due date or discount period that is one or more months later than the invoice date.

Day of Month

Specify the day of the month that is the due date or the end of the discount period.

Ending Day

Enter the last day in the range.

Range

For each standard due date or discount date, define at least one range of days.

Starting Day

Enter the first day in the range.
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A/P Distribution Codes Screen

To Open this Screen

Open Accounts Payable > A/P Setup > Distribution Codes.

Related Tasks

 l "Adding or Modifying a Distribution Code" (page 22)

 l "Printing the Distribution Codes Report" (page 227)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Distribution Codes screen to:

 l Define codes to identify the general ledger account numbers to use when distributing purchases to 
general ledger accounts.

 l Specify a description (name) for each distribution code.

 l Specify whether the distribution code is active or inactive.

 l Specify a Discountable status for the distribution code.

Fields and Controls

Description

Type a description of the distribution code.

Discountable

Select this option if you want invoice, credit note, debit note, and recurring payable details that use this 
distribution code to be discountable by default. (You can change the Discountable status when you 
enter a detail.)
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Distribution Code

Type a code, up to six characters, to identify the distribution code.

G/L Account

Enter the general ledger account number to which amounts posted with the distribution code are 
distributed. If you use Sage 300 General Ledger, you can select the general ledger account number 
from the Finder.

Inactive

Select this option if you do not want to assign the distribution code to any vendors.

If you make a distribution code inactive, you can no longer assign it to vendor records. You also cannot 
save changes to vendor records that use the inactive distribution code, unless you first assign an active 
distribution code to the records.

You would primarily use the option when you decide to delete a distribution code, and want to ensure no 
further vendor accounts are assigned to it. You can change your entry any time.

Last Maintained

This is an information field in which the program displays the date of the last change made to the 
distribution code. You do not make an entry in this field.

Setup Reports Screens
Use the screens in the A/P Setup Reports folder to print reports of:

 l The options you selected, data you entered, and records you added to set up your Accounts 
Payable system.

 l Records you revised.

 l Vendor and vendor group statistics.

A/P Account Sets Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports >        Account Sets.
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Related Tasks

 l "Printing the Account Sets Report" (page 226)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

This report lists the descriptions and numbers of the general ledger accounts used in the account sets in 
your Accounts Payable system. 

When to Print

Print the report when you add, change, or delete account sets.

Information Printed on This Report

For each account set, the report lists:

 l The account numbers for your general ledger Payables Control, Purchase Discounts, and 
Prepayment accounts.

 l The range of account sets printed.

If you use multicurrency accounting, the report also lists:

 l The currency code that identifies the currency used by the vendors assigned to this account set.

 l The exchange gain and loss general ledger accounts (if the account set is in a currency other than 
the functional currency). Exchange gains and losses occur when you revalue Accounts Payable 
transactions, or when you settle a document (such as paying an invoice) at a different rate of 
exchange than the invoice rate.

 l The exchange rounding account to which to post differences that arise during currency 
conversion.

A/P Distribution Codes Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports >        Distribution Codes.
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Related Tasks

 l "Printing the Distribution Codes Report" (page 227)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Distribution Codes report lists the descriptions and numbers of the general ledger accounts used in 
the distribution codes in your Accounts Payable system.

When to Print

Print the report when you add, change, or delete distribution codes.

Information Printed on This Report

For each distribution code listed, the report shows:

 l The description and general ledger account number assigned.

 l Whether distributions using the code are discountable.

 l The date the record was last edited.

 l For inactive distribution codes, the date on which a code was made inactive.

A/P Distribution Sets Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports >        Distribution Sets.

Related Tasks

 l "Printing the Distribution Sets Report" (page 228)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)
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Overview

The Distribution Sets report lists the distribution methods and distribution codes specified for the 
distribution sets you use to allocate purchase amounts in your Accounts Payable system.

When to Print

Print the report when you add, change, or delete distribution sets.

Information Printed on This Report

 l The number and description of the general ledger account assigned to the distribution code.

 l The Distribution Percentage column contains information only when the distribution method is 
Fixed Percentage.

A/P E-mail Messages Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports >        E-mail Messages.

Related Tasks

 l "Printing the E-mail Messages Report" (page 229)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The E-mail Messages report lists the messages you send to vendors with e-mailed letters.

When to Print

Print the report when you add, change, or delete e-mail messages.

Information Printed on This Report

Each e-mail message is printed, along with its message ID, description, and subject line.
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A/P G/L Integration Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports > G/L Integration.

Related Tasks

 l "Printing the G/L Integration Report" (page 229)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The G/L Integration report lists the integration options and other information specified on the G/L 
Integration screen that determine how your Accounts Payable system interacts with General Ledger.

When to Print

Print the report when you change G/L Integration settings for Accounts Payable.

Information Printed on This Report

 l The options selected on the G/L Integration screen.

 l The posting sequences through which you have created general ledger transactions.

 l The segments and separators to be used for the reference, description, and comment fields for 
each type of transaction created for general ledger (specified on the Transactions tab of the G/L 
Integration screen).

A/P Optional Fields Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports > Optional Fields.
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Related Tasks

 l "Printing the Optional Fields Report" (page 230)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

This report lists the optional fields you have defined for Accounts Payable.

When to Print

Print the report when you add, change, or delete optional fields.

Information Printed on This Report

For each type of optional field, the report shows the optional field codes, descriptions, default values, and 
whether an optional field is set for automatic insertion in new records.

A/P Options Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports >        Options.

Related Tasks

 l "Printing the A/P Options Report" (page 231)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The A/P Options report lists the options selected and other information entered on the A/P Options 
screen to specify how your Accounts Payable system operates.

When to Print

Print the report when you change your selections for Accounts Payable options.
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Information Printed on This Report

 l The options on the A/P Options screen, and the selection for each.

 l The prefix and next number to assign to prepayments.

 l The numbers that will be assigned to the next invoice, payment, and adjustment batch you create, 
and the next posting sequence for each batch type.

 l The posting sequences through which you have created general ledger transactions.

A/P Payment Codes Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports > Payment Codes.

Related Tasks

 l "Printing the Payment Codes Report" (page 232)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Payment Codes report lists the codes, descriptions, and methods of payment used in your Accounts 
Payable system.

When to Print

Print the report when you add, change, or delete payment codes.

Information Printed on This Report

For each payment code, the report lists:

 l The name of the payment code that appears in payment code fields in Accounts Payable (such as 
CASH, CHECK, WIRE, or the name of a credit card).

 l The description.

 l The payment type (such as Cash, Check, Credit Card, or Other).

 l The date the payment code record was last edited.

 l For inactive payment codes, the date on which Inactive status was selected.
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A/P Payment Selection Codes Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports > Payment Selection Codes.

Related Tasks

 l "Printing the Payment Selection Codes Report" (page 233)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Payment Selection Codes report lists the bank and currency codes, selection criteria, and exclusion 
criteria defined for the payment selection codes you use to create payment batches in your Accounts 
Payable system.

When to Print

Print the report when you add, change, or delete payment selection codes.

Information Printed on This Report

 l The bank code associated with each payment selection code.

 l The selection criteria assigned to the code, including the method of selecting documents and the 
ranges of vendor groups, vendor numbers, account sets, and amounts from which to select.

 l The list of vendors, if any, who are excluded from the accounts that can be selected by the 
payment selection code.

A/P Terms Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports > Terms.
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Related Tasks

 l "Printing the Terms Report" (page 234)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Terms report lists the information entered for each terms code to specify how to calculate due dates, 
discount amounts, and discount periods on invoices that use the code.

When to Print

Print the report after you add, change, or delete terms codes.

Information Printed on This Report

 l The range of terms codes you chose to print on the report.

 l The terms code and description, and date the terms record was last edited.

 l The method used to determine the due dates for invoices assigned to the terms code. You can 
calculate due dates using a number of days from the invoice date, the end of the next month, a day 
of the next month, a number of days from a day of the next month, or a due date table.

 l Discount information, including the method used to determine the discount period, whether to 
include tax in the base for discount calculations, and the discount percentage.

 l If the terms code uses a table to calculate due dates or discount dates, the report lists the 
information in the table.

 l For multiple payment schedules, the report shows the percentage due, the method of calculating the 
due date, and discount information for each payment.

Note: This information appears only if you select the Include Multiple Payment Schedules option.

A/P 1099/CPRS Codes Report Screen

To Open this Screen

Open Accounts Payable > A/P Setup Reports > 1099/CPRS Codes.
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Related Tasks

 l "Printing the 1099/CPRS Codes Report" (page 225)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The 1099/CPRS Codes report lists the 1099/CPRS codes that are entered in your Accounts Payable 
system.

When to Print

Print 1099 and CPRS Codes reports whenever you update 1099/CPRS codes to verify that they are 
correct and complete. Then file the report.

Information Printed on This Report

The report lists the 1099/CPRS codes in your Accounts Payable system. For each 1099/CPRS code, the 
report includes the following information:

 l Code

 l Description

 l Minimum amount to report

 l Dates that the code was last edited and/or made inactive

 l Tax report type (1099 or CPRS)

 l For 1099 codes, the amount type

A/P Transactions Screens
Use Accounts Payable transaction entry screens to record, edit, post, and inquire on the following types 
of transactions:

 l Invoices, debit notes, credit notes

 l Payments

 l Adjustments
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A/P Adjustment Batch List Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Adjustment Batch List.

Related Tasks

 l "Creating or Modifying an Adjustment Batch" (page 181)

 l "Deleting Adjustments" (page 182)

 l "Opening an Existing Adjustment Batch" (page 182)

 l "Posting an Adjustment Batch" (page 183)

 l "Posting a Range of Batches" (page 127)

 l "Printing Batch Listings" (page 245)

 l "Printing the Batch Status Report" (page 248)

 l "Printing the Posting Errors Report" (page 265)

 l "Printing Posting Journals" (page 266)

Overview

Use the A/P Adjustment Batch List screen to:

 l Display a list of posted and unposted adjustment batches, beginning with the batch number you 
specify. More...

Displayed information includes:

 l Batch number

 l Batch date

 l Batch description

 l Number of entries

 l Type (Entered, Imported, Generated)

 l Status (Open, Printed, Ready To Post, Deleted, Posted, Post In Progress, Check Creation 
In Progress)

 l Posting sequence number

 l Number of errors
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 l Last edited

 l Adjustment amount

 l Create a new adjustment batch.

 l Select an existing batch to edit, delete, or post.

To view the transactions in an unposted batch, either open the batch you want to view, or print the batch 
listing report (or preview it on your screen). 

Tip: If you try to post a batch for which you have not selected the Ready To Post option, you see a 
message that lets you select the option from the Adjustment Batch List screen.

 l Post individual adjustment batches.

 l Post all unposted batches that are set Ready To Post.

 l Print batch listings, batch status reports, posting journals, and posting error reports:

 l To print the Batch Status report, you click File > Print Batch Status.

 l To print the posting errors report, you double-click in the Number Of Errors column for the 
error batch.

 l To print the posting journal, you double-click in the Posting Sequence Number column.

Notes: 
 l You cannot edit a batch for which you have selected the Ready To Post option.

 l You can view, but you cannot edit, posted batches. However, to view a posted batch, you must 
not have cleared the batch using the Clear Deleted And Posted Batches option (on the A/P 
Clear History screen ).

 l You cannot open deleted batches.

Fields and Controls

Buttons

Delete

Click this button to delete a batch. For more information, see "Deleting Adjustments" (page 182).

New

Click this button to create a new batch. For more information, see "Creating or Modifying an Adjustment 
Batch" (page 181).
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Open

Click this button to open a batch in the A/P Adjustment Entry screen. For more information, see 
"Opening an Existing Adjustment Batch" (page 182).

Post

Click this button to post a batch. For more information, see "Posting an Adjustment Batch" (page 183).

Post All

Click this button to post all unposted adjustment batches that are set Ready To Post. For more 
information, see "Posting a Range of Batches" (page 127).

Print

Click this button to print a batch listing. For more information, see "Printing Batch Listings" (page 245).

Refresh

Click this button to update the information in the displayed batch list, if it has changed since you opened 
the screen. 

For example, if you have chosen not to show posted/deleted batches and another user has posted or 
deleted a batch, the batch disappears from the list when you click Refresh.

A/P Adjustment Entry Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Adjustment Entry.

Secondary Screens

A/P Batch Information Screen (Adjustment Entry)
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Related Tasks

 l "Adjusting a Posted Transaction" (page 184)

 l "Creating or Modifying an Adjustment Batch" (page 181)

 l "Deleting Adjustments" (page 182)

 l "Opening an Existing Adjustment Batch" (page 182)

 l "Posting an Adjustment Batch" (page 183)

Overview

Use the A/P Adjustment Entry screen to:

 l Adjust open and fully paid documents in vendor accounts.

Note: You can use this screen to adjust fully paid documents only if you have not yet cleared the 
documents from Accounts Payable.

 l Edit batches of adjustments created during posting (when adjustment batches contain errors) and 
imported from other accounting programs.

 l Print a batch listing report for the selected batch.

 l Post adjustment batches individually.

Tip: If the Allow Adjustments In Payment Batch option is selected on the A/P Options screen, you can 
adjust documents when you apply payments to them using the Payment Entry screen. You also use 
the Payment Entry screen to edit this type of adjustment.

Document Tab

Use the Document tab to:

 l Specify the vendor number.

 l Specify the document number and the payment number for the document you want to adjust.

 l Open a Finder that lets you select a particular detail for adjustment.

Click the Select Detail button to open the Open Document Details Finder that lets you select an existing 
detail used on the document.

 l Use the detail table to add details that did not exist on the original document, or to enter debit or 
credit amounts to modify existing details.
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Optional Fields Tab

Note: The Optional Fields tab appears on the Adjustment Entry screen only if you use Sage 300 
Transaction Analysis and Optional Field Creator.

If you marked any adjustment optional fields for automatic insertion, they appear on the tab, along with 
their default values, when you add a new adjustment entry.

You can add any other optional fields that are defined for adjustments, and you can delete any that are 
assigned automatically, except Required fields.

Default values for the optional fields appear, as follows:

 l If an optional field assigned to the current adjustment was also used on the document you are 
adjusting, the program displays the values from the original document.

 l If an optional field assigned to the current adjustment was not used on the original document, but it 
is assigned to the vendor record, Accounts Payable displays the default value from the vendor 
record.

 l If an optional field assigned to the current adjustment was neither used on the original document 
nor assigned to the vendor, the program uses the default value from the optional field record.

You can change the default values, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services. If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can select a predefined value, or you can enter any value 
that is consistent with the type of field (amount, text, yes or no, and so on), providing your entry 
does not exceed the length permitted for the field.

Rates Tab

Note: This tab appears only in multicurrency Accounts Payable systems when you enter an adjustment 
for a vendor that does not use your functional currency.

Use this tab to edit the rate type, rate date, and exchange rate for a selected adjustment.

You can also use the tab to check the exchange rate that was used on the document you are adjusting.

You enter adjustments in the vendor’s currency. The exchange rate shows the rate for conversion to the 
functional currency.

Accounts Payable automatically displays the exchange rate that is entered in Common Services for the 
rate type assigned to the vendor record and the rate date that corresponds to the adjustment date.

You should check the rate for the original document before you add adjustments.
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Important! Use the same exchange rate as the original document if you do not want to register a gain 
or loss on exchange with this adjustment.

Retainage Tab

Note: The Retainage tab appears if you use retainage accounting in your Accounts Payable system.

Use this tab to enter retainage terms and (if you use multicurrency) the retainage exchange rate for a 
selected adjustment.

Fields and Controls

Buttons

Close

Click this button to close the screen.

Delete

Click this button to delete the current entry.

Post

Click this button to post the adjustment batch that is currently displayed.

Note: This button allows you to post one adjustment batch at a time. For information about posting 
multiple batches, see "Posting a Range of Batches" (page 127).

Save

Click this button to save the current entry.

Batch Date

This date is usually the date on which an adjustment batch was created. Accounts Payable 
automatically displays the session date in new batches, but you can type another date or choose one 
from the drop-down calendar.
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You must enter a date that is in the fiscal calendar defined for your Sage 300 system in Common 
Services.

You can change the date any time before you post the batch, provided the Ready To Post option is not 
selected for the batch.

Batch Description

Enter a description for the batch using up to 60 characters. 

The batch description helps to identify the batch in the Adjustment Batch List screen and in Finder lists 
of adjustment batches.

You can change the description any time before you post the batch, provided the Ready To Post option 
has not been selected.

Entered By

This field displays the name of the person who entered the transaction.

No. of Entries

This field displays the number of entries in the selected batch.

Total Amount

This field displays the total for the batch.

Document Tab

Adjust Line Number

Use the Finder for this field to select the document detail you want to adjust.

Adjustment Date

The adjustment date determines the default fiscal year and period displayed for the transaction and the 
aging period into which the adjustment is placed on statements and reports. It is also used as the 
default posting date for the transaction.

This date appears as the Document Date in the Vendor Activity screen and on reports that include 
adjustment transactions.
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You can print posting journals by adjustment date.

Adjustment Number

This is an internal number that is assigned sequentially by Accounts Payable to identify the sequence in 
which all adjustment transactions are entered. It is not associated with the batch number.

Adjustment Total (display only)

This field displays the net total of the adjustment details in the vendor's currency. 

If you are entering an adjustment to transfer an amount from one account to another, the adjustment 
total should be zero.

Category

This field appears only if the document you are adjusting is job-related .

Enter or use the Finder to select the category for the contract and project that you are adjusting. 

You can use only categories that are assigned to the specified contract and project in Project and Job 
Costing.

Contract

This field appears only if the document you are adjusting is job-related .

Enter or use the Finder to select the Project and Job Costing contract that you want to adjust. 

You can select only contracts that are open or on hold. 

Note: You cannot enter transactions for a contract that has never been opened.

Debit/Credit

Enter the amount of the adjustment detail:

 l Enter a debit to increase the balance of an expense, purchases, or inventory account.

 l Enter a credit to decrease the balance of an expense, purchases, or inventory account.

If you use multicurrency accounting, enter the amount in the vendor's currency.
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Distribution Code

You can specify a distribution code to identify the general ledger revenue account to which to post the 
adjustment.

When you enter a distribution code, the revenue account number appears automatically in the Account 
column, but you can enter a different account number if you want. 

You can also omit the distribution code, and just type the general ledger account number.

Document Balance (display only)

This field displays the current balance in the document for which you are entering an adjustment.

Document Number

Type the number of the document to adjust, or select it from the Finder. You must enter a valid 
document number for the vendor, and the document must still be in your Accounts Payable data. (That 
is, you cannot specify a fully paid document that you have already cleared from Accounts Payable.)

If Document Number is selected for either the G/L Reference Field or the G/L Description Field option 
on the A/P Options screen, this number appears on the G/L Transactions report and in the General 
Ledger batch (if you do not consolidate general ledger transactions).

Entry Description

This description appears with the entry number in the Finder list for the Entry Number field. 

You can type up to 60 characters as the entry description. 

Note: You can also type a 60-character reference description for each entry and a description for the 
batch.

Entry Number

Accounts Payable automatically assigns the entry number to each new entry you create.

The entry number identifies the sequence in which an entry was added to a batch and, along with the 
batch number, forms part of its audit trail for the transaction.

To select an existing entry for editing or deleting, type its number in the Entry Number field, or choose 
the number from the Finder. 

To add a new entry, click the New button beside the Entry Number field.
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If you delete an entry, you cannot reuse its number.

G/L Account

This field specifies the general ledger account to which to post the adjustment detail. 

If you use Sage 300 General Ledger, you can choose the account number from the Finder.

If you entered a distribution code, the corresponding general ledger account number is displayed 
automatically, but you can type a different account number.

Job Related (display only)

This field indicates whether the selected document is for a contract administered using Sage 300 and 
Job Costing.

Adjustment Entry displays a different set of fields when you select job-related invoices, credit notes, and 
debit notes, letting you enter the contract, project, category, and resource, as required for the 
adjustment.

If you click the Jobs button that becomes available when you select a job-related  document, you can 
select particular details for adjustment.

Payment Balance (display only)

This field displays the outstanding balance of the payment selected for adjustment, when you are 
adjusting a payment associated with an invoice that uses a multiple payment schedule.

Note: If the document you are adjusting does not have a multiple payment schedule, the payment 
balance is the same as the document balance.

Payment Number

This field identifies the payment number associated with an invoice that contains a multiple payment 
schedule. 

If no payment schedule applies to the selected document, the payment number is always 1.

Posting Date

The posting date is used to record the date the adjustment transaction is actually posted to General 
Ledger.
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Accounts Payable also uses this date to select the fiscal year and period to which the transaction is 
posted. (You cannot edit the year or period.)

The default posting date that appears depends on the selection for the Default Posting Date option on 
the A/P Options screen, but you can change the posting date for an entry.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Project

This field appears only if the document you are adjusting is job-related .

Enter or use the Finder to select the project that you are adjusting. You can use only projects that you 
have assigned to the selected contract.

Note: Transactions are not moved from one project to another in Project and Job Costing. When you 
post the transaction, the program adjusts the amounts for the affected projects.

Reference

Use this field for an optional reference, such as a purchase order number or check number. 

The information in this field appears with the transaction on the posting journal and in the General 
Ledger batch if Reference is selected for either the G/L Description Field or G/L Reference Field 
option on the A/P Options screen, and you do not consolidate general ledger transactions.

Resource

This field appears only if the document you are adjusting is job-related .

If required, select the code for the resource affected by this adjustment—for example, an employee code 
or an equipment code.

You can enter a resource only if:

 l You have assigned the resource to the specified project in Project and Job Costing.

 l The specified project is a time and materials project.

 l The specified contract is a standard contract.

Retainage Balance (display only)

Accounts Payable displays the outstanding retainage balance for the document.
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Retainage Debit/Credit

You can add or edit the retainage debit or retainage credit field, even if the original document did not 
include retainage. 

Enter the debit or credit as a positive number. (If you enter a retainage debit or retainage credit amount 
using a negative number, the program will move the amount to the retainage credit or retainage debit 
field.)

Notes: 
 l The retainage debit and retainage credit fields do not appear for retainage invoices, debit 

notes, and credit notes.

 l If the document you are adjusting included retainage, the only retainage field you can edit for a 
document detail is the original retainage debit or retainage credit. You add or edit retainage on 
the detail-entry table. You do not enter a retainage debit or credit for the document as a whole.

 l You can adjust the retainage amount and add or change document details on the same 
adjustment document. (The program then creates two journal entries: one for the retainage 
adjustment, and the other for the detail adjustment.)

Retainage Due Date

If retainage was taken on the detail you are adjusting, the program displays the retainage due date from 
the original document.

If you are adding retainage to a detail that did not include it, you must enter a retainage due date.

Vendor Number

Specify the vendor to whose account you will post the adjustment. The vendor number determines the 
currency for the adjustment and the list of documents that will appear in the Finder on the Document 
Number field.

Year/Period

This field displays the fiscal year and the period to which the adjustment will be posted.

Accounts Payable automatically displays the fiscal year and period that contains the date you enter in 
the Posting Date field. You cannot change this field except by changing the posting date.
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Optional Fields Tab

Any optional fields that are set up for automatic insertion in adjustment entries appear, along with 
their descriptions, as defaults on this tab.

Optional Field and Description

You can add different optional fields that are defined for adjustments on the A/P Optional Fields screen. 
When you select an optional field code, the program displays the description from the optional field 
setup record.

You can also delete optional fields that appear as defaults. However, if an optional field is required for 
adjustments, do not delete it. You cannot add the adjustment until you enter a value for the optional 
field.

Value and Description

If you select an adjustment optional field that has a default value, the program automatically displays an 
entry in the Value field. You can change the value. However, if the optional field requires validation, you 
must select a value that is defined for the optional field in Common Services (unless the optional field 
allows blanks).

The program also displays the description for a specified optional field value, and you cannot change 
the description for the transaction. (You can change the description for a value only in the optional field 
setup record.)

Note: If an optional field is required, you cannot save the transaction until you enter a value.

Value Set (display only)

If an optional field is a required field, it must contain a value before you can save an entry.

This field indicates Yes if Accounts Payable has already set a value—including an acceptable blank—for 
the field.

Rates Tab

Currency (display only)

Accounts Payable displays the vendor currency in this field.
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Exchange Rate

This field displays the current exchange rate for the specified currency, rate type, and rate date. If 
necessary, you can type a different rate or select a rate from the Finder. (Accounts Payable selects the 
rate to display from the Currency tables in Common Services.)

Rate Date

Accounts Payable uses the exchange rate specified for this date in Common Services to convert 
amounts from the vendor currency to your functional currency.

Accounts Payable displays the batch date as the default rate date, but you can enter a different date. If 
you enter a new date, Accounts Payable displays the exchange rate associated with that date.

Rate Type

The rate type is code for the kind of rate to use when converting multicurrency amounts to functional 
currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type or select one from the Finder. (You define rate types using the Currency 
Rate Types screen in Common Services.)

Retainage Tab

Retainage Exchange Rate

If you use multicurrency, specify whether to use the current exchange rate or the exchange rate used on 
the original document when you process the retainage document.

This field does not appear if the original document included retainage. In this case, Adjustment Entry 
uses the retainage exchange rate setting from the original document.

Retainage Terms

If retainage was taken on the document you are adjusting, the program displays the retainage terms 
from the original document.

If you are adding retainage to a document that did not include retainage, you must enter a terms code to 
be used for the retainage document when you process it.
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A/P Control Payments Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Control Payments.

Related Tasks

"Applying Payment Controls" (page 156)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Control Payments screen to:

 l View or change the due date, discount date and percent, prepayment activation date (if 
applicable), discount amount, and document status of individual transactions.

 l Set a payment limit for an invoice, or clear all payment limits for invoices in a range.

 l Change the status of groups of selected transactions, for ranges of vendors.

Single Document Tab

Use this tab to:

 l Select single documents for a specific vendor.

 l Change the status of individual documents, as well as the due date, discount date, discount 
percent, and discount amount.

 l Change the prepayment activation date for prepayments.

 l Set a payment limit for a selected document.

For background information on setting payment controls for a specific document, see "About Applying 
Payments Controls to a Single Document" (page 153).

Range Of Documents Tab

Use this tab to:
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 l Change the status of groups of selected transactions.

 l Clear payment limits set for invoices in the range of documents.

For background information on setting payment controls for a range of vendors, see "About Applying 
Payment Controls for a Range of Vendors" (page 154).

Fields and Controls

Single Document Tab

Activation Date

You can change the activation date of a prepayment. The activation date is the date on which the 
prepayment is included when calculating amounts due for payment when you create a payment batch.

Prepayments are not used to calculate amounts due to vendors until they reach the activation date. If 
you change the activation date, you will change the posted prepayment information and lose the 
original details.

Balance

This is the current amount of the document.

Currency

This field displays the document currency, which is the vendor currency. 

This field appears only in multicurrency ledgers.

Disc. Amount

You can change the amount of the discount.

If you change the due date or discount details, you will change the posted invoice information and lose 
the original details.

Disc. Date

You can change the discount date if it was entered incorrectly or you want to take the discount even 
though the original discount date has passed.
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If you change the due date or discount details, you will change the posted invoice information and lose 
the original details.

Disc. Percent

You can change the discount percent.

If you change the due date or discount details, you will change the posted invoice information and lose 
the original details.

Doc. Date

This the date that was entered with the document, usually the invoice date.

Doc. Total

This is the original amount of the document.

Doc. Type

You can choose Invoice, Credit, Debit, or Prepayment.

Note: The Invoice type includes interest invoices.

Document No.

Enter the number of the document (invoice, credit note, debit note, or prepayment) that you are 
controlling.

After you enter the vendor number, document number and payment number, click the Go  button (or 

press F7) to display document information and change the due or discount dates, status, or activation 
date of the document.

Due Date

You can change the due date if the invoice was entered incorrectly, is in dispute, or has been 
renegotiated.

If you change the due date or discount details, you will change the posted invoice information and lose 
the original details.
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Payment Limit

Specify a maximum amount that you can pay for an invoice when using the Create Payment Batch 
screen. For more information, see "About Payment Limits" (page 133).

Payment No.

The payment number is "1" unless the document has a multiple payment schedule; in which case, enter 
the number of the payment.

After you enter the vendor number, document number, and payment number, click the Go  button 

(or press F7) to display document information and change the due or discount dates, status, or 
activation date of the document.

Status

You can set the status for this document at any time. It has no permanent effect on document 
information.

You can reset all the documents that have an On Hold or Forced status by selecting a range of vendors, 
and then choosing Normal for all documents.

Terms Code

This field displays the terms code entered with an invoice, and the current due date, discount date, and 
discount percentage and amount. 

You can change the due date and discount details.

Vendor No.

If you are selecting a single document, enter the vendor number or select it from the Finder.

After you enter the vendor number, document number, and payment number, click the Go  button 

(or press F7) to display document information and change the due or discount dates, status, or 
activation date of the document.

Range Of Documents Tab

Clear Payment Limit

Select this option if you want to clear payment limits set for all documents in the range you are 
processing.
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Document No.

This option is most useful if you are selecting invoices from a single vendor (since different vendors use 
different numbering systems).

When you have selected the document or range of documents and specified the change, click Process.

Document Type

Select the type of document for which you want to change the status.

When you have selected the document or range of documents and specified the change, click Process.

Status

Choose the status to which the documents are to be set (Normal, Forced, or On Hold).

When you have selected the document or range of documents and specified the change, click Process.

Vendor Group

Select the range of vendor groups for which you want to control documents.

When you have selected the document or range of documents and specified the change, click Process.

Vendor No.

Select the range of vendors for which you want to control documents.

When you have selected the document or range of documents and specified the change, click Process.

A/P Create Payment Batch Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Create Payment Batch.

Secondary Screens

A/P Pre-Check (Payment) Register Screen
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Related Tasks

 l "Applying Payment Controls" (page 156)

 l "Creating a Payment Batch Automatically" (page 147)

 l "Printing a Single Check When You Pay a Vendor" (page 252)

 l "Printing Checks for a Batch of Payments" (page 255)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Create Payment Batch screen to:

 l Create batches of checks to pay vendor invoices that are due or have a discount available for early 
payment.

Note: You can have only one system-generated batch open at one time.

You use the A/P Payment Entry screen to edit batches you create using the Create Payment Batch 
screen, if the Allow Edit Of System Generated Batches option is selected on the A/P Options screen.

 l Print a report (payment register) of the payment transactions to be created by the current payment 
criteria when you generate a payment batch. 

Tip: We recommend that you always print and review the payment register, so you do not get 
unexpected results when you generate the batch.

The Create Payment Batch screen generates payments for vendors according to their payment code. For 
vendors with no specific payment code, Accounts Payable creates checks only if a check-type payment 
code is specified as the default for  Accounts Payable on the AP Options screen.

For background information on creating payment batches, see "About Creating Payment Batches 
Automatically" (page 140).

Criteria Tab

Use this tab to specify payment selection criteria:

 l Specify whether to select documents for payment by due date or discount date.

 l Set the selection due date and/or range of dates for available discounts.
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 l Specify whether to select all documents that meet the criteria or only forced documents.

 l Set ranges of vendors, vendor groups, account sets, and payment amounts.

Exclusion Tab

Use this tab to list all vendors that you want to exclude from the payment batch.

Optional Fields Tab

Note: This tab appears if you use Sage 300 Transaction Analysis and Optional Field Creator. 

Accounts Payable automatically inserts the payment optional fields and default values assigned to the 
payment selection code you specify for the payment batch.

You can add or delete payment optional fields for the batch you are creating, and you can accept or 
change the default values that appear on this tab.

When you create the batch, the program includes with each payment:

 l All payment optional fields that are marked for automatic insertion.

Note: If you delete an automatically inserted optional field on this tab, the program reinserts it when 
you create the batch.

 l Any additional payment optional fields that you specified for the payment batch.

Rates Tab

You use this tab to change the exchange rates for the payment batch.

The default bank rate for the check currency and the vendor currency comes from Common Services, 
and is based on the rate type and the session date.

Note: These rates are for converting the bank currency and/or the vendor currency to your functional 
currency. If either of these currencies is the functional currency, the exchange rate for that currency will 
be 1.0000000.

The rates you specify on this tab apply to the whole batch. If you need to change the rate for a few 
transactions, you can edit them using the Payment Entry screen.

Select Tab

You use this tab to specify:

 l The batch date and the date that will appear on checks.

 l The bank account from which the checks will be drawn.
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 l The bank currency (check currency) and the vendor currency (multicurrency ledgers only).

 l Whether the Pre-Check Register will list payables that were bypassed due to the selection criteria.

The tab also provides the date that the Pre-Check Register, was last printed, the date that the last 
manually entered check was printed, and the date that the last system check was printed, and it shows 
whether there are any unposted payment batches.

Fields and Controls

Buttons

Clear

This button clears the current payment selection criteria, and allows you to specify a new selection 
code.

Generate

Click this button to generate a payment batch. 

For more information, see "Creating a Payment Batch Automatically" (page 147).

Register

Click this button to preview the payment transactions that will be created by the current payment criteria 
when you generate a payment batch.

For more information, see "Printing the Pre-Check Payment Register" (page 269).

Selection Code

Enter the code for the selection criteria you want to use to create a payment batch.

The Selection Code field disappears after you enter a code. If the Selection Code field does not appear 
at the top of the screen, and you do not want to use the current payment selection criteria, click the 
Clear button to erase previous selection criteria, and then enter the code you want to use. 

Tip: Do not click Clear if you want to keep most of the criteria you used previously. You can modify the 
selection criteria after entering the code.
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Criteria Tab

Criteria from the specified payment selection code record appear as defaults on this tab, but you 
can change the criteria for a particular check run.

Accounts Set

Specify a range of account sets to include in the check run, or accept the blank in the From field and the 
ZZZZZZs in the To field to include all account sets.

Note: Vendors must meet all selection criteria you specify on the screen.

Discounts Available From / To

These fields appear only if you specified Discount Date or Due Date or Discount Date in the Select 
Documents By field.

Accounts Payable selects only transactions with a discount date that falls within the range of dates you 
specify. The discount must also be available as of the batch date to be selected.

Note: Because discounts do not apply to debit notes, credit notes, interest charges, and 
prepayments, they are not included in batches generated using the Discount Date selection method.

Due On or Before

These fields appear only if you specified Due Date or Due Date or Discount Date in the Select 
Documents By field.

The date you enter is used as the cutoff date for selecting transactions.

[Pay] All Selected Documents

Select this option if you want to pay all documents that meet the selection criteria.

[Pay] Only Forced Documents

Select this option if you want to pay only documents that are marked Forced in the Control Payments 
screen and that:

 l Use the specified bank, if you selected Select Vendors With This Bank Code Only on the Select 
tab.

 l Use the vendor currency specified on the Select tab.
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 l Do not have pending payments in an open batch.

 l Are within the range of vendor amounts.

Payment Code

Specify the range of payment codes for which to create checks, or accept the blank in the From field 
and the ZZZZZZs in the To field to include all payment codes.

Note: Vendors must meet all selection criteria you specify on the screen.

Select Documents By

Choose whether to pay only transactions that are due on or before a specified date, pay only 
transactions that have available discounts for early payment, or pay transactions that are due and 
provide a discount.

Note: Because discounts do not apply to debit notes, credit notes, interest charges, and 
prepayments, they are not included in batches generated using the Discount Date selection.

Vendor Amounts

Specify the range of amounts you want to pay, or set a range from 0.01 to 999,999,999.99 to pay any 
amount, regardless of its size.

Restricting the vendor amounts allows you to pay smaller amounts routinely, and use different 
procedures for larger checks.

Note: The total amount due for a vendor (one or more invoices) must be within the range you specify.

Vendor Group

Specify the range of vendor groups to include in the check run, or accept the blank in the From field and 
the ZZZZZZs in the To field to include all vendor groups.

If you have only one vendor group, enter the vendor group code in both fields.

Note: Selected vendors must meet all selection criteria.
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Vendor Number

Specify the range of vendors to include in the check run, or accept the blank in the From and the 
ZZZZZZs in the To field to include all vendors.

Note: Selected vendors must meet all selection criteria.

Vendor Optional Fields

This field appears if you use Sage 300 Transaction Analysis and Optional Field Creator.

You can use this option to specify a vendor optional field as a criteria for selecting vendors for a 
payment batch. 

If you specify an optional field, additional fields appear, letting you specify a range of values for the field. 
You can also accept the blank From field and the ZZZZZZs in the To field to include all the values for 
the optional field.

If you do not want to use an optional field as criteria, accept None, the default setting for this field.

Note: Selected vendors must meet all the selection criteria on the screen.

Exclusion Tab

Exclusion criteria specified for the payment selection code appear as defaults on this tab. You can 
exclude additional vendors, or remove vendors from the exclusion list for a particular check run.

Vendor Number and Name

On the table, type the number of each vendor you want to exclude from the payment batch, or use the 
Finder to select the number.

Optional Fields Tab

Accounts Payable automatically inserts the payment optional fields assigned to the payment 
selection code you specified for the payment batch. You can add or delete payment optional fields, 
and change the default values that appear. 

394Sage 300 2023 Accounts Payable User's Guide



Optional Field and Description

You can add or delete any optional fields that are defined for payments on the Optional Fields setup 
screen.

You can delete an automatically inserted optional field from the tab. However, when you create the 
batch, Accounts Payable reinserts the optional field with the default value from the optional field setup 
record.

Value and Description

Accounts Payable assigns values to optional fields in the payment batch, as follows:

 l For optional fields assigned to the batch on the Create Payment Batch screen, it uses the value 
from the Optional Fields tab.

 l For automatically inserted payment optional fields that are not assigned to the payment selection 
code or on the Optional Fields tab:

 l If the optional field matches an optional field in the vendor record, the program uses the 
value from the vendor record, unless you also specified a remit-to location.

 l If the optional field matches an optional field in the remit-to location record specified on an 
invoice, the program uses the value for the remit-to location.

 l If the values for an optional field in the vendor record and the remit-to location record are 
different, the value from the remit-to location is used.

 l If the vendor does not use the payment optional field, the program uses the value 
specified in the optional field setup record.

The program also displays the descriptions for the specified values.

Rates Tab

Accounts Payable uses the rates specified on the Rates tab to convert the bank currency and the 
vendor currency to your functional currency.

Note: If the bank currency, the vendor currency, and the functional currency are the same, this 
tab does not appear.

Currency

This tab displays the vendor currency and the bank currency (which is the currency of the check). 

If either of these currencies is the same as the functional currency, the rate is 1.0000000.
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If both currencies are the same currency, but not the functional currency, only one rate appears under 
the Bank Rate heading.

Note: All payment applications are in the vendor currency, and all payments are in the bank currency.

Exchange Rate

This is the exchange rate currently in effect for the specified currency and the displayed rate type and 
rate date. You can change the rate, if necessary. 

Accounts Payable uses the Currency Rates tables in Common Services to select a rate that matches 
the rate type and date.

Rate Date

The Currency Rates tables in Common Services store exchange rates by date for each currency and 
rate type. 

The rate displayed in this field is for the date that corresponds most closely to the batch creation date.

You can change the bank rate date for an existing payment batch on the Payment Entry Batch 

Information screen. (Click the Batch Number Zoom  button on the Payment Entry screen.)

Rate Type

This is the code for the type of rate you want to use when converting source amounts to functional 
currency. Examples of rate types are "spot rate," "average rate," and "contract rate."

You must type a valid rate type, or select one from the Finder.

You define rate types using the Currency Rate Types screen in Common Services.

Select Tab

Apply Method

Specify how to apply partial payments to job-related  invoices that use different contracts, projects, and 
categories:

 l Top Down. Select this option to apply payments automatically to invoice details, beginning with 
the first detail on an invoice until the payment is fully applied.

 l Prorate By Amount. Select this option to apply payments proportionately to all invoice details.
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Notes: 
 l This field appears only if you use Sage 300 Project and Job Costing.

 l The Create Payment Batch screen generates a partial payment if the invoice uses a multiple 
payment schedule, or if a payment control limits the size of a payment for a document.

 l The apply method affects only job-related  invoices for which the applied amount is less than 
the current balance. For example, it does not affect the last payment on a multiple payment 
schedule.

 l The apply method for the payment selection code appears as the default when you specify a 
code on the Create Payment Batch screen. However, you can specify a different apply method 
when you create a payment batch.

Bank Currency

This field appears only if you have a multicurrency ledger.

The bank currency is the payment currency. You can change the currency only to another currency that 
the bank uses.

If you need to add a currency for a bank, you must use the Banks screen in Bank Services to do so.

Batch Date

The batch date appears on batch listings, posting journals, and on the Payment Batch List screen.

Include Bypassed Payables on Register

Select this option to include payments on the payment register that are due but are excluded from the 
batch because they have payment controls, or are on the exclusion list.

This option lets you check which invoices will not be paid as a result of an old hold—or a too-generalized 
hold on a range of vendors.

Pay From Bank

This is the bank from which the checks will be drawn. 

If you have a multicurrency ledger, make sure the bank supports the currency that you want to use. 

Use the screens in Bank Services to change bank information.

Payment Date

This is the date that appears on the checks when you print them.
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The batch date determines the year and period to which the payment transactions will be posted, 
unless you edit the transactions using the Payment Entry screen.

Select Vendors with this Bank Code Only

Each vendor is assigned a bank code (on the Processing tab of the Vendors screen), which allows you 
to pay vendors from particular banks. 

If you select this option, Accounts Payable creates payments only for vendors that use the bank code 
you specify on the Create Payment Batch screen.

Vendor Currency

This field appears only if you have a multicurrency ledger.

Accounts Payable restricts payment batches to a single currency. For example, you can pay vendors 
whose source currency is US dollars, or you can pay vendors whose currency is Canadian dollars, but 
you cannot pay both sets of vendors in the same system-generated batch. 

If you are paying vendors manually using the Payment Entry screen, you can mix vendor currencies, 
although all the payments will be in a single currency.

A/P Invoice Batch List Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Invoice Batch List.

Related Tasks

 l "Creating a New Invoice Batch" (page 107)

 l "Posting an Invoice Batch" (page 127)

 l "Posting a Range of Batches" (page 127)

 l "Working with Invoice Batches" (page 105)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.
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Use the A/P Invoice Batch List screen to:

 l Display a list of posted and unposted invoice batches, beginning with the batch number you 
specify. More...

Displayed information includes:

 l Batch date

 l Batch description

 l Batch number

 l Last edited date

 l Number of entries

 l Number of errors

 l Posting sequence number

 l Status (Open, Printed, Ready To Post, Deleted, Posted)

 l Total amount

 l Type (Entered, Generated, Imported)

 l Create a new invoice batch.

 l Select an existing batch to edit, post, or delete. 

If you try to post a batch for which you have not selected the Ready To Post option, you see a message 
that lets you select the option for the batch from the Invoice Batch List screen.

 l Post individual batches.

 l Post all unposted batches that are set Ready To Post.

 l Print batch listings, batch status, posting journals, and posting error reports.

Fields and Controls

Buttons

Delete

Click this button to delete a batch. For more information, see "Deleting an Invoice Batch" (page 108).
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New

Click this button to create a new batch. For more information, see "Creating a New Invoice Batch" (page 
107).

Open

Click this button to open a batch in the A/P Invoice Entry screen.

Post

Click this button to post a batch. For more information, see "Posting an Invoice Batch" (page 127).

Post All

Click this button to post all unposted invoice batches that are set Ready To Post. For more information, 
see "Posting a Range of Batches" (page 127).

Print

Click this button to print a batch listing. For more information, see "Printing Batch Listings" (page 245).

Refresh

Click this button to update the information in the displayed batch list, if it has changed since you opened 
the screen. 

For example, if you have chosen not to show posted/deleted batches and another user has posted or 
deleted a batch, the batch disappears from the list when you click Refresh.

Ready To Post

Ready To Post status indicates that a batch is complete and ready for posting. Once you select the 
option for a batch, you cannot make further changes to the batch (unless you return the batch to Open 
status), although you can still look at the batch on your screen or print listings of it.

Ready To Post status has three main purposes:

 l It prevents you from accidentally posting batches before they are ready.

 l It lets you specify a range of batches to post that can include batches which are not ready. Only 
the batches with the Ready To Post option selected will be posted.

 l It prevents you from making changes to batches for which the Ready To Post option is selected.
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Notes: 
 l You must assign Ready To Post status on the Invoice Batch List screen before you can post an 

invoice batch.

 l You cannot delete a batch that is set Ready To Post.

 l You can list batches on the Invoice Batch Listing by their Ready To Post status. Batches with 
this status are also indicated on the Batch Status report.

A/P Invoice Entry Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Invoice Entry.

Secondary Screens

 l A/P Batch Information Screen (Invoice Entry)

 l A/P Batch Information Screen (Prepayments)

 l A/P Detail Accounts/Taxes Screen (Invoices)

 l A/P Prepayments Screen

 l A/P Remit-To Location Information Screen (Invoice Entry)

 l A/P Vendor Information Screen

Related Tasks

 l "Entering an Invoice" (page 108)

 l "Entering a Debit Note or a Credit Note" (page 123)

 l "Entering a Prepayment with an Invoice" (page 119)

 l "Entering a job-related  Invoice" (page 121)

 l "Invoicing a Recurring Payable Manually" (page 122)

 l "Manually Entering and Distributing Tax Amounts" (page 117)

 l "Posting a Range of Batches" (page 127)

 l "Posting an Invoice Batch" (page 127)
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 l "Printing Batch Listings" (page 245)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Invoice Entry screen to:

 l Enter vendor invoices, credit notes, debit notes, and individual interest charges.

 l Enter prepayments with invoices.

 l Edit invoices, credit notes, debit notes, and invoices in batches created in Accounts Payable or 
imported from other accounting programs.

 l Add a new vendor or a new remit-to location during invoice entry or when editing an existing 
invoice.

 l Enter job-related  details that will update contracts and projects in Project and Job Costing.

 l Enter intercompany transaction details, if you use the Sage 300 Intercompany Transactions (ICT) 
program to send transactions between companies.     

The following ICT fields appear only for ICT companies: Originator, Destination, and Route No.

 l Print a batch listing report for a selected batch. (Click File > Print Batch Listing Report > Print.)

 l Post invoice batches individually.

Note: You can use the Quick Mode option on the Settings menu to copy many of the fields from the 
previous transaction or detail to a new transaction or detail, so you don't have to re-enter them. For 
more information, see "Menu Commands" (page 558).

Document Tab

Use this tab to:

 l Enter header information for the document.

 l Indicate that the transaction is related to a project you maintain in Sage 300 and Job Costing, and 
enter job-related  information for each document detail.

 l Enter account distribution information for the document.

 l Edit or delete existing distributions.

 l Add a new vendor or a new remit-to location during invoice entry or when editing an existing 
invoice.

402Sage 300 2023 Accounts Payable User's Guide



 l Indicate that the transaction is an intercompany transaction by selecting the originating company 
for the transaction (the originator), the destination company, and the route number of the 
transaction. For more information about intercompany transactions, see the Intercompany 
Transactions help.

Note: Posting an ICT batch creates an A/P batch in the originating company's Accounts Payable 
ledger (for posting to vendor accounts), and creates an ICT G/L batch in the ICT company.

Optional Fields Tab

Note: This tab appears only if you use Sage 300 Transaction Analysis and Optional Field Creator and 
you have defined optional fields for Accounts Payable invoices.

Use this tab to:

 l Check the optional fields used on a document.     

Accounts Payable displays the optional fields that you set up for automatic insertion on invoices, but 
you can change them or add other optional fields defined for Accounts Payable invoices.

 l Assign different optional fields to a document.

 l Check or change optional field values.    

Default values appear for optional fields, as follows:

 l If you assigned exactly the same optional fields to the vendor and remit-to location records 
as you defined for invoices, the optional field values for the remit-to location appear on the 
Optional Fields tab.

 l If the remit-to location record and the vendor record use different optional fields, the optional 
field values from the vendor record appear as defaults for the invoice.

 l If an optional field is defined for invoices, but is not assigned either to the vendor or the 
remit-to location, the program displays the value specified for the optional field in the 
Optional Fields record.

Automatically inserted invoice optional fields appear on the Invoice Entry Optional Fields tab when you 
add new documents.

Automatically inserted invoice details optional fields are associated with each detail line. The Optional 
Fields indicator field on the detail table and on the Detail Accounts/Taxes screen shows whether optional 
fields are used with a particular detail. 

To add, edit, or delete invoice detail optional fields, select the detail, then click the Optional Fields Zoom 

 button to open a separate Optional Fields screen that lets you change the optional field information 

for the detail. 
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If an optional field uses validation, you can select only entries that are defined for the optional field in 
Common Services.

For more information about entering invoice detail optional fields on invoices, see "About Entering 
Optional Fields on Invoices" (page 102).

Rates Tab

Note: This tab appears only if you use multicurrency accounting, and you are entering a document for 
a vendor that does not use the functional currency.

Use this tab to change the rate type, rate date, and exchange rate for converting the document amount 
from the vendor's currency to the functional currency.

Retainage Tab

Note: This tab appears if you select the Retainage option on the Document tab.

Use this tab to specify how to process retainage for this invoice, debit note, or credit note.

The program displays the retainage percentage, retainage rate, and the retainage terms from the vendor 
record. Unless the document is job-related , you can change these retainage factors for a particular 
document.

If the document is job-related , you can change only the retainage rate and retainage terms on this tab. 
You enter job-related  retainage amounts, retention periods, and retainage due dates with each job detail.

Accounts Payable calculates and displays the retainage amount and retainage due date for the selected 
document. You can change these fields, whether or not the document is job-related .

For more information about processing retainage, see "About Processing Retainage in Accounts Payable" 
(page 195).

Taxes Tab

Use this tab to:

 l Change the tax class and tax included settings for the specified tax group.

 l If you want to enter taxes manually, edit the tax base and tax amount fields.

Notes: 
 l To change the tax authorities listed on this tab, you must select a different tax group on the 

Document tab.

 l To change the tax rates, you must use the Tax screens in Common Services.
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Terms Tab

Use this tab to:

 l Specify the terms for the invoice, if they are different from those specified in the vendor record.

 l Edit multiple payment schedules that are calculated for invoices.

 l Override the discount base or discount amount calculated for an invoice.

A payment schedule is created only if the invoice terms code uses the Multiple Payment Schedule option.

Multiple Payment Schedules

Accounts Payable adds a Payment Schedule to the Terms tab if you assign a terms code that uses a 
multiple payment schedule (for a number of payments over a period of time such as six monthly 
payments).

The payment schedule divides the invoice total into the number of payments specified by the terms code. 
Each payment has its own due date, payment amount, and discount period, which is displayed on the 
Terms tab of the Invoice Entry screen. If you want, you can change any dates on the schedule, as well as 
decrease the number of payments (by making later payments blank).

You can use multiple payment schedules with Intercompany Transactions.

You can print payment schedules on batch listings if you select the Show Schedules option when 
printing listings of invoice batches from the Batch Listing screen.

Totals Tab

Use this tab to see the amount of recoverable tax, separately expensed tax, and allocated tax, and to see 
why an invoice has an undistributed amount.

The Totals tab displays the total tax amount on the invoice for each taxing authority, as well as current 
totals for the document in two summaries: an invoice summary and a tax summary.

Recoverable and Separately Expensed Taxes

The tax authority record in Tax Services specifies whether a particular tax is recoverable or expensed 
separately. For example, the GST in Canada and VAT in many other countries are recoverable taxes and 
are not distributed with invoice totals.

When you click the Dist. Taxes button, Accounts Payable:

 l Removes (deducts) any recoverable portion of the tax from the tax distribution amount and 
assigns it to the tax recoverable account.

 l Removes (deducts) any portion of the tax which is expensed separately and assigns it to the tax 
expense account.
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Fields and Controls

Buttons

Account/Tax

Click this button to open the Detail Accounts/Taxes screen, which lets you check or change the 
distribution code or the accounts to which you are distributing a selected detail.

You can also change tax classes for the particular detail line and indicate whether tax is included or 
excluded in the detail you are entering. If you are entering taxes manually, you can enter the tax base 
and the tax amount for the detail.

Add

After entering a new invoice, credit note, or debit note, click this button to add the document.

Note: After adding a document, the button name changes to Save.

Calculate Taxes

Click this button to recalculate the tax amount after you change the vendor tax class for the invoice.

Derive Rate

This button appears if you are entering tax reporting amounts manually or distributing tax reporting 
amounts to invoice details.

After entering the taxes and tax reporting amounts for the tax authorities, click this button to calculate 
the exchange rate implicit in converting manually entered taxes from the vendor currency to the tax 
reporting currency.

Distribute Taxes

Click this button to prorate the tax you enter manually to the invoice details.

Note: You cannot prorate a tax amount to an authority that uses an exempt tax class.

Post

Click this button to post the invoice batch that is currently displayed.

406Sage 300 2023 Accounts Payable User's Guide



Note: This button allows you to post one invoice batch at a time. For information about posting 
multiple batches, see "Posting a Range of Batches" (page 127).

Save

When editing an invoice, credit note, or debit note, click this button to save your changes.

Batch Date

You use the batch date as part of your audit trail and to select batches to print on the batch listing and 
batch status reports. The batch date is also used as the default document date when you create a new 
document.

Accounts Payable displays the session date as the default batch date when you create a new batch, but 
you can change it.

To select a date using the calendar, click the arrow button beside the Batch Date field to display the 
calendar, use the Previous or Next button to display the required month, then click the date you want to 
use for the batch.

You can also use your mouse or the arrow keys on your keyboard to move from day, month, or year, 
and then type over the existing date.

Batch Number

Enter the number of an existing batch, or click the New  button to create a new batch. In the field to 

the right, enter a description for the batch.

Notes: 
 l Accounts Payable automatically assigns a number to each new batch, and to each entry you 

add to a batch, starting with 1.

 l The batch number is a permanent part of the information stored for each invoice, debit note or 
credit note, and it appears with the transaction on Accounts Payable reports, such as posting 
journals and the G/L Transactions report, if you use the option to use the numbers as the 
description or reference for general ledger transactions.

407Sage 300 2023 Accounts Payable User's Guide



Tips: 
 l Click the Zoom  button to open the Batch Information screen, which displays additional 

details about the batch.

 l You can use batch and entry numbers to trace transactions through the Accounts Payable 
system and, if you use the numbers as the descriptions or references for G/L transactions, into 
your general ledger (unless you consolidate the transactions during posting in Accounts 
Payable).

Entered By

This field displays the name of the person who entered the transaction.

No. of Entries

This field displays the number of entries in the selected batch.

Total Amount

This field displays the total for the batch.

Document Tab

1099/CPRS Amount

This field appears only if the vendor is subject to 1099 reporting (for a US vendor), or CPRS reporting 
(for a Canadian vendor).

Enter the amount of the document that is subject to 1099 or CPRS reporting.

1099/CPRS Code

This field appears only if the vendor is subject to 1099 reporting (for a US vendor), or CPRS reporting 
(for a Canadian vendor). 1099 forms are used in the United States, and CPRS reports are used in 
Canada. 

Select the 1099/CPRS code that matches the type of purchase or payment you are making.

Account Set

The account set from the vendor record appears in this field as the default.
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You can change the account set for a particular transaction. If you use multicurrency, however, the new 
account set must use the same currency as the vendor's account set.

Apply To Document

For credit notes and debit notes, you can enter the number of the document to which the note applies.

If the note applies to several invoices, or is issued on account (for example, as a purchase volume 
rebate), you do not enter an invoice number here. You apply the credit note or debit note later, in the 
Payment Entry screen.

When you select an apply-to document in multicurrency ledgers, you will also see the exchange rate at 
which the document was posted. You would normally enter the credit note or debit note at the same 
exchange rate.

Currency and Rate

The vendor's currency and the exchange rate appear when you enter the vendor number in a 
multicurrency system. You use the Rates tab to change the rate type, rate date, and exchange rate for 
an entry that is not in the functional currency. You cannot change the currency type.

If you need to change the tax group for a multicurrency vendor, you must select another tax group that 
also uses the vendor's currency.

Dist. Amount

Type the total amount to distribute to the details created by the distribution set.

This total does not have to be the full amount you need to distribute. For example, after creating 
distribution details for a distribution set, you may need to add distribution lines for general ledger 
accounts that are not included in the distribution set.

Distribution Set

If you are using a distribution set, enter or accept a distribution set code.

If you are not using a distribution set, leave this field blank, and enter or select the distribution codes or 
G/L account numbers in the distribution list.

Document Date

The document date sets the default due date and discount period, if any, for an invoice. It also sets the 
aging date from which invoices, credit notes, and debit notes are aged on reports. (You can choose 
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whether to age credit notes and debit notes by document date or treat them as current transactions. 
Invoices are always aged by date.)

You can also print posting journals by document date.

To select a date using the calendar, click the button beside the Document Date field.

Document Number

The document number is the number on the invoice, debit note or credit note you received. You can add 
standard prefixes to each document (such as INV, NCR, NDR, INT) so they will be grouped on 
combined listings.

You can use a document number only once for a vendor.

You can also print posting journals by document number.

Document Total

Enter the total amount of the document, including taxes.

If you know only the amount net of taxes, you can enter that amount, but you must then perform some 
additional steps. For more information, see "Entering an Invoice" (page 108).

Document Type

You use the Invoice Entry screen to enter the following kinds of documents: invoices, credit notes, debit 
notes, and interest invoices.

If you use retainage accounting and you selected the Retainage option for the invoice, you can also 
enter retainage invoices, retainage credit notes, and retainage debit notes.

You can add all document types to a single batch, or use separate batches for each type.

Entry Number

Accounts Payable assigns an entry number to each new entry you create. An entry number identifies 
the sequence in which an entry was added to a batch and, along with the batch number, forms part of 
the audit trail for the transaction.

To select an existing entry for editing or deleting, type its number in the Entry field or choose the number 
from the Finder. To add a new entry, click the New button next to the Entry field.

If you delete an entry, you cannot reuse its number.
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You can enter a description for the entry in the field to the right. This description appears with the 
document information on the Invoice Batch Listing and the Invoice Posting Journal.

Job Related

Select this option if the document you are entering is related to a contract that you manage in Sage 300 
and Job Costing.

When you select this option, additional fields appear in the detail section of the screen to let you enter 
the contract, project, category, and resource for each detail.

Note that a document can contain either job-related  details or non-job-related  details. You cannot mix 
details on the same document.

On Hold

Select this field if you want to put an invoice, debit note, or credit note on hold. (You can also put 
specific documents on hold using Control Payments.)

When you post the invoice batch, Accounts Payable does not apply any matching prepayments if either 
the prepayment or the invoice has an On Hold status. In addition, you cannot post credit notes or debit 
notes if either the credit (or debit) note or the specified Apply-To document is on hold.

To apply a payment, debit note, or credit note to a document that is on hold when using the Create 
Payment Batch screen, you must first remove the On Hold status using the Control Payments screen. 
You can always apply the document manually in Payment Entry, without removing the hold, if you want.

On retainage invoices, debit notes, and credit notes, Accounts Payable sets the On Hold status used on 
the original document as the default.

Order Number

You can enter a sales order number or other information in this field, or leave the field blank. 

Tip: You can list documents by sales order number in Finders and for payment application, and you 
can use the number as the reference or description in G/L transaction batches.

Original Document

This is the term used in Sage 300 to identify the invoice, credit note or debit note from which retainage is 
taken from.
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Originator

This field appears only if Intercompany Transactions is activated for the company you are working with.

Click the Finder to select the originating company for this entry. When the entry is posted, an invoice will 
be created in the originating company's A/P ledger.

PO Number

You can type your company's purchase order number, if any, use the field for another purpose, or leave 
it blank. 

Tip: You can list documents by purchase order number in Finders and when applying payments, and 
you can use the number as the reference or description in G/L transaction batches.

Posting Date

Use this field to specify the date that a selected document is posted to General Ledger. The posting 
date also determines the year and period to which the transaction is posted.

Accounts Payable uses posting dates, rather than document dates, to select open documents for 
revaluation, so that exchange adjustments are posted to the correct fiscal year and period.

The default posting date that appears can be the document date, the batch date, or the session date, 
depending on the selection for the Default Posting Date option on the A/P Options screen.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Remit-To Location

If necessary, you can select or enter a different name for the check and a different address to which you 
will send payment. 

You can select a remit-to location that has been defined for the vendor, or use the Zoom  button 

beside the field or press F9 to open a separate screen in which you can enter a name and address for 
the document.

Retainage option

Select this option if retainage applies to the document you are entering.
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Notes: 
 l This option appears only if you selected the Retainage Accounting option for your Accounts 

Payable system. For more information, see "A/P Options Screen" (page 325).

 l When you select the Retainage option in Invoice Entry, a Retainage tab appears where you 
specify how to process retainage for this invoice, debit note, or credit note.

Vendor Number

Identifies the vendor to whose account you will post the document. The vendor number determines the 
vendor, payment address, the default tax group, the payment terms, and whether the vendor is subject 
to 1099/CPRS reporting. In multicurrency systems, the vendor number also specifies the currency of 
the document.

Year/Period

Accounts Payable displays the fiscal year and period to which the document will be posted.

Accounts Payable automatically displays the fiscal year and period that contains the date you enter in 
the Posting Date field. You cannot change this field except by changing the posting date.

Detail Table

Allocated Tax

If you use Distribute or Enter as the tax entry method, use the Distribute Tax button to distribute to the 
distribution lines the taxes you enter on the Taxes tab. If you use Enter as the tax entry method, you can 
edit the Allocated Tax column to redistribute the tax, if necessary.

If you select Calculate as the tax entry method, you cannot directly edit tax amounts for distribution 
lines, but you can change tax classes. To change the tax class for a distribution line, highlight the line 
and press F9, then make the changes in the screen that appears.

If you select Calculate or distribute as the tax entry method, you must distribute all of the invoice 
amounts before you use the Distribute Taxes button to calculate and distribute tax amounts.

Amount

For each detail you add, enter the amount of the detail in the Amount field, or edit the existing detail 
amount, if necessary.
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The portion of the document total you distribute to details depends on whether tax is included in the 
price.

A/R Item Number

If you selected the Job Details option for the invoice, debit note, or credit note, this field appears in the 
detail-entry section of the Invoice Entry screen and on the Detail Accounts Taxes screen.

The program displays the A/R item number used in the contract in Project and Job Costing. You can 
select a different A/R item number only for time and material projects, as follows:

 l On a standard contract, the program displays the A/R item number and unit of measure specified 
for the project resource category as the default. You can accept the item number or select 
another valid A/R item number.

 l On a basic contract, program displays the A/R item number and unit of measure specified for the 
project category. You can accept the item number or select another valid A/R item number.

 l If you change the A/R item number, the item number must be a valid item number in Accounts 
Receivable, and the unit of measure must be a valid unit of measure both for the new item 
number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number.

Billing Currency

This field appears only for time and materials projects on job-related  invoices, debit notes, and credit 
notes. The billing currency is the customer's currency specified on the contract, and you cannot change 
it.

Billing Rate

This field displays the billing rate for the specified resource (for standard contracts) or category (for 
basic contracts).

Notes: 
 l This field appears only for job-related  invoices, credit notes, and debit notes.

 l You can change the billing rate only if the detail is billable (specified in the Billing Type field).

 l The billing rate cannot be negative.
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Billing Type

This field appears in the detail-entry section of the Invoice Entry screen and on the Detail Accounts 
Taxes screen for job-related  invoices, debit notes, or credit notes. The billing type indicates to Project 
and Job Costing whether to bill the cost to the customer. For more information, see "About Billing Types" 
(page 92).

Category

This field appears in the detail-entry section of the Invoice Entry screen and on the Detail Accounts 
Taxes screen if you selected the Job Related option for the invoice, debit note, or credit note.

Select or enter a category that you have assigned to the specified project in Project and Job Costing.

Comment

Accounts Payable lets you enter a comment with each detail on an invoice, credit note, or debit note. 
For example, you might include a comment indicating that the invoice discount does not apply to a 
particular detail.

Contract

This field appears in the detail-entry section of the Invoice Entry screen and on the Detail Accounts 
Taxes screen if you selected the Job Related option for the invoice, debit note, or credit note.

Select or enter a contract number for each detail. You can enter or select only contracts that are open 
or on hold. (You cannot process transactions to an account that is on hold, if it has never been opened.)

Date

This is the date the expense was incurred. Accounts Payable displays the invoice date as the default 
for this field, but you can change it.

Description

Type a description for the distribution line. 

The description from the distribution code record appears as the default description.

Destination

This field appears only if Intercompany Transactions is activated for the company you are working with.
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Using the Finder, select the company that ultimately receives the entry made by the originating 
company. For example, Company B is the destination company where Company A pays an expense 
on behalf of Company B.

The destination company can be a single or multicurrency company, but, if single currency, it must 
have the same functional currency as the originator.

Discountable

You use this option to specify whether a selected detail is subject to the invoice discount. For example, 
if you do not give discounts on freight charges, you can exempt a freight detail from the invoice 
discount.

To indicate that a detail is not discountable, you simply clear the Discountable option for the detail on 
the Detail Accounts/Taxes screen, or select No for the option on the detail-entry table.

Dist. Code

A distribution code appears if the vendor record is set up to distribute details by distribution code, or if 
you used the Create Dist. button to create distributions from a distribution set.

Accept or change the distribution code, as needed.

You can also enter a distribution code if none appears, or leave the field blank, and then enter the 
general ledger account number.

Dist. Net Of Tax

The amount calculated for the detail line, before tax is added.

G/L Account

Enter, accept, or change the displayed general ledger account number, as needed.

For invoices that are not job-related, Accounts Payable displays the account numbers for the 
distribution codes you specify. However, you can enter the general ledger account codes directly. You 
can also change the account number for a distribution line on the detail table on the Invoice Entry 
screen.

For recurring payables, you can change the account number on the Detail tab.
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Note: 
For job-related  documents, Accounts Payable displays accounts associated with the project or 
category in Project and Job Costing.

For most projects, the program displays the Work In Progress account for the specified category. For 
projects using accrual-basis as the accounting method, however, the program displays the Cost Of 
Sales account.

You can change the account only for:

 l Any time and materials project.

 l Projects that use the accrual-basis accounting method.

G/L Dist. Amount

This is the total amount—purchases and tax—that is being distributed to the general ledger account 
specified by this distribution line.

Include Tax Amount

If tax was included in the distribution amount, this column indicates the amount of tax that was included.

Optional Fields

This field indicates whether optional fields are assigned to the document detail.

Notes: 
 l If any invoice details optional fields are set for automatic insertion, the field is selected when 

you add a new detail to an invoice, credit note, debit note, or recurring payable.

 l If you use exactly the same optional fields in vendor records and on invoices, the program 
assigns the optional field values used in the vendor record to transaction details that you add 
in the Invoice Entry screen and the Recurring Payables setup screen.

 l You can accept or delete the optional fields that appear as defaults, and you can add other 
optional fields that you have set up for invoice details. You can also change the optional field 
values used in document details.

 l For job-related  details, if the invoice details optional fields used on an invoice detail are 
identical to those assigned to the contract project, Accounts Payable uses the optional field 
values from the contract project as default values for the details.

 l If you assign to a job-related  detail an optional field that is not assigned to the contract project, 
the program displays the default value for the invoice details optional field.
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Project

This field appears on the detail entry table and on the Detail Accounts Taxes screen if you selected the 
Job Related option for the invoice, debit note, or credit note.

Select or enter a project for each detail.

You can enter or select only projects that are:

 l Assigned to the specified contract.

 l Open or on hold. (If a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Quantity

Use this field to enter a quantity for the detail, using up to 5 decimal places. (You can enter a negative 
quantity.)

The program calculates the detail amount based on the quantity and unit cost you enter. This 
information is used to update the actual extended cost for the contract, project, category, and resource 
in Project and Job Costing when you post the transaction.

Resource

This field appears on the detail entry table and on the Detail Accounts Taxes screen if you selected the 
Job Related option for the invoice, debit note, or credit note.

For details you are entering for standard projects, you must specify a resource that you have assigned 
to the project in Project and Job Costing. Select or enter the code for the resource for which the vendor 
is invoicing, such as an equipment code or a subcontractor code.

If you specified a basic project, you can enter anything you want in this field, or you can leave it blank.

Retainage %

The program uses the retainage percentage to calculate the retainage amount for a detail on an original 
invoice, credit note, or debit note.

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you enter 
a new percentage, the program recalculates the retainage amount for the detail.
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Retainage Amount

The retainage amount is the amount you can withhold for an original document or document detail until 
the end of the retention period, when retainage is due.

This field works differently depending on whether or not the document is job-related :

 l For a document that is not job-related :

 l To calculate the retainage amount, the program multiples the document amount (or the 
document total, if you include taxes in retainage) by the retainage percentage.

 l The retainage amount is subtracted from the document amount (or the document total) to 
calculate the amount due.

 l For a document that is job-related :

 l To calculate the retainage amount, the program multiples the extended detail amount (or 
the extended amount plus tax, if you include taxes in retainage) by the retainage 
percentage.

 l The retainage amount is subtracted from the detail amount to calculate the amount due.

You can enter a new retainage amount, if necessary. When you enter an amount to replace a 
calculated amount, the program recalculates the retainage percentage.

Retainage Due Date

The program calculates the retainage due date (the date the outstanding retainage is due for invoicing) 
by adding the number of days in the retention period to the original document date. You can enter a 
different due date, if you want.

Retainage Tax Amount

This field shows the tax on retainage calculated for a selected detail on an original invoice, credit note, 
or debit note.

Retention Period

The retention period is the number of days following the document date that retainage for the document 
detail will be due.

The program uses the retention period to calculate the due date for the retainage. When you change 
the retention period, the program recalculates the retainage due date, and vice versa.
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Route No. and Description

This field appears only if Intercompany Transactions is activated for the company you are working with.

Select the appropriate route between the originating company and the destination company selected 
for this detail line. If the destination company for this detail is also the originating company, the route 
must be zero.

Undistributed Amount

After distributing taxes, you should have distributed all document amounts, and the Undistributed 
Amount field should show zeros.

If the Undistributed Amount field does not show zeros, you have distributed either more or less than the 
total amount of the invoice, credit note, or debit note.

Examples: 
 l If the Undistributed Amount field contains a positive number, you have not distributed the total 

invoice. (If you used Calculate or Distribute as the tax entry method and tax is included, you 
must also distribute the tax amount.)

 l If the Undistributed Amount is a negative amount (with a minus sign or in parentheses), check 
to see whether you accidentally distributed the taxes.

Click the Totals button to see the document summary information, so you can find out where the 
mistake occurred.

Unit Cost

Use this field to enter a unit cost for the detail. The program calculates the detail amount based on the 
quantity and unit cost you enter. This information is used to update the actual extended cost for the 
contract, project, category, and resource in Project and Job Costing when you post the transaction. and 
quantity to let the program calculate the detail amount for you.

Unit of Measure

This field appears in the detail-entry section of the Invoice Entry screen and on the Detail Accounts 
Taxes screen if you selected the Job Details option for the invoice, debit note, or credit note.

You must enter a unit of measure that is valid both for the specified item number and for the contract 
customer's currency.

420Sage 300 2023 Accounts Payable User's Guide



Optional Fields Tab

Optional Field and Description

Any invoice optional fields that are set up for automatic insertion appear, along with their descriptions, 
as defaults on the Optional Fields tab.

You can add different optional fields, providing they are defined for invoices in the A/P Optional Fields 
screen. When you select an optional field code, the program displays the description from the optional 
field setup record.

You can delete optional fields that appear as defaults. However, if an optional field is required, do not 
delete it. You cannot add the transaction until you enter a value for the optional field.

Value and Description

Default values appear for invoice optional fields, as follows:

 l If you assigned the same optional fields to the vendor and remit-to location records as you 
defined for invoices, the optional field values for the remit-to location appear on the Optional 
Fields tab.

 l If the optional fields in the remit-to location record and the vendor record are different from each 
other, the optional field values from the vendor record appear as defaults for the invoice.

 l If an optional field is defined for invoices, but is not assigned either to the vendor or the remit-to 
location, the program displays the value specified for the optional field in the Optional Fields 
record.

You can change the value that appears for an optional field. If the optional field is validated, you must 
specify a value that is defined for the optional field in Common Services. If the optional field is not 
validated, you can select a value from Common Services or you can enter another value that is 
consistent with the type of optional field.

The description for the value appears automatically. You cannot change it.

Value Set

If an optional field is a required field, it must contain a value before you can save an entry.

The Value Set field indicates Yes if Accounts Payable has already set a value—including an acceptable 
blank—for the field.
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Rates Tab

You use the Rates tab to change the rate type, rate date, and exchange rate for an entry that is not 
in the functional currency. You cannot change the currency type.

Apply-To Document Original Exchange Rate

If you are applying a debit note or a credit note to a specific document, the exchange rate used on the 
original document appears in this display-only field.

Currency

The vendor's currency and the exchange rate appear when you enter the vendor number in a 
multicurrency system. 

If you need to change the tax group for a multicurrency vendor, you must select another tax group that 
also uses the vendor's currency.

Exchange Rate

This is the exchange rate currently in effect for the specified currency and the displayed rate type and 
rate date. You can change the rate, if necessary. 

Accounts Payable uses the Currency Rates tables in Common Services to select a rate that matches 
the rate type and date.

Rate Date

Enter a rate date. This is the date you want to use for selecting the currency exchange rate. 

Tip: You maintain exchange rates by date in the Currency screens in Common Services. If you 
update exchange rates daily, the rate date will provide the rate in effect on the date you specify.

Rate Type

Specify the code for the kind of rate you want to use when converting non-functional amounts to 
functional currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type, or select one from the Finder.

Rate types are defined using the Currency Rate Types screen in Common Services.
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Retainage Tab

Retainage %

The program uses the retainage percentage to calculate the retainage amount.

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you enter 
a new percentage, the program recalculates the retainage amount.

Retainage Amount

To calculate the retainage amount, the program multiples the document amount (or the document total, 
if you include taxes in retainage) by the retainage percentage. You can enter a new retainage amount, if 
necessary. When you enter an amount to replace a calculated amount, the program recalculates the 
retainage percentage.

The retainage amount is subtracted from the document amount (or the document total) to calculate the 
amount due.

Retainage Rate

Specify the method the program will use to determine the exchange rate for the retainage document 
when you eventually process it:

 l Use Original Document Exchange Rate. This method uses the same rate as the document you 
are processing.

 l Use Current Exchange Rate. This method uses the rate in effect when you process the 
retainage document to clear the outstanding retainage.

Retainage Terms

You can use different terms for retainage documents (used to invoice for outstanding retainage) than 
you used for the original document from which the retainage was taken.

The program displays the code specified for retainage terms in the vendor record, but you can change 
the retainage terms for a document, if you want.

Taxes Tab

Currency Code

This field appears in the Tax Reporting Currency Rate section on the Taxes tab if the tax group you 
specified for the document is different from the vendor's currency.
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The program displays the currency code for the tax group, and you cannot change it.

Estimated Tax Withheld

The total estimated amount that you will withhold for a transaction to be remitted to a tax authority on 
behalf of the vendor.

Exchange Rate

Accounts Payable uses this exchange rate to calculate the tax reporting amount in the tax reporting 
currency.

The program displays the exchange rate specified for the tax reporting currency, rate type, and rate 
date in Common Services, but you can change the rate.

Import Declaration Number

If the invoice is for imported goods, enter the import declaration number for the invoice. This number is 
required for tax purposes in some jurisdictions (such as Malaysia and Singapore).

Rate Date

Enter a rate date. This is the date you want to use for selecting the currency exchange rate. 

Tip: You maintain exchange rates by date in the Currency screens in Common Services. If you 
update exchange rates daily, the rate date will provide the rate in effect on the date you specify.

Rate Type

Specify the code for the kind of rate you want to use when converting non-functional amounts to 
functional currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type, or select one from the Finder.

Rate types are defined using the Currency Rate Types screen in Common Services.

Retainage Tax Amount

This column appears on the Invoice Entry Taxes tab only for original invoices, debit notes, and credit 
notes to which retainage applies. It shows the total amount of tax calculated for retainage for the 
document.
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Retainage tax amounts are computed using the retainage tax base and the tax rate for each tax 
authority.

If you report tax for Accounts Payable As Per Tax Authority, and the tax authority reports tax when the 
retainage document is posted, Accounts Payable can compute the amount, or you can enter or 
distribute a retainage tax amount. If tax is reported when the original document is posted, however, the 
amount is zero.

Accounts Payable updates Project and Job Costing with retainage tax amounts when you post original 
documents. The tax amounts appear as committed costs in the Contract Maintenance screen in Project 
and Job Costing.

Retainage Tax Base

This field appears on original documents to which retainage applies. It shows the amount (before 
included taxes) used to calculate tax on retainage, if the tax will be reported when you post the 
retainage document.

Two factors determine when tax on retainage is reported:

 l Your choice for the Report Tax option for Accounts Payable (on the Retainage tab of the A/P Options 
screen):

 l At Time Of Original Document. If you select this option, Accounts Payable calculates and 
posts tax on retainage when you post the original document, regardless of the tax 
reporting options you select in Tax Services for the tax authority.

 l As Per Tax Authority. If you select this option, Accounts Payable respects the selection 
for the Report Tax On Retainage Document option for the tax authority.

 l The setting for the Report Tax On Retainage Option for the tax authority, in Tax Services.

The tax authority may specify that no tax on retainage will be calculated (No Reporting), or that tax will 
be calculated and posted either when you post the original document or when you post the retainage 
document.

Note: A retainage tax base does not apply if tax on retainage is reported when you post the original 
document.

Reverse Charges Amount

From all details in the document, the total of reverse chargeable tax amounts owed to a tax authority, if 
the Reverse Charges Base for the tax authority is above the reverse charges threshold amount for the 
tax authority. If the Reverse Charges Base is not above the reverse charges threshold amount, this field 
displays 0.
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Tip: You can change the amount in this field if you select Enter or Distribute in the Tax Amount field 
on the Taxes tab.

Reverse Charges Base

From all details in the document, the total of Tax Base amounts used to calculate reverse chargeable 
tax amounts owed to a tax authority.

The Reverse Charges Base is shown only if it is above the reverse charges threshold amount for the tax 
authority. If the Reverse Charges Base is not above the reverse charges threshold amount, this field 
displays 0.

Tax Amount

If you selected Enter as the tax entry method, enter the amount of each tax that is listed on the invoice. 
If a tax does not appear on the tab, you likely selected the wrong tax group for the document.

If you selected Calculate as the entry method for the tax amount and Distribute or Enter for the tax base, 
the program uses the tax base you enter to calculate the tax amount automatically.

Tax Authority

The tax group you specify on the Taxes tab of the Invoice Entry screen determines which tax authorities 
appear.

Tax authorities are the taxing bodies, such as federal, state, county, provincial, or municipal 
governments, that levy taxes in the areas where your company buys products.

If your business has a head office and branch offices, different taxes may apply in the different 
geographical locations.

Tax Base

This is the amount (before included taxes) used to calculate tax for the tax authority.

Note: On original documents to which retainage applies, if the tax on retainage will be reported when 
you post the retainage document, this is the amount before tax (or the cost, depending on the tax 
authority) less retainage.

If you select Calculate for the tax base, you cannot change the amount that appears in the Tax Base 
field.
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If you select Enter or Distribute for the tax base, you can enter the amount on which tax is based for the 
document.

If you select Calculate for the tax amount and Distribute or Enter for the tax base, the program uses the 
tax base you enter to calculate the tax amounts automatically.

Tax Group

Enter a tax group. For more information, see "About Tax Groups" (page 98).

Tax Included

Select Yes if taxes charged by the authority are included in the prices on the invoice you are entering. 
The default setting comes from the vendor record.

This setting applies to the whole invoice. You can override this setting for single distribution lines on the 
Document tab.

Tax Reporting

This field appears only if the tax group you specify for the invoice does not use the vendor currency.

You can select:

 l Calculate. Select Calculate for the Tax Reporting option if you want Accounts Payable to 
calculate tax reporting amounts automatically using information you specify in the Tax Reporting 
Currency Rate section.

 l Enter. Select Enter if you want to enter tax reporting information manually for the document.          

The sum of the detail amounts must equal the totals you enter for each tax authority. However, you do 
not need to enter tax amounts manually for the details. You can enter the total tax amounts for the 
document, and then click the Distribute Taxes button to distribute the total tax amounts to the details.

You can also click the Derive Rates button to compute the exchange rate used to convert manually 
entered tax amounts to the tax reporting currency.

 l Distribute. Select Distribute if you want to enter total tax reporting information manually for the 
document, and have the program automatically distribute tax reporting amounts to the details.          

You can also click the Derive Rates button to compute the exchange rate used to convert manually 
entered tax amounts to the tax reporting currency.
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Tax Reporting Amount

This field appears only if the currency for the tax group specified for the document is different from the 
vendor's currency.

This field shows the tax amount converted to the tax reporting currency specified for the tax authority (in 
Tax Services).

Tax Reporting Total

This field appears only if the tax group uses a different currency than the vendor currency.

It shows the amount of tax to be reported on tax tracking reports for all the tax authorities listed on the 
invoice.

Total Tax

This is the total tax amount for the document, including recoverable or separately allocated tax.

If you selected Enter or Distribute as the tax entry method for the tax amount, this field displays the total 
amount of taxes that you entered on the Taxes tab.

If you selected Calculate and clicked the Calculate Taxes button, this field shows the tax amount 
calculated by Accounts Payable.

Vendor Tax Class

The tax class of each tax authority usually indicates a taxable or non-taxable status for your business or 
the goods you are purchasing. Tax classes occasionally indicate the tax rate as well. A typical set of 
classes might be: 1=taxable at rate 1, 2=taxable at rate 2, and 3=non-taxable. The default tax class 
comes from the vendor record.

Note: This setting applies to the whole invoice. You can override this setting for single distribution 
lines on the Document tab.

Terms Tab

Amount Due

This is the amount due for the particular payment. The amount for each payment is calculated from the 
percentage that is specified in the terms code. You can change payment amounts as needed, but the 
total of all payments in a schedule must equal the invoice total.
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As of Date

The As Of Date is the date from which the terms are calculated. Accounts Payable automatically 
displays the document date, but you can type another date.

For example, if the first payment is not due for six months (so you would consider the first invoice date 

as six months from today), you would add six months to the As of Date, then click the Go  button to 

recalculate the schedule dates.

Disc. Amount

This is the amount of the discount you can take if payment is made by the discount date. While the 
discount period is in effect, the discount amount is displayed for the payment when you are applying 
payments to the invoice (in Payment Entry).

Disc. Base

This field appears on the Terms tab of the Invoice Entry screen. The program displays the document 
amount as the default, but you can change it.

The program multiples the discount base by the discount percentage to determine the discount amount.

Disc. Date

This is the date by which payment must be made to qualify for the early payment discount. The dates 
are calculated only if the terms code includes discount information, but you can enter discounts in an 
individual multiple payment schedule, if you want.

Disc. Percent

This is the percentage amount of any discount that is permitted by the terms code assigned to an 
invoice. If the invoice includes a multiple payment schedule, a separate discount percentage is 
assigned for each payment. You can change the discount percentages at any time until you post the 
invoice.

Due Date

This is the due date for the particular payment. It is used to age outstanding payments on Overdue 
Payables and Aged Cash Requirements reports. You can change due dates at any time until you post 
the invoice.
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Payment Number

Each of the payments in a multiple payment schedule is assigned a number. You specify the payment 
number when applying payments or entering adjustments to an invoice with a multiple payment 
schedule.

Terms Code

The terms code is used to calculate the due date, discount period, and discount amount for the 
document.

Notes: 
 l The vendor's default terms code appears when you enter the vendor number for the invoice, 

but you can change to any other terms code that is defined in Accounts Payable.

 l You can specify a terms code that includes multiple payments. For more information, see 
"About Assigning Multiple Payment Schedules to Invoices" (page 94).

 l You can change the due date, discount date, amount, and rate at any time until you post the 
invoice.

Totals Tab

Allocated Tax

If you selected Distribute or Enter as the tax entry method, click the Distribute Tax button to distribute to 
the distribution lines the taxes you enter on the Taxes tab. If you use Enter as the tax entry method, you 
can also edit the Allocated Tax column to redistribute the tax, if necessary.

If you select Calculate as the tax entry method, you cannot directly edit tax amounts for distribution 
lines, but you can change tax classes. To change the tax class for a distribution line, highlight the line, 
press the F9 key, and then make the changes in the screen that appears.

If you select Calculate or Distribute as the tax entry method, you must distribute all of the invoice 
amounts before you use the Distribute Taxes button to calculate and distribute tax amounts.

Document Total

Enter the total amount of the document, including taxes.

If you know only the amount net of taxes, you can enter that amount, but you must then perform some 
additional steps. For more information, see "Entering an Invoice" (page 108).
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Less Discount

This field shows the early payment discount calculated for this invoice, based on the information 
entered on the Terms tab. This amount is subtracted from the Document Total in calculating the Net 
Payable amount.

If the terms code for the invoice includes a multiple payment schedule, Accounts Payable displays the 
sum of the early payment discounts available.

Less Estimated Tax Withheld

The total estimated amount that you will withhold for a transaction to be remitted to tax authorities on 
behalf of the vendor.

The amount displayed in this field is based on the Document Total after discount. For example, if the 
document total is $100.00 and the withholding tax rate is 10%, the estimated withholding amount is 
$10.00. But if the invoice has a discount of $10.00, in effect reducing the document total to $90.00, the 
estimated withholding amount is $9.00.

Less Prepayment

This field shows the amount of the invoice that has been prepaid. This amount is subtracted from the 
Document Total in calculating the Net Payable amount.

Less Reverse Charges

The total of Reverse Charges Amounts for the document.

Net Payable

The program displays the amount payable on the invoice, less any discount. This amount does not 
change when you add a prepayment.

Out Of Balance

This field shows the  difference between the To Be Calculated amount less the Allocated Tax amount.

Recoverable Tax

This field shows the amount of tax that you can recover from the tax authority. It is not expensed, but is 
assigned to the tax recoverable account you specified for the tax authority in Tax Services.
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Tax Exp. Separately

This field shows the amount of any tax that you expense separately. Accounts Payable assigns it to the 
separate tax expense account you specified for the tax authority in Tax Services.

Taxes

This field shows the total amount of taxes for the invoice. This amount is subtracted from the Total 
Distribution Net Of Tax in calculating the Document Total.

To Be Allocated

This field shows the total amount of tax, less any tax that is recoverable or expensed separately, that 
you must distribute for the document.

Total Dist. Net of Tax

This field shows the sum of the invoice details, before taxes.

Total Tax

This field shows the total tax amount for the document, including recoverable or separately allocated 
tax.

If you selected Enter or Distribute as the entry method for the tax amount, this field displays the total 
amount of taxes that you entered on the Taxes tab.

If you selected Calculate and clicked the Calculate Taxes button, this field shows the tax amount 
calculated by Accounts Payable.

Undistributed Amount

After distributing taxes, you should have distributed all document amounts, and the Undistributed 
Amount field should show zeros.

If the Undistributed Amount field does not show zeros, you have distributed either more or less than the 
total amount of the invoice, credit note, or debit note.
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Examples: 
 l If the Undistributed Amount contains a positive number, you have not distributed the total 

invoice. (If you used Calculate or Distribute as the tax entry method and tax is included, you 
must also distribute the tax amount.)

 l If the Undistributed Amount is a negative amount (with a minus sign or in parentheses), check 
to see whether you accidentally distributed the taxes.

Click the Totals button to see the document summary information, so you can find out where the 
mistake occurred.

A/P Payment Batch List Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Payment Batch List.

Secondary Screens

"A/P Print Checks Screen" (page 471)

Related Tasks

 l "Listing Payment Batches" (page 146)

 l "Printing Checks for a Batch of Payments" (page 255)

 l "Posting a Range of Batches" (page 127)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Payment Batch List screen to:

 l Display a list of open, posted and deleted payment batches, beginning with the batch number you 
specify. More...

Displayed information includes:
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 l Batch number

 l Batch date

 l Batch description

 l Number of entries

 l Total amount

 l Type (Entered, Imported, Generated, System Checks)

 l Status (Open, Printed, Ready To Post, Deleted, Posted, Partially Posted, Posting in 
Progress, Check Printing In Progress)

 l Posting Sequence Number

 l Number of errors

 l Last edited

 l Create a new payment batch.

 l Select an existing batch to edit, print checks for and post, or delete.

 l Post all unposted batches that are set Ready To Post.

 l Print batch listings, batch status reports, posting journals, and posting error reports.

Note: You must use this screen to post payment batches. Accounts Payable does not have a Post 
Payment Batch screen.

To view the transactions in an unposted batch, either open the batch you want to view, or print the batch 
listing or preview it on your screen. You cannot view deleted batches, and you cannot edit batches for 
which you have selected the Ready To Post option.

Fields and Controls

Buttons

Delete

Click this button to delete a batch. For more information, see "Deleting a Payment Batch" (page 146).

New

Click this button to create a new batch.
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Open

Click this button to open a batch in the A/P Payment Entry screen.

Post All

Click this button to post all unposted payment batches that are set Ready To Post. For more 
information, see "Posting a Range of Batches" (page 127).

Print

Click this button to print a batch. For more information, see "Printing Batch Listings" (page 245).

Print/Post

Click this button to print checks for a batch, and post the payment information to vendor accounts. For 
more information, see "Printing Checks for a Batch of Payments" (page 255).

A/P Payment Entry Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Payment Entry.

Secondary Screens

 l A/P Batch Information Screen (Payment Entry)

 l A/P Detail Accounts/Taxes Screen (Miscellaneous Payments)

 l A/P Detail Tax Withheld Screen

 l A/P Document History Screen

 l A/P Document Taxes Screen

 l A/P Miscellaneous Adjustment Entry Screen

 l A/P Project and Job Costing Apply Details Screen

 l A/P Rate Override Screen

 l A/P Remit-To Location Information Screen (Payment Entry)

 l A/P Tax Withheld Screen

435Sage 300 2023 Accounts Payable User's Guide

../../../../../../Content/Transactions/POPUPS/PaymentEntry/BatchInformation.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/DetailAccountsTaxes.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/DetailTaxWithheld.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/DocumentHistory.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/DocumentTaxes.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/MiscellaneousAdjustmentEntry.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/PJCApplyDetails.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/RateOverride.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/RemitToLocationInformation.htm
../../../../../../Content/Transactions/POPUPS/PaymentEntry/TaxWithheld.htm


Related Tasks

 l "Adding a Payment Batch" (page 145)

 l "Applying a Payment or Credit Note to a job-related  Invoice" (page 168)

 l "Applying a Posted Prepayment or a Credit Note" (page 165)

 l "Applying Prepayments and Credit Notes Using the Payment Entry Screen" (page 164)

 l "Applying a Payment" (page 162)

 l "Displaying an Existing Payment to Apply or Edit" (page 163)

 l "Distributing Miscellaneous Payment Details" (page 179)

 l "Entering a Cash Invoice or Miscellaneous Payment" (page 176)

 l "Entering an Advance Credit for Goods You Return" (page 179)

 l "Entering and Applying a Payment" (page 157)

 l "Partially Paying a job-related  Document" (page 169)

 l "Prepaying a Vendor" (page 173)

 l "Printing a Single Check When You Pay a Vendor" (page 252)

 l "Printing Checks for a Batch of Payments" (page 255)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Payment Entry screen to:

 l Start new payment entries and enter the general information for a check—such as the type of 
payment entry, the vendor number, the name on the check, the check date, and whether you are 
recording information for a check that is already issued or printing it from Accounts Payable.

Note: The fields that appear on the Document tab of the Payment Entry screen depend on the type of 
transaction you are entering.

 l Record payments to vendors who are not defined in your Accounts Payable system, such as 
payments of C.O.D. charges.

 l Apply payments to projects you maintain in Sage 300 Project and Job Costing, and allocate partial 
payments to different contracts and projects listed on the invoice.

 l Enter and optionally print checks for vendors to pay outstanding invoices or cash invoices, or to 
prepay vendors.
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 l Enter and optionally print miscellaneous checks.

 l Apply previously posted prepayments or credit notes to posted invoices and debit notes.

 l Import payment batches from non-Sage 300 programs.

 l Edit system-generated payment batches (generated by the Create Payment Batch screen).

 l Enter adjustments to invoices you are paying in the Payment Entry screen, instead of using the 
Adjustment Entry screen.

 l Print a batch listing report for a selected batch.

Fields and Controls

Buttons

Add

Click this button to add a new payment and its details.

Note: After adding a payment, the button name changes to Save.

Adjust

Click this button to adjust a payment. For more information, see "Writing Off Small Differences During 
Payment Entry" (page 170).

Delete

Click this button to delete the entry that is currently displayed in the Payment Entry screen.

Note: If you delete a payment for which the check has already been printed, Accounts Payable voids 
the check.

History

Click this button to view the history of an invoice, credit note, or debit note while applying a payment or 
credit note. For more information, see "Viewing Document History when Applying a Payment or a Credit 
Note" (page 171).
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Jobs

Click this button to apply payments to job-related  invoices. For more information, see A/P Project and 
Job Costing Apply Details Screen.

Print Check

Click this button to print a check for a payment. For more information, see "Printing a Single Check When 
You Pay a Vendor" (page 252).

Post

Click this button to print checks for the payment batch that is currently displayed, and then post the 
batch.

For information about posting multiple batches, see "Posting a Range of Batches" (page 127).

Save

If you edit a payment you applied previously, click this button to record your changes.

Tax Withheld

Click this button to open the Tax Withheld screen, where you can view the total tax withheld for invoices 
in the entry.

This button appears only if you select Payment or Apply Document in the Transaction Type field.

Void Check

Click this button to void a check. For more information, see "Voiding a Printed Check" (page 173).

Account Set

The vendor's account set appears as the default in this field, but you can change the account set to 
another one that uses the vendor's currency.

Note: You cannot specify an account set for apply transactions, for miscellaneous payments that 
have no vendor number, or for adjustments you make in Payment Entry.
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Advance Credit

This field appears if you selected payment as the transaction type. You use it to record a credit for goods 
that you have returned, for which the vendor has not yet sent you a credit note. For more information, 
see "Entering an Advance Credit for Goods You Return" (page 179).

The invoice to which advance credit is applied will appear as if it is fully paid. However, because the 
advance "credit" is actually a separately numbered debit document, it reflects the true unpaid balance in 
the vendor account, until you record the "real" credit note.

Apply Method

Specify a default method for allocating partial payments to details on job-related  invoices that use 
different contracts, projects, and categories:

 l Top Down. Select this method to apply payments automatically to invoice details, beginning with 
the first detail on an invoice, until the payment is fully applied.         

Note: If you use this method to apply a payment to an invoice that uses a multiple payment 
schedule, you may have to adjust the amounts manually. For invoices that use a multiple payment 
schedule, it is preferable to prorate the payment by amount.

 l Prorate By Amount. Select this method to apply payments proportionately to all invoice details, 
depending on their relative amounts.

Bank

Specify the bank on which you are writing the checks for the batch.

Initially, this field displays the default bank code specified on the Transactions tab of the A/P Options 
screen, but you can change it.

Notes: 
 l You must specify a default bank code on the A/P Options screen before you can enter and 

save information and transactions in payment batches.

 l You define bank codes for your company in Bank Services.

 l If you are starting a multicurrency batch, you also specify the currency for the batch and the 
rate at which to convert amounts in the batch to the functional (home) currency.

 l You can use only one bank and one currency per batch. The bank you select must be set up to 
accept the currency you want to use for the batch.
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Batch Date

This is usually the date on which the batch was created.

The program uses the batch date as the default document date for new documents you add to the 
batch.

Accounts Payable displays the session date as the default batch date when you create a new batch. 
You can type a different date in the field, or select a date using the calendar. (Click the button beside the 
Batch Date field to display the calendar.)

You can change the batch date any time before you post the batch, provided the Ready To Post option 
is not selected for the batch.

Once the batch is posted, the batch date becomes part of your audit trail. You use it to select batches to 
print on the batch listing and batch status reports.

Batch Number

Enter the number of an existing batch, or click the New  button to create a new batch. In the field to 

the right, enter a description for the batch.

Tip: Click the Zoom  button to open the Batch Information screen, which displays additional details 
about the batch. For more information, see A/P Batch Information Screen (Payment Entry).

Check Language

This is the language for printing the amount of the check in words only. All other text on the check or 
advice comes from the check report screen.

Check Number

If you are recording a manual check that you issued earlier, enter the check number in this field.

If you are printing the check from Accounts Payable, you do not enter a number. Bank Services assigns 
the check number when you print the check.

Check numbers must be unique for each bank.

Currency

This field appears only in multicurrency ledgers.
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Enter the currency code to use for the batch or select the code from the Finder. You can pay vendors in 
any currency, but all the transactions you enter in a single payment batch must be in the same currency.

You can change exchange rate details for a batch. For more information, see A/P Batch Information 
Screen (Payment Entry).

Document Number

For payment, miscellaneous payment, and prepayment transactions, Accounts Payable assigns a 
document number to the transaction when you click the Add button.

The assigned number uses the prefix and next sequence number specified on the Numbering tab of the 
A/P Options screen, and you cannot edit the document field.

For Apply Document transactions, you enter the document number of the prepayment or credit note you 
want to apply in this field.

Entered By

This field displays the name of the person who entered the transaction.

Entry Number

To create a new entry, click the New  button beside the Entry Number field.

To work with an existing entry, type its number or select it from the Finder beside the Entry Number field.

The entry number identifies the payment entry on batch listings and posting journals. You can also 
include this number in transactions you send to the general ledger (if you do not consolidate 
transactions).

Entry numbers are assigned sequentially by the program.

Job Related

Select this option if you are adding a prepayment or a miscellaneous payment for a contract you 
administer using Sage 300 Project and Job Costing.

If you are entering a miscellaneous payment, the program replaces the columns in the payment 
application table with job-related  columns that let you identify a specific contract, project, category, and 
resource from Project and Job Costing for which you are making this payment.

If you are entering a prepayment, click the Jobs button to open a separate Project and Job Costing 
Application Details screen that lets you identify the contract, project, category, and resource.
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No. of Entries

This field displays the number of entries in the selected batch.

Optional Fields

The Optional Fields check box indicates whether optional fields are assigned to the currently selected 
payment. If you marked any payment optional fields for automatic insertion, the field is selected when 
you add a new payment entry.

For more information, see "Changing Optional Fields" (page 172).

Payment Amount

Accounts Payable displays the amount of the payment transaction in the bank currency, letting you 
quickly identify payments and check amounts when reviewing or editing entries.

Payment Code

The payment code specified in the vendor record appears as the default in this field. (If none exists in 
the vendor record, Accounts Payable displays the default payment code specified on the A/P Options 
screen.)

You can change the code if you want to use a different method of payment for this entry.

If you select a code that uses a Cash payment type, enter the cash account from which to disburse the 
payment. If you do not enter a cash account, Accounts Payable credits the bank account.

If you select a code that uses a Check payment type, fill in the following fields:

 l Print Check.

 l Check Number (if recording a manually written check; you cannot enter a number if you selected 
Print Check).

 l Check Language (for printing the amount only; edit the check form to change other aspects of the 
check).

Payment Date

Accounts Payable uses this date to:

 l Assign the payment to aging periods on reports.

 l Calculate any payment discount.

 l Report the number of days to pay.
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If you are recording a check that you have already issued, enter the date from the check.

If you are printing a check from Accounts Payable, this is the date that will appear on the check when 
you print it.

If you are entering an Apply Document transaction, the Payment Date field is not available. Accounts 
Payable assigns the date of the document being applied.

This date appears as the Document Date in the Vendor Activity screen and on reports that include 
payments and apply document transactions.

Posting Date

The posting date is used to record the date the document was applied to another transaction and when 
it is actually posted to General Ledger. It does not affect the determination of the discount or the days to 
pay statistics.

The field to the right displays the fiscal year and period to which the transaction will be posted. You 
cannot change this field except by changing the posting date.

Notes: 
 l The default posting date that appears depends on your selection for the Default Posting Date 

option on the A/P Options screen.

 l If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Print Check

Select this option if you want to print the check using the Accounts Payable program.

If you are recording a manual check you have already issued, do not select this option. You must enter 
the number of the manual check in the Check Number field. (If Accounts Payable prints the check, it 
assigns the check number when you print the check.)

Accounts Payable treats a check with a number as printed once you save it. This means that you cannot 
edit the check later unless you zero the Check Number field and select the Print Check option.

Reference

Enter additional information to include with a transaction (for example, an EFT transaction number).

Note: This field appears for payments, prepayments, miscellaneous payments, and apply document 
transactions.
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Remit-To

This is the person or company name that will appear on the check.

You can enter another name or select a remit-to location (if the vendor has alternative payment 
addresses).

Press the F9 key (Zoom) to view or change the remit-to information. You can choose remit-to locations 
from the Finder in the Remit-To Information screen.

Select Mode

This field lets you identify how to select invoices to which to apply this payment.

Select this option if you want to list vendor documents for selection in the application table at the bottom 
of the screen—in the order you want. Select mode provides more information about the vendor's 
documents, adding information from any unposted payments that you have already applied.

Clear this option if you know the number of document to which you are applying the invoice, or if you 
have a lot of vendor documents. This method is faster than Select mode because it is faster to look up 
documents in the Finder than to scroll through all the items in the document list.

Total Amount

This field displays the total for the batch.

Transaction Type

You can enter the following types of transactions:

 l Payment. Select this type to record a check to pay outstanding transactions. You can print the 
check from Payment Entry or enter the number of a previously written check.

 l Prepayment. Select this type to record a check written as a prepayment. You can print the check 
from Payment Entry or enter the number of a previously written check.                              

Prepayments pay for a purchase before you are invoiced for it. When you enter and post the invoice, 
Accounts Payable automatically applies the prepayment.

 l Apply Document. Select this type to apply a posted prepayment or credit note against an invoice, 
debit note, or interest charge.

 l Miscellaneous Payment. Select this type to issue a check to a person or company for which you 
have not set up a vendor record. You enter the distribution details of the purchase in the same 
way as you enter them for an invoice.
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Vendor Amount

The field shows the amount you have applied using the table on the Payment Entry screen, unless you 
are entering a prepayment.

In multicurrency ledgers, the payment amount is converted from the vendor currency to the bank 
currency using the exchange rate information on the Rate Override screen. To change the exchange 
information for a selected payment, open the Rate Override screen by clicking the Rates button at the 
bottom of the Payment Entry screen.

If you are entering a prepayment, you use this field to type the amount you are prepaying. If you have a 
multicurrency ledger, enter the amount in the vendor currency—not in the bank currency. The amount is 
converted to the bank currency for the check amount, using the rates shown on the Rate Override 
screen.

Vendor Number

Identifies the account to which to post the payment. You can type the vendor number or select it from 
the Finder.

Detail Table

Activation Date

Enter the date on which you want the payment activated. This is the date from which they are included 
when calculating amounts due for payment.

Prepayments are not used to calculate account balances or amounts due to vendors (when you use the 
Create Payment Batch screen) until they reach their Activation dates.

Adjustment Amount

This column displays the amount of an adjustment you entered to the document in this payment batch. 
You cannot change the amount in this column.

You can enter adjustments in payment batches if the option to allow adjustments in payment batches is 
selected on the A/P Options screen.

After saving the transaction, you adjust the document by highlighting the line to which you are applying 
the payment, and then clicking the Adjust button 
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Amount

Enter the amount of the distribution.

Applied Amount

Type the amount you want to apply to the selected document.

Accounts Payable automatically applies the full outstanding amount when you select the document, but 
you can change the amount.

You cannot enter an amount that is greater than a document's outstanding or pending balance.

If you are applying a prepayment or credit note, you cannot apply an amount that is greater than the 
total for the document you are applying.

Apply

Use the Apply column to select documents to which to apply the payment, prepayment, or credit note.

Select Yes for each document you want to pay by double-clicking the Apply field or by typing any 
character in the column.

If another transaction has been applied to the document in another unposted batch or entry, you see 
"Pend" in the Apply column.

You can adjust a document if the option to allow adjustments in payment batches is selected on the 
A/P Options screen. To adjust a document, you must select Yes in the Apply column, highlight the line, 
and then click the Adjust button. 

You can click the History button to view the payment history for the highlighted line.

Apply By

Select how you want to identify the document for which you are entering the prepayment.

You can identify it by its document (invoice) number, by the sales order number, or by the purchase 
order number. An additional field appears if you choose to apply by purchase order, listing all the 
existing POs posted for the vendor.

Apply To

Enter the invoice number, PO number, or sales order number for the invoice you are prepaying 
(depending on your choice for Document Type). Accounts Payable uses this number to identify the 
invoice to which you are applying this prepayment.
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Check Amount (display only)

This field shows the amount of the payment—computed from a running tally of the distribution amounts.

Current Balance

This column displays the current balance in the document in the vendor's account. The amount is 
calculated from the transactions that have been posted to the account, and does not include pending 
(unposted) transactions.

Description (of distribution)

Enter an optional description for the distribution. 

This description appears with the distribution in the General Ledger batch, if the Posting Seq.-Batch for 
the G/L Description Field option is selected on the G/L Integration screen and you do not consolidate 
general ledger transactions during posting.

Discount Available

This column shows the amount of the discount that is available for the document, if any. You cannot 
change this amount and you cannot enter a larger discount amount in the Discount Taken field.

You can change discount amounts using the Control Payments screen.

Discount Date

This column lists the discount dates that were assigned to the documents when they were posted to 
Accounts Payable. If no discount applied to the document, the discount date is the same as the 
document date.

When you choose to list documents by their discount dates, the list begins with the document with the 
earliest (oldest) discount date. If you enter a starting discount date in the Starting field, the list omits any 
documents with earlier discount dates.

Discount Taken

Use this column to enter the amount of any discount that applies to the document.

You can take a discount on a document, even if the applied amount is zero.

If the discount period has expired, this field will show zeros.

You can change discount amounts using the Control Payments screen.
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Dist. (Distribution) Code

If the vendor record is set up to create document details by distribution code, the distribution code from 
the vendor record appears as the default in this field.

You can change the distribution code that appears. To change the distribution code, double-click the 
Dist. Code field for the detail you are adding, then type the new distribution code or use the Finder to 
select it.

If no distribution code appears, you can skip the Dist. Code field, and enter a general ledger account 
number instead.

Document Date

The Document Date column lists the dates that were entered with the documents.

When you choose to list documents by their document dates, the list begins with the document with the 
earliest (oldest) date. If you enter a starting document date in the Starting field, the list omits any 
documents with earlier dates.

Document Number (payment application)

The Document Number column in the payment application table shows the numbers of outstanding 
documents that you can pay at this time, or to which you can apply a prepayment or a credit note.

Doc. (Document) Type

Specify the type of documents you want to choose from when applying payments in Select mode. You 
can choose All, Invoice (includes interest invoices), Debit Note, or Credit Note.

Click the the Go  button once you have specified the order, document type, and starting number.

Due Date

The Due Date column lists the due dates that were assigned to the documents when they were entered 
into Accounts Payable.

When you list documents by their due dates, the list begins with the document with the earliest (oldest) 
due date. If you enter a starting due date in the Starting field, the list omits any documents with earlier 
due dates.

448Sage 300 2023 Accounts Payable User's Guide



G/L Account

If the vendor record is set up to create document details by general ledger account, the account number 
from the vendor record appears as the default in this field.

If the vendor record specifies a distribution code, the general ledger account for the specified 
distribution code appears as the default.

You can change the general ledger account.

Invoice Number

Use this field to enter the vendor's invoice number.

Job Related (display only)

This display-only field appears in the application details table of the Payment Entry screen if you use 
Sage 300 Project and Job Costing.

The field indicates whether a document is job-related  or not. (The program sets the entry in this field; 
you cannot change it.)

When you apply a payment to a job-related  document, the Jobs button becomes available, letting you 
open the Project and Job Costing Apply Details screen where you can change the apply method or the 
allocations for particular document details.

Net Balance

This column displays the document balance net of the current unposted applied amount, adjustment, 
and/or discount.

Order By

Use the Order By field when applying payments in Select mode to specify the order by which to list the 
vendor's documents. You can choose Document (number), Purchase Order Number, Due Date, Order 
Number, Document Date, or Current Balance.

You set the default order for this field by your choice for the Default Order Of Open Documents option 
on the A/P Options screen.

Click the Go  button once you have specified the order, document type, and starting number.
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Order Number

This column displays the sales order number, if any, that was entered with the document.

When you choose to list documents by their sales order numbers, all the documents issued with a 
particular sales order number are displayed together, beginning with the lowest sales order number or 
the sales order number you specify in the Starting field.

Original Amount

This column displays the original document total.

Payment Number

This column displays the payment number for the corresponding document. This payment number is 1 
unless the document contains a multiple payment schedule, then it is the number for the particular 
payment.

Pending Adjustment

This column displays the total amount of unposted adjustments that have been entered for the 
document in any other unposted entries or payment batches.

Pending Discounts

This column displays the total amount of discounts taken for the document in other unposted entries in 
payment batches.

Pending Payments

This column displays the total of any payments that have been applied to the document in other 
unposted batches or entries.

Pending Balance

The pending balance shown for a document is the amount that the document balance would be if all 
pending transactions were posted to it. You cannot type in this field. You can change the pending 
balance only by changing the pending amounts that have been applied to the document.

You cannot apply an amount to a document that is greater than its pending balance.
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Vendor PO Number

This column displays the purchase order number, if any, that was entered with the document.

When you list documents by their purchase order numbers, all the documents issued with a particular 
purchase order number are displayed together, beginning with the lowest purchase order number or the 
purchase order number you specify in the Starting field.

Ref. (Reference)

Enter an optional reference for the distribution. 

This reference appears with the distribution in the General Ledger batch, if the Posting Sequence-Batch 
option is selected for the G/L Detail Reference field on the G/L Integration screen, and you do not 
consolidate general ledger transactions during posting.

Select Mode

You select this option depending on how you prefer to select the invoices, prepayments, and credit 
notes to which to apply this document.

If you want to select vendor documents from a list on the screen, choose Select Mode, then use the 
Order By field to specify the order you want to list the documents.

Select Mode provides more information about the vendor's documents, including information from any 
unposted payments that you have already applied, than you see if you enter document numbers 
yourself.

However, if you know the number of the document to which you are applying the payment, prepayment, 
or credit note or if you have a lot of vendor documents, it is faster to type the document numbers—or to 
look them up in the Finder—than to scroll through the items in the document list.

Starting Doc. No.

The name of this field varies according to your selection in the Order By field.

Use the field to type the number, amount, or date of the first record you want to see in the list of the 
vendor's open documents. Leave the field blank to start with the first outstanding document.

Click the Go  button once you have specified the order, document type, and starting number.
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Tax Group

Tax groups specify the authorities that tax the vendor and assign the vendor's tax classes in each 
authority. (Tax classes determine the specific classification for a tax, such as which rate is applied or 
whether the vendor is exempt.)

The vendor's tax group appears in the field when you enter the vendor number. You can assign a 
different tax group, or you can change the tax information for the document on the Document Totals 
screen. You can also change the detail tax class or tax included status for any of the detail lines you 
enter with the document.

To change the tax rates for a tax authority, however, you must use the Tax Services screens in 
Common Services.

In multicurrency ledgers, if you change the tax group to one that uses a different currency than the 
vendor, you can choose whether to let the program calculate the tax reporting amount, and you can 
change the tax type, rate date, and exchange rate for the tax reporting currency.

Tax Withheld

The amount that you have withheld for an invoice to be remitted to tax authorities on behalf of the 
vendor.

Double-click this field to open the Detail Tax Withheld screen, where you can view the tax withheld for 
each tax authority for the invoice.

This field shows a value for an invoice only if the Apply field is set to Yes for the invoice.

Total Tax (display only)

The program displays the total tax calculated or entered for all the details and tax authorities used on 
the document.

Unapplied Amount

This field shows how much of the selected prepayment or credit note has not yet been applied to the 
vendor's account in the detail entry table. Use it to check that you have applied as much of the 
prepayment or credit note as you intended.

Note: If you have a multicurrency ledger, the unapplied amount is in the vendor's currency—as are the 
invoices to which you are applying the prepayment or credit note. The exchange rate in effect is the 
rate that you entered with the prepayment or credit note. You cannot change it at this time.
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A/P Payment Inquiry Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Payment Inquiry.

Secondary Screens

A/P Payment Information Screen

Related Tasks

"Looking Up Vendor Payment Information" (page 72)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Payment Inquiry screen to:

 l Look up payments by bank range, vendor range, check status, transaction type, date range, year 
and period range, and check number range.

For example, you can look up all the payments from a selected bank, or you can display information for 
a payment for which you have only the payment number. 

You are not limited to viewing payments for one vendor at a time, as when using the Vendor Activity 
screen.

 l Open a separate Payment Information screen that displays detailed information for a selected 
payment. (Select the payment on the table, and then click Open.)

 l Drill down from a selected line on the list to view the original payment in the Payment Entry screen. 
(Select the payment on the table, and then click Document.)

Fields and Controls

Buttons

Document

453Sage 300 2023 Accounts Payable User's Guide

../../../../../../Content/Transactions/POPUPS/PaymentInquiry/PaymentInformation.htm


Click this button to display a selected document in the Payment Entry screen. 

Open

Click this button to display detailed payment information for a selected transaction in a separate 
Payment Information screen. 

The information includes (but is not limited to) the vendor number, payment document number, and the 
documents to which the payment was applied.

Print

Click this button to print a report of posted payments.

From Bank / To Bank

Use these fields to specify a range of banks for which to select payments for display on the Payment 
Inquiry screen.

From Check Number / To Check Number 

Use these fields to specify a range of checks from which to select payments to display on the Payment 
Inquiry screen.

From Payment Date / To Payment Date 

Use these fields to specify the range of dates that the payments you want to display were issued.

From Vendor Number / To Vendor Number

Use these fields to specify a range of vendors for which to display payments on the Payment Inquiry 
screen.

From Year/Period / To Year/Period 

Use these fields to specify the range of year/periods to which the payments you want to display were 
posted.

Payment Type

Use this field to limit the display to one type of payment (Cash, Check, Credit Card, or Other), or select 
All to display all payments that meet your other criteria.
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Status

Specify a reconciliation status (Outstanding, Cleared, or Reversed) for the payments you want to 
display, or select All to display all payments that meet your other criteria.

Transaction Type

Select Payment or Prepayment to restrict the display to one type of payment, or select All to display all 
payments that meet your other criteria..

Post Batches Screen

To Open this Screen

Open Accounts Payable > A/P Transactions > Post Batches.

Related Tasks

"Posting a Range of Batches" (page 127)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Post Batches screen to post batches of payments, invoices, or adjustments to vendor 
accounts. 

Note: 
 l You can post only one type of batch at a time. However, you can post a single batch, a range of 

batches, or all unposted batches of the chosen type.

Important! Batches are posted only if they are marked Ready To Post on the respective Batch List 
screen. 

 l You do not specify a batch type for an ICT company because you can post only invoice batches in 
Intercompany Transactions.

 l You can post all batches that are marked Ready To Post, or a range of batches that you specify.
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Fields and Controls

Batch Type

Specify the type of batch to post.

You can post only one type of batch at a time.

Note: You do not specify a batch type for an ICT company because you can post only invoice batches 
in Intercompany Transactions.

Post the Following Batches

Specify batches to post:

 l All Batches. Post all open invoice batches.

 l Range. Post a range of batches. If you select this option, you must also specify the starting and 
ending batch numbers in the range.

Notes: 
 l If the Force Listing Of Batches option is selected on the A/P Options screen, you must print 

listings of the batches you post.

 l Only batches that are set Ready To Post can be posted. 

For more information, see "A/P Invoice Batch List Screen" (page 398).

Transactions Reports Screens
Use the screens in the A/P Transaction Reports folder to print a variety of transaction reports to maintain 
your audit trail and to analyze Accounts Payable data.

A/P Aged Cash Requirements Report Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Aged Cash Requirements.
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Related Tasks

 l "Printing the Aged Cash Requirements Report" (page 235)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Aged Cash Requirements report highlights the cash amounts required to meet obligations as they 
become due, including the amount needed to pay invoices that are overdue, current, and due in each of 
four future periods you define.

Use the report for cash flow analysis and projections.

You can print a detailed report or a summary report:

 l The detailed report lists all outstanding documents for each vendor.

 l The summary report prints one line for each vendor number, including the overdue and current 
balance in the vendor's account, and the balance that will come due in each of four periods.

When to Print

Print the Aged Cash Requirements report when you need to see the amounts owed and when they are 
due to help you with cash‐flow management, short‐term planning, and budgeting.

Information Printed on This Report

 l The Due Date/Applied Number/Applied Type column lists the due date for documents at the left, 
and the document number and type of applied details at the right.

 l The Current column contains documents that are not yet due. 

Credit notes, debit notes, and prepayments appear in this column if you select As Current for the Age 
Credit Notes And Debit Notes and Age Prepayments options on the A/P Options screen.

 l The vendor contact and phone number, and your company's credit limit with the vendor are listed if 
you select the Contact/ Phone/Credit option.

 l Subtotals (for a single currency company) or subtotals by currency (for a multicurrency company), if you 
select Vendor Group or Account Set as the primary sort order. 
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Subtotals appear on both the summary and the detail report.

 l Extra space appears between each vendor record if you select the Space For Comments option.

 l Miscellaneous payments appear as "MC" in the Document Type or Applied Type fields.

 l Reports aged by due date have an option to display aged retainage for each vendor. (This option is not 
available for reports aged by document date.)

A/P Aged Payables Report Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Aged Payables.

Related Tasks

 l "Printing the Aged Payables Report" (page 238)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Aged Payables report groups outstanding transactions into a current period and four aging periods 
by document date or due date. 

Use the report to analyze your payables.

You can print detailed or summary reports;

 l The detailed report lists all outstanding documents for each vendor.

 l The summary report prints one line for each vendor number, including the current balance and the 
balance in each aging period.

Note: You also print the Overdue Payables By Due Date and the Overdue Payables By Document 
Date reports using the Aged Payables Report screen.
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When to Print

Print the Aged Payables report when you need a listing of the status of your payables on a given date, 
such as at the end of a fiscal year or period, or when you want to identify documents or balances you may 
need to write off.

Information Printed on This Report

 l The Due Date/Applied Number/Applied Type column lists the due date for documents at the left, 
and the document number and type of applied details at the right.

 l The Current column contains documents that are not yet due. Credit notes, debit notes, and 
prepayments appear in this column if you select As Current for the Age Credit Notes And Debit 
Notes and Age Prepayments options in the A/P Options screen. (You can choose whether to 
include prepayments when printing the report.)

 l The vendor contact and phone number, and your company's credit limit with the vendor are listed if 
you select the Contact/ Phone/Credit option.

 l Subtotals (for a single currency company), or subtotals by currency (for a multicurrency company), 
if you select Vendor Group or Account Set as the primary sort order. Subtotals appear on both the 
summary and the detail report.

 l Extra space appears between each vendor record if you select the Space For Comments option.

 l Miscellaneous payments appear as "MC" in the Document Type or Applied Type column.

 l Reports aged by due date can display aged retainage for each vendor. (This option is not available 
if the report is aged by document date.)

 l The summary version of the report includes one line for each vendor number, listing the current balance 
in the vendor's account and the balance in each of four periods.

A/P Aged Retainage Report Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Aged Retainage.

Related Tasks

 l "Printing the Aged Retainage Report" (page 242)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Aged Retainage report lets you print reports of outstanding retainage amounts owed to vendors.

You can print detailed or summary reports:

 l The detailed report lists all outstanding retainage amounts for each vendor.

 l The summary report prints one line for each vendor number, including the outstanding retainage 
amounts in each aging period.

When to Print

Print the report whenever you need a list of retainage amounts that are overdue or outstanding.

Information Printed on This Report

 l The Aged Retainage By Due Date report includes six aging periods: the five aging periods you 
specify for the report, including the current period, plus a Future period.

 l For job-related  documents, each detail has its own outstanding retainage amount and its own 
retainage due date. Therefore, the retainage amount printed on the report for a job‐related 
document may be broken out across several aging periods, depending on the retainage due dates 
of the document details.

 l The Overdue Retainage By Due Date report may also include an amount in the Future aging 
period, if a job-related  retainage amount for a document detail is due in a future period.

 l If you select Vendor Group or Account Set as the primary sort order, subtotals (for a single currency 
company), or subtotals by currency (for a multicurrency company) appear on both the summary and the 
detail report.

A/P Batch Listing Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Batch Listing.
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Related Tasks

 l "Printing Batch Listings" (page 245)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

A batch listing is the printed record of the transactions in a batch.

You can print batch listings for invoice, payment, and adjustment batches that have been entered, 
imported, generated, or posted. The invoice batch listing includes debit notes and credit notes, as well as 
interest invoices.

Tip: To enforce a strict audit trail, turn on the Force Listing Of All Batches option on the A/P Options 
screen. This option prevents you from posting batches that are unlisted.

When to Print

You should print batch listings after entering, importing, generating, or editing batches—at any time before 
the batches are posted—and then file them with your other audit trail records.

If you use the Force Listing Of Batches option, you must print all batch listings before you can post the 
batches.

Information Printed on This Report

The following information is printed on the report:

 l The batch entry number assigned to each transaction in the Invoice Entry, Payment Entry, or 
Adjustment Entry screen. This number is a permanent part of the information stored for an entry, 
and appears on the posting journals and on the unconsolidated G/L Transactions report. Use this 
number to select an unposted transaction for editing, and to trace the history of posted 
transactions.

 l The Type (Ty.) column lists the transaction type for the entry. More...

The invoice batch listing may contain the following transaction types:
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 l CR Credit Note

 l DB Debit Note

 l IN Invoice

 l IT Interest Charge

The payment batch listing may contain the following transaction types:

 l AD Adjustment

 l CF Applied Credit (from)

 l CT Applied Credit (to)

 l DF Applied Debit (from)

 l DT Applied Debit (to)

 l ED Earned Discount Taken

 l GL Gain or Loss (multicurrency ledgers)

 l PI Prepayment

 l PY Payment

The adjustment batch listing contains adjustment transactions only.

 l Payment terms and due date for invoices. 

Note: This information appears only on invoice batch listings.

 l The following codes may appear:

 l A "T", indicating that the payment terms have been edited, as noted on the final tab of the 
report.

 l For multicurrency ledgers, an "R" appears if the exchange rate has been edited. 

 l An "E" appears on payment batch listings if an entry has been edited.

Note: The "R" and "T" codes appear only on invoice batch listings.

 l Optional field information.

 l Payment schedules are printed on invoice batch listings if you select the Show Schedules option.

 l Summary pages include information, as follows:

 l The invoice batch listing includes a summary page that lists batch totals for the invoices, 
credit notes, debit notes, and interest charges entered, and a total for the batch.
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 l The payment batch listing summary page lists totals for adjustments entered in the batch, 
discounts taken, and payments (amounts), and a total for the batch.

 l The adjustment batch listing summary page lists the total debits and credits for the batch.

 l The final page lists the descriptions of symbols that appear on the report (for invoice and payment batch 
listings only), and the number of entries and batches printed.

The payment batch listing final page also lists the general ledger account debits and credits for 
adjustments entered in the batch.

A/P Batch Status Report Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Batch Status.

Related Tasks

 l "Printing the Batch Status Report" (page 248)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Batch Status report describes all unposted invoice, payment, or adjustment batches, and posted or 
deleted batches for which the information has not yet been cleared from Accounts Payable. The report is 
a valuable management tool for tracking batches, particularly when several operators are entering 
batches on a multi-user system.

When to Print

Print the report as part of the transaction-entry cycle, to discover batches for which you need to print or 
reprint listings before posting, and batches that contain errors.

Information Printed on This Report

The report includes a summary that lists the number of entries, number of batches, and total amount for 
each type of batch and each batch status.
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A/P Check Register Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Check Register.

Related Tasks

 l "Printing a Check Register" (page 250)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Check Register report lists details of checks that are produced and posted to vendor accounts during 
a check run. It can also list the general ledger distributions that result. 

Note: Checks that are used for alignment or leading, as well as checks that are voided before posting, 
are not included on this report because they do not result in the creation of general ledger distributions 
or changes to vendor account balances. These checks are listed on the Check Status report in Bank 
Services.

When to Print

Print the report after posting a check run, as part of your audit trail of payments made during the check 
run.

Information Printed on This Report

The report lists the checks issued to vendors, in vendor number order. Miscellaneous payments are listed 
first. Information includes:

 l Sequence numbers that count the number of checks that will be printed for the batch. (These 
numbers are not posting sequence numbers or check numbers.)

 l The type of payment (PI for prepayments; PY for payments).
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 l The number of the document paid by the check, followed by the payment schedule number. The 
payment schedule number is always 1 unless the document has a multiple payment schedule.

 l Discounts taken or adjustments made at the time the payment was entered. You can make 
adjustments during payment entry only if you select the Allow Adjustments In Payment Batch 
option on the A/P Options screen.

 l Any miscellaneous payments. Miscellaneous payments, which are not assigned to vendor 
records, are listed under "MISC," with the name (or other information) you entered in the Remit-To 
field on the A/P Payment Entry screen.

 l Entries that were edited after they were added are marked with an asterisk.

A/P G/L Transactions Report Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        G/L Transactions.

Related Tasks

 l "Printing the G/L Transactions Report" (page 259)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The G/L Transactions report is a list of the general ledger transactions created from all posted Accounts 
Payable batches, and from posted revaluations (in multicurrency ledgers). You can print detailed or 
summary versions of the report.

Sage 300 creates the general ledger batch in a CSV (Comma Separated Values) file, tailored to the Sage 
300 General Ledger format. You can send the file to a remote location that uses Sage 300 General 
Ledger, or modify the information in the file to suit another general ledger program.

When to Print

Print the report when you add, change, or delete distribution sets.
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Information Printed on This Report

The summary report lists one total for each account number.

The level of detail for transactions on the detailed report depends on your choices on the Integration tab 
of the G/L Integration screen. For example, if the Consolidate By Account And Fiscal Period option is 
selected, the report shows a total for each general ledger account and fiscal period. If the Do Not 
Consolidate option  selected, the report shows full details for each transaction.

The detailed report includes:

 l The batch and entry number. The entry number is assigned when the transaction is added to a batch, and is a 
permanent part of the record of the transaction.

The source code assigned during posting to identify the transaction type.More...

Accounts Payable source codes are:

 l AP-AD Adjustment

 l AP-CF Applied Credit (from)

 l AP-CR Credit Note

 l AP-CT Applied Credit (to)

 l AP-DB Debit Note

 l AP-DF Applied Debit (from)

 l AP-DT Applied Debit (to)

 l AP-ED Earned Discount Taken

 l AP-GL Gain or Loss (multicurrency ledgers)

 l AP-IN Invoice

 l AP-IT Interest Charge

 l AP-PI Prepayment

 l AP-PY Payment

 l The reference and description information selected on the GL Integration screen.

 l Total by sorting option.

 l The summary version of the report includes a single line for each account number, with the total debits 
and credits posted to the account.

 l Total debits and credits for the report.
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A/P Overdue Payables Report Screen

To Open this Screen

 1. Open Accounts Payable > A/P Transaction Reports >        Aged Payables.

 2. Select Overdue Payables By Due Date or Overdue Payables By Document Date as the report 
format.

Related Tasks

 l "Printing the Overdue Payables Report" (page 261)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Overdue Payables report groups outstanding transactions or balances into a current period and four 
aging periods by document date or due date. Use the report to analyze your overdue payables.

You can print the report with transactions listed by due date or by document date, in detail or summary 
form.

Note: You can also print the Aged Payables By Due Date and the Aged Payables By Document Date 
reports using the Aged Payables Report screen.

When to Print

Print the Overdue Payables report when you need a listing of overdue payables on a given date, such as 
at the end of a fiscal year or period, or when you want to identify documents that must be paid 
immediately.

Information Printed on This Report

Depending on the options you select for the Overdue Payables report, the report can include:

 l The telephone number and contact at the vendor's location, and the credit limit allowed by the 
vendor (if you select the Contact/ Phone/Credit option for the report).

 l Detailed information about individual transactions, included to give you a complete picture of your 
overdue payables.

 l Space between each vendor record (if you select the Space For Comments option).
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 l Applied details (if you select the Include Applied Details option). 

If you do not select this option, the report lists the net amounts owing on invoices.

A/P Posting Errors Report Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Posting Errors.

Related Tasks

 l "Printing the Posting Errors Report" (page 265)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Accounts Payable creates  the Posting Errors report when you post batches that contain errors. The 
report lists the incorrect entries and explains why they could not be posted. You can print the report for 
invoice, payment, and adjustment batch posting errors.

Note: The Payment and Adjustment Error reports are not available for an Intercompany Transactions 
company.

When to Print

Print the report after posting a batch, if the program warns you that an error batch has been created.

Information Printed on This Report

The report includes the following information:

 l The incorrect entries, listed in order by the posting sequence numbers assigned to their original 
batches, then by their original batch and entry numbers.

 l An explanation of the error in each entry.
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A/P Posting Journals Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Posting Journals.

Related Tasks

 l "Printing Posting Journals" (page 266)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

A posting journal is the printed record of the transactions in a group of batches that were posted together. 
It provides an audit trail of all uncleared details that have been posted. 

You can print posting journals for invoice, payment, and adjustment batches. In multicurrency ledgers, 
you can also print posting journals of the transactions that are created when you revalue documents at 
new exchange rates.

You use the A/P Clear History screen to clear the data for the journals after printing.

When to Print

You should print posting journals after each posting run, then file them with your other audit trail records. 

Note: You must print all outstanding posting journals before you can use the A/P Clear History screen 
to clear them or use the Year End screen to do year-end processing.

Information Printed on This Report

The report can include the following information:

 l The original batch and entry number for each transaction. Use these numbers to trace transactions 
back to their batch listings. 

If you do not consolidate general ledger transactions (using the Consolidate G/L Batch option on the 
A/P Options screen), you can use these numbers to identify the transactions on the G/L Transactions 
report.
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 l Tax information appears only on the Invoice Posting Journal, showing the total tax for each tax 
authority on each invoice, credit note, or debit note.

 l Optional information that you can choose to include on the report (such as optional fields, if you 
use them), job-related  information (if you use Project and Job Costing), or the General Ledger 
detail reference and description used with transactions.

 l The Payment Posting Journal includes an Adjustment and a Discount column, listing any adjustments 
made to documents in the Payment Entry screens and discounts taken when payments were applied to 
documents. 

You can make adjustments during payment entry if the Allow Adjustments In Payment Batch option is 
selected on the A/P Options screen.

 l The Adjustment Posting Journal includes a Debit and a Credit column, listing the general ledger 
account number or distribution code to which each debit or credit was posted.

 l A summary page.

The Invoice Posting Journal includes a summary tab that lists separate totals for invoices, debit notes, 
credit notes, and interest invoices.

The Payment Posting Journal summary tab lists totals for adjustments, discounts taken, and payments.

The Adjustment Posting Journal summary tab lists the totals of debits and credits.

 l A General Ledger Summary lists the total amounts of the transactions that were created for each 
general ledger account used in the posted batches. These transactions are placed in the general 
ledger batches Accounts Payable creates in Sage 300 General Ledger, if you use it, or in the 
batches that are produced for you to transfer to another general ledger system.

If you use multicurrency accounting, the posting journals also include the following additional information:

 l The currency, exchange rate, and rate date for each transaction.

The Payment Posting Journal shows exchange rates for vendors and banks that do not use the 
functional currency.

 l The total for the transaction (and the total tax, for invoice posting journals) in the functional 
currency as well as the source currency.

 l A Summary tab which lists totals for each source currency used in the report, as well as the 
equivalent totals in the functional currency.

 l The amounts on the General Ledger Summary tab are shown in their source currencies, with the 
corresponding equivalent amounts in the functional currency.

 l A Revaluation Posting Journal includes the transactions that are created for the general ledger 
exchange gain and loss accounts when you revalue multicurrency documents at new exchange rates. 
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This report groups transactions by posting sequence, and for each posting sequence they are grouped 
and totaled by account set.

Note: If you do a provisional revaluation, you can also print the Provisional Revaluation Listing, to 
check the transactions that will be created when you post the revaluation. (Posting sequence 
numbers do not appear on the Provisional Revaluation Listing because no transactions are posted 
when you revalue provisionally.)

A/P Print Checks Screen

To Open this Screen

 1. Open Accounts Payable > A/P Transactions >        Payment Batch List.

 2. Select the batch for which you want to print checks.

 3. Click Print/Post.

 4. If you are posting the payments, click Yes.

Related Tasks

 l "Printing a Single Check When You Pay a Vendor" (page 252)

 l "Printing Checks for a Batch of Payments" (page 255)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You can print checks for the payments you enter in Accounts Payable on check forms that include an 
advice slip listing the details of the payment, or you can print the checks and advices separately on 
different forms, or you can print checks or advices only.

Sage 300 Accounts Payable comes with four sample formats for checks, with attached advice slips. You 
can use the sample formats or change them to suit your company's requirements (for example, to adapt 
the formats if you use separate pre-printed check and advice forms).
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Printing Checks

You can print checks in one of three ways from the Accounts Payable program:

 l Open the Payment Entry screen, add a payment or open an existing one, and then click the Print 
Check button to print the check for the payment.

 l Open the Invoice Entry screen, add a prepayment with an invoice, select the Print Check option 
on the Invoice Entry Prepayment screen, and then click the Print Check button to print the check 
for the prepayment.

 l Open the Payment Batch List screen, select a payment batch, and then click the Print/Post button to 
print checks for all the payments in a batch.

The Print/Post button also posts the payment batch to vendor accounts after printing the checks.

Note: You can print checks while other users are printing checks, as long as the check runs are all for 
different payment batches.

When to Print

Print a check when you finish entering it, or print all the checks in a batch.

Information Printed on This Report

The sample combined check and advice slip that comes with Accounts Payable contains the following:

 l Information about the transaction(s) being paid by the check.

 l The check number on the preprinted form. You specify the first check number to use when you 
print the check, so that Accounts Payable assigns check numbers to the payments that match the 
check numbers on your forms.

 l The numeric check amount. It is preceded by asterisks (and the textual check amount is followed 
by asterisks) to prevent alteration.

 l The name of the payee. It is positioned on the sample check to be visible in form envelopes. You 
can change the position of this and any other information printed on the check forms.

A/P Vendor Transactions Report Screen

To Open this Screen

Open Accounts Payable > A/P Transaction Reports >        Vendor Transactions.
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Related Tasks

 l "Printing the Vendor Transactions Report" (page 271)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Vendor Transactions report lists transactions that were posted to vendor accounts during the period 
you specify when you print the report. 

You can sort the transactions by document date, by document number, or by fiscal year and period.

When to Print

Print the report when you want to see the current status of your vendor accounts.

Information Printed on This Report

 l The transaction type. More...

The possible transaction types are:

 l IN Invoice

 l CR Credit Note

 l DB Debit Note

 l IT Interest Charge

 l PI Prepayment

 l PY Payment

 l Order number and 1099/CPRS information. If you do not enter a 1099/CPRS tax number in the 
record for a vendor who is subject to 1099/CPRS reporting, the total for the vendor is marked with 
an asterisk to indicate that the tax identification number is missing.

 l The applied type. More...

The possible applied types are:
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 l AD Adjustment

 l CF Applied Credit (from)

 l CT Applied Credit (to)

 l DF Applied Debit (from)

 l DT Applied Debit (to)

 l ED Earned Discount Taken

 l GL Gain or Loss (multicurrency ledgers)

 l PY Payment

 l The number of days that the transaction is overdue on the date you print the report. This 
information shows your payment habits with each vendor and highlights seriously overdue 
transactions that may require immediate payment.

 l Vendor contact, phone, and credit limit (if you select the Contact/Phone/Credit option for the 
report).

 l Totals by vendor of outstanding invoices, credit notes, debit notes, interest charges, and 
prepayments (if you select the Include Applied Details option).

 l Miscellaneous payments appear as "MC" in the Document Type or Applied Type column.

 l Space between each vendor record (if you select the Space For Comments option).

Vendor Screens
Use the screens in the A/P Vendors folder to add the following types of records for vendors:

 l Vendor groups

 l Vendors

 l Remit-to locations

 l Recurring payables

A/P 1099/CPRS Inquiry Screen

To Open this Screen

Open Accounts Payable > A/P Vendors > 1099/CPRS Inquiry.
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Related Tasks

 l "Looking Up 1099 or CPRS Vendor Amounts" (page 73)

 l "Adding, Modifying, or Deleting a 1099 or CPRS Vendor Amount" (page 73)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P 1099/CPRS Inquiry screen to:

 l Look up the history of 1099/CPRS payments made to vendors that are subject to 1099/CPRS 
reporting.

 l Add, modify, or delete 1099 or CPRS amounts, if your Accounts Payable system allows you to edit 
these amounts.

Note: Before you can add, modify, or delete a 1099 or CPRS amount, the Allow Edit of 1099/CPRS 
Amounts option must be selected on the Transactions tab of the A/P Options screen.

Fields and Controls

Buttons

Print

Click this button to print 1099 or CPRS amounts for the specified months, year, and vendors.

From Code/To

Specify the range of codes for the amounts you want to view, or accept the blank entry in the From Code 
field and the ZZZs in the To field to display amounts for all 1099/CPRS codes..

From Vendor/To

Specify a range of vendor numbers. 

You can also accept the blank entry in the From Vendor field and the ZZZs in the To field to include 
amounts for all vendors.
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Year

Type the year in which you paid the amounts you want to view.

A/P Recurring Payables Screen

To Open this Screen

Open Accounts Payable > A/P Vendors >        Recurring Payables.

Secondary Screens

 l Recurring Payables Detail Accounts/Taxes Screen

 l Remit-To Location Information Screen

 l Vendor Information Screen

Related Tasks

 l "Setting Up a Recurring Payable for a Vendor" (page 66)

 l "Invoicing a Recurring Payable Manually" (page 122)

 l "Processing Recurring Payables" (page 194)

Overview

Use the A/P Recurring Payables screen to:

 l Create records for standard invoices you receive from your vendors. A recurring payable can be 
for a single item such as rent, or for a standing order or service that is almost identical from month 
to month. Recurring payables are identified by code as well as by vendor number, so you can 
generate a batch of a single invoice type.

 l View statistics for invoices created for the recurring payable.

 l Manually create an invoice for a recurring payable, if necessary.

You can also include recurring payables in the Reminder List, so that System Manager can remind a 
specific user, or all users, to process the payables when they become due. For more information about 
reminders, see the System Manager help.
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Detail Tab

The Detail distribution tab on the Recurring Payable setup screen lets you:

 l Enter the details of the recurring payable.

 l Open a separate Detail Accounts/Taxes screen to enter distribution and tax information for the 
detail.

 l To open the detail Accounts/Taxes screen, highlight the detail line, and then click the Acct/Tax button.

 l Lets you view estimated tax amounts for each payable detail (if you selected Calculate or 
Distribute as the tax entry method for the Tax Amount and Tax Base fields on the Tax/Totals tab).

You assign a distribution code or general ledger payable account, and enter a description and amount for 
each detail line in the recurring payable record.

Invoice Tab

This tab lets you specify the following information for the recurring payable:

 l The starting date.

 l The expiration type, and, depending on the type you specify:

 l The expiration date, if there is one.

The Create Recurring Payable Batch screen does not create invoices for payables unless the 
creation date is between the start date and the expiration date.

 l A maximum amount that you will pay for the recurring payable, if there is a maximum.

 l A maximum number of invoices. (If an invoice would cause the amount invoiced to date to 
exceed the maximum, Accounts Payable does not create the invoice.)

 l Assign a schedule to set the frequency of payable invoices.

 l Select a remit-to location for the payable, if needed.

 l Assign payment terms and tax information for the payable.

 l Enter a description and the purchase order number, if any.

Optional Fields Tab

Note: This tab appears only if you use Sage 300 Transaction Analysis and Optional Field Creator and 
you have defined invoice optional fields. 

Use the Optional Fields tab to assign optional fields to a document.

Recurring payables use the same optional fields as invoices. 
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Accounts Payable displays any optional fields set up for automatic insertion on invoices. It also displays 
default values for the invoice optional fields, as follows:

 l If you assigned exactly the same optional fields to the vendor and remit-to location records as you 
defined for invoices, the program displays the optional field values from the remit-to location on the 
Optional Fields tab.

 l If the optional fields in the remit-to location record and the vendor record are different from each 
other, the optional field values from the vendor record appear as defaults for the invoice.

 l If an optional field is defined for invoices, but is not assigned either to the vendor or the remit-to 
location, the program displays the value specified for the optional field in the Optional Fields 
record.

You can change the values that appear, or add other optional fields defined for Accounts Payable 
invoices. If an optional field is validated, you must specify a value that is defined for the optional field in 
Common Services. If the optional field is not validated, you can select a value from Common Services or 
you can enter another value that is consistent with the type of optional field.

Statistics Tab

Use the Statistics tab to:

 l View the number and amount of posted and unposted invoices created for the recurring payable. 
You can edit these fields to include historical amounts.

 l View the year-to-date number and amount of invoices created for the recurring payable. Accounts 
Payable updates these amounts when you post the invoices, and you cannot change them.

 l View information about the last invoice posted for the recurring payable, including the date, 
amount, invoice and entry numbers, as well as the batch number and posting sequence of the 
batch that contained the last invoice.

Tax/Totals Tab

Tax/Totals tab displays for the recurring payable:

 l The tax group and tax authorities. The tax group assigned in the vendor record appears as the 
default for the recurring payable, but you can change it, if necessary.

 l The vendor tax class. The vendor tax class is also assigned in the vendor record. However, for 
many tax authorities, the tax class varies depending on the purpose of the goods or services being 
purchased. You can change the tax class, if necessary.

 l Estimated tax amounts, if tax is calculated for the recurring payable. 

You specify how tax is to be calculated for the recurring payable using the Tax Amount and Tax Base 
fields.

 l Whether tax is included in the total for this document.
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You can change the Tax Included option only if the Allow Tax in Price option is selected for the tax 
authority in Tax Services.

Note: There is no exchange rate information tab on this tab because the exchange rates are unknown 
for the recurring invoice. The only rate information you enter is the rate type on the Invoice tab.

Fields and Controls

Buttons

Create Invoice

Click this button if you want to create a manual invoice for a recurring payable. 

Example: You might create an invoice manually if you accidentally delete an invoice from a recurring 
payable batch, or if you need to create an additional invoice for some other reason.

Recurring Payable Code

Enter the code for an existing recurring payable, or select it from the Finder.

To define a new record, type the code you want to use using up to 16 characters.

Tip: You can use the same recurring payable code for payables with different vendors, so you can 
create monthly RENT payables for one vendor, and quarterly RENT for another vendor.

You can specify a range of one or more codes when you create a batch of recurring payables.

Vendor Number

Enter the number of the vendor for whom you are creating this recurring payable, or select the vendor 
from the Finder. 

Tip: To see the address for this vendor, click the Zoom  button beside the field.

If you want to specify a remit-to address to use on invoices for the payable, use the Remit-to field on the 
Invoice tab.
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Detail Tab

Amount

For each detail you add, enter the amount of the detail in the Amount field, or edit the existing detail 
amount, if necessary.

The portion of the document total you distribute to details depends on whether tax is included in the 
price.

Comment

You can enter an optional comment with a selected recurring payable detail. For example, you might 
include a comment indicating that the invoice discount does not apply to a particular detail.

You can enter a comment for a detail in either of the following ways:

 l In the detail table, type a comment for the detail in the Comment column.

 l On the Detail Accounts/Taxes screen, type a comment in the Comment field for the current detail. 

Tip: Using the Detail Accounts/Taxes screen, you can see the entire comment you are entering 
without having to scroll.

Description

Type a description for the distribution line. 

The description from the distribution code record appears as the default description.

Discountable

You use this option to specify whether a selected detail is subject to the invoice discount. For example, 
if you do not give discounts on freight charges, you can exempt a freight detail from the invoice 
discount.

To indicate that a detail is not discountable, you simply clear the Discountable option for the detail on 
the Detail Accounts/Taxes screen, or select No for the option on the detail-entry table.

Dist. Code

A distribution code appears if the vendor record is set up to distribute details by distribution code, or if 
you used the Create Dist. button to create distributions from a distribution set.
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Accept or change the distribution code, as needed.

You can also enter a distribution code if none appears, or leave the field blank, and then enter the 
general ledger account number.

Distribution Amount

Type the total amount to distribute to the details created by the distribution set.

This total does not have to be the full amount you need to distribute. For example, after creating 
distribution details for a distribution set, you may need to add distribution lines for general ledger 
accounts that are not included in the distribution set.

Distribution Set

If you are using a distribution set, enter or accept a distribution set code.

If you are not using a distribution set, leave this field blank, and enter or select the distribution codes or 
G/L account numbers in the distribution list.

G/L Account

Enter, accept, or change the displayed general ledger account number, as needed.

For invoices that are not job-related, Accounts Payable displays the account numbers for the 
distribution codes you specify. However, you can enter the general ledger account codes directly. You 
can also change the account number for a distribution line on the detail table on the Invoice Entry 
screen.

For recurring payables, you can change the account number on the Detail tab.

Note: 
For job-related  documents, Accounts Payable displays accounts associated with the project or 
category in Project and Job Costing.

For most projects, the program displays the Work In Progress account for the specified category. For 
projects using accrual-basis as the accounting method, however, the program displays the Cost Of 
Sales account.

You can change the account only for:

 l Any time and materials project.

 l Projects that use the accrual-basis accounting method.
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Optional Fields

This field indicates whether optional fields are assigned to the document detail.

Notes: 
 l If any invoice details optional fields are set for automatic insertion, the field is selected when 

you add a new detail to an invoice, credit note, debit note, or recurring payable.

 l If you use exactly the same optional fields in vendor records and on invoices, the program 
assigns the optional field values used in the vendor record to transaction details that you add 
in the Invoice Entry screen and the Recurring Payables setup screen.

 l You can accept or delete the optional fields that appear as defaults, and you can add other 
optional fields that you have set up for invoice details. You can also change the optional field 
values used in document details.

 l For job-related  details, if the invoice details optional fields used on an invoice detail are 
identical to those assigned to the contract project, Accounts Payable uses the optional field 
values from the contract project as default values for the details.

 l If you assign to a job-related  detail an optional field that is not assigned to the contract project, 
the program displays the default value for the invoice details optional field.

Invoice Tab

1099/CPRS Amount

This field appears only if the vendor is subject to 1099 reporting (for a US vendor), or CPRS reporting 
(for a Canadian vendor).

Enter the amount of the document that is subject to 1099 or CPRS reporting.

1099/CPRS Code

This field appears only if the vendor is subject to 1099 reporting (for a US vendor), or CPRS reporting 
(for a Canadian vendor). 1099 forms are used in the United States, and CPRS reports are used in 
Canada. 

Select the 1099/CPRS code that matches the type of purchase or payment you are making.

Account Set

The account set from the vendor record appears as the default in this field.
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You can change the account set for a particular recurring payable record. If you use multicurrency, 
however, the new account set must use the same currency as the vendor's account set.

Currency

This field displays the vendor's currency when you enter the vendor number in a multicurrency system.

Current Amount

If the recurring payable uses the Maximum Amount expiration type, the program displays the sum of the 
unposted and posted total invoiced amounts from the Statistics tab.

Current Count

If the recurring payable uses the Number Of Invoices expiration type, the program displays the sum of 
the unposted and posted number of invoices from the Statistics tab.

Description

This description appears with the document information on the Invoice Batch Listing and the Invoice 
Posting Journal.

Expiration Type

Specify whether to restrict invoices beyond a specific date, a maximum amount, or a specified number 
of invoices. Depending on your choice for the expiration type, you enter additional information about the 
recurring payable, as follows:

 l If you select Specific Date, you also enter an expiration date for the recurring payable. Accounts 
Payable does not create any invoices for the payable after its expiration date. The program 
warns you when it creates the final invoice before the recurring payable expires, so that you can 
update the recurring payable record, if necessary.

 l If you select Maximum Amount, you must also specify the maximum amount for the recurring 
payable. When you have invoiced the maximum amount, Accounts Payable creates no 
additional invoices for the payable.

 l If you select Number of Invoices, specify the number of invoices to process for the recurring 
payable. When the specified number of invoices has been created, Accounts Payable creates no 
additional invoices.

 l If you select No Expiration, Accounts Payable creates invoices indefinitely for the recurring 
payable.
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Inactive

You select this option if you want to prevent this payable from being used, but do not want to delete it. 

If you select Inactive status, Accounts Payable displays the system date at the time, so that later you 
can find out when the record was made inactive.

You can reactivate the payable at any time.

Job Related

Select this option if the recurring payable is for a project you are managing using Sage 300 Project and 
Job Costing.

When you select the option, additional fields appear in the detail-entry table so that you can enter 
job-related  information.

When you post invoices generated for the recurring payable, Accounts Payable updates the specified 
contract, project, category, and (if required) the resource in Project and Job Costing.

Last Generated

This field displays the last date on which an invoice was generated for the recurring payable. You 
cannot change the date.

Last Maintained

This field displays the last date on which a change was made to the recurring payable record.

Next Invoice Date

Accounts Payable updates this field when you generate an invoice using the Create Recurring Payable 
Batch screen, or when you change the schedule for the recurring payable. You cannot change the date.

Note: The program uses the Last Generated date together with the schedule to determine when the 
next invoice should be generated.

Order Number

You can enter a sales order number or other information in this field, or leave the field blank. 

Tip: You can list documents by sales order number in Finders and for payment application, and you 
can use the number as the reference or description in G/L transaction batches.
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PO Number

You can type your company's purchase order number, if any, use the field for another purpose, or leave 
it blank. 

Tip: You can list documents by purchase order number in Finders and when applying payments, and 
you can use the number as the reference or description in G/L transaction batches.

Rate Type

Specify the code for the kind of rate you want to use when converting non-functional amounts to 
functional currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type, or select one from the Finder.

Rate types are defined using the Currency Rate Types screen in Common Services.

Remit To

If necessary, you can select or enter a different name for the check and a different address to which you 
will send payment. 

You can select a remit-to location that has been defined for the vendor, or use the Zoom  button 

beside the field or press F9 to open a separate screen in which you can enter a name and address for 
the document.

Schedule Code

Enter the code for the schedule to assign to the recurring payable record, or select it using the Finder. 

To set up a new schedule or modify an existing one, click the Zoom  button beside the field. You can 

use up to 15 characters to create a new code. 

Note: You must have security authorization to maintain schedules in Common Services to add or 
modify an existing schedule.

For more information about schedules, see the System Manager help.

Start Date

Enter the date on which the payable comes into effect.
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Accounts Payable will create invoices only when the run date is between the start and expiration dates 
specified for the recurring payable.

Terms

The terms code is used to calculate the due date, discount period, and discount amount for the 
document.

Notes: 
 l The vendor's default terms code appears when you enter the vendor number for the invoice, 

but you can change to any other terms code that is defined in Accounts Payable.

 l You can specify a terms code that includes multiple payments. For more information, see 
"About Assigning Multiple Payment Schedules to Invoices" (page 94).

 l You can change the due date, discount date, amount, and rate at any time until you post the 
invoice.

Optional Fields Tab

Optional Field and Description

Any invoice optional fields that are set up for automatic insertion appear, along with their descriptions, 
as defaults on the Optional Fields tab.

You can add different optional fields, providing they are defined for invoices in the A/P Optional Fields 
screen. When you select an optional field code, the program displays the description from the optional 
field setup record.

You can delete optional fields that appear as defaults. However, if an optional field is required, do not 
delete it. You cannot add the transaction until you enter a value for the optional field.

Value and Description

Default values appear for invoice optional fields, as follows:

 l If you assigned the same optional fields to the vendor and remit-to location records as you 
defined for invoices, the optional field values for the remit-to location appear on the Optional 
Fields tab.

 l If the optional fields in the remit-to location record and the vendor record are different from each 
other, the optional field values from the vendor record appear as defaults for the invoice.
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 l If an optional field is defined for invoices, but is not assigned either to the vendor or the remit-to 
location, the program displays the value specified for the optional field in the Optional Fields 
record.

You can change the value that appears for an optional field. If the optional field is validated, you must 
specify a value that is defined for the optional field in Common Services. If the optional field is not 
validated, you can select a value from Common Services or you can enter another value that is 
consistent with the type of optional field.

The description for the value appears automatically. You cannot change it.

Statistics Tab

[Last Invoice Posted] Batch Number

This field is updated when you post an invoice for the recurring payable.

[Last Invoice Posted] Entry Number

This field is updated when you post an invoice for the recurring payable.

[Last Invoice Posted] Invoice Amount

This field is updated when you post an invoice for the recurring payable. You cannot change it.

[Last Invoice Posted] Invoice Date

This field is updated when you post an invoice for the recurring payable. You cannot change it.

[Last Invoice Posted] Invoice Number

This field is updated when you post an invoice for the recurring payable. You cannot change it.

[Last Invoice Posted] Posting Sequence

This field is updated when you post an invoice for the recurring payable. You cannot change it.

[Posted] Number of Invoices

This field is updated when you post an invoice for the recurring payable.
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If the recurring payable uses Number of Invoices as the expiration type, the program uses this field, 
together with the [Unposted] Number of Invoices field, to determine if the limit has been reached.

Important! We recommend you change the entry in this field only when upgrading from a prior 
version. Editing the field does not affect the year-to-date total.

[Posted] Total Invoiced

This field is updated when you post an invoice for the recurring payable.

If the recurring payable uses Maximum Amount as the expiration type, the program uses this field, 
together with the [Unposted] Total Invoiced field, to determine if the limit has been reached.

Important! We recommend you change the entry in this field only when upgrading from a prior 
version. Editing the field does not affect the year-to-date amount.

[Unposted] Number of Invoices

Accounts Payable updates this field when you generate or post an invoice for the recurring payable, 
providing a gauge of the number of open documents generated for the recurring payable code. When 
you post the invoice, the amount is transferred to the [Posted] Number of Invoices field.

If the recurring payable uses Number of Invoices as the expiration type, the program uses this field, 
together with the [Posted] Number of Invoices field, to determine if the limit has been reached.

Important! We recommend you change the entry in this field only when upgrading from a prior 
version.

[Unposted] Total Invoiced

Accounts Payable updates this field when you generate or post an invoice for the recurring payable, 
providing a gauge of the amount of open documents generated for the recurring payable code. When 
you post the invoice, the amount is transferred to the [Posted] Total Invoiced field.

If the recurring payable uses Maximum Amount as the expiration type, the program uses this field, 
together with the [Posted] Total Invoiced field, to determine if the limit has been reached.

[Year To Date] Number of Invoices

This field is updated when you post an invoice for the recurring payable. You cannot change it.

Accounts Payable clears this field when you process year end.
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[Year To Date] Total Invoiced

This field is updated when you post an invoice for the recurring payable. You cannot change it.

Accounts Payable clears this field when you process year end.

Tax/Totals Tab

Estimated Tax Withheld

The total estimated amount that you will withhold for a transaction to be remitted to a tax authority on 
behalf of the vendor.

Reverse Charges Amount

From all details in the document, the total of reverse chargeable tax amounts owed to a tax authority, if 
the Reverse Charges Base for the tax authority is above the reverse charges threshold amount for the 
tax authority. If the Reverse Charges Base is not above the reverse charges threshold amount, this field 
displays 0.

Tip: You can change the amount in this field if you select Enter or Distribute in the Tax Amount field.

Reverse Charges Base

From all details in the document, the total of Tax Base amounts used to calculate reverse chargeable 
tax amounts owed to a tax authority.

The Reverse Charges Base is shown only if it is above the reverse charges threshold amount for the tax 
authority. If the Reverse Charges Base is not above the reverse charges threshold amount, this field 
displays 0.

Tax Amount

Specify one of the following methods for entering tax amounts for the recurring payable:

 l Calculate. Accounts Payable calculates tax amounts for you.           

If you select this tax entry method:
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 l You do not enter tax amounts. Accounts Payable calculates them for you.

 l You use the Tax Included column to specify whether taxes are included or excluded in the 
tax amounts.

 l Check the tax classes. If they are incorrect, use the Finder to select the correct classes.

 l Enter. You manually enter all tax amounts for the recurring payable.           

If you select this tax entry method, enter the total amount of each tax for the recurring payable on the 
Tax/Totals tab, and then enter the amount of tax for each detail on the Detail Accounts/Taxes screen. 
(Select a detail on the Detail tab and then press F9, or click the Account/Tax button.)

Note: The sum of the tax entered for all the details for a tax authority must equal the total amount 
you enter for the authority on the Tax/Totals tab.

 l Distribute. You enter the total tax amount for each tax authority manually, and Accounts Payable 
automatically prorates the tax to the details.           

If you select this tax entry method, enter the total amount of each tax for the recurring payable on the 
Tax/Totals tab.

Note: If a tax does not appear on the Tax/Totals tab, you likely selected the wrong tax group for the 
document.

Tax Authority

The tax group you specify on the Tax/Totals tab of the Recurring Payables screen determines which tax 
authorities appear on the tab.

Tax authorities are the taxing bodies, such as federal, state, county, provincial, or municipal 
governments, that levy taxes in the areas where your company buys products.

If your business has a head office and branch offices, different taxes may apply in the different 
geographical locations.

Tax Base

This is the amount (before included taxes) used as the base for calculating tax for each tax authority.

If you select Calculate, you cannot change the tax base.

If you select Enter or Distribute as the tax entry method for the Tax Base, you can enter the amount on 
which tax is based for the document. 
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If you select Calculate as the entry method for the tax amount, and select Distribute or Enter for the tax 
base, Accounts Payable uses the tax base you enter to calculate the tax amounts automatically.

Tax Group

Enter a tax group. For more information, see "About Tax Groups" (page 98).

Tax Included

Select Yes if taxes charged by the authority are included in the prices for the detail you are entering. 
The default setting comes from the vendor record.

You can override this setting for single distribution lines on the Detail Accounts/Taxes screen. (Select 
the detail on the Detail tab, and then click the Account/Tax button.)

Total Estimated Tax Withheld

The total estimated amount that you will withhold for a transaction to be remitted to tax authorities on 
behalf of the vendor.

Total Reverse Charges

The total of Reverse Charges Amounts for the document.

Vendor Tax Class

The tax class of each tax authority usually indicates a taxable or non-taxable status for your business or 
the goods you are purchasing. 

Tax classes occasionally indicate the tax rate as well. A typical set of classes might be: 1=taxable at 
rate 1; 2=taxable at rate 2; and 3=non-taxable. The default tax class comes from the vendor record.

This setting applies to the whole invoice. You can override this setting for single distribution lines on the 
Detail tab or on the Detail Accounts/Taxes screen.
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A/P Remit-To Locations Screen

To Open this Screen

 1. Open Accounts Payable > A/P Vendors >        Remit-To Locations.

 2. In the Vendor Number field, type the code for the vendor for which you are adding or editing a remit-to 
location, or use the Finder to select the vendor, and then press the Tab key.

Accounts Payable displays a list of all the remit-to locations for the specified vendor, if any exist. You 
open a separate Remit-To Locations screen for a specific location as follows:

 l To view a remit-to location record, select the line for the location (on the table), and then 
click the Open button.

 l To start a new remit-to location record, click the New button.

Related Tasks

 l "Adding, Modifying, or Deleting a Remit-to Location for a Vendor" (page 62)

 l "Looking Up Remit-to Locations for a Vendor" (page 64)

Overview

Use the A/P Remit-To Locations screen to:

 l Add, edit, and delete remit-to locations—additional addresses to which you send payments and other 
correspondence to vendors.

Note: You use this code in the Invoice Entry screen to assign a remit-to location to a document you 
enter for the vendor.

 l Look up the remit-to locations assigned to a vendor.

 l Assign a primary remit-to location displayed as the default for vendor invoices and printed on 
checks to the vendor.

 l Specify the check language to use for each location.

Note: You can change the language in which the amounts are printed on checks. If you want to 
change the language for other items on the check or advice form, you must change the check report.

 l Provide default entries for remit-to location optional fields. If you use the location when entering 
invoices, the optional entries from the remit-to location record override the entries provided by the 
vendor record.
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Tip: If you want to view all locations for a vendor, or delete a remit-to location, you can do so directly 
from the initial screen that opens when you double-click the Remit-To Locations icon.

You can change all the information in a remit-to location except the remit-to code. If you need to change 
the code, you must add another record using the new code, then delete the record you no longer need.

Address Tab

Use this tab to:

 l Change the check language, address, contact name, telephone number, and fax number for remit-
to locations.

 l Select primary remit-to locations for vendors.

 l Assign Inactive status to remit-to locations you want to suspend temporarily or delete at year end.

Contact Tab

Use this tab to enter the name, telephone number, fax number, and e-mail address for a contact person 
at the remit-to location.

Optional Fields Tab

Note: This tab appears only if you use Sage 300 Transaction Analysis and Optional Field Creator.

You use the Optional Fields tab to assign optional fields for particular remit-to locations.

If you set any optional fields for automatic insertion in remit-to location records, they appear on the tab, 
along with their default values.

Note: If you defined the same optional fields for remit-to locations as for vendors and vendor groups, 
the program uses the values from the vendor record as default values for the optional fields in the 
remit-to location record.

You can accept or change the optional field values. If an optional field requires validation, you can select 
only a value that is assigned to the optional field in Common Services or, if the optional field allows it, you 
can leave the default value field blank.

Tip: If you use exactly the same optional fields for invoices, vendors, and remit-to locations, when you 
specify a remit-to location on the Invoice Entry screen, Accounts Payable uses the optional field values 
from the remit-to location for the invoice, debit note, or credit note.
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Fields and Controls

Remit-To Location

Type a unique code, using up to six characters, to identify a new remit-to location. 

Tip: Each of the location codes for a single vendor must be unique, but you can use the same codes 
for different vendors. This means you can use standard codes to represent cities or suburbs, or 
location types for offices, stores, warehouses, or factories.

To select an existing remit-to code, type the code or select it from the Finder beside the Remit-To Code 
field. You can also click the navigation buttons beside the field to select existing codes.

Remit-To Name

Type a description or name of the location, using up to 60 characters. 

You must enter a name for a new location before you can add the record.

Vendor Number

Type the code for the vendor for which you are adding or editing a remit-to location, or use the Finder 
beside the Vendor Number field, to select the vendor.

Address Tab

Use this tab to specify address and contact details for a remit-to location.

Address

Type the address at the remit-to location.

If you mark a remit-to location as the primary remit-to address, Accounts Payable uses the location as 
the default address on invoices and on vendor checks.

Check Language

Select the name of the language in which you want to print the check amount when issuing checks to 
the location.
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Tip: If you are using a keyboard, press the Down Arrow key until the abbreviation you want to use is 
displayed.

City

Type the name of the city for the remit-to location. 

Tip: Although you can enter the city in other address lines, this field is more useful if you use it 
consistently for the city.

Country

This field contains the country for the remit-to location. 

You can type up to 20 characters in the field, including spaces.

E-mail

Enter a primary e-mail address for the remit-to location.

Fax

This field contains the fax number, if any, at the remit-to address.

The field contains area code parentheses and hyphens if you selected the Format Phone Number 
option on the Company Profile screen in Common Services.

Inactive

Select this option if you do not want to use a remit-to location again for a vendor, usually because you 
plan to delete the account.

Important! If you make a primary remit-to location inactive, make sure that you also turn off (clear) 
the Primary Remit-To option for the location.

You cannot use inactive remit-to locations inactive, can no longer use it when adding an invoice. 

Last Maintained

In this field, Accounts Payable displays the date of the last change made to the vendor record. 

You cannot make an entry in this field.
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Primary Remit-To

Select this option if you want to use this location as the default address on invoices you enter for this 
vendor and on the checks you print for the vendor.

The location is automatically selected for the vendor when you begin invoice entry, but you can select 
another location or use the address from the vendor record for individual invoices.

You can select only one primary remit-to location for each vendor. 

Important! If you make a primary remit-to location inactive, make sure that you also turn off (clear) 
the Primary Remit-To option for the location.

State/Province

This field contains the name of the state or province for the remit-to address. You can type up to 30 
characters in the field, including spaces.

Telephone

This field usually contains the telephone number at the remit-to location.

The field contains area code parentheses and hyphens if you selected the Format Phone Number 
option on the Company Profile screen in Common Services.

Zip/Postal Code

Type the zip code or postal code for the remit-to address.

Contact Tab

Use this tab to specify contact details for the contact person at a remit-to location.

Contact

Type the name of the person or position you contact at the remit-to location.

E-mail

Enter an e-mail address for the contact person at this remit-to location.
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Fax

Use this field for the fax number for the contact person at this remit-to location.

The field contains area code parentheses and hyphens if you selected the Format Phone Number 
option on the Company Profile screen in Common Services.

Telephone

Use this field for the telephone number of the contact at this remit-to location.

The field contains area code parentheses and hyphens if you selected the Format Phone Number 
option on the Company Profile screen in Common Services.

Optional Fields Tab

When you add a new record, this tab displays any optional fields that are set up for automatic 
insertion for that type of record. If default values are defined for any of these fields, they are also 
displayed.

You can remove optional fields, and you can add optional fields that are set up for use with this 
screen. You can also change any default values.

For more information, see "About Accounts Payable Optional Fields" (page 30).

Note: If you defined the same optional fields for remit-to locations as for vendors and vendor 
groups, the program uses the values from the vendor record as default values for the optional 
fields in the remit-to location record.

A/P Vendor Activity Screen

To Open this Screen

Open Accounts Payable > A/P Vendors >        Vendor Activity.

Secondary Screens

 l Document Information Screen

 l Payment Information Screen
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Related Tasks

"Looking Up Vendor Activity" (page 71)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Vendor Activity screen to view  a variety of information about the current status of your vendor 
accounts.

Activity Tab

This tab displays summary information about the current status of the account for a selected vendor, and 
shows the most recently posted transactions.

Aging Tab

This tab displays your company's account balance with the vendor in each of the aging periods used in 
your Accounts Payable system, selected by the aging and cutoff dates you specify. Use it to:

 l Display the vendor's outstanding transaction balances aged into the periods you specify. More...

Accounts Payable sorts outstanding transactions and balances into five periods: a current (not due) 
period and four aging periods.

You specify the length of each aging period for the Accounts Payable system on the A/P Options 
screen, but you can assign any aging periods you want on this tab.

 l Specify the date as of which you want to age transaction balances (such as by today's date).

You can choose whether to age transactions by their due dates or their document dates for each type of 
report.

 l Specify a cutoff date, so you can include or exclude transactions that are more recent than the Age As 
Of date.

Payments Tab

Use this tab to view a list of payments made to a selected vendor. For each payment, the tab displays the:

 l Bank code.

 l Check number and check date.
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 l Check amount in the functional currency or vendor currency (if you have a multicurrency ledger).

 l Check status (outstanding, cleared, or reversed).

 l Payment batch number and entry number.

 l Payee (name on the check).

Transactions Tab

Use this tab to:

 l View summary and detailed information about the transactions (invoices, debit notes, credit notes, and 
payments) currently posted to vendor accounts. 

Accounts Payable displays a single line of summary information for each invoice, credit note, debit note, 
prepayment, and payment that has been posted to the vendor's account. 

You can choose the types of documents to display, the order of their appearance, and the starting 
document number. You can include pending amounts in the display, if you want. 

 l View completed (fully paid) documents that you have not yet cleared from Accounts Payable. You 
choose whether to include or exclude fully paid transactions.

 l View information about pending transactions, including pending document balances.

 l Open a separate screen to view detailed history for each displayed document.

In multicurrency ledgers, you can view amounts in the functional currency or the vendor's currency.

Fields and Controls

Buttons

Details

Click this button to view the details for a selected document.

Document

This button appears on the following tabs:

 l Payments. You can select any payment, and then click Document to view the original entry in 
the A/P Payment Entry screen.

 l Transactions. You can select any transaction, and then click Document to view the transaction 
in the original entry screen.
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Open

This button appears on the following tabs:

 l Payments. You can select any payment, and then click Open to view details about the payment. 
For more information, see A/P Payment Information Screen.

 l Transactions. You can select any transaction, and then click Open to view details about the 
history of the transaction. For more information, see A/P Document Information Screen.

Optional Fields

The Optional Fields button appears only if you use Sage 300 Transaction Analysis and Optional Field 
Creator. 

Click this button to view optional fields assigned to the transaction.

Activity Tab

Amounts In

In multicurrency ledgers, use these fields to select the currency in which to display information. You can 
display amounts in the functional currency for the ledger or in the vendor's currency.

Type F to select Functional currency, or type V to select Vendor currency. You can also click your 
choice, or use the Up or Down arrow key on your keyboard to highlight your choice, and then press 
Enter.

Credit Limit

This field displays the amount of the credit limit that the selected vendor allows your company.

Inactive

This field indicates whether the vendor account is active.

Last Invoice Amount

This field displays the amount of the last invoice that was posted to the vendor's account.

Last Invoice Date

This field displays the document date entered with the last invoice you posted to the account.
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Last Payment Amount

This field displays the amount of the last payment you sent to the vendor and posted to the account.

Last Payment Date

This field displays the date of the last payment that was posted to the account.

On Hold

This field indicates whether the account is on hold.

Open Invoice Count

This field shows the current number of open (unpaid) invoices in the account. You cannot edit the 
figure.

Outstanding Balance

This field displays the current net amount owed to a vendor, including all invoices, credit notes, debit 
notes, payments, and adjustments posted to the account. You cannot edit the figure.

Outstanding Retainage

This field shows the outstanding retainage balance for the vendor.

Prepayment Amount

This field displays the total amount of outstanding prepayments that have been posted to the vendor 
account. You cannot edit the figure.

Prepayment Count

This field displays the current number of outstanding prepayment transactions in the account. You 
cannot edit the figure.

Vendor No.

Use this field to select the vendor whose account activity you want to view.

You can type the number in the field, or use the Finder or navigation buttons to select the vendor 
number.
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Tip: After you specify the vendor number, you can click the Zoom  button to display the vendor 
record in the A/P Vendors screen, where you can view or edit it.

Aging Tab

Age As Of

Type the date from which to age (count back) to determine the balance to display in each aging period. 
All outstanding transactions will be listed unless they were posted after the cut-off date.

Age By

Specify whether to age balances by the document dates used in the transactions or by the due dates:

 l Due Date. Select this option to display outstanding balances. 

Current transactions are those with due dates that are later than the Age As Of date. The first period 
starts at one day past the due date.

 l Document Date. The first period includes transactions with document dates that are earlier than 
the Age As Of date.

Current transactions are those with the same date as or a later date than the Age As Of date.

Aging Period Information

Aging periods are assigned for Accounts Payable on the A/P Options screen, but you can temporarily 
change the lengths of the periods when viewing individual accounts on this tab. 

The aging periods you specify in the Vendor Activity screen have no effect on the aging periods set on 
the A/P Options screen.

Tip: 
If your vendor accounts include credit notes, debit notes, and prepayments that have not been 
applied to specific documents, you can also specify (on the A/P Options screen) whether to report the 
amounts in the aging periods that contain their document dates or group them all in the current (not 
due) period. 

These options have no effect on credit notes, debit notes, and prepayments that are applied to 
specific document numbers. Applied amounts are always included in the same aging periods as the 
documents to which they apply.
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Cutoff Date

The cutoff date lets you include or exclude transactions that are more recent than the Age As Of date.

Type the last date for which to include transactions in the balances. Only transactions that were posted 
to the vendor's account on or before that date are selected.

Include Prepayments

Select this option if you want to include prepayments in the statistics.

Include Transactions On Hold

Select this option if you want to include in the statistics transactions that are on hold.

Payments Tab

Bank

The code for the bank from which you issued this check.

Check Number

This is the check number Accounts Payable assigned when it printed the check, or the number entered 
manually in the Payment Entry screen. 

Bank Services uses the check number to identify all checks in Sage 300.

Check Status

The check status can be outstanding, cleared, or reversed.

Currency

This field displays the currency in which the check was written.

Entry Number

This is the entry number of the payment or prepayment transaction in the batch. (You can identify it as a 
payment or prepayment if you select the check, and then click the Open button.)
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Order By

Specify whether to list payments in order of check number or document date.

Tip: Click the Ascending/Descending  button beside the Order By field to change the display from 
ascending to descending order, or from descending to ascending order, for your Order By selection.

Payment Amount

This is the amount that appeared on the check, in the currency that the check was written.

To see the check amount in the vendor currency or the functional currency, highlight (select) the check 
on the table, and then click Open.

Payment Batch

The payment batch is the one to which you added and posted the payment or prepayment transaction.

Payment Date

This field displays the date you made the payment.

If you paid by check, this date was on the face of the check.

Remit To

This field displays the remit-to name that appeared on the check.

Starting Value

Depending on your selection for the Order By field, specify the check number or the document date 
with which to start the list of payments.

Notes: 
 l If you are ordering by check number, you can select a check number using the Finder .

 l If you are ordering by document date, you can select a date using the calendar button.

Status

Select the status of the payments you want to review:
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 l All

 l Cleared

 l Outstanding

 l Reversed

Vendor Number

Enter or use the Finder or the navigation buttons to select the vendor whose checks you want to view. 
You must enter a vendor number.

Transactions Tab

Amounts In

In multicurrency ledgers, use these fields to select the currency in which to display information. You can 
display amounts in the functional currency for the ledger or in the vendor's currency.

Type F to select Functional currency, or type V to select Vendor currency. You can also click your 
choice, or use the Up or Down arrow key on your keyboard to highlight your choice, and then press 
Enter.

Currency

This field displays the vendor's currency code.

Document Type

Specify the type of documents to display:

 l All

 l Invoices

 l Debit notes

 l Credit notes

 l Interest charges

 l Unapplied cash

 l Payments

 l Prepayments
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Note: 
If you select Order Number or PO Number in the Order By field, transactions that do not include an 
order number or PO number are listed:

 l In ascending document number order and before transactions that include an order number or 
PO number, if you display the list in ascending order.

 l In descending document number order and after transactions that include an order number or 
PO number, if you display the list in descending order.

Include Fully Paid Transactions

Select this option to include fully paid invoices, credit notes, and debit notes in the list of documents.

Include Pending Amounts

Select this option to include information for pending transactions, including the pending payment total, 
pending discount total, and pending balance for each document.

Order By

Specify how to list documents. You can list documents by:

 l Document number

 l PO number

 l Sales order number

 l Due date

 l Document date

 l Current balance

Tip: Click the button  beside the Order By field to change the display from ascending to 
descending order, or from descending to ascending order, for your Order By selection.

Original Retainage Amount

This field indicates the retainage amount that was posted for the document, before any outstanding 
retainage was invoiced.

Payment Status

This column shows whether a document has an On Hold or Forced status.
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Pending Adjustment Total

This field appears if you selected the Include Pending Amounts option on the Transactions tab.

The Pending Adjustment Total field shows the adjustment total for a selected document, including 
adjustment transactions that you have entered but not posted.

Pending Balance

This field appears if you selected the Include Pending Amounts option on the Transactions tab.

The Pending Balance field shows the balance for a selected document, including transactions that you 
have entered but not posted.

Pending Discount Total

This field appears if you selected the Include Pending Amounts option on the Transactions tab.

The Pending Discount Total field shows the discount total for a selected document, including 
transactions that you have entered but not posted.

Pending Payment Total

This field appears if you selected the Include Pending Amounts option on the Transactions tab.

The Pending Payment Total field shows the payment total for a selected document, including 
transactions that you have entered but not posted.

Retainage Amount

This field indicates the outstanding retainage balance that remains for the document.

Retainage Due Date

This field displays the due date entered with the original retainage document (the date that retainage is 
due).

Starting Value

Depending on your selection for the Order By field, specify the number, amount, or date with which to 
start the list of transactions.

507Sage 300 2023 Accounts Payable User's Guide



Tip: If you use the Finder, you can use the Find By field to specify a different order by which to list 
documents.

A/P Vendor Groups Screen

To Open this Screen

Open Accounts Payable > A/P Vendors > Vendor Groups.

Related Tasks

"Adding, Modifying, or Deleting a Vendor Group" (page 49)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Vendor Groups screen to create vendor groups to which you can assign vendors.

You use vendor groups to:

 l Classify vendor records by common characteristics.

 l Set default entries to speed up the task of adding records for vendors.

 l Select records for processing.

For more information about vendor groups, see "About Vendor Groups" (page 47).

Group Tab

Use this tab to:

 l Assign the account set, terms code, and bank code to use for new vendors you add to the group.

 l In multicurrency ledgers, specify the default rate type to assign for vendors who do not use the 
functional currency.

Invoicing Tab

Use this tab to:
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 l Specify the default distribution method to assign to vendor records you add to the group.

 l Select the default tax group and tax classes to which your company belongs when invoiced by 
vendors in this group.

 l Select options to specify how to identify duplicate invoices for this vendor group and whether to 
print separate check for each invoice or pay several invoices with a single check to a vendor.

 l Specify whether vendors in the group are normally subject to 1099/CPRS reporting and enter the 
1099/CPRS code for the group.

You can change your choices for these options at any time.

Optional Fields Tab

Note: This tab is available only if you use Sage 300 Transaction Analysis and Optional Field Creator.

You use this tab to specify default optional field values for vendor records you assign to the vendor group. 
You can:

 l Accept the default optional fields that appear on the tab, or delete them. 

When you add a new vendor group record, the tab displays optional fields that are set up for automatic 
insertion in vendor group and vendor records, along with their default values.

 l Assign different optional fields that are set up for vendors and vendor groups.

 l Accept or change any default values that appear.

Note: If an optional field requires validation, you can select only a value that is assigned to the 
optional field in Common Services. (If the optional field allows blanks, you can leave the default value 
field blank.)

The values you assign to the vendor group appear on new vendor records you add to the group, if you 
assign the same optional fields to the vendor records.

For more information about optional fields and how they are used in Accounts Payable, see "About 
Accounts Payable Optional Fields" (page 30).

Statistics Tab

Important! If you are entering statistics as part of the setup of your Accounts Payable ledger, do not 
include amounts you will post for the group's vendors when you enter historical and year-to-date 
Accounts Payable transactions. If you do, the amounts will be added twice to the statistics.

The Statistics tab:
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 l Lists the following information for each period in the year you select:

 l Number and amount of all transactions processed for the vendor group.

 l Total days to pay and average days to pay for the vendor group.

 l Lists the following information for each year for which you have statistical data:

 l Number and amount of all transactions processed for the vendor group.

 l Total days to pay and average days to pay for the vendor group.

 l Lets you change statistical information (if the Allow Edit Of (vendor) Statistics option is selected 
on the Processing tab of the A/P Options screen).

Fields and Controls

Group Tab

Account Set

To specify an account set for the group, type its code in this field, or use the Finder to select it.

The account set specifies the default general ledger payables control, purchase discounts, and 
prepayment accounts to which you distribute transactions from the vendors in the group.

In multicurrency systems, the account set also determines the currency for vendors assigned to the 
group. 

If the currency is not the functional currency, the account set also specifies the exchange gain, 
exchange loss, and exchange rounding accounts to use when currencies are revalued or when 
transactions are settled at different exchange rates than those assigned to the transactions.

Bank Code

Type the code for the bank from which you normally issue checks to the vendors in the group, or use the 
Finder to select it.

Generate Separate Payments for Each Invoice

Select this option if you usually generate separate checks for each invoice for vendors in this group 
when you process payments automatically. 

Do not select the option if you want to create a single check to cover all outstanding amounts owing to 
an individual vendor.
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You selection is used as the default for the option in vendor records you add to the group. You can 
change the choice for individual vendors.

Group Code

To display an existing vendor group record, type the group code, or use the Finder or navigation buttons 
to select it.

To create a new vendor group record, enter a unique code using up to six characters, including letters 
and digits.

Note: If you are creating a new vendor group, also enter a description for the vendor group in the field 
to the right.

Inactive

Select this option if you do not want to post any new transactions to the vendors that are assigned to the 
group, usually because you plan to delete the group.

When a vendor group is inactive, you cannot save changes to the vendor records that use the group, 
except to select another vendor group.

You can make the group active again at any time.

Last Maintained

This field displays the date of the last change made to the vendor group. You do not make an entry in 
this field.

Payment Code

On the Vendor Group record, you use this field to specify the default payment code for new vendors you 
add to the vendor group.

You can change the payment code for a vendor in the vendor record. When you process a new 
payment for the vendor, the code specified on the vendor record appears as the default payment code.

Rate Type

If you use multicurrency accounting, type or select the rate type normally used to convert invoice 
amounts for the group's vendors to your functional currency.

To specify the rate type, type its code or use the Finder to select it. 
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Note: You must specify a rate type that is defined for the company in the Currency screens in 
Common Services.

Terms Code

In this field, type the terms code to use as the default terms codes for new vendor records, or use the 
Finder to select the code. 

You can select a different terms code for any vendor you assign to the group.

Terms codes determine invoice due dates, set discount rates and periods, calculate discount bases, 
and specify the number of payments in multiple payment schedules.

Note: You must assign a terms code to each group.

Invoicing Tab

1099/CPRS Code

Select the 1099/CPRS code that matches the type of goods or services you purchase from this group of 
vendors.

Note: This field appears only if you selected 1099 or CPRS in the Tax Reporting field for the vendor 
group.

Distribute By

Select the method by which you usually distribute invoice amounts to general ledger accounts for 
invoices from the vendors in this group. You can change the method for individual vendors.

You can distribute amounts by distribution code, distribution set, or general ledger account number. 
You can also select None if you prefer not to use a default distribution on invoices from vendors in this 
group. 

Tip: We suggest that you select None if you frequently purchase goods or services from this vendor 
for projects you manage using Sage 300 and Job Costing. You cannot enter job-related  details on 
invoices that contain non-project details.
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Distribution Code

To distribute transactions with the group's vendors to a single general ledger account that is 
represented by a distribution code, select Distribution Code in the Distribute By field, and then type the 
distribution code, or select it from the Finder. 

You can specify a different distribution code or use another distribution method for vendors assigned to 
the group.

Distribution Set

To assign a distribution set (a defined group of distribution codes) as the default distribution method for 
vendors in this group, select Distribution Set in the Distribute By field, and then specify the distribution 
set. 

You can specify a different distribution set or use another distribution method for vendors assigned to 
the group.

Duplicate Invoice Checking

Specify the default method of checking for duplicate invoices, debit notes, and credit notes for new 
vendors you assign to this group.

Accounts Payable can ignore duplicates, warn you, or stop you from posting invoices that might be 
duplicates according to two criteria that you specify separately: Vendor and Amount and Vendor and 
Date.

You can change the method for individual vendors in the group.

G/L Account

To use a single general ledger account as the default distribution method for the vendors in the group, 
select G/L Account for the Distribute By option, and then type the account number or select it from the 
Finder.

You can specify a different general ledger account or use another distribution method for individual 
vendors you assign to the group.

Tax Authority

When you select a tax group for the vendor group, the associated tax authorities are displayed. (Tax 
authorities are the types of taxes that you may be subject to on invoices from the vendor. For example, 
state and provincial sales taxes are tax authorities, as are GST and VAT.)
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Note: You define and update records for tax authorities and enter other taxation information in the 
Tax Services screens in Common Services.

Tax Class

Select your tax class for each of the tax authorities in the tax group. 

Tax classes identify the tax rates used to calculate taxes when you enter invoices, debit notes, and 
credit notes from a vendor.

You can change the classes for individual vendors and on invoices.

Note: You use the Tax Services screens in Common Services to define and update tax classes and 
enter other taxation information.

Tax Group

Select the code for the tax group that are applied to the purchases you make from vendors in this group. 
The taxing authorities in the tax group appear on the screen so you can enter tax classes for each 
authority.

You must assign a tax group to each vendor group. 

Note: You use the Tax Services screens in Common Services to define and update tax groups and 
enter other taxation information.

Tax Included

Specify whether this tax is typically included in the total invoice amount or listed separately.

Note: You can change the Tax Included option only if the tax authority (in Common Services) permits 
it.

Tax Reporting

This option appears in vendor records only if the Use 1099/CPRS Reporting option is selected on the 
A/P Options screen.

Select 1099, CPRS, or None, depending on the type of tax forms you are required to submit for the 
vendors in this group.
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When you select 1099 or CPRS, you also enter the 1099 or CPRS code that matches the type of goods 
or services you typically purchase from this vendor group.

Vendor and Amount

Select the method, if any, you want Accounts Payable to use to warn you when you enter two or more 
invoices for the same amount from individual vendors in this group.

Vendor and Date

Select the method, if any, you want Accounts Payable to use to warn you when you enter two or more 
invoices for the same date from individual vendors in this group.

Optional Fields Tab

When you add a new record, this tab displays any optional fields that are set up for automatic 
insertion for that type of record. If default values are defined for any of these fields, they are also 
displayed.

You can remove optional fields, and you can add optional fields that are set up for use with this 
screen. You can also change any default values.

For more information, see "About Accounts Payable Optional Fields" (page 30).

Statistics Tab

Accounts Payable automatically updates statistics as you post transactions for the vendors in the group.

Year

Type or select the year for which you want to enter or view statistics.

The type of year by which you keep statistics is determined by the selection for the Accumulate By field 
on the Processing tab of the A/P Options screen.

Tables

Adjustment Amount

Enter the total amount of the adjustments that were processed for the vendors in the group during the 
statistical period or year.
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Adjustment Count

Enter the total number of adjustments that were processed for the vendors in the group during the 
statistical period or year.

Average Days to Pay (Period Statistics table)

Accounts Payable keeps track of the average number of days it takes your company to pay invoices 
from the vendors in a group, and displays the figure in this field. You cannot change the figure.

The figure for each period is calculated by dividing the total number of days it took to pay the invoices 
that were fully paid in the period by the number of invoices that were issued to your company by the 
group's vendors, both in the displayed period and in prior periods.

Average Days to Pay (Year Statistics table)

Accounts Payable keeps track of the average number of days it takes you to pay each invoice for 
vendors in a vendor group, and displays the average for the year in this field. You cannot change this 
figure.

Credit Amount

Enter the total amount of the credit notes that were processed for the vendors in the group during the 
statistical period or year.

Credit Count

Enter the total number of credit notes that were processed for the vendors in the group during the 
statistical period or year.

Days to Pay (Period Statistics table)

Accounts Payable records the length of time it takes your company to fully pay invoices from the 
vendors in the group, and displays the total in this field.

The total that appears for a period is the number of days it took to pay all the associated vendor 
invoices that were paid in full during the selected period.

You can edit this figure, as needed, if the Allow Edit Of (vendor) Statistics option is selected on the 
Processing tab of the A/P Options screen.
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Days to Pay (Year Statistics table)

Accounts Payable records the length of time it takes you to fully pay invoices for vendors assigned to a 
vendor group for the year, then displays the total in this field.

You cannot change this figure.

Debit Amount

Enter the total amount of the debit notes that were processed for the vendors in the group during the 
statistical period or year.

Debit Count

Enter the total number of debit notes that were processed for the vendors in the group during the 
statistical period or year.

Discount Lost Amount

Enter the total amount of the discounts lost that were processed for the vendors in the group during the 
statistical period or year.

Discount Lost Count

Enter the total number of discounts lost that were processed for the vendors in the group during the 
statistical period or year.

Discount Taken Amount

Enter the total amount of the discounts taken that were processed for the vendors in the group during 
the statistical period or year.

Discount Taken Count

Enter the total number of discounts taken that were processed for the vendors in the group during the 
statistical period or year.

Invoice Amount

Enter the total amount of the invoices that were processed for the vendors in the group during the 
statistical period or year.
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Invoice Count

Enter the total number of invoices that were processed for the vendors in the group during the statistical 
period or year.

Payment Amount

Enter the total amount of the payments that were processed for the vendors in the group during the 
statistical period or year.

Payment Count

Enter the total number of payments that were processed for the vendors in the group during the 
statistical period or year.

Period

Displays the periods for the year you specify in the Year field for the Period Statistics table.

The selection for the Period Type option on the Processing tab of the A/P Options screen determines 
the type of period for which Accounts Payable accumulates statistics. (The period type can be weekly, 
seven days, bi-weekly, four weeks, monthly, bi-monthly, quarterly, semi-annually, or fiscal period.)

Total Invoice Paid Amount

Enter the total amount of the invoices paid that were processed for the vendors in the group during the 
statistical period or year.

Total Invoice Paid Count

Enter the total number of invoices paid that were processed for the vendors in the group during the 
statistical period or year.

Year

Displays each year for which you have statistical data.

A/P Vendors Screen

To Open this Screen

Open Accounts Payable > A/P Vendors > Vendors.
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Related Tasks

"Adding, Modifying, or Deleting a Vendor" (page 58)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/P Vendors screen to:

 l Add new vendor records.

 l Change or delete existing records.                 

Note: If a vendor is used in any documents, you must clear history before you can delete the vendor.

 l Review period and activity statistics.

For more information about vendor records, see "About Setting Up Vendor Records" (page 50).

Activity Tab

Use the Activity tab to:

 l View current-year and previous-year account activity for the selected vendor.

Account activity includes the current balance of your account with the vendor and the current number of 
open documents, the number and amount of outstanding prepayments, and the amount and date of the 
highest and lowest balances and largest invoices for the current and previous years, as well as the 
amount and date of the last posted invoice, payment, credit note, debit note, adjustment, and discount 
posted for the vendor.

 l Edit activity statistics when setting up vendor accounts.

Address Tab

Use the Address tab to change the vendor's group, short name, site address, telephone number, fax 
number, start date and company e-mail address.

You cannot change the vendor number, but you can change all other information on this tab with a few 
restrictions. For more information on these restrictions, see "About Editing Vendor Records" (page 56)

Comments Tab

Use the Comments tab to:
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 l Add any number of comments to the vendor record, along with follow-up and expiration dates for 
each comment.

 l Make changes to existing comments.

For more information on vendor comments, see "About Vendor Comments" (page 55).

Contact Tab

Use the Contact tab to enter the name of a contact person for the vendor, and an e-mail address and 
telephone and fax numbers for the contact.

If you use the Multiple Contacts (M/T) program, this tab includes a Multiple Contacts section that allows 
you to assign multiple contacts to a vendor. For more information, see "Setting Up Multiple Contacts for 
Vendors" (page 57).

Invoicing Tab

Use the Invoicing tab to:

 l Specify the default method by which you distribute the vendor's invoices to general ledger 
accounts.

 l Select options to specify how to identify duplicate invoices you enter from the vendor and whether 
you print a separate check for each invoice from the vendor, or pay several invoices with a single 
check.

 l Select the tax group and tax classes to which your company belongs when invoiced by this vendor.

 l Enter your company's tax registration or tax exemption number, if any, for each tax class.

 l Specify whether the vendor is subject to 1099, CPRS, or no tax reporting, and enter the 1099 or 
CPRS tax number, type, and code for vendors that use 1099 or CPRS reporting.

You can change your choices for these options at any time.

Optional Fields Tab

Note: This tab is available only if you use Sage 300 Transaction Analysis and Optional Field Creator.

On this tab, you can:

 l Accept the default optional fields that appear on the tab, or delete them. 

When you add a new vendor record, the tab displays optional fields that are set up for automatic 
insertion in vendor group and vendor records, along with their default values.
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 l Assign different optional fields that are set up for vendors and vendor groups.

If you assign the same optional fields to the vendor as you assigned to the vendor group, values from 
the vendor group record appear as defaults. Otherwise, the default values from the optional field record 
appear.

 l Accept or change any default values that appear.

Note: If an optional field requires validation, you can select only a value that is assigned to the 
optional field in Common Services. (If the optional field allows blanks, you can leave the default value 
field blank.)

For more information about optional fields and how they are used in Accounts Payable, see "About 
Accounts Payable Optional Fields" (page 30).

Processing Tab

Use the Processing tab to:

 l Select the vendors account set, which identifies the general ledger accounts to which to post 
transactions for the vendor. 

In multicurrency ledgers, the account set also determines the vendor's currency.

 l Select the terms code to enter with invoices from the vendor.

 l Select the bank code from which you usually issue checks to the vendor.

 l Specify whether to generate separate checks for each invoice, or create a single check to cover all 
outstanding invoices, when you create payments automatically for the vendor.

 l Enter the credit limit the vendor allows your company.

 l Select the rate type to use for converting transactions for the vendor to the functional currency (in 
multicurrency ledgers).

Statistics Tab

Important! If you are entering statistics as part of the setup of your Accounts Payable ledger, do not 
include amounts you will post for the vendors when you enter historical and year-to-date Accounts 
Payable transactions. If you do, the amounts will be added twice to the statistics.

Use the Statistics tab to:
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 l List the following information for each period in the year you select:

 l Number and amount of all transactions processed for the vendor.

 l Total days to pay and average days to pay for the vendor.

 l List the following information for each year for which you have statistical data:

 l Number and amount of all transactions processed for the vendor.

 l Total days to pay and average days to pay for the vendor.

 l Change statistical information (if the Allow Edit Of (vendor) Statistics option is selected on the 
Processing tab of the A/P Options screen).

Fields and Controls

Activity Tab

Accounts Payable automatically updates information on this tab as you post transactions to the account. 

Amount

The Amount column lists the total amount of each of the transaction types in the left column.

You can edit the amounts if the Allow Edit Of (vendor) Statistics option is selected on the Processing 
tab of the A/P Options screen. Use the arrow keys on your keyboard to move from field to field.

Average Days to Pay

This field displays the average number of days it has taken your company to pay all the vendor's 
invoices that have been fully paid in the current year. 

The figure is calculated by dividing the Total Days To Pay figure by the Total Invoices Paid figure. You 
can alter this number only by editing the other two figures.

Currency

If you use multicurrency accounting, you use the Currency field to select the currency in which to 
display statistical totals.

In a multicurrency system, activity statistics are recorded in the vendor's currency as well as in their 
equivalent values in the functional currency. You can choose whether to view or edit statistics in the 
vendor currency or the functional currency.

522Sage 300 2023 Accounts Payable User's Guide



If you select Vendor in this field, Accounts Payable displays the vendor's currency code and description 
in the adjacent fields.

Date

The Date column lists the date each type of transaction (shown in the corresponding left column) was 
posted to the vendor's account.

Accounts Payable updates these dates when you post transactions to the vendor's account. You can 
edit the dates if the Allow Edit Of (vendor) Statistics option is selected on the Processing tab of the 
A/P Options screen.

Number of Payments

This field lists the total number of payments that your company has sent to the vendor in the current 
year to date.

Open Invoice Count

This field shows the current number of open (unpaid) invoices in your company's account with the 
vendor. 

You cannot edit the figure.

Outstanding Balance

This field displays the current net amount owed to a vendor, including all invoices, credit notes, debit 
notes, payments and adjustments posted to the account. 

You cannot edit the figure.

Outstanding Retainage

This field shows the outstanding retainage balance for the vendor.

Prepayment Amount

This field on the Vendor Activity tab displays the total amount of outstanding prepayments that your 
company has sent to the vendor.

Prepayment Count

This field displays the number of outstanding prepayments that your company has sent to the vendor.
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Statistics

The Activity tab lists the amount and date for the following statistics: the highest balance this year and 
last year, the largest invoice this year and last year, and the last invoice, payment, credit note, debit 
note, adjustment, and discount.

Accounts Payable updates these figures each time you post transactions for the account. You can edit 
the amounts and dates of each of the transaction types if the Allow Edit Of Statistics option is selected 
on the Processing tab of the A/P Options screen.

Total Days to Pay

This is the total number of days your company has taken to pay all outstanding invoices from the vendor 
that have been fully paid in the current year to date.

Accounts Payable updates this figure when you post transactions to fully pay the vendor's invoices. You 
can also change the figure, as needed, if the Allow Edit Of (vendor) Statistics option is selected on the 
Processing tab of the A/P Options screen. For example, you may want to change the number if it has 
been inflated by unusual circumstances, and so gives an inaccurate impression of your payment record 
with the vendor.

Important! If you are entering this number when setting up vendor records, do not enter figures from 
invoices and payments that you will post for the vendor when you enter historical and year-to-date 
Accounts Payable transactions.

Total Invoices Paid

This field shows the total number of invoices that were fully paid in the current year to date.

Accounts Payable updates this figure when you post transactions to fully pay invoices in the vendor's 
account. You can also change the figure, as needed, if the Allow Edit Of (vendor) Statistics option is 
selected on the Processing tab of the A/P Options screen.

Important! If you are entering this number when setting up vendor records, do not include the 
numbers of invoices and other types of transactions you will post for the vendor when you enter 
historical and year-to-date Accounts Payable transactions.

Address Tab

Address

The address in the vendor record is usually the address to which you send payments for the account. 
You can print the address on checks, letters and labels for the vendor.
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You can also keep other addresses for the vendor, adding them in the Remit-To Locations screen.

Business Reg. No.

Enter the business registration number for the vendor. This number is required for tax purposes in some 
jurisdictions (such as Malaysia and Singapore).

City

Type the name of the city in which the vendor is located. Although you can enter the name of the city in 
other address lines, this field is more useful if you use it consistently for the city.

Country

This field contains the name of the country where the vendor's business is located. You can type up to 
30 characters in the field, including spaces.

E-mail

Enter a primary e-mail address for the vendor.

Fax

This field contains the vendor's fax number, if any, at the address.

The field contains area code parentheses and hyphens if you selected the Format Phone Number 
option on the Company Profile screen in Common Services.

Group Code

This field identifies the vendor group to which the vendor is assigned. 

Type the group code or choose it from the Finder. You must specify a vendor group for each vendor.

If you change the vendor group for an existing vendor, the settings in the existing vendor record remain 
the same, except for the group code. If you use multicurrency accounting, you can change the vendor 
group to one that uses the same currency or a different currency.

Inactive

Select this option if you do not want to post any new transactions to the vendor's account—usually 
because you plan to delete the account.
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You can select Inactive only if the account balance is zero and there are no outstanding transactions.

You can make the account active again at any time.

Last Maintained

This field displays the date of the last change made to the vendor record. 

You cannot make an entry in this field.

Legal Name

Type the legal name of your company.

Sage 300 uses this name when creating 1099 and T5018 information returns for electronic filing.

On Hold

Select this option to place a vendor account on hold. 

Accounts Payable warns you when you start to enter a transaction for a vendor whose account is on 
hold. You can then choose whether to continue entering the document.

You can always enter and post invoices, credit notes, debit notes, and payments whether a vendor 
account is on hold or not.

Short Name

You can enter a short name for the vendor in this field.

Accounts Payable automatically displays the first ten characters (including any spaces) of the vendor 
name. You can type another short name or erase the default name and leave the field blank.

Short names are a means by which you can list vendors in alphabetical order or another order on 
reports, and still include the full vendor name in the vendor record.

Start Date

In this field, record the date on which you first started to do business with the vendor.

State/Province

This field contains the name of the state or province where the vendor's business is located. You can 
type up to 30 characters in the field, including spaces.
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Telephone

This field usually contains the telephone number at the vendor's place of business.

The field contains area code parentheses and hyphens if you selected the Format Phone Number 
option on the Company Profile screen in Common Services.

Vendor Name

Use this field to record the name of the vendor, using up to 60 characters. 

Type the name in the order in which you want it to appear in Accounts Payable screens and on reports 
(for example, first name, followed by surname).

You must type a name for each vendor record before you can add the record.

Vendor Number

This field identifies the vendor in Accounts Payable.

To create a new vendor record, enter a unique code of up to 12 characters, using any combination of 
letters, digits, symbols, and spaces.

To open an existing vendor record, type its number or choose it from the Finder in the Vendor Number 
field.

Web site

This field usually contains the name of a contact person, position, or department at the vendor location. 
You can also leave the field blank or enter other information in it, using up to 100 characters.

Zip/Postal Code

Type the zip code or postal code for the vendor's address.

Comments Tab

Use a separate line on the Comments tab for each comment.

Comment

You can enter up to 2,500 characters for each comment. 
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Select (highlight) the comment line on the table, and then click the Zoom  button to view or edit a 

comment in a separate screen. To start a new line (when you reach the right side of the screen), press 
Ctrl+Enter. Or, you can type the complete comment on a single line. The text will scroll to the left when 
you reach the right margin.

Comments are printed on reports exactly as you format them on this screen. 

Date Entered

Type the comment entry date, or use the system date that is displayed.

Accounts Payable stores comments by entry date.

Expiration Date

Type the date used for marking the comment for deletion.

You use the A/P Clear History screen to remove comments that have reached their expiration dates. 
You can also delete comments individually in the Vendors screen.

Follow-Up Date

Type the date on which you want to check on the comment.

Tip: On the Vendors report, you can select comments to print by entering a range of follow-up dates.

Contact Tab

Contact

This field usually contains the name of a contact person, position, or department at the vendor location. 
You can also leave the field blank or enter other information in it, using up to 60 characters.

E-mail

Enter a secondary e-mail address for the company contact person in this field.

Fax

This field contains the fax number for the vendor's contact person.
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The field contains area code parentheses and hyphens if the Format Phone Number option is selected 
on the Company Profile screen in Common Services.

Telephone

This field usually contains the telephone number of the contact for the vendor company.

The field contains area code parentheses and hyphens if the Format Phone Number option is selected 
on the Company Profile screen in Common Services.

Multiple Contacts

If you use the Multiple Contacts (M/T) program, this section appears on the Contact tab, allowing 
you to assign multiple contacts to a vendor. For more information, see "Setting Up Multiple Contacts 
for Vendors" (page 57).

Create New Contact

Click this button to create a new contact record and assign the new contact to the vendor.

Show Documents For

This field displays All by default, and the table includes a column for each type of document that can be 
sent to contacts. If you select a specific program in this field, the table includes columns for only 
documents for the selected program.

View Contact Details

Select a contact in the table and then click this button to view and edit the contact's details.

Invoicing Tab

1099/CPRS Code

Select the 1099/CPRS code that matches the type of goods or services you purchase from this vendor.

Note: This field appears only if you selected 1099 or CPRS in the Tax Reporting field for the vendor.
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Distribute By

Select the method by which to distribute invoice amounts to general ledger accounts for invoices from 
the vendor. You can change the method for individual invoices.

You can distribute amounts by distribution code, distribution set, or general ledger account number. 
You can also select None if you prefer not to use a default distribution on invoices from this vendor. 

Tip: We suggest that you select None if you frequently purchase goods or services from this vendor 
for projects you manage using Sage 300 and Job Costing. You cannot enter job-related  details on 
invoices that contain non-project details.

Distribution Code

To distribute transactions with the vendor to a single general ledger account that is represented by a 
distribution code, select Distribution Code in the Distribute By field, and then type the distribution code 
or select it from the Finder. 

You can specify a different distribution code on individual invoices you enter from the vendor, or use 
another distribution method.

Distribution Set

To assign a distribution set (a defined group of distribution codes) as the default distribution method for 
the vendor, select Distribution Set in the Distribute By field, and then specify the distribution set. 

The distribution set appears as the default when you enter transactions for the vendor in the A/P Invoice 
Entry screen. You can use the default distribution set, select another set, or use another distribution 
method. You can also add detail lines to distribute invoice amounts to additional general ledger 
accounts that are not included in the selected distribution set.

Duplicate Invoice Checking

Specify how you want Accounts Payable to check for duplicate invoices, debit notes, and credit notes 
from this vendor.

Accounts Payable can ignore duplicates, warn you, or stop you from posting invoices that might be 
duplicates according to two criteria that you specify separately: Vendor and Amount and Vendor and 
Date.
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G/L Account

To distribute transactions to a single general ledger account, select G/L Account for the Distribute By 
option, and then type the account number or select it from the Finder.

You can specify a different general ledger account on invoices you enter for the vendor, or use another 
distribution method.

Registration Number

Type your tax registration or exemption numbers, if any.

Retainage %

You can specify on the vendor record the default percentage to use for calculating retainage on original 
documents. You can always change the retainage percentage when you enter an invoice, debit note, or 
credit note for the vendor.

When you add a new vendor record, the retainage percentage specified on the A/P Options screen 
appears as the default, but you can change the percentage for a particular vendor.

Retainage Terms

You can specify on the vendor record a default terms code to use for original documents. You can 
always change the retainage terms when you enter an invoice, debit note, or credit note for the vendor.

When you add a new vendor record, the retainage terms code specified on the A/P Options screen 
appears as the default, but you can change the code for a particular vendor.

Retention Period

You can specify on the vendor record the default retention period to use on original documents. You 
can always change the retention period when you enter an invoice, debit note, or credit note for the 
vendor.

When you add a new vendor record, the retention period specified on the A/P Options  screen appears 
as the default, but you can change the period for a particular vendor.

Tax Authority

When you select the vendor's tax group, the associated tax authorities are displayed. (Tax authorities 
are the types of taxes that you may be subject to on invoices from the vendor. For example, state and 
provincial sales taxes are tax authorities, as are GST and VAT.)
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Note: You use the Tax Services screens in Common Services to define and update tax authorities 
and enter other taxation information.

Tax Class

Select your tax class for each of the tax authorities in the tax group.

Tax classes identify the tax rates used to calculate taxes when you enter invoices, debit notes, and 
credit notes from a vendor.

Note: You use the Tax Services screens in Common Services to define and update tax classes and 
enter other taxation information.

Tax Group

Select the code for the tax group to which you belong when invoiced by this vendor. The taxing 
authorities in the group appear on the screen so you can enter tax classes for each authority.

If you use multicurrency accounting, you must select a tax group that uses the same currency as the 
vendor, and you can change a vendor's tax group only to another group that also uses the same 
currency. The Finder displays only the tax groups that use the vendor's currency.

You must assign a tax group to every vendor record. 

Note: You use the Tax Services screens in Common Services to define and update tax groups and 
enter other taxation information.

Tax Included

Specify whether this tax is typically included in the total invoice amount or listed separately.

Note: You can change the Tax Included option only if the tax authority (in Common Services) permits 
it.

Tax Number

Enter the vendor's 1099 or CPRS tax number.

This field appears only if you select 1099 or CPRS in the Tax Reporting field for the vendor. To enter or 
change information in this field, you must have security authorization to maintain tax numbers.
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Tax Number Type

Specify the type of tax number you entered in the Tax Number field.

This field appears only if you select 1099 or CPRS in the Tax Reporting field for the vendor. To enter or 
change information in this field, you must have security authorization to maintain tax numbers.

Note: The only types of tax numbers allowed for CPRS reporting are GST Registration Number, 
Social Insurance Number, or Business Number (the 15-character "RZ" account number).

Tax Reporting

This option appears in vendor records only if the Use 1099/CPRS Reporting option is selected on the 
A/P Options screen.

Select 1099, CPRS, or None, depending on the type of tax forms you are required to submit for each 
vendor, if any.

Note: If you select 1099 or CPRS, you also enter the vendor's 1099 or CPRS tax number and type, as 
well as the 1099 or CPRS code that matches the type of goods or services you purchase from the 
vendor.

Vendor and Amount

Select the method, if any, you want Accounts Payable to use to warn you when you enter two or more 
invoices for the same amount from this vendor.

Vendor and Date

Select the method, if any, you want Accounts Payable to use to warn you when you enter two or more 
invoices for the same date from this vendor.

Optional Fields Tab

When you add a new record, this tab displays any optional fields that are set up for automatic 
insertion for that type of record. If default values are defined for any of these fields, they are also 
displayed.

You can remove optional fields, and you can add optional fields that are set up for use with this 
screen. You can also change any default values.

For more information, see "About Accounts Payable Optional Fields" (page 30).
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Notes: 
 l If you use exactly the same optional fields for vendors as for invoices, the optional field 

data you enter in a vendor record appears on new invoices you enter for the vendor.

 l If the optional fields for a vendor match those used by the vendor group, values from the 
vendor group record appear as defaults. Otherwise, the default values from the optional 
field record are used.

Processing Tab

Account Set

Accounts Payable displays the account set assigned to the vendor group as the default for a new 
vendor, but you can change it.

Note: Multicurrency account sets identify the vendor's currency and general ledger exchange gain 
and loss accounts. You can change the account set for a multicurrency vendor only to another set 
that uses the same currency.

To assign an account set to a vendor, type its code in this field, or use the Finder to select the code.

The account set specifies the general ledger payables control, purchase discounts, and prepayment 
accounts to which a vendor's transactions are distributed.

If you change a vendor's group, the new group's account set replaces the set in the vendor record, but 
you can select another account set if you do not want to use the group set.

Bank Code

Type the code for the bank from which you normally issue checks to the vendor, or select the code from 
the Finder.

Check Language

Select the language in which you print checks for a vendor. 

The language you select is used only for the check amount when it is written out.

Credit Limit

Use this field to enter the credit limit the vendor allows your company.
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In multicurrency ledgers, you enter the credit limit amount in the vendor's currency.

Currency

If you have a multicurrency ledger, the vendor's currency is displayed when you select the account set. 
You enter all invoices, credit notes, and debit notes from the vendor in this currency, but you can pay in 
any currency the vendor accepts.

Delivery Method

Specify how purchase orders, returns, and letters are delivered to the vendor:

 l Mail. Print to your usual print destination.

 l Email (vendor). Print to a file and email the file to the email address specified for the vendor on 
the Address tab.

 l Email (contact). Print to a file and email the file to the contact email address specified for the 
vendor on the Contact tab.

 l Email (multiple contacts). If you use the Multiple Contacts (M/T) program, you can use this 
delivery method to print to a file and email the file to all the contact email addresses specified for 
the vendor in the Multiple Contacts section on the Contact tab.

Note: If you select Vendor as the delivery method when printing purchase orders or returns, the 
program uses the delivery method specified in the vendor record.

Generate Separate Payments for Each Invoice

Select this option if you want Accounts Payable to generate separate checks for each invoice when you 
process payments automatically.

If you do not select the option, Accounts Payable creates a single check to cover the total outstanding 
amount of all invoices from the vendor each time you process payments for the vendor.

Payment Code

On the Vendor Group record, you use this field to specify the default payment code for new vendors you 
add to the vendor group.

You can change the payment code for a vendor in the vendor record. When you process a new 
payment for the vendor, the code specified on the vendor record appears as the default payment code.
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Rate Type

For multicurrency vendors who do not use the functional currency, you specify the default rate type to 
use to convert transactions into the functional currency. 

You can change the rate type when you enter transactions for the vendor, if necessary.

To specify the rate type, type its code or use the Finder to select it. 

Note: You must specify a rate type that is defined for the company in the Currency screens in 
Common Services.

Terms Code

Type the terms code to use in this field, or use the Finder to select it. 

You must assign a terms code to every vendor and vendor group. 

Terms codes determine invoice due dates, set discount rates and periods, calculate discount bases, 
and specify the number of payments in multiple payment schedules. 

You can select any valid terms code when entering invoices from a vendor.

Accounts Payable displays the terms code from the vendor group when you create a new vendor 
record, but you can change the code. 

If you change a vendor's group, the new group's terms code replaces the previous group's code in the 
vendor record, but you can change it again, if necessary.

Statistics Tab

Currency

If you use multicurrency accounting, you use the Currency field to select the currency in which to 
display statistical totals.

In a multicurrency system, period statistics are recorded in the vendor's currency as well as in their 
equivalent values in the functional currency. You can choose whether to view or edit statistics in the 
vendor currency or the functional currency.

If you select Vendor in this field, Accounts Payable displays the vendor's currency code and description 
in the adjacent fields.
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Year

Type or select the year for which you want to enter or view statistics.

The type of year by which you keep statistics is determined by the selection for the Accumulate By field 
on the Processing tab of the A/P Options screen.

Tables

Adjustment Amount

Enter the total amount of the adjustments that were processed for the account during the statistical 
period or year.

Adjustment Count

Enter the total number of adjustments that were processed for the account during the statistical period 
or year.

Average Days to Pay (Period Statistics table)

Accounts Payable keeps track of the average number of days it takes your company to pay each 
invoice from a vendor,  and displays the figure in this field. You cannot change the figure.

Note: The Statistics tab on the Vendor Groups screen displays a similar statistic for all vendors in the 
group.

The figure for each period is calculated by dividing the total number of days it took to pay the invoices 
that were fully paid in the period by the number of invoices that your company received from the vendor, 
both in the displayed period and in prior periods.

Average Days to Pay (Year Statistics table)

Accounts Payable keeps track of the average number of days you take to pay each vendor invoice, and 
displays the average for the year in this field. You cannot change this figure.

Credit Amount

Enter the total amount of the credit notes that were processed for the account during the statistical 
period or year.
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Credit Count

Enter the total number of credit notes that were processed for the account during the statistical period 
or year.

Days to Pay (Period Statistics table)

Accounts Payable records the length of time it takes your company to fully pay each invoice from a 
particular vendor, and displays the total in this field.

Note: The Statistics tab on the Vendor Groups screen displays a similar statistic for all vendors in the 
group.

The total that appears for a period is the number of days it took to pay all the invoices that were paid in 
full during the selected period.

You can edit this total, as needed, if the Allow Edit Of (vendor) Statistics option is selected on the 
Processing tab of the A/P Options screen.

Days to Pay (Year Statistics table)

This is the total number of days you have taken to fully pay all outstanding invoices for this vendor in the 
year.

Accounts Payable updates this figure when you post transactions to fully pay the vendor's invoices. 
You cannot change this figure.

Debit Amount

Enter the total amount of the debit notes that were processed for the account during the statistical 
period or year.

Debit Count

Enter the total number of debit notes that were processed for the account during the statistical period or 
year.

Discount Lost Amount

Enter the total amount of the discounts lost that were processed for the account during the statistical 
period or year.
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Discount Lost Count

Enter the total number of discounts lost that were processed for the account during the statistical period 
or year.

Discount Taken Amount

Enter the total amount of the discounts taken that were processed for the account during the statistical 
period or year.

Discount Taken Count

Enter the total number of discounts taken that were processed for the account during the statistical 
period or year.

Invoice Amount

Enter the total amount of the invoices that were processed for the account during the statistical period 
or year.

Invoice Count

Enter the total number of invoices that were processed for the account during the statistical period or 
year.

Payment Amount

Enter the total amount of the payments that were processed for the account during the statistical period 
or year.

Payment Count

Enter the total number of payments that were processed for the account during the statistical period or 
year.

Period

Displays the periods for the year you specify in the Year field for the Period Statistics table.

The selection for the Period Type option on the Processing tab of the A/P Options screen determines 
the type of period for which Accounts Payable accumulates statistics. (The period type can be weekly, 
seven days, bi-weekly, four weeks, monthly, bi-monthly, quarterly, semi-annually, or fiscal period.)
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Total Invoice Paid Amount

Enter the total amount of the invoices paid that were processed for the account during the statistical 
period or year.

Total Invoice Paid Count

Enter the total number of invoices paid that were processed for the account during the statistical period 
or year.

Year

Displays each year for which you have statistical data.

Vendor Reports Screens
Use the screens in the A/P Vendor Reports folder to print lists of vendors, vendor groups, remit-to 
locations, and recurring payables in your Accounts Payable system, as well as letters and labels for 
vendors.

Note: If the Use 1099/CPRS Reporting option is selected on the A/P Options screen, you can print 
1099/1096 and T5018 (CPRS) amounts in the required formats.

You can also print statistics reports for vendor groups and vendors.

A/P Print 1099/1096 Forms Screen

Note: To use this screen, you must have security authorization to maintain tax numbers.

To Open this Screen

Open Accounts Payable > A/P Vendor Reports > Print 1099/1096 Forms.

Related Tasks

 l "Printing 1099/1096 Forms" (page 274)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

If the Use 1099/CPRS Reporting option is selected on the A/P Options screen, you can use Accounts 
Payable to track payments to vendors who are subject to 1099 reporting.

You can print this data on official forms—1099-MISC, 1099-NEC, or 1096—for vendors for which 1099 is 
selected for the Tax Reporting option in the vendor record.

Sage 300 Accounts Payable comes with sample 1099 and 1096 formats, designed for laser printers. The 
formats were valid at the time this program was released. If the forms change, you can update the report 
formats using Crystal Reports.

Printing Alignment Copies

To print a test copy of a 1099 or 1096 form to check the alignment of the forms in your printer, click the 
Align button. You can repeat this step as often as needed when the printing destination is set to Printer.

When to Print

Print 1099 and 1096 forms at the end of each calendar year, after you have entered all transactions for 
the calendar year.

Information Printed on This Report

The sample 1099 form includes the following information:

 l Your company name, address, and identification number.

 l The vendor name, address, and identification number.

 l The 1099 payments to the vendor in the calendar year.

 l A summary that contains the information you need to complete Form 1096 (required when filing 
1099 forms).

A/P Print T5018 (CPRS) Forms Screen

Note: To use this screen, you must have security authorization to maintain tax numbers.

To Open this Screen

Open Accounts Payable > A/P Vendor Reports >        Print T5018 (CPRS) Forms.
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Related Tasks

 l "Printing T5018 (CPRS) Forms" (page 276)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

If the Use 1099/CPRS Reporting option is selected on the A/P Options screen, you can use Accounts 
Payable to track payments to vendors who are subject to CPRS reporting.

To print this data, you must select CPRS for the Tax Reporting option in the vendor record.

You can print the data on an official CPRS form, or you can print on plain paper. To print on plain paper, 
you need a file for printing the entire form (instead of only the data). For more information and to get the 
file, see Knowledgebase article 102399.

Accounts Payable comes with a sample T5018 (APCPRS.rpt) format, designed for laser printers. (The 
format was valid at the time this program was released. If the form changes, you can update the report 
formats using Crystal Reports.)

When to Print

Print T5018 (CPRS) forms at the end of each calendar year, after you have entered all transactions for 
the calendar year.

Information Printed on This Report

The sample T5018 (CPRS) form includes the following information:

 l Your company name, address, and tax number (TIN/SSN).

 l The vendor name, address, and tax number (TIN/SSN).

 l The CPRS payments you made to the vendor in the calendar year.

 l Only standard codes are printed on the stock T5018 (CPRS) Amounts report.
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A/P Letters and Labels Screen

To Open this Screen

Open Accounts Payable > A/P Vendor Reports >        Letters / Labels.

Related Tasks

 l "Printing Letters and Labels" (page 277)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Letters and labels contain the information you specify for them in the report format you choose to print. 
You can print letters and labels for the individual vendors in your Accounts Payable system.

If you use optional fields as selection criteria when printing the report, you can specify the ranges of 
values from which to select records for printing. The report then includes only vendors that use the 
specified optional fields, whose values fall within the specified range.

If you select Vendor as the delivery method when printing letters, Accounts Payable prints the letters 
according to the delivery method specified in the individual vendor records. You can then specify the 
code for the message to send with e-mailed letters. 

When to Print

Print letters and labels for your vendors whenever you need to communicate formally with them. For 
example, you might want to send covering letters to your vendors with your payments.

Information Printed on This Report

Letters and labels can include the following types of information:

 l Your company's name, address, telephone numbers, and contact person.

 l The vendor's name and address, from the vendor account or at the remit-to location.
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You can use Crystal Reports (available separately) to adapt the report format that comes with Accounts 
Payable to suit your own needs.

A/P Recurring Payables Report Screen

To Open this Screen

Open Accounts Payable > A/P Vendor Reports >        Recurring Payables.

Related Tasks

 l "Printing the Recurring Payables Report" (page 279)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Recurring Payables Report lists your recurring payable records by recurring payable code.

When to Print

Print the Recurring Payables report whenever you need a listing of the recurring payables set up in 
Accounts Payable.

Information Printed on This Report

Information is printed for each recurring payable record included in the report, as follows:

 l Details from the Document tab, including: the vendor, schedule code, start date, expiration type, 
expiration date or maximum amount or number of invoices, the next invoice date, the date the recurring 
payable became inactive (if the record is inactive), the date the record was last changed (maintained), 
the maximum amount, the vendor’s currency and the rate type, remit-to location, description of the 
recurring payable, the vendor’s tax group, the method of tax calculation, as well as the purchase order 
and (sales) order number.

It also shows the distribution code, description, general ledger account and description, the amount of 
each detail, as well as tax amounts (if entered manually), and the invoice total.

 l If you select the Show Schedules option for the report, the schedule code, the date the schedule 
was last processed, the recurring period, and the frequency.

 l If you select the Optional Fields option for the report, any optional fields assigned to the recurring 
payable, along with the optional field values.
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A/P Remit-To Locations Report Screen

To Open this Screen

Open Accounts Payable > A/P Vendor Reports >        Remit-To Locations.

Related Tasks

 l "Printing the Remit-To Locations Report" (page 280)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Remit-To Locations report lists the remit-to locations (alternate addresses) used by your vendors.

The report also identifies primary remit-to locations.

When to Print

Print the report when you add, change, or delete remit‐to locations.

Information Printed on This Report

Information printed for each vendor listed on this report includes:

 l If you select the Address option for the report, the vendor name, address, telephone and fax 
numbers, check language, and contact.

 l If you select the Optional Fields option for the report, any optional fields assigned to the location.

A/P Vendor Activity Statistics Report Screen

To Open this Screen

 1. Open Accounts Payable > A/P Vendor Reports >        Vendors.

 2. Select Vendor Activity Statistics as the report type.
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Related Tasks

 l "Printing Vendor Activity Statistics Reports" (page 281)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Vendor Activity Statistics report lists information about the purchases and payment history for the 
current year to date and previous fiscal year for the vendor records in your Accounts Payable system. 

Note: Most of the information on this report is also available on the Vendor Activity tab of the Vendors 
screen.

When to Print

Print the report when you need to check on vendor account activity, such as the last time you made a 
purchase from the vendor, the date and amount of your last payment to the vendor, the average number 
of days it takes you to pay the vendor, or the date a vendor’s balance was last revalued (if you have a 
multicurrency Accounts Payable system).

Information Printed on This Report

Information included on this report includes:

 l Outstanding balance, number of invoices in the system, number of paid invoices, the total days to 
pay invoices, and the average number of days to pay.

 l Last posting date.

 l The date and amount of the last invoice, credit note, debit note, payment, discount, and 
adjustment posted to the account.

 l The amount and date of the largest invoice and balance in the account in the current year and 
previous year.

In multicurrency ledgers, you can print report amounts in the functional currency or the vendor's currency.
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A/P Vendor Period Statistics Report Screen

To Open this Screen

 1. Open Accounts Payable > A/P Vendor Reports >        Vendors.

 2. Select Vendor Period Statistics as the report type.

Related Tasks

 l "Printing the Vendor Period Statistics Report" (page 283)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

This report lists the total amount of amount of invoices, payments, discounts taken, discounts lost, credit 
and debit notes, and adjustments you have recorded for a given vendor during the period covered by the 
report, as well as the total number of invoices paid during that period. 

Note: The reports list statistics for the type of year and period specified on the A/P Options screen.

The information on this report is also available on the Vendor Statistics tab of the Vendors screen.

When to Print

Print the report when you need a summary of vendor statistics (for example, at the end of each period).

Information Printed on This Report

 l The totals for each type of transaction in the years and periods selected for the report.

 l If selected for the report, the number of each type of transaction (document) posted in the selected 
years and periods.

 l Totals for all periods by vendor.
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A/P Vendor Group Statistics Report Screen

To Open this Screen

 1. Open Accounts Payable > A/P Vendor Reports >                Vendor Groups.

 2. Select Vendor Group Statistics as the report type.

Related Tasks

 l "Printing the Vendor Group Period Statistics Report" (page 284)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

This report lists the total amount of invoices, payments, discounts taken, discounts lost, credit and debit 
notes, and adjustments you have recorded for a given vendor group during the period covered by the 
report, as well as the total number of invoices paid during that period. 

Note: The information on this report is also available on the Group Statistics tab of the Vendor Groups 
screen.

The reports list statistics for the type of year and period specified on the A/P Options screen.

When to Print

Print the report when you need a summary of statistics, such as at the end of each reporting period.

Information Printed on This Report

The report includes the following information:

 l The totals for each type of transaction in the years and periods selected for the report.

 l If selected for the report, the number of each type of transaction (document) posted in the selected 
years and periods.

 l Totals for all periods by vendor group.
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A/P Vendor Group List Screen

To Open this Screen

Open Accounts Payable > A/P Vendor Reports >        Vendor Groups.

Related Tasks

 l "Printing the Vendor Group List" (page 282)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

The Vendor Group List reports the information entered for each vendor group used in your Accounts 
Payable system. The report can also include a list of the vendors who are assigned to each group.

When to Print

Print the report when you add, change, or delete vendor groups.

Information Printed on This Report

 l If you select the Profile option for the report, the report lists for each vendor group on the report:

 l The group's account set and bank code.

 l The code or account number specified for the Distribute By option in the vendor group 
record (distribution code, distribution set, or G/L account).

 l The tax group and related tax authorities and tax classes.

 l Selections for the Duplicate Invoice Checking and Generate Separate Payment For Each 
Invoice options in the vendor group record.

 l If you select the Optional Fields option for the report, the optional fields used in each vendor group 
record (if any).

 l The group's currency code (in multicurrency ledgers).

 l If you select the Group Members option for the report, the report includes the vendor number, 
name, telephone number, and contact person for each of the member vendors, for quick 
reference.
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A/P Vendors Screen

To Open this Screen

Open Accounts Payable > A/P Vendor Reports >        Vendors.

Related Tasks

 l "Printing the Vendors List" (page 285)

 l "Selecting a Print Destination" (page 222)

 l "Selecting a Printer for Reports" (page 223)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Vendors report lists the information entered for the vendor records in your Accounts Payable system.

When to Print

Print the report when you add, change, or delete vendor records.

Information Printed on This Report

 l If you select the Address option for the report, the vendor's address, short name, telephone and 
fax numbers, and contact.

 l If you select the Profile option for the report:

 l The vendor's group, account set, terms code, bank code, credit limit, check language, start 
date, and business registration number.

 l The primary remit-to location, if any.

 l The code or account number specified for the Distribute By option in the vendor record 
(distribution code, distribution set, or G/L account).

 l The tax group and related tax authorities, classes, and registration numbers.

 l If you select the Show Tax Numbers option, the tax number (such as an SSN or SIN 
number) specified in the vendor record.
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 l The selections for the Duplicate Invoice Checking and Generate Separate Payment For Each 
Invoice options in the vendor record.

 l The vendor's currency code (in multicurrency ledgers).

 l If you select the Comments option, any comments and dates entered in the vendor record (for 
comments entered with follow-up dates in the specified range).

 l If you select the Optional Fields option, any optional fields used in the vendor records.
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Appendix B: Accounts Payable Security 
Authorizations

If security is turned on for your Sage 300     system,     the system administrator must assign users security 
authorization for Accounts Payable screens.

For information on turning on security, setting up security groups, and assigning authorizations, refer to 
the System Manager help.

Note: To change the print destination for forms and reports, you must have Change Print Destination 
security authorization for Administrative Services.

To view records and to print reports in Accounts Payable, you must belong to a security group with 
Common Inquiry authorization. Common Inquiry authorization by itself does not let you edit any Accounts 
Payable records.

To edit records or perform processing tasks, the system administrator must grant the group access to 
additional tasks from the following list:

Security 
Authorization

Description

Common 
Inquiry

View records and print reports for Vendor Groups, Vendors, and Remit-to 
Locations.
View setup records and print setup reports.

Common Inquiry is automatically assigned with any other type of authorization, 
except:

 l Import Processing

 l Export Processing

 l Transaction Optional Fields

 l Set Ready To Post (for any type of batch)

 l Check Printing

Accounts Payable Security Authorizations
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Security 
Authorization

Description

Setup 
Maintenance

Update and print setup choices and records using the A/P Options, Account 
Sets, 1099/CPRS Codes, Distribution Codes, Distribution Sets, Terms, 
G/L Integration, Payment Codes, E-mail Messages, and Optional Fields 
screens.

Control 
Payments

Process payment controls using the Control Payments screen.

Vendor 
Maintenance

Update records for Vendor Groups, Vendors, Remit To Locations, and 1099/CPRS 
Amounts (if the Allow Edit of 1099/CPRS Amounts option is selected on the 
A/P Options screen).
Add or delete optional fields for vendor groups, vendors, and remit-to locations.

Vendor 
Analysis

View vendor information in Vendor Activity.
Use the 1099 Electronic Filing screen.
Print Vendor Transactions, Aged Payables, Aged Cash Requirements, Aged 
Retainage, 1099/CPRS Amounts, and Letters/Labels.

Invoice Batch 
Inquiry

View and print transactions in the Invoice Batch List and Invoice Entry screens.
View and print recurring payables records.
View records in the 1099/CPRS Amounts screens.
View invoice records in the Vendor Activity screen.
Print transaction reports for invoices from the Batch Listing, Batch Status, Posting 
Journals and Posting Errors, and transaction entry screens.
Use the 1099 Electronic Filing screen.

Invoice Batch 
Entry

The same rights as Invoice Batch Inquiry, plus:

 l Create, edit, and delete transactions using the Invoice Batch List and Invoice 
Entry screens.

 l Create, edit, and delete records using the Recurring Payables setup screen, 
and create batches of recurring payable invoices using the Create Recurring 
Payable Batch screen.

 l Create batches of retainage documents using the Create Retainage Batch 
screen.

If you also have Payment Entry authorization, enter prepayments in Invoice Entry.
If you also have Set Invoice Batch Ready To Post authorization, set batches ready 
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Security 
Authorization

Description

to post on the Invoice Batch List screen.

Invoice Batch 
Posting

The same rights as Invoice Batch Inquiry, plus:

 l Post invoice batches using the Invoice Batch List and Post Batches screens.

 l Send transactions to the General Ledger automatically, if the Create 
G/L Batches During Posting option is selected on the A/P Options screen.

If you also have Set Invoice Batch Ready To Post authorization, set batches ready 
to post on the Invoice Batch List screen.

Set Invoice 
Batch Ready 
To Post

If you also have Invoice Batch Entry or Invoice Batch Posting authorization, set 
invoice batches ready to post on the Invoice Batch List screen.

Payment Batch 
Inquiry

View and print transactions using the Payment Batch List, Payment Entry, Payment 
Inquiry, and Check Register screens.
View payment records on the Vendor Activity screen.
Print transaction reports for payments using the Batch Listing, Batch Status, 
Posting Journals, Posting Errors, and G/L Transactions screens.
Use the 1099 Electronic Filing screen.

Payment Batch 
Entry

The same rights as Payment Batch Inquiry, plus:

 l Create, edit, and delete transactions using the Payment Batch List and 
Payment Entry screens.

 l Create payment batches automatically using the Create Payment Batch 
screen.

 l Create, edit, and delete payment selection codes.

Print transaction reports for payments using the Batch Listing, Batch Status, Check 
Register, and G/L Transactions screens.
If you also have Set Payment Batch Ready To Post authorization, set batches 
ready to post on the Payment Batch List screen.

Payment Batch 
Posting

The same rights as Payment Inquiry, plus post payment batches using the 
Payment Batch List and Post Batches screens.
Send payment transactions to the general ledger automatically, if the Create 
G/L Batches During Posting option is selected on the A/P Options screen.
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Security 
Authorization

Description

If you also have Set Payment Batch Ready To Post authorization, set batches 
ready to post on the Payment Batch List screen.

Note: You cannot set a payment batch Ready To Post if it contains unprinted 
checks. You require Check Printing authorization to print the checks.

Check Printing Print checks using the Payment Entry and the Payment Batch List screens.

Note: You also require Payment Inquiry, Payment Entry, or Payment Posting 
authorization to print checks.

Set Payment 
Batch Ready 
To Post

If you also have Payment Batch Entry or Payment Batch Posting authorization, 
set payment batches ready to post.

Adjustment 
Batch Inquiry

View transactions and print reports using the Adjustment Batch List and 
Adjustment Entry screens.
Print transaction reports for adjustments using the Batch Listing, Batch Status, 
Posting Journals, Posting Errors, and G/L Transactions screens.
Use the 1099 Electronic Filing screen.

Adjustment 
Batch Entry

The same rights as Adjustment Batch Inquiry, plus create, edit, and delete 
transactions in the Adjustment Batch List and Adjustment Entry screens.
If you also have Set Adjustment Batch Ready To Post authorization, set batches 
ready to post on the Adjustment Batch List.

Adjustment 
Batch Posting

The same rights as Adjustment Batch Inquiry, plus post adjustment batches using 
the Adjustment Batch List and Post Batches screens.
Send transactions to the General Ledger automatically, if the Create G/L Batches 
During Posting option is selected on the A/P Options screen.
Use the 1099 Electronic Filing screen.
If you also have Set Adjustment Batch Ready To Post authorization, set batches 
ready to post on the Adjustment Batch List screen.

Set Adjustment 
Batch Ready 
To Post

If you also have Adjustment Batch Entry or Adjustment Batch Posting 
authorization, set adjustment batches ready to post on the Adjustment Batch 
List screen.

Transaction View vendor information on the Vendor Activity screen and the inquiry screens.
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Security 
Authorization

Description

History Inquiry Use the 1099 Electronic Filing screen.

Transaction 
Optional Fields

Add or delete optional fields on the Invoice Entry, Payment Entry, Adjustment 
Entry screens, and other Accounts Payable screens that create transactions 
automatically.

Clear History / 
Records / Stats

Do periodic processing using the Clear History, Clear Statistics, and Delete 
Inactive Records screens.
View and print vendor and setup records.

Period End 
Maintenance

Do periodic processing using the Create G/L Batch and Revaluation screens.
Print revaluation transactions using the Posting Journals and G/L Transactions 
screens.

Year End 
Maintenance

Do periodic processing using the Year End screen.

Import 
Processing

Import records using the File menu.

Note: You also require update authorization for the types of records you want to 
import. For example, to import vendor records, you need both Import Processing 
and Vendor Maintenance authorizations.

Export 
Processing

Export setup, vendor, and transaction records, using the File menu.
You also require Inquiry authorization for the types of records you want to export. 
For example, to export payment records, you need both Export Processing and 
Payment Inquiry authorization.

Vendor 
Developer 
Inquiry

This authorization supports the Inquiry feature in web screens.
Developers of third-party programs, including macros, need to incorporate this 
resource in their security structures.

Sage 300 
Inquiry

Query Accounts Payable data in web screens.
If you also have Export Processing authorization for Accounts Payable, print or 
export the results of these queries.

Sage 300 Web 
API

Use the Sage 300 Web API to process GET, POST, PUT, PATCH, and DELETE 
requests.
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Security 
Authorization

Description

Note: You must also have authorization to view and/or modify any records or 
transactions for which API requests will be processed.

Tax Number 
Maintenance

Enter and change tax numbers (such as SSN and SIN numbers).
View full (unmasked) tax numbers.
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Appendix C: Data Entry Tools, Tips, and 
Shortcuts

Use these tools and tips to speed up data entry in Sage 300.

Menu Commands
The following commands appear on the File, Settings (when available), and Help menus on Sage 300 
screens.

Note: Menu names and commands may differ by screen.

File Menu

Command Description Notes

Close Closes the current screen. You can also press Alt+F4 to close a screen.

Customize Lets you hide or display 
fields for users by UI Profile 
ID. 

Click File > Customize to hide fields on an open 
screen for users assigned to a UI Profile ID for that 
screen. 
When these fields are hidden, data that would normally 
appear in these fields cannot be printed.
For more information, see the help for the UI Profile 
Maintenance screen in the System Manager help.

Export Exports data records to 
other Sage 300 databases 
and non-Sage 300 
programs.

Click File > Export to export data. 
For example, you could export purchase statistics for 
use in spreadsheet or database software.

Note: You cannot export serial or lot numbers for kit 
components.

Import Imports data records from 
other databases and from 

Click File > Import to import data.
For example, you could use a spreadsheet to enter 

File Menu Commands
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Command Description Notes

non-Sage 300 programs. current requisitions         or purchase orders when setting 
up your system, and then import        the transactions later.

Note: You cannot import serial or lot numbers for kit 
components.

Print Prints the current report, list, 
or screen.

On screens with a corresponding report, click File > 
Print to open the report screen, which you use to 
select report options (if applicable) before printing the 
report.

Print Setup Selects a printer and sets 
printing options. 

Click File > Print Setup to set up your printer. You can 
select the default printer or select another from the list 
of installed printers.
For more information about print options, refer to your 
operating system documentation.

Save Saves the entries or 
changes you have made to 
the current screen.

If you have just entered a new record, Add appears 
instead of Save.

Settings Menu

Command Description Notes

Auto Clear Creates a new entry 
automatically when you post 
a transaction. 

Use the Auto Clear option to streamline data 
entry in transaction entry screens.

 l If Auto Clear is turned on, all fields are 
cleared each time you post a transaction, 
allowing you to immediately begin entering 
another transaction. 

 l If Auto Clear is turned off, transaction 
information remains on the screen after you 
post it. Click the New button to begin 
entering another transaction. 

Quick Mode If you select Quick Mode, 
when you start a new entry 
or detail, fields from the 

This command is available for Invoice Entry. 
When you click Quick Mode on the Settings 
menu, a separate screen appears that lets you 

Settings Menu Commands
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Command Description Notes

previous transaction or 
detail are copied to the new 
transaction or detail, so you 
don’t have to re-enter them.

select Quick Mode settings:

 l To copy header fields to new transactions 
in the batch you are working on, select 
Quick Mode For Entries, and then specify 
the entry fields you want to copy.

 l To copy detail fields to new details in the 
transaction you are working on, select 
Quick Mode For Lines, and then specify 
the detail fields you want to copy.

Clear Saved 
Settings

Restores default settings for 
a report.

This command is available for screens and for 
some reports.

Save Settings as 
Defaults

Saves the current report 
settings as personal 
defaults.

This command is available for screens and for 
some reports.

Help Menu

Command Description

About Displays version and copyright information for the current screen and program.

Contents Opens Help.

Using Help Opens Help to an introductory topic on how to use Help.

Help Menu Commands

Data Entry Tools and Shortcuts
Use these tools and shortcuts to speed up data entry in Sage 300.

Tool Shortcut 
Key

Description

 Alt + A Add or save a new record.

Calendar F4 Display the calendar for a date field.

Data Entry Tools and Shortcuts
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Tool Shortcut 
Key

Description

or 
Alt + Down 
Arrow

 Alt + C 
or 
Alt + F4

Close a screen or dialog box

 Del or 
Alt + D

Delete the selected row or record.

Drilldown n/a The Drilldown  button appears beside some data entry fields and in 

some column headings in transaction detail entry tables. Click it to 
view details of the record or transaction in the corresponding field. More...

You can "drill down" both within Sage 300 programs and between 
separate programs. For example, you can drill down:

 l From General Ledger transactions to original transaction 
entries.

 l From Accounts Receivable to Order Entry.

 l From Accounts Payable to Purchase Orders.

 l From one transaction to an originating transaction (such as from 
a credit note to the invoice) within a program.

 Alt + E Open the Set Criteria dialog box to filter the list of records to display 
in the Finder.

Finder F5 The Finder  appears in some data entry fields, and in some table 

headings in transaction entry screens. Click it when you want to look 
up records you can select for a field. More...
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Tool Shortcut 
Key

Description

Use the Finder to search lists of codes maintained in         or used by Sage 
300 programs (such as document numbers, terms codes, and account 
set codes). You can use menu commands in the Finder to help you 
search, as follows:

 l On the Settings menu, select  Color options to          highlight a field 
using color for the text or for the background.

 l On the Settings menu, select Field Name as Column           Heading 
to use field descriptions or internal field names          as column 
headings.

 l On the Settings menu, use Columns options to specify columns 
that appear in the table. 

 l On the Global Settings menu, select the Go to Filter First option 
if you want the Finder to display the same filter settings you 
specified on the Find By list the next time you search this type of 
record.

You can also use the Auto Search option to locate a record quickly          in 
a long list. To do this, select Auto Search and the criteria by which          you 
want to search, and then begin typing the characters that start or are 
contained         in the field you are searching on.

Note: Records that appear in the Finder are restricted by          any 
selection criteria          you apply to this field.  If you cannot find the record 
you are          looking for with the Finder or the navigation buttons, check 
the Finder          to see whether any criteria are being used to limit the 
selection. If         necessary, remove the selection criteria. (For more 
information, see "Setting Finder Criteria" (page 565))

Tip: For additional instructions on using the Finder to select records, 
press F1 when the Finder screen appears.

Go F7 The Go  button appears on screens where you must enter 

information (such as filter criteria) before viewing records that match 
the information you enter. More...

For example, on some Statistics and Inquiries screens, you must 
select a range of years and periods and specify an item number or 
vendor number before you can view statistics. (If you use 
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Tool Shortcut 
Key

Description

multicurrency accounting, you must also specify a currency.) After 

specifying this information, you click the Go  button or press F7 to 

view statistics.

Navigation n/a Click the Previous and Next buttons to navigate through a list of 
existing records, or click the First and Last buttons to navigate to the 
first and last records. More...

Note: If you clicked the Set Criteria button on the Finder screen and 
specified criteria, only records that match the criteria you specified 
will appear when you use the navigation buttons. If a record does 
not appear, click the Finder  and check to see whether you have 
specified criteria that prevent the record from appearing.

New n/a Click the New  button or select New from a menu to begin creating 

a new record.

 Alt + S Save changes to the displayed record.

Zoom F9 Click the Zoom  button  or press the F9 key to view or enter 

supplementary information        for a transaction detail or for a field. More...

In any detail entry table, you can select a detail line and press F9 to 
open a screen that displays all the fields for a single detail,          including 
additional tax-related fields that do not appear on the detail          table. You 
can edit existing details, and even add new details for         the document.
Beside any field that displays a Zoom button, you can click the button (         
or select the field and then press F9) to open          a separate screen where 
you can view and enter supplementary information specific         to that 
field. 

Note: If another Zoom button appears on the detail screen, you can 
click it or press Shift+F9 to open the new detail screen. (If you simply 
press F9 again, the first detail screen closes.) This function is 
referred to as "Detail Zoom." To close the second detail screen, 
press Shift+F9 again.

After viewing or editing the information in the detail screen, you can 
press F9 to close the screen.
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Working with Detail Entry Tables
The first tab of each transaction entry screen in Sage 300 contains    a detail entry table that shows the 
document details in tabular format.

In most cases, you can enter all the necessary details for a document    right on the table.

Tip: If there are more columns than can be displayed at one time, you can     use the horizontal scroll bar 
at the bottom of a list to view the additional     columns. You can also rearrange the order of columns, or 
change column    widths, consistent with how you enter data. 

You can also view and edit all the fields for a single detail on a separate    Detail Items/Taxes screen. To 
view this screen, select a detail line and click the Item/Tax button below the table, or press F9. 

Note: You use the Detail Items/Taxes screen to view or change tax    information for a detail. Detail tax 
fields do not appear in the detail table.

To add details using the detail table, do one of the following:

 l If a blank line is highlighted,      tab to the Item Number field, then either type the item number or 
select     it from the Finder. Enter the remaining information for the detail.

 l To start a new line, press      Insert or tab through the end of the last line on the table. 

If you want       to insert a new line in a specific location, highlight the line above     the location, and then press 
Insert.

Note: A detail line is saved as you enter it on the detail entry table. 

To edit details using the detail table: 

 l Select the line you     want to edit, and then enter your changes on that line.

Note: For information about using your keyboard to move within a detail table, see "Keyboard Shortcuts 
for Detail Tables" (page 565)

To delete details using the detail table: 

 1. Select the line you     want to delete.

 2. Press the Delete key on     your keyboard.

 3. If you see a message asking     you to confirm the deletion, click Yes.
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To edit item information or detail tax information using the Detail Items/Taxes screen:

 1. Select the detail on the table, and  then either click the Item/Tax button, or press F9.

 2. Edit the item information and/or change     the Tax Class or Tax Included options for the detail.

Keyboard Shortcuts for Detail Tables
Use the following keyboard shortcuts to navigate in detail tables.

Key Menu Command Action

Ins/Insert New Insert a blank row to add a new record.

Del/Delete Delete Remove the selected row.

Up or Down Arrow  Go up or down one row.

Left or Right Arrow  Go left or right one column.

Pg        Up  Go to the top row in view.

Pg Dn  Go to the bottom row in view.

Home First Go to the first row in a list.

End Last Go to the last row in a list.

Tab or Enter; 
Shift+Tab        or 
Shift+Enter

 Go to the next or previous column in a list.

Keyboard Shortcuts for Detail Tables

Setting Finder Criteria
To help you search quickly through a long list of records, you can use criteria to restrict the records that 
are displayed in the Finder and when    you use the navigation buttons. 

However, at other times, if the Finder uses criteria, it    might not display all the records you expect to see.

To check or remove the criteria:

 1. Click the Finder .

 2. Click the Set Criteria button.
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 3. On the screen that appears, click the Clear button.

For instructions on setting criteria, click the Help button when the    Set Criteria screen appears.
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Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.

Finding Help and Documentation
You can find information about setting up and using Sage 300 in the Sage 300 help and in the product 
documentation included with this release.

Note: For technical support, visit our customer support website at https://support.na.sage.com or 
contact your Sage business partner.

Context-Sensitive Help

Sage 300 features context-sensitive help that you can use to quickly open and view articles and 
information directly from Sage 300 screens.

 l On the Sage 300 Desktop, press F1 to view help for the current screen.

 l On Sage 300 Web Screens, click the help menu at the top of the screen to see help articles and 
resources related to your current task.

Product Documentation

Sage 300 includes guides in printable PDF format, including the Installation and Administration Guide, 
Upgrade Guide, and other documentation related to installation and setup.

These guides are available in the Docs folder on the Sage 300 server, and online at:

 l https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

To view the guides in the Docs folder:

 l On the Windows taskbar, click Start > Programs > Sage 300 > Documentation.

Support and Resources
Use the links below to find instructions,   software training, one-on-one support, technical specifications, or 
other   resources to get Sage 300 working smoothly for your business.
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Your Sage Business Partner is also an excellent resource to consult when you have questions about 
Sage 300.

How can we help you?

I'm setting up Sage 300 and need information or assistance

 l Sage 300 Resources online — https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_
Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage 300 Web Portal — www.sage.com/us/erp/sage-300

Find a business partner, get priority support, and more.

I'm looking for instructions to complete a task in Sage 300

While using Sage 300, you can get instructions directly from the software in the following ways:

 l Contextual Help  — To see topics related to your current task:

 l In the Sage 300 Desktop, press F1.

 l In Sage 300 Web Screens, click the help menu at the top of the screen.

 l Help Topics — To explore topics and information in the Sage 300 Desktop, click Help > Help 
Topics.

I think something is broken, or I'm getting error messages                 

Search our knowledge base for solutions to common issues, or contact us for one-on-one assistance.

 l Knowledge Base — https://support.na.sage.com

Find answers and solutions to FAQs and known software issues.

 l Customer Center — https://customers.sagenorthamerica.com/irj/portal/anonymous/login

Exclusive support for Sage customers.

 l Partner Center — https://partners.sagenorthamerica.com

Exclusive support for Sage partners.
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I'm looking for downloads, updates, or technical specifications                 

Find product updates, download resources, or review technical specifications for Sage 300.

 l Sage 300 Resources online — https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_
Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage Business Care — www.sage.com/us/erp/sage-business-care

Find links to support services, contact our support team, and learn how to guarantee your Sage 
software is always up to date.

I want to become a more skilled user of Sage 300

Find links to Sage software training, online communities, and more.

 l Sage University — https://sageu.csod.com/LMS/catalog/Welcome.aspx?tab_page_id=-67

Convenient, professional training options to help you achieve your business goals.

 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.

 l Priority Software Support — www.sage.com/us/erp/sage-business-care

Learn how to get unlimited support by phone, e-mail, and live chat.

I want to share knowledge with other Sage 300 users                 

Find and share tips, tricks, and solutions online in the Sage 300 Community.

 l Sage 300 Community — http://sagecity.na.sage.com/support_communities/sage300_erp

Explore Sage 300 blogs, discussions, FAQs, resources, and more. 

 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.
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I want to contact a Sage 300 representative                 

 l Support and Services — http://support.na.sage.com

Find links to support services, contact our support team, and learn how to guarantee your Sage 
software is always up to date.
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1

1096 reporting  See 1099/CPRS reporting

1099 Electronic Filing screen  305

fields and controls  306

1099/CPRS Codes report  368

printing  225

1099/CPRS Codes screen  352

fields and controls  353

1099/CPRS Inquiry screen  474

1099/CPRS reporting  16-17, 274, 368, See 
also T5018 (CPRS) reporting

amounts, removing from A/P  203

formats  44

inquiry  474

reporting  328

reports, printing  540

submitting electronically  205, 305

A

account activity  271, 473

queries  508, 518

account sets  18-19

controlling  312

multicurrency  9

vendor  508, 521

Account Sets report  360

printing  226

Account Sets screen  312

fields and controls  313

Accounts Payable setup  3, 12

activation dates  153-154, 156, 384

activity on accounts  271, 473

statistics, clearing  214

vendor  519

year end  304

addresses  492-493

Adjustment Batch List screen  370

fields and controls  371

Adjustment Entry screen  372

fields and controls  375

adjustments  164, 181

adding  184

batches  181-182, 370

deleting  182

G/L journal entries for  77

optional fields  184

posting  84, 183

advance credits  94

advices  257

printing  471

Index
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Aged Cash Requirements report  456-457

printing  235

Aged Payables report  458

printing  238

Aged Retainage report  459

printing  242

aging  325, 498

reports  458

vendor activity  498

ANSI-compliant check formats  46, 138

B

backdated documents, revaluing  208

bank codes  325, 435, 508

Batch Listing report  460

printing  245

batch processing  293

Batch Status report  463

printing  248

batches  182, 370, 398, 469

adjustments  181, 183, 370

cancelling  146

creating  82, 107, 140, 433

deleting  108, 146, 182, 398

displaying  370, 398, 433

editing  82

errors  468

forcing listing  81, 325

G/L  188, 292

imported  325

invoices  398

listing  87, 460, 463

numbering  435

numbers, resetting  214, 303

opening  182, 398

payments  129, 140, 146, 433

posting  84, 127

prepayments  173

printing  146

printing checks  136

processing  80

recurring payables  191

removing deleted and posting 
batches  203

revaluation  301

revaluing  301

system generated  325

tracking  86

types  80

billing types  92

buttons

Drilldown  561

Finder  561

Go  562

Navigation  563

New  563

Zoom  563

C

Calculate Taxes button  401

572Sage 300 2023 Accounts Payable User's Guide



cash invoices  175

Check Register report  464

printing  250

checking integrity  191

checks  346, 435, 471

ANSI-compliant  138

batches  325

cancelling  435

duplicated  325

formats  44

generating  140, 147, 390

inquiry  497

miscellaneous  176, 179

posting  137

printing  136, 252, 255, 471-472

refunds, clearing electronically  46

reversing  135

voiding  139, 173

Clear History screen  288

fields and controls  289

Clear Statistics screen  291

fields and controls  292

codes  13, 36, 352, 367

terms  354

commands  560

comments  325

clearing  288

vendor  519

company options  326

contracts  401

Control Payments screen  384

fields and controls  385

CPRS reporting  See 1099/CPRS reporting

Create G/L Batch screen  292

fields and controls  293

Create Payment Batch screen  388

fields and controls  391

Create Recurring Payable Batch screen  294

fields and controls  295

Create Retainage Batch screen  296

fields and controls  297

credit notes  89, 398, 401

aging  325

applying  91, 164-165

deleting  108, 126

distributing  91

G/L journal entries for  76

multicurrency  101

CSV files  188

custom fields  See optional fields

D

data entry screens  565

data integrity  191, 299

date tables  40

days to pay counter  304

debit notes  89, 101, 108, 398, 401

aging  325

applying  91
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deleting  126

distributing  91

G/L journal entries for  76

Delete Inactive Records screen  298

fields and controls  298

delivery methods  278, 543

Derive Rate button  401

detail entry tables  564

discount date tables  354

discounts  93

payment controls  153-154, 156, 384

terms  40, 354

Distribute Taxes button  401

distribution codes  21, 24, 359

Distribution Codes report  361

printing  227

Distribution Codes screen  359

fields and controls  359

distribution method  508

distribution sets  24, 315

Distribution Sets report  362

printing  228

Distribution Sets screen  315

fields and controls  316

documentation and help  567

documents  6, 114

applying  165

forcing  156

headers  114

numbering  326

on hold  156

order  6, 328

status, changing  152-154, 156, 384

Drilldown button  561

due dates  40

E

e-mail  28-29

printing reports as attachments to  222

variables  28

E-mail Messages report  363

printing  229

E-mail Messages screen  318

fields and controls  319

electronic filing  305

exchange gains and losses  18

exchange rates  134, 374, 390, 401, 508, 521

entering on invoices  118

exporting  15

F

File menu commands  558

Close  558

Customize  558

Export  558

Import  558

Print  559

Print Setup  559

Save  559
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Finder button  561

setting criteria  565

FIRE system  305

fiscal periods, locked  79

fiscal years  304

starting a new year  214

forced documents  151, 153-154

form letters  277, 543

function keys  560

functional currency  325

G

G/L (general ledger)  75, 292

account sets  312

batches  292

distribution codes  359

distribution sets  315

integration with A/P  10, 320

reports  88

source codes for transactions  75, 261

transactions  188

G/L Integration report  364

printing  229

G/L Integration screen  320

fields and controls  322

G/L Transactions report  465

printing  259

Go button  562

guides and documentation  567

H

Help menu  560

history  67, 164

clearing  203, 288

deleting  201, 288

I

icons  560

importing  15

inactive records  298

deleting  201-203, 298

remit-to locations  492

vendor groups  508

Inquiry  See also queries

Installation and Administration Guide  567

installing Sage 300, documentation on  567

installment payments  354, 401

integrity

checking  191

Integrity Checker screen  299

fields and controls  300

intercompany transactions  109

interest  91

Invoice Batch List screen  398

fields and controls  399

Invoice Entry screen  401

fields and controls  406

575Sage 300 2023 Accounts Payable User's Guide



invoices  89, 101, 401, 508

batches  107-108, 127, 327, 399

clearing  215

deleting  126

distributing  91

entering  108

entering prepayments with invoices  119

exchange rates, editing  118

G/L journal entries for  75

interest  91

job-related  90, 121

optional fields  102, 104

options  327

paid invoices, clearing  203, 303

payment schedules  94

posting  84

recurring payables  65, 122, 191, 294, 476

taxes  325

IRS FIRE system

using to file 1099s  305

J

Jobs button  435

journal entries  75

journals  88, 269-270, 469

K

keyboard shortcuts

for detail tables  565

keys  560

L

labels  277, 543

letters  277, 543

Letters and Labels report  543

locations, remit-to  280, 492

locked fiscal periods  79

M

mail merges

variables for e-mail messages  28

menus and commands  558, 560

File  558

Help  560

Settings  559

miscellaneous checks  176

miscellaneous payments  179, 435

applying  176

G/L journal entries for  77

month end activities  288, 291, 293, 298, 301

multicurrency  101, 325, 401

entering exchange rate information  118

ledger  301, 372, 391, 435

reports  269

revaluing transactions  208

setting up Accounts Payable to use  8

multiple payments  354, 401

schedules  94
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N

Navigation buttons  563

New button  563

normal status documents  153-154, 384

numbering  13, 312, 435

options  8, 325

O

On Hold documents  151, 153-154, 384

open documents  6

optional fields  30, 341

adjustments  185

invoices  102, 104

payments  135, 346, 389

remit-to locations  492

vendor groups  509

Optional Fields report  364

printing  230

Optional Fields screen  341

fields and controls  342

options  6, 8

for printing reports  224

Options report  365

printing  231

Options screen  325

fields and controls  328

original documents, adjusting  195

orphan records  300

Overdue Payables report  467

printing  261

P

paid invoices

clearing  203, 304

parent records  300

payables reports  261, 457-458, 467

payables, recurring  65, 191

Payment Batch List screen  433

fields and controls  434

Payment Codes report  366

printing  232

Payment Codes screen  344

fields and controls  345

Payment Entry screen  435

fields and controls  437

Payment Inquiry screen  453

fields and controls  453, 475

Payment Selection Codes report  367

printing  233

Payment Selection Codes screen  346

fields and controls  347

payments  129, 157, 435

adjustments  170

applying  157, 162

batches  105, 140, 147, 389

checks  136, 252, 255

checks, reprinting  139
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codes  36, 344

controlling  151, 153-154, 156, 384

deleting  146

displaying  6, 163

distributing  179

due dates  354

excluding vendors  149

G/L journal entries for  76

limits  133

listing  146, 433

miscellaneous  176

optional fields  135

options  325

posting to future year  134

queries  497

schedules  94, 354, 401

selection codes  36-37, 346

system-generated  147

terms  40, 354, 367

types  132

vendor activity  497

period end activities  187

G/L transactions, creating  292

history, clearing  288

inactive records, deleting  298

revaluation  301

statistics, clearing  291

year end  303

period statistics

vendor groups  285, 508, 548

vendors  284, 518, 547

periodic processing  187, 293, 301

history, clearing  288

inactive records, deleting  298

recurring payables  294

statistics, clearing  291

year-end  213, 303

Periodic Processing screens

1099 Electronic Filing screen  305

Clear History screen  288

Clear Statistics screen  291

Create G/L Batch screen  292

Create Recurring Payable Batch 
screen  294

Create Retainage Batch screen  296

Delete Inactive Records screen  298

Revaluation screen  301

T5018 (CPRS) Electronic Filing 
screen  308

Year End screen  303

Post Batches screen  455

fields and controls  456

posted transactions  469

posting errors

clearing  203

Posting Errors report  468

printing  265

posting journals  75, 88

printed  203

revaluation  269
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Posting Journals report  469

printing  266

posting sequence numbers  320

Pre-Check (Payment) Register report

printing  269

pre-revaluation listings  269

prepayments  119, 173, 435

aging  325

applying  164-165

G/L journal entries for  77

numbering  7

Print 1099/1096 Forms report  540

printing  274

print destinations  221-222

e-mail attachment  222

file  222

physical printer  222

preview (on screen)  222

Print T5018 (CPRS) Forms report  541

printing  276

printed forms  274, 277, 471, 543

sample formats  44

printer

assigning to a specific report  223

printer, physical

setting as print destination  222

printing

setting a print destination  221

printing reports  223

options  224

processing options  8

processing sequence numbers  320

provisional revaluation  301

Q

queries  498-499, 509, 519, 521

Quick Mode  559

R

Ready To Post status  398

Realized and Unrealized Gain/Loss 
accounting method  208

Recognized Gain or Loss accounting 
method  208

records

clearing  288

importing and exporting  15

inactive, deleting  201, 298

recurring payables  65, 122, 191, 476

clearing amounts at year end  214

reminders  476

Recurring Payables report  544

printing  279

Recurring Payables screen  476

fields and controls  479

remit-to locations  61

deleting  492

queries  492
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Remit-To Locations report  545

printing  280

Remit-To Locations screen  492

fields and controls  494

reports  88, 219, See also entries for specific 
reports

customizing  224

print destinations  222-223

printing  44

printing options  224

printing to a destination  221

Reports screens

1099/CPRS Codes report  368

Account Sets report  360

Aged Cash Requirements report  456

Aged Payables report  458

Aged Retainage report  459

Batch Listing report  460

Batch Status report  463

Check Register report  464

Distribution Codes report  361

Distribution Sets report  362

E-mail Messages report  363

G/L Integration report  364

G/L Transactions report  465

Letters and Labels report  543

Optional Fields report  364

Options report  365

Overdue Payables report  467

Payment Codes report  366

Payment Selection Codes report  367

Posting Errors report  468

Posting Journals report  469

Print 1099/1096 Forms report  540

Print Checks report  471

Print T5018 (CPRS) Forms report  541

Recurring Payables report  544

Remit-To Locations report  545

Terms report  367

Vendor Activity Statistics report  545

Vendor Group List report  549

Vendor Group Statistics report  548

Vendor Period Statistics report  547

Vendor Transactions report  472

Vendors report  550

retainage  195

options  8

returned goods  94

revaluation  301

Revaluation Posting Journal

printing  269

Revaluation screen  301

fields and controls  302

S

schedules, for payments  94, 354

screen guides  288

security authorizations  552

selection codes  346

setting up Accounts Payable  3
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Settings menu commands  559

Auto Clear  559

Clear Saved Settings  560

Save Settings as Defaults  560

settlement

exchange gains and losses  211

Setup screens    See also individual Setup 
reports

1099/CPRS Codes  352

Account Sets  312

Distribution Codes  359

Distribution Sets  315

E-mail Messages  318

G/L Integration  320

Optional Fields  341

Options  325

Payment Codes  344

Payment Selection Codes  346

Terms  354

shortcuts  560

source codes for G/L transactions  75, 261

statistics  70, 509, 519

activity statistics  281, 546

clearing  288

options  325

period statistics  283, 285, 547-548

year end  304

status of batches, changing  370, 398, 433

status of documents, changing  153-154, 
156, 384

T

T5018 (CPRS) Electronic Filing screen  308

fields and controls  309

T5018 (CPRS) reporting  44, 206, 276, See 
also 1099/CPRS reporting

taxes  95, 508, 518

calculating  99, 116-117, 401

changing for single distribution lines  99

distributing  99

groups  98

method of calculating  325

recurring payables  476

reporting  325

reporting amounts  401

self-assessed  5, 99

status  401

technical support  567

terms for payment  354

specifying for vendors and vendor 
groups  508, 518

terms codes  40, 42

Terms report  367

printing  234

Terms screen  354

fields and controls  354

tools  560

Transaction screens    See also individual 
Transaction reports

Adjustment Batch List  370
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Adjustment Entry  372

Control Payments  384

Create Payment Batch  388

Invoice Batch List  398

Invoice Entry  401

Payment Batch List  433

Payment Entry  435

Payment Inquiry  453

Post Batches  455

transactions  88

adjusting  184

applying  162, 164

batch types  80

editing  82, 163

G/L batches, creating  293

options  8, 327

reporting  261, 467, 469

revaluing  301

source codes for G/L  261

U

Upgrade Guide  567

V

variables

for e-mail messages  28

Vendor Activity screen  497, 499

fields and controls  499

Vendor Activity Statistics report  545

printing  281

Vendor Group List report  549

printing  282

Vendor Group Statistics report  548

printing  284

vendor groups  47-48

Vendor Groups screen  508-509

fields and controls  510

vendor list  See Vendors report

Vendor Period Statistics report  547

printing  283

Vendor Transactions report  472

printing  271

vendors  50, 58

addresses  56

comments  55, 325

contacts  57

excluding from payment batches  149

history, clearing  288

listing  285

optional fields  341

remit-to locations  280, 492

statistics  70, 284, 291

Vendors report  550

printing  285

Vendors screen  518-521

fields and controls  522

Vendors screens

1099/CPRS Inquiry  474

Recurring Payables  476

Remit-To Locations  492
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Vendor Activity  497

Vendor Groups  508

Vendors  518

Y

year end  213-214, 304

Year End screen  303

fields and controls  304

Z

Zoom button  563
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